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Avant-propos 

 
Ce manuel présente une série d’exercices de télédétection spatiale, prêts à l’emploi, avec 
données et logiciels libres. Les exercices vont du « niveau découverte » à un « niveau plus 
avancé » tout en restant très abordables pour des étudiants de Master 1 et 2. Les exercices 
peuvent se réaliser en autonomie grâce aux instructions méthodologiques détaillées et aux 
nombreuses illustrations. En plus des exercices en tant que tels de nombreuses ressources 
complémentaires sont proposées (sites web, applications). 
 
 
Ce manuel et les données y afférentes sont libres de droit et redistribuables moyennant une 

mention de la source*. Ils sont téléchargeables gratuitement à l’adresse web : 

https://orbi.uliege.be/handle/2268/240835. 

 

Pensez à l’environnement avant d’imprimer ces notes!!** 
 
 

Ce manuel a été rédigé par Antoine DENIS 
Université de Liège (ULIEGE) 

Arlon Campus Environnement 
Département des Sciences et Gestion de l’environnement 

Unité Eau Environnement Développement (EED) 
 Avenue de Longwy, 185 

6700 Arlon, Belgique 
Antoine.Denis@ULiege.be 

 
 
Merci de signaler toute erreur rencontrée dans ce manuel par email à l’adresse ci-dessus. 
Les mises à jour de ce manuel seront disponibles via l’adresse web ci-dessus. 
 
 
 

Version du 20 mars 2026 

 
 
 
 

Images de couverture : images extraites du livre « EARTH as ART », NASA disponible à l’adresse 
http://www.nasa.gov/connect/ebooks/earth_art_detail.html et vue d’artiste du satellite « Sentinel 2 ». 

 
* Comment citer ce manuel ? : « DENIS Antoine, 2021, Travaux Pratiques de télédétection spatiale II - Avec données et 

logiciels libres, ULIEGE, Belgique, https://orbi.uliege.be/handle/2268/240835 ». 
 

** N’imprimez pas ces notes ! Si vous devez les imprimer, utilisez le verso de feuilles déjà utilisées, imprimez recto-verso 
et/ou imprimez en 2 pages par feuilles.  

https://orbi.uliege.be/handle/2268/240835
https://www.eed.uliege.be/cms/c_4961023/fr/eed-equipe
https://www.uliege.be/cms/c_8699436/fr/portail-uliege
https://www.campusarlon.uliege.be/cms/c_3973705/fr/portail-arlon
https://www.campusarlon.uliege.be/cms/c_3973705/fr/portail-arlon
https://www.eed.uliege.be/
mailto:Antoine.Denis@ULiege.be
http://www.nasa.gov/connect/ebooks/earth_art_detail.html
https://orbi.uliege.be/handle/2268/240835
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Du même auteur 

 

Sont également disponibles, du même auteur, les manuels de Travaux Pratiques suivants: 

 

Manuel de TP Année Pages 
Adresse de 

téléchargement 
Commentaires 

SIG – ArcGIS 9.3 2012 89 https://orbi.ulg.ac.be/
handle/2268/135775 

ArcGIS = le logiciel SIG payant de référence. 

Données fournies. 

SIG – QGIS 2026 254 http://orbi.ulg.ac.be/h
andle/2268/190559 

QGIS = le logiciel SIG gratuit de référence. 

Données fournies. 

Chaine YouTube  : 
https://www.youtube.com/@TutorielsSIGett%C
3%A9l%C3%A9d%C3%A9tectio-f5j  

Télédétection 
spatiale I 

2020 111 https://orbi.ulg.ac.be/
handle/2268/143553 

Ancienne version de ce manuel-ci basée 
essentiellement sur le logiciel payant ENVI.  

Données fournies.  

Télédétection 
spatiale II 

2025 461 
https://orbi.uliege.b
e/handle/2268/2408
35 

Ce manuel-ci, avec données et logiciels libres.  

Données fournies. 

Ce manuel reprend la très grande majorité du 
contenu du manuel « Télédétection spatiale I » 
mais adapté avec données et logiciels libres,  
souvent en version améliorée, et présente une 
série d’exercices et ressources supplémentaires. 

 
 
Egalement disponible, une « Revue des modes de représentation de l'information 
spatiale » 

• https://orbi.uliege.be/handle/2268/241653 (2021) 
 
 
Toutes les publications de l’auteur sont disponibles en libre accès ici : 

• https://orbi.uliege.be/profile?uid=p005248 
https://orbi.uliege.be/browse?type=author&value=Denis%2C+Antoine+p005248 

 
  

https://orbi.ulg.ac.be/handle/2268/135775
https://orbi.ulg.ac.be/handle/2268/135775
http://orbi.ulg.ac.be/handle/2268/190559
http://orbi.ulg.ac.be/handle/2268/190559
https://www.youtube.com/@TutorielsSIGett%C3%A9l%C3%A9d%C3%A9tectio-f5j
https://www.youtube.com/@TutorielsSIGett%C3%A9l%C3%A9d%C3%A9tectio-f5j
https://orbi.ulg.ac.be/handle/2268/143553
https://orbi.ulg.ac.be/handle/2268/143553
https://orbi.uliege.be/handle/2268/240835
https://orbi.uliege.be/handle/2268/240835
https://orbi.uliege.be/handle/2268/240835
https://orbi.uliege.be/handle/2268/241653
https://orbi.uliege.be/profile?uid=p005248
https://orbi.uliege.be/browse?type=author&value=Denis%2C+Antoine+p005248
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1. Introduction 

1.1. Objectifs de ce manuel 

Ce manuel présente une série d’exercices de télédétection spatiale, prêts à l’emploi, avec 

données et logiciels libres. Les exercices vont du « niveau découverte » à un « niveau plus 

avancé » tout en restant très abordables pour des étudiants de Master 1 et 2. Les exercices 

peuvent se réaliser en autonomie grâce aux instructions méthodologiques détaillées et aux 

nombreuses illustrations. En plus des exercices en tant que tels de nombreuses ressources 

complémentaires sont proposées (sites web, applications). 

Ce manuel propose : 

▪ La présentation de quelques concepts de base via quelques rappels théoriques 

▪ Des exercices de pure découverte via 

o La découverte d’applications web (Google Earth Pro, portails web) permettant 

de visualiser des images satellites et de réaliser des analyses sommaires 

o L’exploration de base d’une image satellite dans QGIS (ouverture, description 

technique, technique de visualisation 2D et 3D, etc) 

▪ La présentation de quelques portails web mettant à disposition au téléchargement 

des images satellites de différents types : USGS Earth Explorer, Copernicus Open 

Access Hub,… 

▪ Une variété de techniques d’analyse de données d’observation de la terre :  

o Analyse de changement visuelle et mathématique 

o Analyse de séries temporelles d’images via des applications web et des 

logiciels spécialisés (SPIRITS, R et RSTUDIO) 

o Classification supervisée d’images satellites multispectrales 

o Analyse diachronique pour étudier l’évolution de l’occupation du sol 

o La cartographie de zones inondées par télédétection RADAR (SAR-Sentinel-1) 

o La découverte de Google Earth Engine et la possibilité de travailler facilement 

à l’échelle de la planète via le cloud 

▪ Appliquées sur une variété de type d’images :  

o De diverses résolutions spectrales : multispectrale, hyperspectrale, RADAR 

o De diverses résolutions spatiales : basse à très haute résolution spatiale 

▪ Avec des outils, logiciels ou applications web, récents et libres : QGIS, SPIRITS, SNAP, 

R et RSTUDIO, Google Earth Engine, Google Earth Pro, EO Browser, etc 

▪ La présentation de nombreuses ressources en ligne supplémentaires : sites web 

intéressants, exemples d’applications liées à la gestion des risques et des 

catastrophes, sites web de référence mettant à disposition des tutoriaux, etc  
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1.2. Accès aux données et ressources relatives à ce manuel 

Ce manuel et les données nécessaires pour faire les exercices sont disponibles gratuitement 

via le site web ORBI de l’ULIEGE à l’adresse : 

• https://orbi.uliege.be/handle/2268/240835 

 

Attention !, l’ensemble des données est très volumineux (~3.5 Go pour 
l’ensemble du manuel). Ne téléchargez donc PAS systématiquement toutes les 
données mises à disposition mais uniquement les données nécessaires pour les 
exercices que vous entreprenez. L’encadré en début de chaque section du 
manuel vous indiquera quel dossier vous devrez télécharger pour mener à bien 
cette section. Vous téléchargerez ces données sur votre ordinateur en local. 

 

 
Attention !, le répertoire qui accueillera les données sur votre ordinateur 
personnel : 

• Ne doit pas être trop longs : idéalement votre répertoire de travail doit 
se trouver proche de la racine d’un disque dur (proche de la lettre du 
disque dur) 

• Ne doit pas contenir de caractères spéciaux (é, à, è, -, etc) ou espace 
(préférez l’underscore « _ ») mais uniquement des chiffres ou des lettres 
de base sans accents. 

Téléchargez le/les dossiers d’intérêt 

Placez chaque dossier téléchargé dans votre répertoire de travail.  

Décompressez/dézippez les dossiers compressés avant de les utiliser.  

Les données non directement disponibles sur ORBI (parce que trop volumineuses) sont 

téléchargeables à partir des sites web renseignés dans chacune des sections.   

https://orbi.uliege.be/handle/2268/240835
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1.3. Conseil d’utilisation de ce manuel 

Aidez-vous, pour naviguer dans ce document, de la table des matières et des « signets » du 

document PDF disponibles via le panneau latéral de gauche de ce document (Figure 1). 

Vous remarquerez que de nombreux hyperliens renvoyant à des sections parfois éloignées 

dans le document sont utilisés. Pour revenir facilement à l’endroit à partir duquel l’hyperlien 

a été cliqué, utilisez, dans le logiciel Adobe Acrobat Reader, les touches « alt flèche 

gauche ». 

 
Figure 1 : Utilisez les signets pour naviguer plus facilement dans ce manuel ! 
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1.4. Liens avec les cours ULIEGE 

Ce document est le manuel des travaux pratiques de télédétection spatiale utilisé pour les 

cours ULIEGE (Belgique) suivants : 

• ENVT2027-3 : 30 heures de TP dont 12 en télédétection 

• ENVT2027-4 : 24 heures de TP dont 12 en télédétection 

• RISQ2018-1 : 36 heures de TP dont 18 en télédétection 

Les parties de ce manuel vues lors de ces différents cours sont sélectionnées en fonction des 

objectifs spécifiques de chaque cours. 

Ce manuel présente, en plus des exercices réalisés dans le cadre de ces cours avec les 

étudiants, une série de ressources supplémentaires.  

 

https://www.uliege.be/cms/c_8699436/fr/portail-uliege
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2. Notions de télédétection - Quelques 

rappels théoriques 

2.1. La télédétection 

La télédétection (détection à distance, Remote Sensing (RS) en anglais) désigne, dans son 

acception la plus large, la mesure ou l'acquisition d'informations sur un objet ou un 

phénomène, par l'intermédiaire d'un instrument de mesure n'ayant pas de contact avec 

l'objet étudié (Figure 2).  

C'est l'utilisation à distance (par exemple, d’un drone, d'un avion, d'un engin spatial, d'un 

satellite ou encore d'un bateau) de n'importe quel type d'instrument permettant 

l'acquisition d'informations sur l'environnement. On fait souvent appel à des instruments 

tels qu’appareils photographiques, lasers, radars, sonars, sismographes ou gravimètres.  

 

Figure 2 : Principe de la télédétection spatiale passive (Source : http://www.alertes-
meteo.com/) 

 

http://fr.wikipedia.org/wiki/Satellite_artificiel
http://fr.wikipedia.org/wiki/Bateau
http://fr.wikipedia.org/wiki/Environnement
http://fr.wikipedia.org/wiki/Laser
http://fr.wikipedia.org/wiki/Radar
http://fr.wikipedia.org/wiki/Sonar
http://fr.wikipedia.org/wiki/Sismographe
http://fr.wikipedia.org/wiki/Gravim%C3%A8tre
http://www.alertes-meteo.com/
http://www.alertes-meteo.com/
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L’on distingue en général les moyens de télédétection « actif » et « passif » (Figure 3): 

• Télédétection passive: enregistrement du rayonnement naturel, fourni par la lumière 

ou la chaleur, qu’il soit émis, réfléchi ou réfracté (ex : photographies aériennes du 

paysage éclairé par la lumière du soleil ainsi que certaines images satellitaires comme 

SENTINEL-2, LANDSAT, IKONOS, SPOT,…) 

• Télédétection active : enregistrement du rayonnement que réfléchit l’objet ou le 

paysage « illuminé » par l’appareil de mesure (ex : images radar (SENTINEL-1,…)) 

 

 

Figure 3 : Illustration des principes de télédétection passive (à gauche) et de télédétection active (à 
droite). (Source de l’illustration : https://paititi.info/research-technology/remote-sensing-from-
space/) 

 

La télédétection spatiale, dans le domaine de l'astronautique, est l'ensemble des 

connaissances et des techniques utilisées pour déterminer les caractéristiques de la surface 

et de l'atmosphère de la Terre ou d'une autre planète, par des mesures effectuées à partir 

d'un engin spatial évoluant à distance convenable de cette dernière. Le terme correspondant 

en anglais est « remote sensing from space ». 

La télédétection spatiale mesure les rayonnements électromagnétiques émis ou réfléchis 

des objets étudiés (végétation, sol, bâtit, surfaces d'eau ou masses d'air, etc) dans un certain 

domaine de longueurs d’ondes ou fréquences (infrarouge, visible, micro-ondes - voir Annexe 

3). Le rayonnement électromagnétique émis ou réfléchis par ces objets peut varier en 

intensité selon la nature de ces objets et selon leur état (teneur en eau, chaleur, etc), ce qui 

permet d’utiliser ce rayonnement électromagnétique pour les identifier et les caractériser.   

Certains instruments de télédétection utilisent des ondes sonores de façon similaire, et 

d'autres mesurent des variations dans des champs magnétiques ou gravitaires. 

https://paititi.info/research-technology/remote-sensing-from-space/
https://paititi.info/research-technology/remote-sensing-from-space/
http://fr.wikipedia.org/wiki/Astronautique
http://fr.wikipedia.org/wiki/Terre
http://fr.wikipedia.org/wiki/Plan%C3%A8te
http://fr.wikipedia.org/wiki/Engin_spatial


24 
 

2.2. La lumière et les longueurs d’ondes 

La lumière blanche du soleil se décompose en lumières colorées de l’arc-en-ciel qui 

correspondent chacune à une longueur d’onde spécifique (confer les 2 figures ci-dessous). 

Un prisme en verre décompose la lumière du Soleil dans toutes ses couleurs et crée un arc-

en-ciel : c'est le spectre de la lumière visible du Soleil. 

Le Soleil produit aussi des types de lumière imperceptibles à l'œil, comme les rayons 

ultraviolets et infrarouges, qui font aussi partie du spectre électromagnétique solaire.  

(Source : NASA/ESA/L. Hustak (STScI), Agence spatiale canadienne.) 
 

 

Source de l’illustration : https://www.asc-csa.gc.ca/fra/multimedia/recherche/image/17423  

 

 

Source des illustrations : https://www.happyview.fr/images/cms/ultraviolets.jpg ; https://lab.cercle-
promodul.inef4.org/knowledge/post/lumiere-naturelle-les-grandeurs-physiques-partie-1  

https://www.asc-csa.gc.ca/fra/multimedia/recherche/image/17423
https://www.happyview.fr/images/cms/ultraviolets.jpg
https://lab.cercle-promodul.inef4.org/knowledge/post/lumiere-naturelle-les-grandeurs-physiques-partie-1
https://lab.cercle-promodul.inef4.org/knowledge/post/lumiere-naturelle-les-grandeurs-physiques-partie-1
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2.3. La réflectance solaire 

La réflectance solaire se définit comme le rapport entre l'énergie solaire réfléchie et 

l'énergie solaire incidente sur une surface (Energie Solaire Réfléchie / Energie Solaire 

Incidente (Figure 4). Par exemple, une réflectance de 100% signifie que la surface en 

question réfléchit toute l'énergie solaire dans l'atmosphère et n'en absorbe aucune fraction. 

 

 

 

Figure 4 : Principe de la réflectance solaire 
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2.4. La signature spectrale et les capteurs satellites 

La signature spectrale d’un élément/d’une matière correspond à la représentation 

graphique de la variation de sa réflectance (axe Y) en fonction des longueurs d’onde du 

spectre auquel le capteur utilisé est sensible (axe X) (Figure 5). Différents éléments/matières 

(ex : terre vs végétation) ou des éléments/matières présentant différents états (ex : plus ou 

moins humide/sec) présenteront en général une signature spectrale différente. La signature 

spectrale peut donc être utilisée pour identifier/reconnaitre/caractériser différents 

éléments/matières et/ou leur état.  

 

Figure 5 : Signature spectrale de différentes matières/éléments du paysage 

Les capteurs multispectraux embarqués sur la plupart des satellites d’observation de la terre 

n’enregistrent pas la signature spectrale de la surface terrestre avec autant de précision que 

présenté à la Figure 5. Ils enregistrent en général l’énergie réfléchie par la surface de la terre 

dans quelques gammes assez larges de longueurs d’ondes tel que présenté pour quelques 

capteurs satellites bien connus à la Figure 6. La « signature spectrale » dérivée de ce type de 

capteur ne sera donc composée que de quelques valeurs, une par bande spectrale. 

Cependant certains capteurs satellites (rares), dit « hyperspectraux », peuvent enregistrer 

une signature spectrale très précise grâce à un très grand nombre de bandes spectrales 

étroites, comme pour le capteur CHRIS embarqué sur le satellite PROBA 1 (Figure 6). 
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Figure 6 : Signature spectrale typique de la végétation verte et résolutions spectrales et spatiales 
de différents capteurs satellites multispectraux bien connus et d’un capteur hyperspectral (capteur 
CHRIS sur le satellite PROBA 1). Les rectangles de couleurs correspondent aux différentes bandes 
spectrales disponibles dans une image satellite. (Source : adapté de DENIS A, 2018, Can satellites 
help organic crops certification? https://orbi.uliege.be/handle/2268/226209)  

  

https://orbi.uliege.be/handle/2268/226209
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2.5. Exemples d’applications de la télédétection 

Les exemples d’applications de la télédétection spatiale sont très nombreux : 

• La production de cartes d’occupation du sol par classification de données 

multispectrales ou autres 

• Le suivi des conditions de végétation naturelle ou agricole via l’utilisation de séries 

temporelles d’indices de végétation (ex : NDVI, FAPAR, etc) 

• Le suivi des catastrophes naturelles telles que les inondations, glissements de 

terrain, tremblements de terre, incendies, déforestation, pollutions marines, etc  

• Le suivi du changement climatique et des effets induits : suivi de la température de 

surface (eau et continent), de la fonte des glaces, du niveau des mers, etc  

• La mesure du relief et la réalisation de cartes topographiques via stéréoscopie ou 

télédétection radar 

• La détection des précipitations, des aéronefs et des navires via télédétection radars  

• La cartographie des fonds marins via l’utilisation de sonars 

• … 

 

   
Figure 7 : Quelques exemples d’application de la télédétection spatiale : carte d’occupation du sol, 
suivi des conditions atmosphériques, réalisation de Modèles Numériques de Terrain (MNT) 
 

  

http://fr.wikipedia.org/wiki/Carte
http://fr.wikipedia.org/wiki/Pr%C3%A9cipitation
http://fr.wikipedia.org/wiki/A%C3%A9ronef
http://fr.wikipedia.org/wiki/Navire
http://fr.wikipedia.org/wiki/Radar
http://fr.wikipedia.org/wiki/Sonar
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2.6. Les différents types de résolutions des images 

satellites 

2.6.1. Résolution spatiale 

o Correspond à la longueur des côtés des pixels de l’image 

o Habituellement exprimée en mètres (ou en kilomètres pour les images de basse 

résolution spatiale ≥ 1km) 

 
30 mètres (Landsat)      15 mètres (Aster) 

 
10 mètres (SPOT 5)     250 mètres (MODIS) 

 

2.6.2. Résolution temporelle (d’une série temporelle d’images ou d’un 

capteur) 

o Fréquence à laquelle les images d’une série temporelle sont disponibles/captées 
pour un endroit donné 

 

Série temporelle de 36 images NDVI décadaires (36 images * 10 jours = 360 jours = 1 an) 
issues du capteur SPOT VEGETATION pour le Pakistan (gauche) et évolution temporelle du 
NDVI en un pixel présentant une alternance marquée de l’état de la végétation selon les 
saisons (droite). La résolution temporelle de cette série est de « 1 image / 10 jours ». 
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2.6.3. Résolution spectrale 

o Aptitude d'un système de détection à distinguer des rayonnements 

électromagnétiques de fréquences (/de longueurs d’onde) différentes. 

o Le nombre et la largeur (gamme de longueurs d’ondes) des bandes spectrales d’une 

image (ou auxquelles un capteur est sensible). 

o Plus la résolution spectrale est fine, plus les gammes de longueurs d’ondes des 

différents canaux du capteur sont étroites. 

 

  

Résolution spectrale du capteur SPOT 4, 
composé de 4 bandes de largeurs comprises 
entre 70 et 170 µm : 

• B1 : 0,50 à 0,59 mm (90 µm) 

• B2 : 0,61 à 0,68 mm (70 µm) 

• B3 : 0,78 à 0,89 mm (110 µm) 

• MIR : 1,58 à 1,75 mm (170 µm) 

« Cube hyperspectrale », issu d’un capteur 
hyperspectral (à très haute résolution 
spectrale). Par exemple : 2150 bandes 
spectrales de 1 nm de large chacune. 
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2.6.4. Résolution radiométrique 

o La résolution radiométrique d'un système de télédétection décrit sa capacité à 

reconnaître de petites différences dans l'énergie électromagnétique. Plus la 

résolution radiométrique d'un capteur est fine, plus le capteur est sensible à de 

petites différences dans l'intensité de l'énergie reçue.  

o La résolution radiométrique est définie par le nombre maximum de niveaux 

d'intensité d'énergie électromagnétique que le capteur peut enregistrer et dépend 

du nombre de bits utilisés pour représenter l'intensité enregistrée, par exemple : 

o Si 8 bits sont utilisés, 28 soit 256 valeurs numériques allant de 0 à 255 sont 

disponibles 

o Si 4 bits sont utilisés, 24 soit 16 valeurs numériques allant de 0 à 15 sont 

disponibles 

 
4 bits 

 
8 bits 

 
2 bits 

 
8 bits 

 
 
Sources d’inspiration de la section 2.6 : 

• Centre canadien de télédétection : http://cct.rncan.gc.ca/index_f.php 

• International Training in Yield forecasting, Introduction to remote sensing for 
agriculture applications, Pr. Pierre Defourny (UCL - Geomatics) 

  

http://cct.rncan.gc.ca/index_f.php
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2.7. Longueurs d’ondes et fréquences du spectre 

électromagnétique 

 

  
(Source: http://en.wikipedia.org/wiki/Electromagnetic_spectrum) 

 

Les couleurs du spectre de la lumière visible 

Couleurs Intervalles de longueur d’ondes Intervalles de fréquence 

Rouge ~ 630–700 nm ~ 480–430 THz 

Orange ~ 590–630 nm ~ 510–480 THz 

Jaune ~ 560–590 nm ~ 540–510 THz 

Vert ~ 490–560 nm ~ 610–540 THz 

Bleu ~ 450–490 nm ~ 670–610 THz 

Violet ~ 400–450 nm ~ 750–670 THz 

http://en.wikipedia.org/wiki/Electromagnetic_spectrum
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3. Découverte de « Google Earth Pro » 

 

 

Objectifs 
pédagogiques 

Découverte de Google Earth Pro et de ses principales fonctionnalités. 

 

Données 
Aucune donnée spécifique n’est nécessaire pour la réalisation de cet 
exercice. 

 

Logiciel ou 
application 

« Google Earth Pro sur ordinateur » 
https://www.google.com/intl/fr/earth/versions/. 

 

Temps 
approximatif 

~ 30 minutes. 

 

Prérequis Aucun. 

 

Consignes de 
départ 

A l’aide des indications ci-dessous : 

• Installez « Google Earth Pro » sur votre ordinateur et  

• Explorez les quelques fonctionnalités de « Google Earth Pro » 
présentées. 

 
 

 

 

 

 

 

 

 

 

 

 

 

https://www.google.com/intl/fr/earth/versions/
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« Google Earth Pro » est probablement la plus belle application de la télédétection spatiale 

réalisée à ce jour. C’est une représentation de la planète terre en 3D, interactive et 

disponible en ligne, construites à partir d’un très grand nombre (milliers/millions ?) d’images 

satellites issues de différents capteurs, de différentes résolutions spatiales et enregistrées à 

différents moments. Il ne s’agit donc pas (encore) d’une visualisation en directe de la terre ! 

Google Earth Pro intègre une série de fonctionnalités et de très nombreuses données 

supplémentaires (limites administratives, photos, lieux, météo, relief, bâtiments 3D, etc) 

(Figure 8 et Figure 9). 

Une présentation de Google Earth est disponible ici : 

• https://www.google.com/intl/fr_ALL/earth/  

 

 

 

 

 

 

 

 

Installation de Google Earth Pro sur votre ordinateur 

• Connectez-vous à internet.  

• Téléchargez Google Earth Pro à 

l’adresse http://www.google.fr/intl/fr_ALL/earth/versions/ (en bas de page : 

« Télécharger Google Earth Pro sur ordinateur ») 

• Installez Google Earth Pro en exécutant le fichier téléchargé 

• Démarrez Google Earth Pro (une connexion internet est nécessaire).  

Google Earth 

https://www.google.com/intl/fr_ALL/earth/
http://www.google.fr/intl/fr_ALL/earth/versions/
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Figure 8 : Aperçu de quelques fonctionnalités de Google Earth Pro 
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Figure 9 : Aperçu de la fonctionnalité « Images d’archive » de Google Earth Pro pour la Mer d’Aral 

Exploration de Google Earth Pro 

• Via les outils de navigation, soit la roulette de la souris et les boutons du coin 

supérieur droit de l’interface, localisez un endroit qui vous est familier (par exemple, 

pour les étudiants d’Arlon, le Campus d’Arlon). 

• Cochez l’option « Relief » dans le panneau « Calques » et déplacez-vous dans les 

Alpes, l’Himalaya ou une chaîne de montagne de votre choix. Constatez la 

modélisation 3D du relief naturel en zoomant sur l’une ou l’autre zone et inclinez 

ensuite votre fenêtre de visualisation dans le plan horizontal via la flèche supérieure 

du bouton  disponible dans le coin supérieur droit de l’interface, ce qui permet 

un déplacement oblique ou horizontal. Remarquez que le relief peut être exagéré 

(jusque *3) via le menu « Outils > Options… > Vue 3D > Relief > Facteur d’élévation 

> et indiquer le chiffre par lequel multiplier artificiellement le relief ». 
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• Dézoomez et positionnez-vous au-dessus de quelques montagnes. Via l’activation du 

bouton « Lumière du soleil en fonction de l’heure du jour »  dans la partie 

supérieure de l’interface et l’utilisation de la ligne du temps qui apparait, constatez 

l’effet de la position du soleil sur le réflectance des images, effet particulièrement 

visible en zone montagneuse (cet effet d’ombrage est modélisé).  

• Tapez ensuite « Manhattan, New-York » dans l’onglet « Recherche ». Vous devriez 

arriver à « Central Park ». Déplacez-vous ensuite vers la pointe sud de Manhattan et 

cochez l’option « Bâtiments 3D » dans le panneau « Calques ». Inclinez à nouveau la 

fenêtre de visualisation dans le plan horizontal et visitez Manhattan en 3D. Déplacez-

vous ensuite vers la « Statue of Liberty ». (Remarque : tout aussi impressionnant, le 

campus d’Arlon au Sud de la Belgique est également modélisé en bâtiment 3D). 

• Déplacez-vous ensuite vers Paris et explorez « l’Avenue des Champs Elysées » et 

« l’Arc de triomphe » et/ou la « Tour Eiffel » à l’aide de l’outil « Street view »  

disponible à droite de l’interface : zoomez d’abord fortement sur l’endroit désiré puis 

placez le bonhomme orange à l’endroit à explorer en mode « Street view ». 

• La couverture nuageuse (mise à jour toutes les 60 à 90minutes) peut être affichée via 

le panneau « Calques > Météo > Nuages ». 

• Visualisez les changements d’occupation du sol s’étant produit à un endroit de votre 

choix, par exemple pour la « Mer d’Aral » (à taper dans l’onglet de Recherche), via 

l’activation du bouton « Afficher des images d’archive… »  et l’utilisation de la 

ligne du temps qui apparait (Figure 9). Remarquez que le nombre et le type d’images 

d’archives visualisables pour une zone varient en fonction du niveau de zoom : zoom 

éloigné : une image annuelle ; zoom rapproché : d’autres images souvent de 

meilleure résolution spatiale. Remarque : vous pourriez également visualiser avec cet 

outil d’autres exemples bien connus d’évolution impressionnante de l’occupation 

du sol, tels que ceux qui sont disponibles dans le panneau latéral de gauche de 

l’application « Google EarthEngine Timelapse » qui sera présentée à la section « 6.3 

Google EarthEngine Timelapse » page 105.  

• Une vision nocturne des lumières de la terre n’est plus disponible dans l’application 

Google Earth à installer sur votre ordinateur, mais elle est disponible dans la version 

en ligne de Google Earth à l’adresse suivante : 

https://earth.google.com/web/@27.4460086,-

84.80131294,9.97674638a,8922808.83754477d,35y,0h,0t,0r/data=CisSKRIgMGY3ZTJ

kYzdlOGExMTFlNjk5MGQ2ZjgxOGQ2OWE2ZTciBWVhcnRo  

Google Earth permet également d’explorer l’espace, la Lune et Mars via le bouton . 

Rem : Attention ! Il est possible de récupérer les images de Google Earth : 

• Via une « capture d’écran » (« print screen » en anglais) ou  

• Via le menu de Google Earth « Fichier > Enregistrer > Enregistrer l’image… ».   

https://earth.google.com/web/@27.4460086,-84.80131294,9.97674638a,8922808.83754477d,35y,0h,0t,0r/data=CisSKRIgMGY3ZTJkYzdlOGExMTFlNjk5MGQ2ZjgxOGQ2OWE2ZTciBWVhcnRo
https://earth.google.com/web/@27.4460086,-84.80131294,9.97674638a,8922808.83754477d,35y,0h,0t,0r/data=CisSKRIgMGY3ZTJkYzdlOGExMTFlNjk5MGQ2ZjgxOGQ2OWE2ZTciBWVhcnRo
https://earth.google.com/web/@27.4460086,-84.80131294,9.97674638a,8922808.83754477d,35y,0h,0t,0r/data=CisSKRIgMGY3ZTJkYzdlOGExMTFlNjk5MGQ2ZjgxOGQ2OWE2ZTciBWVhcnRo
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Notez qu’il s’agira cependant d’une image « dégradée » correspondant au zoom et à 
l’étendue au moment de la capture, le plus souvent au format « jpg », et non de l’image 
satellite originale utilisée pour réaliser cette représentation 
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4. Ouverture et visualisation d’une image 

satellite dans QGIS 

 

 

Objectifs 
pédagogiques 

Les objectifs de cette section sont de vous présenter: 

• Quelques outils pour visualiser correctement une image satellite 
dans QGIS (symbologie, amélioration de contraste, etc) 

• Les caractéristiques techniques principales d’une image satellite 
(résolution spatiale, résolution spectrale, etc) 

• Les notions de « composition vraies couleurs » et « composition 
fausses couleurs » 

• Quelques outils simples pour interroger les images (valeurs de 
pixels, localisation, mesures) 

 

Données 
& 

Projet QGIS! 

Les données nécessaires à la réalisation de cet exercice sont disponibles 
dans le dossier « …\1_VISUALISATION\... » (~ 462 MB) et correspondent 
essentiellement à une image satellite Landsat-5 composée de 7 bandes 
spectrales indépendantes. 

Téléchargez ce dossier sur votre ordinateur en local dans votre 
répertoire de travail et décompressez-le. ATTENTION ! Voyez la section 
1.2 page 19 pour plus d’information sur l’accès aux données. 

Projet QGIS : « VISUALISATION.qgz » situé dans ce même dossier. 

 

Logiciel ou 
application 

QGIS 3.10 ou supérieur 
(https://www.qgis.org/fr/site/forusers/download.html). 

 

Temps 
approximatif 

~ 45 minutes  

 

Prérequis 
Il est préférable, mais non obligatoire, que l’utilisateur ait déjà quelques 
notions de base concernant la gestion d’un projet QGIS. 

 
 

 

https://www.qgis.org/fr/site/forusers/download.html
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Vraies couleurs RGB = B3-B2-B1 
SANS amélioration de contraste 

 

Vraies couleurs RGB = B3-B2-B1 
AVEC amélioration de contraste 

Fausses couleurs RGB = B4-B7-B3 
AVEC amélioration de contraste 

Figure 10 : Image Landsat-5 TM utilisée dans le cadre de cet exercice avec différents effets de 
visualisation : amélioration de contraste et compositions colorées. 

4.1. Présentation de l’image satellite utilisée 

L’image satellite utilisée pour cet exercice est une image gratuite de type Landsat-5 TM 

(capteur « Thématic Mapper ») acquise le 7 août 1987 sur la région de la ville de Kasese en 

Ouganda, région entourée de nombreuses zones naturelles protégées (Figure 10 et Figure 

11). Elle est composée de 7 bandes spectrales à 30 mètres de résolution spatiale (résolution 

spatiale = longueur des côtés des pixels de l’image) (Figure 12).  

Plus d’information sur cette image et la manière de la rechercher et télécharger sur le net 

sont données à la section « 8.5.2.3 Recherche et téléchargement de l’image Landsat-5 via le 

site web « EarthExplorer » page 170. Ces informations ne sont cependant pas utiles pour cet 

exercice-ci.  

Les caractéristiques techniques les plus importantes de cette image, dont la résolution 

spatiale et la résolution spectrale, sont reprises dans les Figure 12 et Figure 11 ci-dessous.  

Les notions de résolution spatiale, résolution spectrale, résolution radiométrique et 

résolution temporelle sont bien expliquées et illustrées à la section « 2.6 Les différents types 

de résolutions des images satellites » page 29 de ces notes.  
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Nom du fichier téléchargé LT05_L1TP_173060_19870807_20170211_01_T1 

Nom du satellite LANDSAT 5 TM 

Lieu dans le système LANDSAT (Path, Row) WRS_PATH = 173 (correspond à la 
ligne/chemin orbital.e)  
 WRS_ROW = 60 (varie selon la latitude) 

Système de coordonnées EPSG 32635 

Etendue spatiale approximative d’une 
image/tile 

170 km north-south by 183 km east-west 

Date d’acquisition 07 08 1987 

Résolution spatiale 30 m 

Nombre de bandes spectrales 7 

Couverture nuageuse Partielle 

Format original des images lors du 
téléchargement 

.tif 

Poids numérique du dossier 
compressé/décompressé contenant une 
image 

138 Mo / 460 Mo 

Site web de référence pour le 
téléchargement 

https://earthexplorer.usgs.gov/ 

Page web reprenant les caractéristiques 
techniques des images 

https://www.usgs.gov/land-resources/nli/landsat/landsat-5?qt-
science_support_page_related_con=0#qt-
science_support_page_related_con  

Figure 11 : Caractéristiques principales de l’image Landsat-5 Thematic Mapper ™ utilisée dans le 
cadre de cet exercice. 

 

Numéro de la bande Longueur d’onde (µm) Nom de la bande Résolution spatiale (m) 

Band 1 0.45-0.52 Blue 30 

Band 2 0.52-0.60 Green 30 

Band 3 0.63-0.69 Red 30 

Band 4 0.76-0.90 Near Infrared (NIR) 30 

Band 5 1.55-1.75 Shortwave Infrared (SWIR) 1 30 

Band 6 10.40-12.50 Thermal 120 (30)* 

Band 7 2.08-2.35 Shortwave Infrared (SWIR) 2 30 

Figure 12 : Description des 7 bandes spectrales des images Landsat-5 Thematic Mapper ™. (Source : 

https ://www.usgs.gov/faqs/what-are-band-designations-landsat-satellites ?qt-news_science_products=0#qt-
news_science_products) 

* TM Band 6 was acquired at 120-meter spatial resolution, but products are resampled to 

30-meter pixels. 

https://earthexplorer.usgs.gov/
https://www.usgs.gov/land-resources/nli/landsat/landsat-5?qt-science_support_page_related_con=0#qt-science_support_page_related_con
https://www.usgs.gov/land-resources/nli/landsat/landsat-5?qt-science_support_page_related_con=0#qt-science_support_page_related_con
https://www.usgs.gov/land-resources/nli/landsat/landsat-5?qt-science_support_page_related_con=0#qt-science_support_page_related_con
https://www.usgs.gov/faqs/what-are-band-designations-landsat-satellites?qt-news_science_products=0#qt-news_science_products
https://www.usgs.gov/faqs/what-are-band-designations-landsat-satellites?qt-news_science_products=0#qt-news_science_products
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4.2. Visualisation des fichiers correspondant à l’image 

satellite dans l’explorateur de l’ordinateur 

Via l’explorateur de votre ordinateur (explorateur Windows ou autre) l’image satellite 

Landsat-5 se présente dans le dossier « …\1_VISUALISATION\... » comme illustré à la Figure 

13 : 

• Les 7 bandes spectrales (Figure 12) correspondent à des fichiers images 

indépendants et se terminent par « B1 » à « B7 ». 

• Le fichier « BQA.tif » est également un fichier image mais contient une information 

sur la qualité des pixels (« Quality Assessment Band ») (pour plus d’info : 

https://www.usgs.gov/land-resources/nli/landsat/landsat-collection-1-level-1-

quality-assessment-band?qt-science_support_page_related_con=0#qt-

science_support_page_related_con) 

• Le fichier « .jpg » (JPEG) est un fichier image léger qui permet d’avoir un aperçu 

rapide de l’image (dont la couverture nuageuse) 

• Une série de fichiers de type texte (à ouvrir avec un éditeur de texte come 

« Notepad/Bloc-notes ») qui contiennent des métadonnées.  

 

Figure 13 : Visualisation des fichiers correspondant à l’image satellite Landsat-5 dans l’explorateur 
de l’ordinateur (explorateur Windows dans ce cas-ci). 

https://www.usgs.gov/land-resources/nli/landsat/landsat-collection-1-level-1-quality-assessment-band?qt-science_support_page_related_con=0#qt-science_support_page_related_con
https://www.usgs.gov/land-resources/nli/landsat/landsat-collection-1-level-1-quality-assessment-band?qt-science_support_page_related_con=0#qt-science_support_page_related_con
https://www.usgs.gov/land-resources/nli/landsat/landsat-collection-1-level-1-quality-assessment-band?qt-science_support_page_related_con=0#qt-science_support_page_related_con
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4.3. Ouverture du projet QGIS à utiliser 

• Ouvrez le projet QGIS préalablement créé pour vous et disponible dans le répertoire 

« …\1_VISUALISATION\VISUALISATION.qgz » en double-cliquant dessus 

Ce projet QGIS est presque vide mais contient une couche shapefile des pays du monde qui 

vous permettra de facilement vous localiser.  

Vous pouvez éventuellement ajouter une couche de fond (« base map ») qui correspond par 

exemple aux images satellites « Google Satellite » via l’utilisation de l’extension QGIS 

« QuickMapServices » (à installer et paramétrer correctement si ce n’est pas encore fait 

comme indiqué dans le manuel de TP QGIS disponible ici 

https://orbi.uliege.be/handle/2268/190559). Cette couche de fond en très haute résolution 

spatiale peut parfois être utile pour mieux comprendre le paysage de la zone étudiée.  

4.4. Définition du SCR du projet QGIS 

L’image Landsat-5 étant fournie dans le système de coordonnées « EPSG : 32635 - WGS84 

UTM Zone 35N - projeté », il est préférable, pour le bon fonctionnement de certains outils 

QGIS, que le projet QGIS soit lui aussi exprimé dans le même système de coordonnées.  

• Cliquez sur le menu « Projet > Propriétés… > SCR > et tapez « 32635 » dans le filtre de 

recherche de SCR afin de trouver plus facilement ce SCR > Sélectionnez-le > Cliquez 

sur OK 

4.5. Ajout des bandes spectrales individuelles d’une image 

satellite dans un projet QGIS et visualisation des 

bandes en « dégradé de gris » 

A l’aide des indications ci-dessous, ajoutez les 7 bandes spectrales individuelles de l’image 
satellite Landsat-5 TM dans votre projet QGIS et visualisez chacune des bandes  en « 
dégradé de gris » 

 

Les images satellites sont des données de type raster et doivent donc s’ouvrir  

• Via le bouton « Gestionnaire des sources Open Data »  > Raster > Naviguer vers le 

répertoire 

« 1_VISUALISATION\DATA\LT05_L1TP_173060_19870807_20170211_01_T1\ » > 

Sélectionner les bandes B1 à B7.tif > Open > Ajouter > Fermer 

https://orbi.uliege.be/handle/2268/190559
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• Pour plus de facilité de manipulation, placez ces bandes dans le groupe de couche 

«LANDSAT BRUT » du projet QGIS préexistant, par simple glissé-déposé dans le 

panneau « Couches » de QGIS 

Chacune des 7 bandes est visible en « dégradé de gris » (en anglais : «  gray scale »).  

Les 7 bandes étant reprises comme 7 couches indépendantes, il n’est pas possible de réaliser 

directement une « composition colorée » multi-bandes (une image couleur RGB). Pour 

pallier à ce problème, il est possible de « fusionner » les 7 bandes en un seul fichier unique 

multi-bandes (confer section 4.7 page 46 ci-dessous). 

4.6. Accès aux propriétés des bandes spectrales d’une 

image satellite 

A l’aide des indications ci-dessous, accédez aux propriétés des bandes spectrales de l’image 
Landsat-5 TM et identifiez ses caractéristiques techniques les plus importantes, à savoir le 
SCR dans lequel elle est exprimée, sa  résolution spatiale, son format. 

 

Les propriétés de chaque couche d’information ajoutée dans QGIS sont disponibles via : 

• Clic-droit sur la couche > Propriétés… > Information (Figure 14) 

• (Clic-droit sur la couche > Propriétés… > Métadonnées : cette rubrique est souvent 

vide) 

Ces informations renseignent notamment sur le SCR dans lequel est exprimée la couche 

d’information, le nombre de pixels constituant l’image en ligne (hauteur) et colonne 

(largeur), le format de l’image (GeoTIFF dans ce cas-ci), quelques statistiques sur les bandes 

spectrales, la taille du pixel, etc. 
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Figure 14 : Accès aux propriétés d’une couche raster (bande 1 d’une image Landsat-5 TM ici) dans 
QGIS 

Ces informations et bien d’autres sont également reprises dans les fichiers de type texte 

(avec l’extension « .txt ») qui accompagnent l’image au moment du téléchargement depuis 

le site web source. Ces fichiers textes, que vous pouvez ouvrir par curiosité avec le logiciel 

« bloc note », sont les fichiers (dans le répertoire 

« …\1_VISUALISATION\DATA\LT05_L1TP_173060_19870807_20170211_01_T1\ ») : 

• LT05_L1TP_173060_19870807_20170211_01_T1_MTL.txt (contient les métadonnées 

les plus intéressantes) 

• README.GTF 

• LT05_L1TP_173060_19870807_20170211_01_T1_ANG.txt 
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4.7. Fusion de bandes spectrales individuelles d’une image 

satellite en un seul fichier unique multi-bandes 

A l’aide des indications ci-dessous, fusionnez les 7 bandes individuelles de l’image Landsat-5 
TM en un seul fichier unique multi-bandes. 

 

Afin de faciliter la manipulation et la visualisation de l’image satellite via notamment la 

réalisation de compositions colorées multi-bandes (compositions RGB), une possibilité est de 

fusionner les différentes bandes spectrales en une seule image multi-bandes.  

Pour fusionner les différentes bandes spectrales en une seule image multi-bandes (Figure 

9) : 

• Utilisez la fonction QGIS disponible dans le menu « Raster > Divers > Fusionner… » et 

paramétrez-la comme indiqué ci-dessous. 

• Couches en entrée : sélectionner les 7 bandes B1 à B7 de l’image Landsat-5 à 

fusionner 

• Cocher l’option « Placer chaque fichier en entrée dans une bande séparée », ce qui 

permettra d’obtenir un raster multi-bandes. Sinon le raster résultant ne contient 

qu’une seule bande.  

• Fusionné : indiquer le répertoire de sortie et nommer le raster en sortie, par exemple 

« LT05_L1TP_173060_19870807_20170211_01_T1_FUSION_B1_B7.TIF » 

• Cliquer sur « Exécuter »  

• Après exécution de la fonction (quelques secondes sont nécessaires) et vérification 

de l’absence de message d’erreur dans le journal de la fonction « Fusionner », fermer 

la fenêtre de cette fonction. 

• Ajouter le raster fusionné produit manuellement dans votre projet QGIS via le bouton 

d’ajout de raster. Pour plus de facilité de manipulation, placez-le dans le groupe de 

couche du panneau « Couches » «LANDSAT FUSION » 
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Figure 15 : Fusion des 7 bandes spectrales d’une image Landsat-5 TM pour produire un raster 
multi-bandes, dans QGIS via la fonction « Fusion » 
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4.8. Visualisation de compositions colorées d’une image 

satellite 

A l’aide des indications ci-dessous, réalisez une composition vraies couleurs et 2-3 
compositions fausses couleurs de qualité de l’image satellite Landsat-5 TM.  
Prenez ensuite quelques secondes pour photo-interpréter l’image satellite, c’est-à-dire 
reconnaitre les différentes classes d’occupation du sol (+ nuages)  présentes sur cette 
image. 

4.8.1. Composition « vraies couleurs » et composition « fausses couleurs » 

2 types de visualisation des images satellites multispectrales sont à distinguer, à savoir les 

« compositions  vraies couleurs » et les « compositions fausses couleurs » (Figure 16). 

Une composition « vraies couleurs » :  

• Est une représentation de l’image en « couleurs naturelles » 

• Ne peut être réalisée que si l’image satellite possède les bandes spectrales du Rouge, 

Vert et Bleu. Aux 3 canaux RGB (Red, Green, Blue) de l’ordinateur sont associées les 

bandes spectrales de l’image satellite correspondant aux longueurs d’onde du rouge, 

vert et bleu.  

Une composition « fausses couleurs » :  

• Correspond à toutes les représentations colorées de l’image qui ne sont pas en 

« couleurs naturelles » 

• Peut être réalisée dans tous les cas 

• Présentent l’avantage de permettre la visualisation de données n’appartenant pas au 

spectre du visible, par exemple, l’InfraRouge (IR), des données de type radar, etc. 

Autrement dit, ces compositions fausses couleurs « transforment » une donnée non 

visible, mais enregistrée par un capteur sensible à ces longueurs d’ondes, en une 

donnée visible à l’écran. Cette technique rend donc visible l’invisible pour des yeux 

humains. 
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Vraies couleurs RGB = B3-B2-B1 Fausses couleurs RGB = B4-B7-B3 

Figure 16 : Image Landsat-5 TM en composition « vraies couleurs » (à gauche) et en composition 
« fausses couleurs » (un exemple parmi les nombreuses possibles) (à droite), toutes deux avec 
amélioration de contraste. 

 

Pour afficher une « composition vraies couleurs » d’une image satellite dans QGIS (Figure 

17): 

• Cliquez-droit sur l’image satellite multi-bandes fusionnée (la fusion de l’image a été 

faite à la section 4.7 page 46) > Propriétés… > Symbologie  

• Dans le menu « Rendu des bandes raster » choisissez  

o « Type de rendu »  = « Couleur à bandes multiples » 

o « Bande rouge » = Bande 3 de l’image Landsat-5 TM qui correspond donc à la 

longueur d’onde du rouge 

o « Bande verte » = Bande 2 de l’image Landsat-5 TM qui correspond donc à la 

longueur d’onde du vert 

o « Bande bleue » = Bande 1 de l’image Landsat-5 TM qui correspond donc à la 

longueur d’onde du bleu 

ATTENTION !  

• L’ordre des bandes RGB=3-2-1 correspond à une composition colorée vraies couleurs 

dans ce cas-ci uniquement parce que les bandes spectrales numéro 3-2-1 des images 

Landsat-5 TM correspondent aux longueurs d’onde rouge-vert-bleu respectivement.  

• Si un autre capteur est utilisé, il faut se renseigner sur la correspondance entre 

numéro de bandes et longueurs d’onde et adapter les 3 bandes à affecter aux 3 

canaux RGB pour une composition vraies couleurs. Par exemple, pour les images de 

type Landsat-8, une composition vraies couleurs sera obtenue via la composition RGB 

= 4-3-2 (confer ici https://www.usgs.gov/faqs/what-are-band-designations-landsat-

satellites?qt-news_science_products=0#qt-news_science_products) 

https://www.usgs.gov/faqs/what-are-band-designations-landsat-satellites?qt-news_science_products=0#qt-news_science_products
https://www.usgs.gov/faqs/what-are-band-designations-landsat-satellites?qt-news_science_products=0#qt-news_science_products
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• Si un capteur ne possède pas les 3 bandes spectrales du rouge, vert et bleu, alors il 

devient impossible de réaliser une composition vraies couleurs pour ce capteur.  

 

Figure 17 : Paramétrisation des propriétés de symbologie de l’image Landsat-5 fusionnée pour 
obtenir une « composition vraies couleurs » (RGB = Bandes 3,2,1 et Paramètres de valeurs 
Min/Max adaptés)  

Le rendu visuel par défaut d’une image satellite dans QGIS est souvent de mauvaise qualité. 

A vous donc d’améliorer la visualisation de l’image via les différentes possibilités reprises ci-

dessous.  
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4.8.2. Amélioration de la visualisation d’une image satellite 

Le rendu visuel par défaut d’une image satellite dans QGIS est souvent de mauvaise qualité. 

A vous donc d’améliorer la visualisation de l’image via les différentes possibilités reprises ci-

dessous. 

  
SANS amélioration de contraste AVEC amélioration de contraste 

Figure 18 : Images satellite Landsat-5 TM en composition vraies couleurs (R-G-B=3-2-1) SANS 
amélioration de contraste (à gauche) et AVEC l’amélioration de contraste telle que paramétrée 
dans la Figure 17 (à droite) 

Les possibilités d’amélioration de la visualisation d’une image satellite sont disponibles via 

les menus: 

• Clic-droit sur la couche raster > Propriétés… > Symbologie OU Transparence OU 

Rendu ou Pyramides (confer ci-dessous) 

4.8.2.1. Symbologie 

Ce menu est le plus important et permet notamment de (Figure 17): 

• Choisir le type de composition colorée à afficher (« vraies couleurs » vs « fausses 

couleurs », confer section 4.8.1 ci-dessus) 

o Via le menu « Rendu des bandes raster » 

o En choisissant les bandes spectrales de l’image satellite à associer aux 3 

canaux RGB de l’ordinateur  

• Améliorer le contraste de l’image (Figure 18) 

o Via le menu « Amélioration de contraste » et « Paramètres de valeurs 

Min/Max » 

o L’amélioration de contraste  consiste en une transformation virtuelle des 

données afin d’utiliser au mieux la gamme de couleurs disponibles pour 

visualiser les données à l’écran. Cette amélioration ne modifie donc pas vos 
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données sources (la valeur des pixels). Elle ne fait qu’attribuer différemment 

la palette de couleurs disponibles à votre image afin de faire ressortir certains 

éléments plus clairement. 

o Dans la Figure 18 - droite, l’amélioration de contraste appliquée est celle de 

la Figure 17. La présence de nuages dans la partie nord de l’image résulte en 

des pixels qui saturent et présentent la valeur maximale possible pour ce type 

d’image (soit 255 dans ce cas-ci vu que l’image est codée sur 8 bit (28= 256 

valeurs possibles allant de 0 à 255)). La distribution de la fréquence des 

valeurs de pixels pour chacune des bandes spectrales de l’image Landsat-5 

TM (Figure 19) montre très clairement que la gamme de valeurs de la plupart 

des pixels pour une bande spectrale donnée  est assez étroite (entre 50 et 100 

pour la bande 1 par exemple) mais que certains pixels (ceux identifiant les 

nuages) présentent une valeur saturant à 255. Ceci a pour conséquence que 

la gamme de couleurs possibles est mal distribuée entre d’une part des 

pixels présentant de relativement faibles valeurs (pour les diverses 

occupations du sol) et d’autres part des pixels présentant la valeur maximale 

possible (255 pour les nuages), et résulte en une image très contrastée avec 

des pixels très sombres et des pixels très clairs, ce qui n’est pas idéale pour 

une bonne analyse visuelle de l’image. 

o L’amélioration de contraste peut être calculée soit, via le menu,   

▪ « Statistiques de l’emprise > Raster entier », sur l’ensemble du raster. 

Cette option présente le grand avantage de résulter en une 

symbologie fixe et donc comparable indépendamment de la partie du 

raster visualisée.  

▪ « Statistiques de l’emprise > Emprise actualisée », sur la partie du 

raster qui est affichée à l’écran. Cette option présente le grand 

avantage de résulter en une symbologie qui s’adapte dynamiquement 

à la partie du raster affichée à l’écran, ce qui est très pratique pour 

visualiser via « zoom in » des parties de raster qui sont soit trop 

claires, soit trop sombres lorsque le raster est affiché dans son 

entièreté. 

• Modifier d’autres paramètres de visualisation (luminosité, contraste, etc) 

o Via les menus « Rendu de la couleur » et « Ré-échantillonage »  
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Figure 19 : Histogramme de la distribution de la fréquence des valeurs de pixels pour chacune des 
bandes spectrales de l’image Landsat-5 TM 
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4.8.2.2. Transparence 

Diverses options de transparence de l’image (Figure 20) sont disponibles via le menu : 

• Clic-droit sur la couche raster > Propriétés… > Transparence 

o Opacité globale : transparence de l’ensemble de l’image 

o Options de transparence personnalisée : cliquez sur la croix verte et indiquez 

les valeurs de 0-0-0 pour les 3 colonnes Rouge-Vert-Blue et une transparence 

de 100% pour faire disparaitre les bordures noires de l’image 

  
Avec transparence générale de l’image de 

70% 
Avec transparence des bordures de l’image 

Figure 20 : Image Landsat-5 TM avec transparence générale de 70% (opacité de 30%) et comme 
image de fond le service QMS « Google Road » (gauche), et avec transparence de 100% des 
bordures et image de fond le service QMS « Google Satellite » (droite) 

4.8.2.3. Rendu 

Permet de définir la gamme d’échelle de visualisation pour laquelle l’image sera affichée à 

l’écran 

• Clic-droit sur la couche raster > Propriétés… > Rendu > Visibilité dépendante de 

l’échelle 

4.8.2.4. Pyramides 

« Des couches raster de haute résolution peuvent ralentir la navigation dans QGIS car leur 

taille empêche leur mise en mémoire complète. La création de copies de résolution 

inférieure (que l'on nomme pyramides) peut améliorer la performance d'affichage. » 

Attention ! Altération possible de l’image d’origine ! (Source = menu QGIS de construction 

des pyramides).  
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4.9. Autres outils d’interrogation des images 

Plusieurs outils, présentés ci-dessous, sont disponibles pour accéder aux informations 
caractérisant une image satellite. 

4.9.1. L’outil « Identifier les entités » 

L’outil « Identifier les entités »  permet d’afficher les valeurs de pixels des différentes 

bandes spectrales d’une image et d’obtenir les coordonnées géographiques du point 

consulté. 

Pour l’utiliser : 

• Sélectionnez l’image d’intérêt dans le panneau « Couches » 

• Cliquez sur cet outil puis sur le pixel à interroger 

Et une fenêtre reprenant les informations d’intérêt s’ouvrira.  

 

Figure 21 : Fenêtre de résultat de l’identification d’un pixel de l’image Landsat-5 TM fusionnée via 
l’outil « Identifier les entités » 
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4.9.2. Outil de mesures de distances, superficies et angles 

L’outil « Mesurer » permet de mesurer des distances, superficies et angles sur une image : 

 

 
Figure 22 : Outil « Mesurer » avec un exemple de mesure d’une superficie 
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5. Analyse de changement simple dans QGIS 

 

 

Dernière mise 
à jour 

• 20/03/2026 : le site web « Copernicus Land Monitoring Service 
(CLMS) » (section 5.1.2.) ne permettant plus pour le moment 
(temporairement) le téléchargement d’images, une procédure 
alternative a été établie à partir du site web « Copernicus Data 
Space Ecosystem » (section 5.1.3.). 

 

Objectifs 
pédagogiques 

• Trouver et télécharger des images satellites NDVI basse résolution 
sur le web 

• Réaliser une analyse de changement visuelle 

• Réaliser une analyse de changement mathématique avec gestion 
des pixels ne représentant pas du NDVI 

• Mettre en relation l’analyse d’images satellites NDVI avec des 
données climatiques 

• Choisir une symbologie raster pertinente par rapport à la donnée à 
représenter 

• Bien comprendre la nature des données afin de réaliser une 
analyse/interprétation correcte 

 

Données 
& 

Projet QGIS! 

Les données nécessaires à la réalisation de cet exercice ET les données 
résultant des opérations à faire dans cet exercice sont toutes disponibles 
dans le dossier « …\2_ANALYSE_DE_CHANGEMENT_SIMPLE\... » (~ 2 
GB). Ce dossier contient 3 sous-dossiers : « NDVI MONDE », « NDVI 
AFRIQUE » et « NDVI MALI » correspondant aux 3 zones pour lesquelles 
l’analyse de changement est illustrée dans ce manuel. Les fichiers 
disponibles pour chaque zone correspondent essentiellement à : 

• 2 images NDVI basse résolution pour janvier et septembre 2006. 

• 1 image exprimant le changement de NDVI entre les 2 dates. 

• 1 image de masque binaire 0/1 qui identifie les pixels 
invalides/valides dans l’image de changement de NDVI. 

Même si ces données sont mises à votre disposition, il vous est conseillé, 
pour un bon apprentissage, de refaire toutes les étapes de l’exercice par 
vous-même (téléchargement et analyse des images) comme indiqué 
dans les sections suivantes. Considérez donc ces données comme 
l’exemple auquel il faut arriver.  

Notez que vous devrez suivre la procédure de téléchargement donnée 
pour les images « MONDE » car le téléchargement d’images NDVI sur 
une zone plus petite (Afrique ou Mali) n’est actuellement plus possible 
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(mars 2026).  

Téléchargez ce dossier sur votre ordinateur en local dans votre 
répertoire de travail et décompressez-le. ATTENTION ! Voyez la section 
1.2 page 19 pour plus d’information sur l’accès aux données. 

Projet QGIS : « ANALYSE_CHANGEMENT_SIMPLE.qgz » situé dans ce 
même dossier. 

 

Logiciel ou 
application 

QGIS 3.12 ou supérieur 
(https://www.qgis.org/fr/site/forusers/download.html). 

 

Temps 
approximatif 

~ 2 heures  

 

Prérequis Aucun. 

 

Consignes de 
départ 

A l’aide des indications ci-dessous, analysez l’évolution des conditions 
de végétation du Mali entre janvier et septembre 2006 (Figure 23) à 
partir des images téléchargées sur le monde entier.  

• Procurez-vous et utilisez des images satellites basses résolution 
de type NDVI sur le monde entier.  

• Réalisez une analyse de changement visuelle sur le Mali. 

• Réalisez une analyse de changement mathématique sur le Mali. 

Interprétez vos résultats en vous aidant de diagrammes 

ombrothermiques (diagrammes climatiques température et 

précipitations). 

 
 

 

https://www.qgis.org/fr/site/forusers/download.html
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Figure 23 : Analyse de changement simple basée sur la soustraction mathématique de 2 images 
NDVI basse résolution sur l’Afrique (valeurs = NDVI) et le Mali (valeurs = DN proportionnel au 

NDVI) et images de changement résultantes. 
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5.1. Accès aux images satellites basse résolution de type 

NDVI du capteur SPOT-VEGETATION : recherche et 

téléchargement 

A l’aide des indications ci-dessous, téléchargez 2 images satellites basses résolution de type 
NDVI sur le monde entier pour janvier et septembre 2006. ~ 30 minutes. 

 

5.1.1. Obtenir des informations générales sur les images NDVI 

Le site web « Copernicus Land Monitoring Service (CLMS) » 

• https://land.copernicus.eu/en  

distribue gratuitement de très nombreux produits (images satellites et produits dérivés) 

issus de l’observation de la terre dans le cadre du programme européen Copernicus.  

• Rendez-vous sur ce site web 

 

• Choisissez le menu « Bio-geophysical Variables » puis « Vegetation », pour arriver ici 

https://land.copernicus.eu/en/products/vegetation  

• Sur cette page, descendez à la section « Dataset » et cliquez sur « Vegetation indices » 

pour arriver ici : 

https://land.copernicus.eu/en/products/vegetation?tab=vegetation_indices  

• Cette page présente les différents produits NDVI (Normalised Difference Vegetation 

Index).   

https://land.copernicus.eu/en
https://land.copernicus.eu/en/products/vegetation
https://land.copernicus.eu/en/products/vegetation?tab=vegetation_indices
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• Choisissez le produit « Normalised Difference Vegetation Index 1999-2020 (raster 1 km), 

global, 10-daily – version 3 > View more » 

 

• Jetez un œil à : 

o La définition du NDVI (aussi développée dans la Figure 26) 

o La section « Data layers », et en particulier aux informations du tableau ci-

dessous (PV = NDVI dans ce cas-ci) : 

 

…  

 

Remarque : (1/250 = 0.004) 

Figure 24 : Caractéristiques des images NDVI distribuées sur le site web « Copernicus Land 
Monitoring Service » accessibles via le menu précisé ci-dessus, avec en particulier les paramètres 
« scaling » et « offset » utilisés pour transformer les Digital Number (DN) en valeurs de NDVI. 

 

Les valeurs de NDVI, qui varient théoriquement entre -1 et +1 (confer Figure 26), sont 

encodées dans les pixels des images à l’aide de nombres entiers. Ces valeurs entières 
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réellement encodées dans les pixels sont appelées les « Digital Number (DN) ». Dans le cas 

d’une image codée sur 8 bits, comme c’est le cas pour les images NDVI SPOT-VEGETATION, 

les DN de chaque pixel peuvent prendre 28= 256 valeurs possibles, allant de 0 à 255. Les 

valeurs de NDVI correspondant à ces DN peuvent être obtenues par simple transformation 

mathématique (Figure 24 et Figure 25), dans ce cas-ci via la formule  

• NDVI = 0.004 * DN - 0.08 

Le paramètre 0.004 (=1/250) correspond à la pente de la droite de transformation (anglais : 

scaling) 

Le paramètre -0.08 correspond à l’intercepte de la droite de transformation (anglais : offset) 

 

Figure 25 : Principe de la conversion des DN (Digital Numbers) en valeurs NDVI via une 
fonction mathématique du premier degré présentant les 2 coefficients pente (ou scaling) 

(a) et intercepte (ou offset) (b). 
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NDVI – Normalized Difference Vegetation Index 

Le NDVI est un indice de végétation qui se définit comme la différence normalisée des mesures de 

réflectance spectrale acquises dans les zones de longueurs d’onde « Proche Infra-Rouge » (« PIR ») et 

« Rouge ».  

)(

)(

RougePIR

RougePIR
NDVI

+

−
=  

 
Sa valeur théorique varie entre -1 et 1.  En pratique, une surface d’eau libre (océan, lac,…) prendra des 

valeurs de NDVI  proches de 0, un sol nu prendra des valeurs de 0.1 à 0.2, alors qu’une végétation 

dense aura des valeurs de 0.5 à 0.8. 

Explication physique du NDVI 

Les plantes vertes absorbent une grande partie des radiations solaires dans une zone de longueurs 

d’onde appelée « PAR » (« Photosynthetically Active Radiation »), dont fait partie la zone du 

« Rouge ». Par contre, le « PIR » est fortement diffusé (non absorbé : transmis et réfléchi) par la 

plante. Par conséquent, une plante verte vive apparait sombre dans le PAR (dont le rouge) car ces 

longueurs d’ondes sont absorbées par la plante (petite valeur de réflectance), et « brillante » dans le 

« PIR » car ces longueurs d’ondes sont réfléchies en partie (grande valeur de réflectance).  

   
 
Le NDVI est directement lié à l’activité photosynthétique des plantes et donc à la capacité 

d’absorbation énergétique de la canopée du couvert végétal. Il agit comme indicateur de la biomasse 

chlorophyllienne des plantes. En termes de réflectance dans le PIR et le Rouge, la neige et les nuages 

se comportent à l’inverse des plantes vertes.   

Figure 26 : Explication du NDVI – Normalisez Difference Vegetation Index 

Une végétation en bonne santé (gauche) 

absorbe la plupart de la lumière visible qui 

l’intercepte et réfléchi une partie importante de 

la lumière PIR.  

Une végétation en mauvaise santé ou clairsemée  

(droite) réfléchi plus de lumière visible et moins 

de PIR.  

Les chiffres de la figure ci-contre sont 

représentatifs de valeurs réelles mais la réalité 

est bien plus variée. 

(Illustration by Robert Simmon, NASA GSFC). 
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5.1.2. Procédure d’accès aux images à partir du site web Copernicus Land 

Monitoring Service (CLMS) (cette procédure bug → voir section 

5.1.3) 

Pour accéder aux et télécharger les images NDVI : 

• Sur la page https://land.copernicus.eu/en/products/vegetation/normalised-

difference-vegetation-index-v3-0-1km, cliquez sur “View in the data viewer”. Vous 

arrivez sur le portail ci-dessous :  

 

• Le bon produit NDVI doit en principe déjà être coché dans le panneau de gauche, 

sinon cochez-le.  

• Enregistrez-vous sur ce site web (menu Register/Login en haut à droite). Suivez la 

procédure via la fenêtre qui apparait pour vous créer un identifiant et un login « EU 

Login ». Vous recevrez probablement* un email dans la boite email que vous avez 

renseignée : pensez à vérifier vos spam ! Cet email vous permettra probablement* de 

créer un mot de passe, en respectant les contraintes imposées. Vous serez invités à 

compléter une série d’information sur votre « user profile » (pays, etc). Notez bien 

votre « user name » et « password ». *La procédure d’enregistrement est 

susceptible de changer à tout moment.  

• Connectez-vous ensuite à ce portail (login). Assurez-vous que vous êtes bien 

connectés (votre nom devrait apparaitre dans le coin supérieur droit du portail). 

• Pour sélectionner la région d’intérêt :  

o Malheureusement pour le moment (juillet 2024) il ne semble pas possible de 

sélectionner une zone aussi grande que l’Afrique car cela désactive la 

possibilité de téléchargement dans le panneau de gauche. (Le téléchargement 

sur une grande zone était possible dans l’ancien portail de téléchargement, 

portail désactivé le 1/7/2024).  

o Dans le panneau de droite, choisissez le menu « Area selection > 

https://land.copernicus.eu/en/products/vegetation/normalised-difference-vegetation-index-v3-0-1km
https://land.copernicus.eu/en/products/vegetation/normalised-difference-vegetation-index-v3-0-1km
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▪ View countries » et sélectionnez le pays qui vous intéresse sur la carte 

(le Mali (code ML) dans le cadre de l’exemple présenté dans ce 

manuel). Confer image ci-dessous. Remarque : les codes de pays sont 

disponibles par exemple ici : https://countrycode.org/.  

▪ OU l’option Draw a rectangle on the map » et dessinez un rectangle 

autour de la zone d’intérêt, rectangle qui doit être suffisamment petit 

que pour permettre le téléchargement (la flèche de téléchargement se 

désactive automatiquement si la taille limite est dépassée et l’option 

alternative de téléchargement « full dataset M2M » semble trop 

complexe que pour être explorée).  

 

o Cliquez ensuite sur la flèche de téléchargement dans le panneau latéral de 

gauche et sur le bouton « Go to cart » dans la fenêtre qui apparait.  

 

o Paramétrez l’interface qui apparait comme ci-dessous (cas du Mali) en 

sélectionnant le format GeoTIFF, la projection EPSG4326 et LA (une seule) 

période de la première image désirée, comme indiqué ci-dessous pour la 

première décade (jours 1 à 10) de janvier 2006. (En juillet 2024, choisir 

plusieurs dates différentes résulte en un bug au moment du téléchargement 

avec le téléchargement de plusieurs fois la même image, avec le même nom : 

à éviter).  

o Puis cliquez sur « Proceed download request ».  

https://countrycode.org/
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o Rendez-vous ensuite sur la page https://land.copernicus.eu/en/cart-

downloads pour suivre le statut de votre demande. 

o Après quelques secondes, minutes ou heures (en fonction du niveau 

d’utilisation du serveur par la communauté mondiale) l’image demandée 

devrait être prête au téléchargement dans la rubrique « Completed » (et vous 

recevrez également un email avec le lien de téléchargement).  

o Téléchargez-la via le texte « Download file ».  

 

o Répétez le processus ci-dessus pour l’image de la première décade de 

septembre 2006. 

o Après téléchargement des 2 images, déplacez les dossiers téléchargés (leurs 

noms ressembleront à ceci : « 90168.zip ») dans votre répertoire de travail, 

https://land.copernicus.eu/en/cart-downloads
https://land.copernicus.eu/en/cart-downloads
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c’est-à-dire dans le répertoire 

« \2_ANALYSE_DE_CHANGEMENT_SIMPLE\MON_ANALYSE \ ». 

o Décompressez ces dossiers. Ceci peut se faire par exemple avec le logiciel 

gratuit 7-zip disponible ici https://www.7-zip.org/ (à n’installer que si un 

logiciel de ce type n’est pas déjà installé sur votre ordinateur). Le contenu du 

dossier de septembre est présenté ci-dessous.  

 

o Après décompression, un dossier a une taille numérique de 20.5 MB dans ce 

cas-ci (Mali). 

o Seules les 2 images suivantes, qui correspondent aux valeurs de NDVI, seront 

utiles (les autres peuvent être supprimées) :  

▪ c_gls_NDVI_200601010000_GLOBE_VGT_V3.0.1_ML_NDVI.tif (janvier) 

▪ c_gls_NDVI_200609010000_GLOBE_VGT_V3.0.1_ML_NDVI.tif 

(septembre) 

o Les dates reprises dans les noms des images, sont indiquées dans le format 

« YYYYMMDD » ou « Année_Mois_Jours_dans_la_décade ». Pour les jours 

(DD), « 01 » correspond à la première décade du mois, « 11 » à la 2ème et 

« 21 » à la 3ème. 

 

Les images NDVI du Mali sont maintenant prêtes à être importées dans QGIS pour analyse 

(confer section suivante). 

5.1.3. Procédure d’accès aux images à partir du site web Copernicus Data 

Space Ecosystem 

• Se rendre sur le site web https://dataspace.copernicus.eu/. 

• Se créer un compte et se loguer sur ce site web : menu LOGIN > Your profile > 

Register et/ou Login. Suivre la procédure indiquée sur le site web.  

• Revenir sur la page principale https://dataspace.copernicus.eu/ et cliquer sur « Get 

Started » pour arriver dans le browser https://browser.dataspace.copernicus.eu/. 

https://www.7-zip.org/
https://dataspace.copernicus.eu/
https://dataspace.copernicus.eu/
https://browser.dataspace.copernicus.eu/
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• Dans le panneau latéral de gauche du browser, bouton « SEARCH » et cocher le 

produit « CLMS Bio-geophysical Parameters > Vegetation > Vegetation Indices > 

NDVI, Global, 10-daily, 1km, (1999–2020), V3 ».  

 

• Paramétrer le panneau TIME RANGE (en bas du panneau latéral de gauche) comme 

ceci : 
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• Cliquer sur « Search » 

• Parmi les images résultantes, identifier les 2 images à télécharger :  

o c_gls_NDVI_200601010000_GLOBE_VGT_V3.0.1_cog.zip (1ère décade janvier 

2006) 

o c_gls_NDVI_200609010000_GLOBE_VGT_V3.0.1_cog.zip (1ère décade 

septembre 2006) 

• 2 formats d’image sont disponibles pour chaque date : nc ou cog. Choisir le format 

cog (Cloud Optimized GeoTIFF), plus facile à manipuler pour la suite de la procédure.  

• Ces images sont disponibles uniquement pour l’ensemble de la planète, pas pour une 

zone particulière. Poids d’une image = ~284 MB.  

• Télécharger les 2 images identifiées avec le bouton de téléchargement : 

 

• Placer ces 2 dossiers téléchargés compressés « .zip » dans votre répertoire de travail 

• Décompresser les 2 dossiers. 

• Dans un dossier, il y a plusieurs fichiers. Le fichier d’intérêt est celui qui commence 

par « c_gls_NDVI-NDVI », ce qui correspond à l’image NDVI en tant que telle.  
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Remarque : il devrait être possible de télécharger une image sur une région d’intérêt définie 

par l’utilisateur, via la procédure ci-dessous, mais cette procédure bug en date du 

20/03/2026. Vous pouvez donc ignorer les indications ci-après :  

• Définir une région d’intérêt avec l’outil de dessin disponible dans les outils à droite 

de l’interface. 

• Passer en mode visualisation via le bouton VISUALISE du panneau de gauche. 

• Cliquer sur le bouton « Download image » à droite de l’interface.  

 

• Choisir le format “Analytical”, tiff 8-bit, CUSTOM résolution spatiale de 1000 m, layer 

NDVI. 
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• Download → Network error (20/03/2026). 
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5.2. Analyse visuelle des images satellites NDVI basse 

résolution 

A l’aide des indications ci-dessous, réaliser une analyse visuelle de l’évolution spatio-
temporelle des conditions de végétation entre janvier et septembre 2006 sur le Mali. ~ 30 
minutes. 
Remarque 20/03/2026 : utilisez les images que vous avez téléchargées sur le monde entier 
(confer ci-dessus) mais focalisez votre analyse visuelle sur le Mali (zoomez sur le Mali).  
 

  

  

  

NDVI Janvier 2006 NDVI Septembre 2006 
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Figure 27 : 2 images NDVI basse résolution du capteur SPOT-VEGETATION sur l’Afrique, le Mali et le 
monde entier pour janvier et septembre 2006. 

Un dossier contenant l’ensemble de l’exercice déjà réalisé (projet QGIS et données utilisées) 

est disponible dans le répertoire : 

• « …\2_ANALYSE_DE_CHANGEMENT_SIMPLE\» 

Vous pouvez bien sûr y jeter un œil, en particulier au projet QGIS 

« ANALYSE_CHANGEMENT_SIMPLE.qgz». 

Cependant il vous est conseillé de faire l’ensemble des manipulations par vous-même, pour 

un bon apprentissage, dans un dossier séparé.  

Les étapes à suivre pour réaliser une analyse visuelle des images satellites NDVI basse 

résolution sont les suivantes : 

• Créez un nouveau projet QGIS que vous appellerez 

o « …\2_ANALYSE_DE_CHANGEMENT_SIMPLE\MON_ANALYSE\ANALYSE_CHAN

GEMENT_SIMPLE.qgz» 

• Ajoutez dans ce projet les 2 images NDVI de la zone d’intérêt au format « .tif » via le 

menu « Bouton « Gestionnaire des sources Open Data » > Raster > sélection et ajout 

des 2 images ». Elles s’affichent en dégradé de gris par défaut. 
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• Changez la symbologie des images via un clic droit sur chaque couche > Propriétés… 

> Symbologie > Pseudo-couleur à bande unique > choisir la palette de couleur 

d’intérêt…, comme ci-dessous par exemple.  

o Pour le monde entier les bornes Min et Max sont de -0.08 et 0.92 (valeurs de 

NDVI) 

o Pour l’Afrique les bornes Min et Max sont de -0.08 et 0.936 (valeurs de NDVI) 

o Pour le Mali (ou tout autre pays) veillez à ce que les bornes Min et Max 

soient 0 et 254 (valeurs de DN de pixel). Vous pouvez les changer 

manuellement si nécessaire.  

Ces bornes Min et Max déterminent la gamme de valeurs de pixels qu’il faut associer 

à la palette de couleurs. La différence entre les bornes « Monde », « Afrique » et 

« Mali » sont liées à une légère différence de format entre ces images, celles du 

monde et de l’Afrique affichant des valeurs de NDVI, et celles du Mali affichant des 

valeurs de DN. 
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• Identifiez le SCR des images via un clic-droit sur une image satellite dans le panneau 

« Couches » > Propriétés… > Information > SCR ». Ce SCR est « EPSG:4326 - WGS 

84 ». 

• Vérifiez le SCR du projet QGIS via le menu « Projet > Propriétés… > SCR » et attribuez 

au projet QGIS le même SCR que celui des images, dans ce cas-ci « EPSG:4326 » si ce 

n’est pas le cas par défaut. 

Prenez quelques secondes pour observer et comparer les 2 images NDVI.  

• Cochez/Décochez l’image NDVI supérieure dans le panneau « Couches » afin de 

visualiser de manière alternée chacune des 2 images. 

• Concernant la palette de couleurs, notez qu’il est très important que cette palette de 

couleurs soit fixe/statique (dans ce cas-ci elle évolue de -0.08 à 0.92 pour les 2 

images sur le monde, de -0.08 à 0.936 pour les 2 images sur l’Afrique, et de 0 à 254 

pour les 2 images sur le Mali (après modification manuelle si nécessaire)) pour que 

des images différentes (et donc présentant potentiellement une gamme de valeurs 

NDVI différentes) soient visuellement comparables, c’est-à-dire que une couleur 

donnée corresponde à une valeur de NDVI donnée dans toutes les images analysées, 

indépendamment des gammes de valeurs de NDVI (ou DN) réellement rencontrées 

dans ces images.  

Pour analyser l’évolution spatio-temporelle des conditions de végétation sur le monde, 

l’Afrique ou le Mali à partir de ces 2 images, vous devez :  

• Identifier le lien entre les couleurs de l’image, les valeurs de pixels (DN) et le NDVI.  

o Les Figure 24 et Figure 25 nous renseignent que il y a un lien directement 

proportionnel entre les DN (variant entre [0-255]) et le NDVI (variant dans la 

pratique entre 0 et 1), c’est-à-dire qu’au plus les DN sont élevés au plus le 

NDVI sera élevé.  

o L’analyse de la palette de couleurs nous indique que : 

▪ La couleur rouge correspond à de faibles DN, c’est-à-dire de faibles 

valeurs de NDVI, c’est-à-dire à un développement de la végétation 

verte faible 

▪ La couleur jaune correspond à des valeurs de DN intermédiaires, c’est-

à-dire des valeurs de NDVI intermédiaires, c’est-à-dire à un 

développement de la végétation verte intermédiaire 

▪ La couleur verte correspond à des valeurs de DN élevées, c’est-à-dire 

à des valeurs de NDVI élevées, c’est-à-dire à un développement de la 

végétation verte plus élevé 

▪ La couleur blanche correspond à des pixels sans donnée, qui 

correspondent typiquement à des pixels ennuagés.  
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o Valeurs spécifiques de pixels :  

▪ Valeur de NDVI maximale = 0.92 = « Physical max » = DN de 250. 

▪ Pixel de valeur 0.936 = pixel de mer ou grande masse d’eau = DN de 

254 (pour l’image sur l’Afrique). 

▪ Pixel « sans donnée » = missing input data = DN de 255. 

o ATTENTION ! Les couleurs utilisées sont donc des couleurs artificielles et pas 

des « couleurs naturelles ». Il ne faut donc les interpréter QUE sur base de 

leur signification précise et pas sur base d’une impression visuelle subjective 

qui pourrait se révéler totalement fausse si la palette n’est pas intuitivement 

interprétable.  

• L’analyse visuelle des 2 images peut être facilitée dans certains cas par l’utilisation 

d’autres outils : 

o La valeur des pixels de l’image est consultable également de manière 

interactive via l’outil « Identifier des entités »  en sélectionnant d’abord 

l’image à interroger dans le panneau « Couches » puis en cliquant avec cet 

outil sur l’image à interroger. 

o L’utilisation de l’extension (à installer) « MapSwipe Tool » qui permet de 

réaliser un swipe vertical ou horizontal sur les 2 images à comparer 

o L’utilisation de plusieurs fenêtres de visualisation spatialement 

synchronisées lors de la navigation mais à différentes échelles (par exemple : 

une fenêtre sur l’ensemble de l’Afrique et une fenêtre de zoom à une échelle 

plus grande). De nouvelles fenêtres peuvent être ajoutées via le menu « Vue 

> Nouvelle vue cartographique » et ensuite être paramétrées selon les 

souhaits de l’utilisateur. 

L’analyse et la compréhension de l’évolution spatio-temporelle des conditions de végétation 

sur l’Afrique peuvent être facilitées par l’utilisation de diagrammes climatiques reprenant 

les variables température et précipitations. Cette analyse est menée ici à titre d’exemple 

pour les 2 villes de Mopti au Mali et Gaborone au Botswana, villes localisées à la Figure 28. 

Les diagrammes climatiques correspondant sont présentés à la Figure 29.   

• Pour Mopti au Mali, janvier correspond au milieu de la saison sèche et septembre à 

la fin de la saison des pluies. Nous observons sur les images NDVI des valeurs de NDVI 

plus importantes, c’est-à-dire une végétation verte plus importante, en septembre 

qu’en janvier. Et nous observons sur l’image de changement (confer section suivante, 

Figure 30 page 81) un changement positif (en vert). En résumé, les précipitations plus 

importantes entre mai et septembre contribuent au développement de la végétation 

verte qui sera plus abondante en septembre, ce qui est visible sur les images NDVI et 

sur l’image de changement. 

• Pour Gaborone au Botswana janvier correspond au milieu de la saison humide et 

septembre à la fin de la saison sèche. Nous observons sur les images NDVI des 

valeurs de NDVI plus importantes, c’est-à-dire une végétation verte plus importante, 
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en janvier qu’en septembre. Et nous observons sur l’image de changement (confer 

section suivante, Figure 30) un changement négatif (en rouge). En résumé, les 

précipitations plus importantes entre octobre et janvier contribuent au 

développement de la végétation verte qui sera plus abondante en janvier, ce qui est 

visible sur les images NDVI et sur l’image de changement. 

Notez enfin la visibilité sur les images NDVI de l’Afrique de quelques « poches de 

végétation » notables : 

• Le Delta du Nil (dans le nord de l’Egypte), un écrin de végétation entouré d’une 

région désertique.  

• Le Lac Tchad à la frontière Nigéria/Tchad 

 

 

 

Figure 28 : Aperçu de l’Afrique telle que présentée dans Google Earth avec localisation des 2 villes 
de Mopti au Mali et Gaborone au Bostwana. Le vert correspond à des zones avec végétation et le 
jaune-orange aux zones plus désertiques 
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Mopti (centre Mali) 

 

Gaborone (sud Bostwana) 

Figure 29 : Diagrammes climatiques de la ville de Mopti au Mali et de la ville de Gaborone au 
Bostwana. Source: https://fr.climate-data.org/. 

5.3. Analyse de changement mathématique  

 
A l’aide des indications ci-dessous, réaliser une analyse de changement mathématique de 
l’évolution spatio-temporelle des conditions de végétation entre janvier et septembre 
2006 sur le Mali, mais en utilisant les images « monde ». ~ 60 minutes. 
 

 

5.3.1. Différence mathématique avec la « Calculatrice Raster » 

Afin de qualifier les changements de conditions de végétation s’étant produits entre janvier 

et septembre 2006 sur l’Afrique ou le Mali de manière plus objective qu’à travers l’analyse 

visuelle menée à la section 5.2 ci-dessus, une simple différence mathématique entre les 2 

images peut être réalisée via la « Calculatrice Raster » de QGIS. Cette analyse produira une 

« image de changement » dont la valeur des pixels ne devra plus être interprétée comme du 

« NDVI » mais comme un « changement de NDVI » (Figure 30 et Figure 31).  

https://fr.climate-data.org/
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Figure 30 : Analyse de changement simple basée sur la soustraction mathématique de 2 images 
NDVI basse résolution sur l’Afrique (valeurs = NDVI) et le Mali (valeurs = DN proportionnel au 

NDVI) et images de changement résultantes (illustration pour les images monde non présentée, 
mais c’est le même principe). 

ATTENTION ! Le « sens » de la soustraction est très important. Il faut soustraire l’image 

initiale (janvier 2006) de l’image finale (septembre 2006), comme indiqué dans les Figure 30 

et Figure 31, ceci afin que l’interprétation des valeurs de l’image de changement soit plus 

intuitive, c’est-à-dire que: 

• Une amélioration des conditions de végétation entre janvier 2006 et septembre 

2006 se traduise par une valeur positive dans l’image de changement 

• Une dégradation des conditions de végétation entre janvier 2006 et septembre 2006 

se traduise par une valeur négative dans l’image de changement 

 

Figure 31 : Illustration de l’opération de soustraction algébrique de 2 images satellites (codées sur 
8 bits → 28 =  256 valeurs possibles dans la gamme [0-255]) avec des exemples de valeurs de pixels 
(Digital Number (DN)) proportionnel au NDVI. 
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Pour calculer une simple différence mathématique entre 2 images via la « Calculatrice 

Raster » de QGIS (Figure 32) : 

• Cliquez sur le menu « Raster > Raster Calculator… », ce qui ouvrira la « Calculatrice 

Raster » 

• Paramétrez l’interface de la « Calculatrice Raster » comme indiqué à la Figure 32 en 

nommant votre raster en sortie « DIFFERENCE_SEPTEMBRE_JANVIER.tif » 

• N’oubliez pas dans « Create Options » de choisir le profil de « Compression élevée », 

sous peine de produire un raster très/trop lourd.  

• Cliquez sur « OK » 

 

Figure 32 : Utilisation de la « Calculatrice Raster » de QGIS pour réaliser la soustraction entre 
l’image NDVI de septembre 2006 et l’image NDVI de janvier 2006, pour les images monde. 

• Ajoutez manuellement le raster de changement « 

DIFFERENCE_SEPTEMBRE_JANVIER.tif » dans votre projet QGIS s’il ne s’est pas ajouté 

automatiquement. 

• Visualisez-le brièvement (Figure 33). Sa visualisation sera améliorée ultérieurement 

(confer plus bas).  
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Figure 33 : Raster de « Changement de NDVI » en dégradé de gris après calcul de la différence 
entre l’image de NDVI de septembre et l’image de NDVI de janvier. 

La différence réalisée à partir de pixels « sans donnée » (DN = 255) de l’une ou l’autre des 2 

images utilisées en entrée résulte en pixels « sans donnée » dans l’image de changement, et 

sont transparents (blancs si aucune autre couche inférieure n’est activée).  

Les pixels identifiés comme des pixels de mer ou de grande masse d’eau (uniquement 

présents sur l’image de l’ensemble de l’Afrique) dans les deux images de janvier et 

septembre présentent une valeur de 0 dans l’image de changement et apparaissent en gris.   

Ce raster de « changement de NDVI » est améliorable de 2 manières : 

• Via la gestion des pixels ne correspondant pas à du NDVI → Confer section 5.3.2 

page 84. 

• Via l’utilisation d’une symbologie qui permet de plus facilement 

interpréter/comprendre les changements de NDVI identifiés → Confer plus bas. 

5.3.2. Gestion des pixels ne correspondant pas à du NDVI 

Section pas utile lorsque l’on travaille avec les images « monde ». 

Attention ! Rappelons-nous que les pixels présentant des valeurs (DN) comprises entre 251 

et 255 dans les 2 « images de NDVI » de départ n’expriment en fait pas une valeur de NDVI 

mais correspondent à des codes ayant les significations suivantes (confer Figure 24 page 61 

(sous le tableau)):  

• 251 : non déterminé 

• 252 : non déterminé 

• 253 : non déterminé 

• 254 : pixel de mer ou de grande masse d’eau 

• 255 : pixel sans donnée 

Dans l’analyse ci-dessus, les pixels avec pour valeur 251 à 254 n’ont pas été exclus de 

l’analyse alors qu’ils auraient dû l’être. (Comme nous l’avons vu à la section précédente, les 

pixels de DN = 255 (sans donnée) ont déjà été pris en considération dans l’opération de 

différence et résultent en pixels « sans donnée ».) En particulier, si un pixel présente une 

valeur comprise entre 251 et 254 dans l’une des 2 images de NDVI ou dans les 2 images 

NDVI, il convient de lui attribuer une valeur spécifique (nous lui attribuerons la valeur 

« sans donnée » dans ce cas-ci) dans l’image de « changement de NDVI » afin que l’on 

puisse facilement identifier ces pixels qui ne traduisent pas un changement de NDVI.  

Pour ce faire la méthode ci-dessous est proposée. Nombre d’autres méthodes pourraient 

être appliquées.  
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5.3.2.1. Création d’un raster de masque binaire « 0-1-sans donnée » 

La première étape consiste en la création d’un masque ou raster binaire « 0-1-sans 

donnée », c’est-à-dire un raster dont les pixels prendront soit la valeur de 0, soit la valeur de 

1, soit la valeur « sans donnée », avec la signification suivante : 

• 1 identifie les pixels pour lesquels les 2 images de janvier et septembre présentent 

des valeurs proportionnelles au NDVI (DN < 251). 

• 0 identifie les pixels pour lesquels une des 2 images de janvier et septembre, ou les 2 

images, ne présentent ni des valeurs proportionnelles au NDVI, ni la valeur « sans 

donnée » (251 ≤ DN < 255). 

• « sans donnée » identifie les pixels pour lesquels une des 2 images de janvier et 

septembre, ou les 2 images, présentent des pixels sans donnée (DN = 255) 

Remarque :  

• si DN = 251 => NDVI = 0.004 * 251 - 0.08 => NDVI = 0.924 

• si DN = 254 => NDVI = 0.004 * 254 - 0.08 => NDVI = 0.936 

Ce raster binaire de masque peut être facilement obtenu via la « Calculatrice raster » de 

QGIS : 

• Cliquez sur le menu « Raster > Raster Calculator… », ce qui ouvrira la « Calculatrice 

Raster » 

• Paramétrez l’interface de la « Calculatrice Raster » comme indiqué à la Figure 35 en 

nommant votre raster en sortie « RASTER_MASQUE_BINAIRE_0_1.tif ». La formule 

utilisée est la suivante : 

o Pour les images monde : 

▪ " "c_gls_NDVI-NDVI_200601010000_GLOBE_VGT_V3.0.1@1" < 0.924 

AND "c_gls_NDVI-NDVI_200609010000_GLOBE_VGT_V3.0.1@1" < 

0.924 

o ( ) Pour les images Afrique : 

▪ "c_gls_NDVI-NDVI_200601010000_AFRICA_VGT_V3.0.1@1" < 0.924 

AND "c_gls_NDVI-NDVI_200609010000_AFRICA_VGT_V3.0.1@1" < 

0.924 

o ( ) Pour les images Mali : 

▪ "c_gls_NDVI_200601010000_GLOBE_VGT_V3.0.1_ML_NDVI@1" < 251 

AND "c_gls_NDVI_200609010000_GLOBE_VGT_V3.0.1_ML_NDVI@1" 

< 251 

Cette formule doit se comprendre comme suit, dans le cas des images Mali : 

• "c_gls_NDVI_200601010000_GLOBE_VGT_V3.0.1_ML_NDVI@1" < 251: il s’agit d’un 

test logique qui doit se comprendre comme suit: 
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o Si la condition est rencontrée, c’est-à-dire si la valeur du pixel dans l’image 

NDVI considérée est strictement plus petite que 251 (valeur correspondant  à 

du NDVI), alors le pixel prendra une valeur de 1. 

o Si la condition n’est pas rencontrée, c’est-à-dire si la valeur du pixel dans 

l’image NDVI considérée est plus grande ou égale à 251 (valeur ne 

correspondant pas à du NDVI), alors le pixel prendra une valeur de 0. 

o A cela se rajoute le fait que si le pixel dans l’image NDVI considérée est 

« sans donnée », avec une valeur de 255, alors le pixel prendra la valeur de 

« sans donnée ». 

• Le « AND » (en français : « ET ») est un opérateur logique booléen permettant de 

réaliser une comparaison entre 2 valeurs (0 ou 1) selon la logique reprise dans la 

Figure 34. 

 

AND (ET)  OR (OU) 

1 AND 1 = 1  1 OR 1 = 1 

1 AND 0 = 0  1 OR 0 = 1 

0 AND 1 = 0  0 OR 1 = 1 

0 AND 0 = 0  0 OR 0 = 0 
Figure 34 : Résultats des opérations booléennes « AND « (et) et « OR » (ou). 

 

Le tableau ci-dessous reprend les 3 cas de figures possibles dans notre cas (sans prendre en 

considération les cas incluant une valeur de pixel de 255) avec des exemples de valeurs de pixels 

et les résultats qui en découlent.  

3 cas de figure possibles 
(sans prendre en 
considération les cas 
incluant une valeur de pixel 
de 255) 

Exemple de valeurs dans la formule de création du raster 
binaire 

           AFRIQUE et MONDE                                    MALI 
Résultat 
intermé
diaire 

Résultat 
final 

Raster_Janvier < 0.924 AND 
Raster_Septembre < 0.924 

Raster_Janvier < 251 AND 
Raster_Septembre < 251 

Les valeurs des pixels 
correspondent à du NDVI 
dans les 2 images 

0.32 < 0.924 AND 0.72 < 0.924 45 < 251 AND 62 < 251 1 AND 1 1 

Les valeurs des pixels 
correspondent à du NDVI 
dans une seule image et pas 
dans l’autre 

0.32 < 0.924 AND 0.936 < 0.924 45 < 251 AND 254 < 251 1 AND 0 0 

0.924 < 0.924 AND 0.72 < 0.924 251 < 251 AND 62 < 251 0 AND 1 0 

Les valeurs des pixels ne 
correspondent pas à du 
NDVI, dans aucune des 2 
images 

0.924 < 0.924 AND 0.936 < 0.924 251 < 251 AND 254 < 251 0 AND 0 0 
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Figure 35 : Création d’un raster de masque binaire 0-1-sans donnée, pour les images Mali, via la 
« Calculatrice raster » de QGIS 

• Ajoutez manuellement le raster de masque « RASTER_MASQUE_BINAIRE_0_1.tif » 

dans votre projet QGIS s’il ne s’est pas ajouté automatiquement. 

• Modifiez sa symbologie pour obtenir un résultat similaire à ce qui est présenté en 

Figure 36, via la symbologie de type « Palette/Valeurs uniques ». 



88 
 

 
AFRIQUE 

 
MALI et MONDE (pas de pixel de mer ou de grande masse 

d’eau) 
 

• Visualisez-le brièvement (Figure 36) 

• Légende du raster de masque binaire ci-dessous.  

o En vert (valeur de 1) les pixels présentant une valeur de DN < 251 (NDVI < 

0.924) dans les 2 images de janvier et septembre. 

o En noir (valeur de 0) les pixels présentant un DN compris entre [251 et 254] 

dans une des 2, ou dans les 2 images de départ, hors pixels sans donnée.  

o En blanc (valeur « sans donnée ») les pixels sans données dans une des 2, ou 

dans les 2 images de départ.  
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Figure 36 : Raster de masque binaire 0-1-sans donnée (légende, confer texte ci-dessus) 
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5.3.2.2. Masquage de l’image de changement de NDVI par le raster de 

masque binaire 0-1-sans donnée 

Section pas utile lorsque l’on travaille avec les images « monde ». 

La deuxième étape consiste en l’application du raster de masque binaire 0-1-sans donnée 

créé à l’étape précédente sur le raster de « changement de NDVI » pour produire un 

nouveau raster de changement de NDVI pour lequel : 

• Les pixels correspondant à du NDVI dans les 2 images de départ conserveront leur 

valeur de changement de NDVI 

• Les pixels ne correspondant pas à du NDVI dans une des deux, ou dans les deux 

images NDVI de départ seront identifiés par le code « sans donnée ». 

Cette étape peut être vue comme un masquage du raster de « changement de NDVI » par le 

raster de masque binaire 0-1-sans donnée.  

Il suffit pour se faire de diviser le raster de « changement de NDVI » par le raster de 

masque binaire 0-1-sans donnée via la « Calculatrice raster » de QGIS : 

• Cliquez sur le menu « Raster > Raster Calculator… », ce qui ouvrira la « Calculatrice 

Raster » 

• Paramétrez l’interface de la « Calculatrice Raster » comme indiqué à la Figure 37 en 

nommant votre raster en sortie « DIFFERENCE_SEPTEMBRE_JANVIER_MASQUE.tif » 

• La formule utilisée est similaire à la suivante : 

"DIFFERENCE_SEPTEMBRE_JANVIER@1" / "RASTER_MASQUE_BINAIRE_0_1@1" 

Cette formule aura les effets suivants : 

• Valeurs de changement de NDVI / 1 = Valeurs de changement de NDVI conservées 

• Valeur autre / 0 = sans donnée (car il n’est pas possible de diviser par 0) 

• Toute valeur / sans donnée = sans donnée 
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Figure 37 : Division du raster de changement par le raster binaire 0 1 dans la « Calculatrice raster » 
de QGIS, pour le Mali 

• Ajoutez manuellement le raster de changement de NDVI masqué « 

DIFFERENCE_SEPTEMBRE_JANVIER_MASQUE.tif » dans votre projet QGIS s’il ne s’est 

pas ajouté automatiquement. 

• Visualisez-le brièvement (Figure 38 à droite) 
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Figure 38 : Masquage de l’image de changement de NDVI (à gauche) par le raster de masque 
binaire 0-1-sans donnée (au centre) via une division dans la « Calculatrice raster » de QGIS et raster 

masqué résultant (à droite) avec les pixels ne traduisant pas un changement de NDVI prenant la 
valeur « sans donnée » et une couleur transparente. 

Dans le raster masqué, les pixels ne traduisant pas un changement de NDVI prennent : 

• la valeur « sans donnée » (en français : « sans donnée ») : vous pouvez le vérifier via 

l’outil « Identifier des entités »   

• une couleur transparente : attention ! Si une autre couche est  

activée/cochée/visible et positionnée en-dessous du raster masqué dans le panneau 

« Couches » de QGIS, c’est cette autre couche qui sera visible à l’endroit des pixels 

transparents du raster masqué. Pour visualiser correctement le raster masqué, il 

vaut donc mieux décocher toutes les autres couches de votre projet QGIS. 

5.3.3. Choix d’une symbologie appropriée  

Section à réaliser sur l’image « DIFFERENCE_SEPTEMBRE_JANVIER.tif » produite à partir des 

images « monde ». 

La représentation de l’image de changement en dégradé de gris (Figure 38-droite) n’est pas 

facile à interpréter. En effet, pour une large gamme de valeurs de gris, il est difficile de leur 

attribuer une signification précise en termes de changement de NDVI ou changement de 

conditions de végétation. La symbologie de l’image de changement doit donc être changée 

pour en faciliter l’interprétation.  
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Pour à la fois conserver l’image en dégradé de gris dans le projet QGIS et produire une 

représentation colorée de cette image, il est possible de simplement dupliquer la couche de 

changement dans le panneau « Couches », comme indiqué ci-dessous : 

Pour dupliquer une couche raster : 

• Cliquez-droit sur l’image de changement > Dupliquer la couche 

Attention, le choix de la palette de couleurs de l’image de changement est très important 

dans ce cas-ci. Une palette de couleurs tri-colore conviendra parfaitement pour représenter 

les valeurs de changement. Il faudra veiller en particulier à : 

• ce que les couleurs choisies soient interprétables intuitivement : dans ce cas-ci  

o Une couleur rouge sera associée à une diminution des valeurs de NDVI entre 

janvier et septembre, c’est-à-dire une dégradation des conditions de 

végétation (pixels de l’image de changement ayant des valeurs négatives) 

o Une couleur verte sera associée à une augmentation des valeurs de NDVI 

entre janvier et septembre, c’est-à-dire une amélioration des conditions de 

végétation (pixels de l’image de changement ayant des valeurs positives) 

o Une couleur jaune sera associée à une stabilité des valeurs de NDVI entre 

janvier et septembre, c’est-à-dire une stabilité des conditions de végétation 

(absence de changement, pixels de l’image de changement ayant une valeur 

aux alentours de 0) 

• ce que la palette contienne une couleur centrale (symbologie symétrique autour de 

0) facilement identifiable (jaune dans ce cas-ci) qui permettra de facilement 

différencier les zones présentant une amélioration ou une dégradation des 

conditions de végétation. Typiquement un dégradé bicolor (noir à blanc par exemple) 

ne conviendra pas. 

Pour choisir une palette de couleurs appropriée : 

• Cliquez-droit sur l’image de changement dupliquée > Propriétés… > Symbologie > 

Rendu des bandes raster > Type de rendu > Pseudo-couleur à bande unique  

• Choisissez un dégradé de couleur adapté pour représenter les changements de NDVI, 

comme indiqué par exemple à la Figure 39 (dégradé de couleur « RdYlGn » par 

exemple). 
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Figure 39 : Choix d’une symbologie adaptée (dégradé de couleur « RdYlGn ») pour visualiser 
l’image de changement de NDVI, pour le Mali. 

! Pour obtenir une palette de couleurs avec une couleur centrale facilement identifiable et 

correspondant à l’absence de changement : 

• Modifiez les bornes Min et / ou Max de la symbologie pour que ces bornes soient 

symétriques autour de 0, dans l’illustration ci-dessous : 

o Pour les images monde ou Afrique : -0.75 à +0.75 (valeurs de NDVI) 

o Pour le Mali : -150 à +150 (valeurs de DN) 

 

 

Modification d’une « Palette de couleurs » 

• Modifiez éventuellement cette palette de couleur selon votre souhait. Dans ce cas-ci 

la couleur centrale par défaut a été remplacée par un jaune un peu plus vif afin de 

mieux différencier les pixels présentant un changement de NDVI nul ou faible des 

pixels ne représentant pas un changement de NDVI (« sans donnée » transparent 

apparaissant en blanc si le background est blanc). Pour ce faire : 

o Cliquez-gauche sur la « Palette de couleurs » sélectionnée dans la fenêtre des 

propriétés de la couche > Symbologie de la couche  
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o Modifiez la palette de couleur comme souhaité via la fenêtre qui s’ouvre 

« Sélectionner un dégradé de couleur » (Figure 40). 

 

Figure 40 : Modification de la couleur centrale de la « Palette de couleurs RdYlGn » par un jaune 
plus vif 

Amélioration de contraste 

Enfin, il peut être souhaitable de réaliser une amélioration de contraste (quelques exemples 

sont donnés à la Figure 41) afin de mieux faire ressortir les différentes classes de 

changement de NDVI. Ceci peut se faire via : 

• Clic-droit sur l’image de changement dupliquée > Propriétés… > Symbologie > Rendu 

des bandes raster > Paramètres « Min » et « Max » (Figure 39) à définir de manière 

symétrique autour de 0 si vous voulez que la couleur centrale de la palette 

corresponde à un changement de NDVI nul.  

Au plus les valeurs des bornes inférieure et supérieure (paramètres « Min » et « Max ») de la 

« Palette de couleurs » seront resserrées autour de 0, au moins la représentation colorée 

sera nuancée étant donné que tous les pixels ayant des valeurs inférieures/supérieures aux 

paramètres « Min »/« Max » prendront la couleur correspondant à la borne 

inférieure/supérieure de la « Palette de couleurs » respectivement, comme illustré à la 
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Figure 41. A vous de choisir la représentation qui vous semble être la plus adaptée à vos 

objectifs de représentation et d ‘analyse.  
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Figure 41 : Image de changement du NDVI entre janvier 2006 et septembre 2006, en dégradé de 
gris et dégradés colorés utilisant différentes améliorations de contraste via l’utilisation des 
paramètres « Min » et « Max » des propriétés de symbologie de la couche. L’image en bas à droite 
pour l’Afrique utilise comme background le raster de masque binaire 0-1-sans donnée avec la 
couleur noire correspondant aux pixels masqués, et la couleur blanche correspondant aux pixels 
sans donnée.  

L’image de changement affichée avec une palette de couleurs appropriée est facilement 

interprétable et le lien avec les conditions climatiques évident, comme déjà expliqué plus 

haut. 
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6. Analyse de séries temporelles d’images 

sur bases d’applications web 

 

 

Objectifs 
pédagogiques 

Découvrir diverses applications web basées sur la télédétection et 
comment ces applications peuvent être utiles pour réaliser une analyse 
d’une série temporelle d’images satellites. 

 

Données 
& 

Projet QGIS! 

Les données nécessaires à la réalisation de cet exercice sont disponibles 
dans le dossier « …\3_SERIE_TEMPORELLE_APPLI_WEB\... » (~ 44 MB).  

Téléchargez ce dossier sur votre ordinateur en local dans votre 
répertoire de travail et décompressez-le. ATTENTION ! Voyez la section 
1.2 page 19 pour plus d’information sur l’accès aux données. 

Projet QGIS : « SERIE_TEMPORELLE_APPLI_WEB.qgz » situé dans le 
sous-dossier « QGIS ». Ce projet ne sera utilisé que très rapidement, pour 
la première partie de cet exercice.  

 

Logiciel ou 
application 

QGIS 3.10 ou supérieur 
(https://www.qgis.org/fr/site/forusers/download.html). 

 

Temps 
approximatif 

~ 1h30 

 

Prérequis Aucun. 

 

Consignes de 
départ 

Confer la « Contextualisation » reprise ci-après 

 
 

 

 

 

 

 

https://www.qgis.org/fr/site/forusers/download.html
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Contextualisation* 

Production de médias mettant en évidence la déforestation à partir de séries 
temporelles d’images satellites disponibles sur des applications web basées sur la 
télédétection. 

Un peuple d’indiens d’Amazonie, les Arumbayas, dans l’Etat de Rondônia au Brésil, voit 
chaque jour leur forêt détruite un peu plus, destruction qui s’est accélérée récemment 
suite à l’accession à la présidence du Brésil de Jair Bolsonaro le 1er janvier 2019.  

Les Arumbayas aimeraient sensibiliser l’opinion nationale et internationale à la 
problématique rencontrée sur leur territoire afin d’en stopper la destruction. 

En tant que géographe fraichement diplômé, et sensibilisé à leur cause, vous proposez de 
les aider via la création d’un ou plusieurs médias qui mettront en évidence la gravité et 
l’urgence de la situation à partir de l’analyse d’images satellites. 

Les Arumbayas ont identifié le périmètre de leur territoire grâce à un GPS reçu de la part 
d’activistes de l’ONG « Treepeace ». Ce territoire est repris dans le shapefile 
« Paraiso_verde.shp » et dans le fichier KML « PARAISO_VERDE.KML ». 

Face à l’urgence de la situation, le délai de réalisation est assez court et vous décidez 
d’utiliser les applications web existantes plutôt que de vous lancez dans un travail 
fastidieux de téléchargement et traitement en local des images satellites. 

Vous testerez les différentes applications présentées ci-dessous et comparerez leurs 
qualités, défauts, avantages et inconvénients.  

Vous pourrez montrer à la fois l’évolution historique (sur plusieurs années ou décennies) 
et l’évolution très récente (derniers mois ou années récentes)! 

Parmi les médias potentiels à produire : 

• Images satellites de la zone montrant la situation (capture d’écran,…) 

• Animation de type « Timelapse » montrant l’évolution de la situation 

• Graphique de l’évolution temporelle de la végétation 

* Cette contextualisation s’inspire de faits réels mais ne se veut pas véridique.  
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6.1. « QuickMapServices » (QMS) via QGIS 

A l’aide des indications ci-dessous, installez « QGIS » sur votre ordinateur si ce n’est pas 
encore fait et utilisez l’extension « QuickMapServices » (QMS) pour consulter une image 
satellite de très haute résolution spatiale sur la zone d’étude de « Paraiso Verde ». (~ 10 
minutes) 

 

QGIS n’est pas une application web mais un logiciel à installer sur votre ordinateur. Une fois 

installé, il permet d’accéder facilement, dans une interface SIG, à une série de données en 

lignes, dont des images satellites très hautes résolutions spatiales, via différents services 

web dont le service « QuickMapServices » qui est utilisé dans cette section.  

! QGIS doit être installé sur votre ordinateur pour cette section. QGIS est disponible 

ici https://qgis.org/en/site/.  

Ouverture du projet QGIS préalablement préparé pour vous : 

▪ Ouvrez le projet QGIS disponible dans le répertoire 

« \3_SERIE_TEMPORELLE_APPLI_WEB\QGIS\SERIE_TEMPORELLE_APPLI_WEB.qgz» et 

contenant le fichier shapefile « Paraiso_verde.shp » afin de localiser rapidement où 

se situe le territoire étudié.  

▪ Pour trouver la zone d’étude, faites un clic droit sur la couche « Paraiso_verde.shp » 

dans le panneau « Couches » > Zoomer sur la couche. 

Installation de l’extension « QuickMapServices » (QMS) dans QGIS : 

• Si ce n’est pas encore fait, dans votre interface QGIS, installez l’extension 

« QuickMapServices » via le Menu Extension > Installer / Gérer les extensions  

• Après l’installation de base de QMS, ajoutez les services supplémentaires de QMS 

via le menu « Internet > QuickMapServices > Settings > More > Get contributed 

pack » 

Utilisation de l’extension « QuickMapServices » et analyse 

▪ Ajoutez le fond de carte “Google Satellite » à votre projet QGIS via le menu « Internet 

> QuickMapServices > Google > Google Satellite » 

▪ Analysez visuellement le territoire de « Paraiso Verde ». Pensez-vous pouvoir 

produire un média intéressant via l’interface QGIS ? 

Avantages de QMS : 

▪ Très haute résolution spatiale → Très haut niveau de détail visible 

https://qgis.org/en/site/
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▪ Accessible directement dans QGIS et donc facilement comparable avec des données 

géographiques personnelles préalablement disponibles dans un projet QGIS 

Désavantages de QMS : 

▪ Vue statique sans information sur la date des images satellites disponibles 

▪ Pas d’accès à une série temporelle d’images qui pourraient montrer l’évolution de 

l’occupation du sol dans la zone 

 

Figure 42 : Ajout du fond de carte « Google Satellite » via l’extension « QuickMapServices » dans 
un projet QGIS et visualisation de la zone d’étude de « Paraiso Verde » dans l’Etat de Rondônia au 
Brésil. Les « couloirs » de déforestation sont très visibles sous la forme de motifs linéaires gris-
brun, le vert correspondant à la forêt.  
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6.2. Google Earth Pro Desktop 

A l’aide des indications ci-dessous, installez « Google Earth Pro » sur votre ordinateur si ce 
n’est pas encore fait et utilisez cette application pour consulter les images satellites 
d’archives disponibles sur la zone d’étude de « Paraiso Verde ». (~ 10 minutes) 

 

« Google Earth Pro » permet d’afficher des images satellites d’archive, ce qui permet de se 

faire une idée de la dynamique de l’occupation du sol dans une région. 

Installation de « Google Earth Pro » 

▪ ! Google Earth Pro doit être installé sur votre ordinateur pour cette section : Google 

Earth Pro est disponible ici : 

https://www.google.be/intl/fr_ALL/earth/versions/#earth-pro. 

▪ Google Earth Pro nécessite une connexion à internet pour fonctionner correctement 

et accéder aux images satellites d’archives notamment.  

Utilisation de « Google Earth Pro » sur la zone d’étude de « Paraiso Verde » 

▪ Double-cliquez sur le fichier KML « \3_SERIE_TEMPORELLE_APPLI_WEB\ 

PARAISO_VERDE.kml ». Cela ouvrira automatiquement, après quelques secondes, 

Google Earth Pro sur la zone de « Paraiso Verde ». 

Par défaut, Google Earth Pro présente le même fond de carte que celui utilisé via l’extension 

« QuickMapServices » dans QGIS ci-dessus.  

▪ Affichez l’outil « Afficher des images d’archive » est disponible comme illustré à la 

Figure 43 : 

 

Figure 43 : Outil « Afficher des images d’archive » de « Google Earth Pro » 

Notez que les images d’archives disponibles à l’affichage varient en fonction du niveau de 

zoom. A partir d’une échelle d’approximativement 1/80 000 en dé-zoomant (zoom out), des 

images annuelles sans nuage sont disponibles de 1984 à 2016. Ce sont probablement 

essentiellement des images LANDSAT (information non vérifiée). Sur la zone, la plus 

ancienne image semble remonter à 1970. En zoomant à une échelle supérieure à 1/80 000 

(zoom in), d’autres images, souvent de plus hautes résolutions spatiales, apparaissent dans 

la liste des images d’archive.  

https://www.google.be/intl/fr_ALL/earth/versions/#earth-pro
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▪ Passez en revue les images disponibles sur la zone d’étude afin de vous faire une idée 

de la dynamique d’occupation du sol dans la région (Figure 44).  

Cette évolution vous parait-elle normale ? 

Réponse : attention ! Les images affichées pour 1970 et 1975 datent en fait de 2001, même 

lorsque l’on zoom sur une toute petite zone ! Il semble donc y avoir une erreur dans Google 

Earth à ce niveau ! Confer série d’images ci-dessous ! 

 
1970 ( ! ) 

 
1984 

 
2000 

 
2001 

 

 
1984 

 
2016 

Figure 44 : Images satellites d’archive sélectionnées pour quelques dates et affichées dans Google 
Earth Pro sur la zone d’étude de « Paraiso Verde » dans l’Etat de Rondônia au Brésil. Les « couloirs 
» de déforestation sont très visibles sous la forme de motifs linéaires gris-brun, le vert 
correspondant à la forêt. 

Pensez-vous pouvoir produire un média intéressant via cet outil ? 

Cet outil à l’avantage de pouvoir montrer la dynamique de l’évolution de l’occupation du 

sol dans la région. Une série de capture d’écran pourraient être faites puis assemblées en 

une animation par exemple. 

Pour information, une animation (image animée GIF) peut facilement être réalisée dans le 

logiciel gratuit GIMP (https://www.gimp.org/) à partir d’une série d’images. Un exemple 

d’animation a été créé avec 4 images de la zone (1984, 2001, 2008, 2016) et est disponible 

dans le dossier « \3_SERIE_TEMPORELLE_APPLI_WEB\GIMP_ANIMATION_GIF\ » pour créer 

ce type d’animation : 

https://www.gimp.org/
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• Ajouter et ordonner chronologiquement les images dans GIMP (la plus récente au-

dessus) 

• File > Export as > et donner un nom de fichier avec l’extension .GIF 

• Export > As animation + loop forever + paramétrer le temps d’affichage d’une image 

de la série (par exemple : 500 ms) > Export 

• Le résultat est le fichier GIF 

« \3_SERIE_TEMPORELLE_APPLI_WEB\GIMP_ANIMATION_GIF\GOOGLE EATH PRO 

PARAISO VERDE 1984 2001 2008 2016.gif » qui s’ouvrira comme animation dans un 

navigateur web. 
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6.3. Google EarthEngine Timelapse  

A l’aide des indications ci-dessous, découvrez l’application « Google EarthEngine 
Timelapse » et utilisez-la pour découvrir une animation de l’évolution de l’occupation du sol 
à partir d’images satellites sur la zone d’étude de « Paraiso Verde ». (~ 10 minutes) 

 

Découverte de “Google EarthEngine Timelapse” 

“Google EarthEngine Timelapse” est une « vidéo mondiale zoomable » qui permet de 

visualiser l’évolution de l’occupation du sol de la planète pendant ces 35 dernières années 

(1984 - 2018) à l’aide d’une couverture mondiale annuelle sans nuage d’images satellites 

(Landsat, Sentinel 2, ~15 millions d’images satellites utilisées). Cette application a été 

réalisée dans le « Google Earth Engine’s cloud computing model ».  

“Google EarthEngine Timelapse” est accessible à l’adresse 

• https://earthengine.google.com/timelapse/ 

Une série d’exemples bien connus d’évolution impressionnante de l’occupation du sol sont 

présentés dans le panneau latéral de gauche, dont la déforestation massive au Brésil dans 

l’Etat de Rondônia où se situe Paraiso Verde.  

▪ Explorez quelques exemples à votre guise, selon votre intérêt (déforestation, mine, 

développement urbain, fonte de glacier, assèchement de la mer d’Aral, irrigation, 

feux, modification du lit de fleuves, etc). Il faut parfois un peu de temps avant que les 

images ne soient nettes. 

En plus de ces exemples bien connus, cette vidéo est disponible pour tout endroit de la 

planète.  

Utilisation de “Google EarthEngine Timelapse” sur la zone d’étude de « Paraiso 

Verde » (Figure 45): 

▪ Zoomez donc sur le « Paraiso Verde », dans le Nord de l’Etat de Rondônia. 

▪ Ou utilisez ce Le lien web qui vous amènera directement sur la zone d’étude : 

o https://earthengine.google.com/timelapse#v=-8.81475,-

63.22497,7.533,latLng&t=3.43&ps=50&bt=19840101&et=20181231&startDw

ell=0&endDwell=0  

Remarquez que le bouton « Share »  permet d’exporter la vidéo courante dans un 

format web et donc de la partager facilement.  

https://earthengine.google.com/timelapse/
https://earthengine.google.com/timelapse#v=-8.81475,-63.22497,7.533,latLng&t=3.43&ps=50&bt=19840101&et=20181231&startDwell=0&endDwell=0
https://earthengine.google.com/timelapse#v=-8.81475,-63.22497,7.533,latLng&t=3.43&ps=50&bt=19840101&et=20181231&startDwell=0&endDwell=0
https://earthengine.google.com/timelapse#v=-8.81475,-63.22497,7.533,latLng&t=3.43&ps=50&bt=19840101&et=20181231&startDwell=0&endDwell=0
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Figure 45 : Aperçu de l’application “Google EarthEngine Timelapse” pour la zone d’étude de 
« Paraiso Verde » dans l’Etat de Rondônia au Brésil. Les « couloirs » de déforestation sont très 
visibles sous la forme de motifs linéaires gris-brun, le vert correspondant à la forêt. 

Pensez-vous pouvoir produire un média intéressant via cet outil ? 

Avantage de “Google EarthEngine Timelapse”: 

• Facile d’utilisation, vidéos/animations prêtes à l’emploi 

Désavantages de “Google EarthEngine Timelapse”:  

• Limité à 2018 au moment de rédiger ces lignes 

• Qualité de l’image variable (dépendante de votre ordinateur et/ou qualité de votre 

connexion internet probablement) 

• Pas de possibilité de superposer les limites du territoire étudié 
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6.4. Global Forest Change par « University of MARYLAND » 

A l’aide des indications ci-dessous, découvrez l’application « Global Forest Change » et 
utilisez-la pour découvrir l’évolution de la couverture forestière sur la zone d’étude de « 
Paraiso Verde ». (~ 10 minutes) 

 

Un autre portail notable, aussi basé sur l’outil Google Earth Engine, est le portail « Global 

Forest Change » développé par la « University of MARYLAND » (Figure 46), disponible ici : 

• http://earthenginepartners.appspot.com/science-2013-global-forest 

Cette application résulte d’analyses de séries temporelles d’images satellites Landsat entre 

2000 et 2018 et met en évidence l’étendue et les changements des forêts sur l’ensemble de 

la planète.  

Consultez les différentes couches d’information disponible via le menu « Data Products ».  

Quelle(s) couche(s) d’information vous semblent la (les) plus pertinentes par rapport à la 

problématique de cet exercice ?  

Remarquez que la couche « Forest Loss Year (2018 Highlight) » permet de bien mettre en 

évidence la déforestation 2018 qui semble inaugurer assez clairement un nouveau front de 

déforestation dans la partie Nord de « Paraiso Verde ».  

http://earthenginepartners.appspot.com/science-2013-global-forest
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Figure 46 : Portail web « Global Forest Change » développé par « University of MARYLAND » pour 
la zone d’étude de « Paraiso Verde » dans l’Etat de Rondônia au Brésil. Donnée affichée : « perte 
en forêt » annuelle avec une mise en évidence de l’année 2018 en bleu clair.   
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6.5. EO Browser 

A l’aide des indications ci-dessous, découvrez l’application « EO Browser » et utilisez-la sur 
la zone d’étude de « Paraiso Verde » en tentant de reproduire les graphiques présentés ci-
dessous à l’aide des données de type NDVI de Sentinel-2. (~ 20 minutes) 

 

EOBrowser est une application plus récente, développée par l’ESA (European Space Agency), 

disponible ici (Figure 47): 

• https://www.sentinel-hub.com/explore/eobrowser 

 

Figure 47 : Interface de recherche d’images satellites dans l’application « EO Browser » 

• Accédez au portail via le bouton “Start exploring” (via le bouton « sign in », vous 

risquez de rencontrer un problème de connexion) 

 

https://www.sentinel-hub.com/explore/eobrowser
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“EO Browser combines a complete archive of Sentinel-1, Sentinel-2, Sentinel-3, ESA’s archive 

of Landsat 5, 7 and 8, global coverage of Landsat 8, Envisat Meris, Proba-V and MODIS 

products in one place.” 

▪ Enregistrez-vous pour avoir accès à toutes les fonctionnalités de cette interface (Sign 

in > Sign up). 

(Nouveau : free trial avec période limitée de 30 jours…) 

6.5.1. Analyse sur la partie Nord du territoire étudié 

Vous allez tenter de mettre en évidence la dynamique de la déforestation dans la zone 

d’étude pour ces 2 dernières années, 2018 et 2019 via la réalisation de graphiques et de 

timelapses (animation temporelle d’images). Concentrez-vous sur la partie Nord du territoire 

étudié pour lequel l’application précédente « Global Forest Change » a mis en évidence une 

déforestation importante en 2018. 

!! Pour faire une recherche d’images, attention, respectez les étapes suivantes : 

• Zoomez sur la zone d’intérêt.  

• Onglet « Search » : choisissez le type d’images et la période à explorer + clic sur 

Search 

o Explorez tour à tour les 2 produits disponibles suivants : 

▪ Sentinel 2 level 2A 

▪ Sentinel 1 (toutes) 

▪ (Remarquez que Landsat est aussi disponible)  

o Remarquez que pour Sentinel 2 et Landsat 8, il y a la possibilité d’appliquer un 

filtre sur la couverture nuageuse 

o Remarquez que pour Sentinel 1, il n’y a pas de filtre nuage. Ceci est normal 

étant donné que les images RADAR ne sont pas impactées par les nuages. 

Constatez-le. 

• Onglet « Results » : une fois les résultats obtenus, cliquez dans l’interface 

géographique à l’endroit sur lequel vous voulez faire votre recherche. Ceci permet 

de ne faire apparaitre dans la fenêtre de visualisation QUE les images couvrant cet 

endroit ! 

• « Fenêtre Pop up » : choisissez une image en particulier à afficher dans l’interface 

principale 

o Remarquez que la plupart des images Sentinel-2 sont fortement ennuagées  

• Naviguez dans le temps à l’aide du calendrier et essayez de trouver une image 

Sentinel-2 peut ennuagée. 
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• Pour une image Sentinel-2 et une image Sentinel-1, explorez rapidement les 

différents modes de visualisation disponibles  (indices de végétation, compositions 

fausse couleur, etc) (exemple à la Figure 48). 

Réalisation d’un graphique de l’évolution temporelle du signal satellite sur la zone (Figure 

49 et Figure 50). 

Seuls certains produits peuvent être utilisés pour la réalisation de graphique : 

• Sentinel 2 : uniquement sur le NDVI, Moisture index et NDWI, AVEC possibilité de 

filtre nuage dans l’application graphique !!! 

• Sentinel 1 : aucun produit 

• PROBAV : aucun produit 

• Landsat8 (USGS) : uniquement pour le NDVI et le thermique, mais pas de filtre 

nuages dans le graphique → série très bruyante ! 

• Landsat 7: ne semble pas y avoir d’image disponible 

Pour réaliser un graphique de l’évolution temporelle d’un produit, il faut utiliser une 

« ROI » (Region Of Interest), soit dessiné manuellement (bouton « Draw area of interest » à 

droite de l’interface), soit importé à partir d’un fichier KML par exemple. 

Après avoir obtenu les résultats de recherche pour les images de type Sentinel-2 2A et choisi 

le rendu « NDVI »: 

• Dessinez une ROI dans la partie impactée par la déforestation en 2018. 

• Cliquez sur le bouton de réalisation d’un graphique temporel 

• Dans l’interface graphique 

o Choisissez d’afficher les produits remontant à 1 an, 2 ans, 5 ans 

o Jouez avec le filtre de nuage et voyez l’impact sur le graphique 

Timelapse 

Utilisez le bouton de création de timelapse  pour tenter de réaliser une animation 

pertinente sur la zone d’étude mettant en évidence la dynamique de la déforestation. Une 

fois enregistrée, cette animation au format « .gif » s’ouvrira par exemple dans un navigateur 

internet. Un exemple de timelapse est mis à disposition dans le répertoire 

« …\3_SERIE_TEMPORELLE_APPLI_WEB\EO_BROWSER\Sentinel-2_L2A-timelapse.gif » 
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Figure 48 : Aperçu de la zone d’étude avec le NDVI d’une image Sentinel-2 

 

Figure 49 : Graphique de l’évolution temporelle (1 an) du NDVI de Sentinel-2 L2A sur la zone 
d’étude, sans filtre de nuages : signal très bruyant en dents de scie.  
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Figure 50 : Graphique de l’évolution temporelle (1 an) du NDVI de Sentinel-2 L2A sur la zone 
d’étude, AVEC filtre de nuages à 52 % : signal moins bruyant qu’à la figure précédente. 



114 
 

 

Figure 51 : Aperçu de la zone d’étude avec une image Sentinel-1 

6.5.2. Analyse sur une parcelle déforestée 

Après avoir étudié le nord de la zone, refaite le même type d’étude pour une petite zone 

correspondant uniquement à une parcelle déforestée en 2018 ou 2019 afin que l’analyse 

mette clairement en évidence l’effet de la déforestation sur le signale NDVI de Sentinel-2, 

comme réalisé ci-dessous. 

L’exemple repris dans les figures ci-dessous correspond aux coordonnées LAT -8.33 et LON -

62.88 entre le 15 et le  20/7/2019 avec le NDVI de Sentinel-2. Un graphique de l’évolution 

temporelle du NDVI met clairement en évidence une cassure (en anglais : « break ») 

correspondant à une forte diminution du signale NDVI entre ces 2 dates. 
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Figure 52 : Parcelle déforestée dans la zone d’étude telle qu’elle apparait sur des images NDVI de 
Sentinel-2, avant (en haut) et après (en bas) déforestation.  
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Figure 53 : Graphique de l’évolution temporelle (6 mois) du NDVI de Sentinel-2 L2A sur la parcelle 
déforestée, SANS (en haut) et AVEC (en bas) filtre de nuages: baisse soudaine du NDVI due à la 
déforestation bien visible en juillet 2019. 
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6.6. Time series viewer SPOT-VGT & PROBA-V 

A l’aide des indications ci-dessous, découvrez l’application « Time series viewer » et utilisez-
la sur la zone d’étude de « Paraiso Verde ». (~ 15 minutes) 

ATTENTION !  

• Cette application n’existe plus ! Les explications ci-dessous sont données pour 
information.  

• Cette application a été remplacée par l’application 
https://viewer.probav.vito.be/probav qui est cependant moins aboutie que 
l’application initiale (lenteur, manipulations moins efficaces pour la production de 
résultats,…) 

 

Analyse d’une série temporelle d’images NDVI basse résolution via une application web 

(temps : 15 minutes). 

A l’aide du « Time series viewer » développé par le VITO et disponible ici (il faut copier-coller 

le lien manuellement dans une page web pour accéder à l’application): 

• https://proba-v-mep.esa.int/applications/time-series-viewer/app/app.html,  

Produits disponibles : 

• NDVI : issus des capteurs PROBAV et SPOT-VGT (S10 = synthèse décadaire (sur une 

période de 10 jours) à partir d’images acquises quotidiennement)  

• 4 produits CGLS (Copernicus Global Land Service) : FAPAR, LAI, FCOVER, Dry Matter 

Productivity 

• Météo 

Pour en savoir plus : 

• Sur SPOT-VEGETATION : http://www.spot-vegetation.com/ 

• Sur PROBA-V : http://proba-v.vgt.vito.be/en 

Explorez différentes régions du monde et mettez en évidence le lien entre l’évolution 

temporelle des conditions de végétation (NDVI) et des précipitations. 

• Pakistan (Figure 54) 
o Double saison de végétation annuelle dans certaines régions  

• Maroc (Figure 55) 
o Nord : saison unique avec amplitude importante et année sèche visible : 

irrégularité interannuelle  
o Sud : faible amplitude 

• Wallonie (Figure 55) 

https://viewer.probav.vito.be/probav
https://proba-v-mep.esa.int/applications/time-series-viewer/app/app.html
http://www.spot-vegetation.com/
http://proba-v.vgt.vito.be/en
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o Saisons larges et amples 
o L’impact de la sécheresse 2018 est-il visible ? 

• Burkina Faso (Figure 55) 
o Nord : saisons amples mais étroites 
o Sud : saisons amples et plus large 

• Sud du Bénin (Figure 56) 
o Evolution latitudinale des types de saisons de végétation 

 

Remarquez la possibilité de travailler avec des masques d’occupation du sol (« landcover »). 

Quelques exemples de graphiques sont repris ci-dessous.  

 

Figure 54 : Double saison de végétation annuelle observée pour le Punjab au Pakistan sur base du 
NDVI PROBA-V (courbe verte) et précipitations (bleu) 
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Figure 55 : Différents types de saisons de végétation pour quelques régions du monde sur base du 
NDVI PROBA-V (courbe verte) et précipitations 
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Figure 56 : Evolution latitudinale des types de saisons de végétation (courbes vertes) pour 3 
régions du Bénin (Afrique de l’Ouest), depuis une double saison sur la côte dans le Sud jusqu’à une 
saison unique dans le Nord en passant par une saison de type intermédiaire (double petit pic) dans 
le centre. Précipitations en bleu.  
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Remarquez que la qualité des données disponibles via ce portail ne semble pas toujours être 

garantie : confer la Figure 57. 

 

Figure 57 : Exemple d’évolution du FAPAR pour une région du Ghana : il semble y avoir une erreur 
dans les données puisque la moyenne historique (Long Term Average - LTA) passe sous le 

minimum. 

Tentez enfin une visualisation pour la zone d’étude de « Paraiso Verde ». 

• Sur l’Etat de Rondônia (Figure 58, courbe verte) 

• Pour un polygone (disponible uniquement pour PROBAV 2014-2020) (Figure 58, 

courbe mauve) 

o Possibilité d’uploader le shapefile mis à disposition dans le répertoire 

« …\3_SERIE_TEMPORELLE_APPLI_WEB\QGIS\VECTOR_DATA\Paraiso_verde.s

hp ». 

• (Pour un point (via le drapeau) (disponible uniquement pour PROBAV 2014-2020) : 

non réalisé dans ce manuel. 

o Documentation du portail: “Custom point of interest to show a time serie 

break or something like this point time series”: 

▪ https://proba-v-mep.esa.int/documentation/manuals/time-series-

viewer#point-timeseries) 

https://proba-v-mep.esa.int/documentation/manuals/time-series-viewer#point-timeseries
https://proba-v-mep.esa.int/documentation/manuals/time-series-viewer#point-timeseries
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Figure 58 : Evolution du NDVI PROBA-V pour l’Etat de Rondônia (courbe verte) et pour la zone 
d’étude Paraiso Verde (courbe mauve). 

Constatez aussi à certains endroits (Figure 59): 

• L’écart de NDVI entre les 2 capteurs SPOT VEGETATION et PROBA V pour 2014 

• La différence d’amplitude et de bruit de NDVI entre SPOT VGT ET PROBAV  

 
Rondônia, Brésil 

 
Région d’Ucayali (Centre-Est du Pérou) 

Figure 59 : Exemples de différences (valeur absolue, amplitude, bruit) entre le « NDVI SPOT-
VEGETATION » et le « NDVI PROBA-V » pour 2 régions. 
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6.7. Terrascope 

Découvrez rapidement, selon votre intérêt, l’application « Terrascope » (non disponible 
pour la zone d’étude, présentée à titre d’information). (~ 10 minutes) 

 

Terrascope est une plateforme belge disponible ici: 

• Site web principal :  

o https://terrascope.be/fr  

• Viewer d’images satellites (Figure 60):  

o https://viewer.terrascope.be/terrascope/?language=fr&bbox=-102,10,77,78  

Les images et produits satellites disponibles sont : Sentinel 1, Sentinel 2, PROBA-V, 

Copernicus Land Services (LAI, FAPAR). Quelques couches externes (orthophotos, parcellaire 

agricole) sont également disponibles.  

Cette plateforme ne couvre que la Belgique et sa proximité immédiate.  

Enregistrez-vous pour avoir accès à toutes les fonctionnalités de cette interface (Register 

and Log in). 

Découvrez éventuellement les diverses fonctionnalités de la plateforme via le bouton « Faire 

un tour ». 

https://terrascope.be/fr
https://viewer.terrascope.be/terrascope/?language=fr&bbox=-102,10,77,78
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Figure 60 : Aperçu du « viewer » de la plateforme « Terrascope » avec les images Sentinel-2 
disponibles pour le 28 mars 2020. 

6.8. Viewer quotidien des images PROBA-V 

Pour information. (~ 5 minutes) 

 

• https://proba-v-mep.esa.int/applications/geo-viewer/app/  

 

https://proba-v-mep.esa.int/applications/geo-viewer/app/
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6.9. Système mondial d’information et d’alerte rapide sur 

l’alimentation et l’agriculture (SMIAR) 

Pour information. (~ 5 minutes) 

 

Site web : 

• http://www.fao.org/giews/earthobservation/index.jsp?lang=fr 

« Le SMIAR suit l'état de développement des principales cultures vivrières à travers le 

monde afin d’évaluer les perspectives de production. Pour appuyer l'analyse et compléter 

les informations recueillies sur le terrain, le SMIAR utilise des données de télédétection en 

vue de récolter des indications importantes sur la disponibilité en eau et la santé générale 

de la végétation au cours des campagnes agricoles. Outre les estimations concernant la 

pluviométrie et l'indice de végétation par différence normalisé (NDVI - Normalized 

Difference Vegetation Index), le SMIAR et la Division CBC de la FAO ont mis au point l'Indice 

de stress hydrique (ASI - Agricultural Stress Index), un indicateur qui permet d’identifier 

rapidement des zones agricoles probablement affectées par des périodes sèches, voire des 

sécheresses dans les cas extrêmes. » 

 

Figure 61 : Carte de l’indice de santé de la végétation sur le site web du SMIAR. 

http://www.fao.org/giews/earthobservation/index.jsp?lang=fr
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6.10. Fonte des glaces du pôle Nord 

Pour information. (~ 5 minutes) 

 

Exemple supplémentaire de monitoring qui peut être fait à partir d’une série temporelle 

d’images satellites.  

• Disappearing Arctic sea ice, animation 

https://www.youtube.com/watch?v=hlVXOC6a3ME 

o Disparition progressive de la glace la plus ancienne/la plus épaisse 

o Plus d’information: https://svs.gsfc.nasa.gov/4616 

• Arctic Sea Ice Reaches 2019 Minimum Extent 

https://www.youtube.com/watch?v=2XKYdSqf2ss (Figure 62) 

 

Figure 62 : “Arctic Sea Ice Reaches 2019 Minimum Extent”. Source: 
https://www.youtube.com/watch?v=2XKYdSqf2ss  

https://www.youtube.com/watch?v=hlVXOC6a3ME
https://svs.gsfc.nasa.gov/4616
https://www.youtube.com/watch?v=2XKYdSqf2ss
https://www.youtube.com/watch?v=2XKYdSqf2ss
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7. Manipulations de données 

hyperspectrales dans QGIS 

 

 

Objectifs 
pédagogiques 

• Mieux comprendre la notion d’image hyperspectrale 

• Constater la variation des signatures spectrales pour différentes 
occupation du sol 

• Se familiariser à l’analyse de diverses formes graphiques de 
représentation de l’information spatiale (signature spectrale, nuage 
de points 2D, cube hyperspectral) 

 

Données 
& 

Projet QGIS! 

Les données nécessaires à la réalisation de cet exercice sont disponibles 
dans le dossier « …\4_HYPERSPECTRAL\... » (~ 50 MB) et correspondent 
à : 

• Des données hyperspectrales ponctuelles de laboratoire  

• Une image satellite hyperspectrale CHRIS-PROBA 

Téléchargez ce dossier sur votre ordinateur en local dans votre 
répertoire de travail et décompressez-le. ATTENTION ! Voyez la section 
1.2 page 19 pour plus d’information sur l’accès aux données. 

Projet QGIS : « HYPERSPECTRAL.qgz » situé dans ce même dossier. 

 

Logiciel ou 
application 

QGIS 3.10 ou supérieur 
(https://www.qgis.org/fr/site/forusers/download.html). 

 

Temps 
approximatif 

~ 15-20 minutes pour les données hyperspectrales ponctuelles. 
~ 30 minutes pour l’image hyperspectrale. 

 

Prérequis Aucun. 

 
 

 

  

https://www.qgis.org/fr/site/forusers/download.html
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7.1. Introduction 

Dans cette section vous aurez brièvement l’occasion de manipuler quelques données de 

type « hyperspectral ». Un signal est dit « hyperspectral » lorsqu’il est composé de 

nombreuses bandes spectrales (généralement 100 ou plus), étroites (1 à 500 nm de largeur 

par exemple) et contiguës (signal continu dans la gamme spectrale considérée) (exemple à la 

Figure 64). 

Les données hyperspectrales peuvent se présenter de différentes façons en fonction du 

capteur duquel elles sont issues (Figure 63) : 

• Image hyperspectrale : il s’agit d’une image (comme une image satellite 

multispectrale par exemple) avec une résolution spectrale très importante. Exemple : 

le capteur “AHS-160” est disposé dans un avion et est composé de 80 bandes 

spectrales, couvrant 5 parties du spectre solaire entre 0.43 – 12.7 µm 

(VIS+NIR+SWIR+TIR). 

• Donnée hyperspectrale ponctuelle : ces données sont enregistrées à l’aide d’un 

capteur portable utilisé par un opérateur directement sur le terrain (en plein air ou 

en laboratoire). Exemple : capteur de type « Analytical Spectral Device (ASD) », qui se 

porte comme un sac à dos et enregistre l’information spectrale dans 2151 bandes 

spectrales contigües de 1 nm de large chacune, entre 350 et 2500 nm. 

 

Figure 63 : Différents types d’acquisitions de données hyperspectrales 
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7.2. Manipulation de données hyperspectrales ponctuelles 

(ASD) dans « ViewSpecPro » 

Les données que vous allez utiliser ont été acquises sur des échantillons de sol agricoles 

étudiés en laboratoire pour différents niveaux de teneurs en eau et d’ombrages. 

(Remarque : pour les sols ombragés, l’énergie incidente correspond à la pleine lumière et 

l’énergie réfléchie correspond à la lumière réfléchie par un sol partiellement ombragé.) 

 

Figure 64 : 4 signatures hyperspectrales de sol agricole pour différents niveaux d’ombrages et de 
teneur en eau 

Le logiciel à utiliser est « ViewSpecPro ». Ce logiciel gratuit peut être téléchargé à l’adresse 

web suivante : https://www.malvernpanalytical.com/fr/support/product-

support/software/ViewSpecProSoftwareInstall.html après inscription sur ce site.  

Les fichiers se trouvent dans le 

répertoire « 4_HYPERSPECTRAL\HYPERSPECTRAL_ASD_LABO »: 

• Naviguez vers ce répertoire (via Windows) et ouvrez le fichier texte 

« Exemple_fichier_hyperspectral_texte.txt ». Il vous donne un aperçu de comment 

peut être organisé l’information spectrale dans un fichier : une colonne pour les 

longueurs d’ondes (nm) et une pour les valeurs de réflectance. Expliquez les valeurs 

de ces deux colonnes. 

• Démarrez le logiciel « ViewSpecPro » 

https://www.malvernpanalytical.com/fr/support/product-support/software/ViewSpecProSoftwareInstall.html
https://www.malvernpanalytical.com/fr/support/product-support/software/ViewSpecProSoftwareInstall.html
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• Cliquez sur « File > Open > » et naviguez jusqu’au répertoire contenant les données 

hyperspectrales 

• Sélectionnez les 4 fichiers dont le nom commence par « Ombre… ». et cliquez sur 

« Ouvrir » 

Les fichiers sélectionnés devraient apparaitre dans la fenêtre principale de « ViewSpecPro » 

• Sélectionnez tous les fichiers et cliquez sur « View > Graph Data ». 

• Modifiez éventuellement la symbologie des courbes via un double-clic gauche sur le 

graphique > Style 

Les spectres correspondants aux fichiers sélectionnés s’affichent à l’écran (Figure 64). 

La présence d’eau et/ou l’ombrage induisent une diminution importante de la réflectance 

(assombrissement du sol).  
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7.3. Manipulation de données hyperspectrales images 

(CHRIS-PROBA) 

7.3.1. Présentation de l’image hyperspectrale 

L’image que vous allez utiliser a été acquise par le capteur CHRIS (Compact High Resolution 

Imaging Spectrometer) monté sur le satellite PROBA (Project for On Board Autonomy) 

(Figure 65). Il enregistre les images dans 62 bandes spectrales comprises dans l’intervalle 

[400 nm - 1000 nm].  

  

Figure 65 : Vue d’artiste du satellite PROBA (crédit image: Verhaert Space, ESA) (gauche) et 
illustration d’une séquence de prises de vue multi-angulaire de PROBA-1 (crédit image : SSTL, ESA) 
(droite). Source: https://directory.eoportal.org/web/eoportal/satellite-missions/p/proba-1. 

Plus d’information sur le couple CHRIS-PROBA est disponible aux pages web suivantes : 

• https://earth.esa.int/web/guest/missions/esa-operational-eo-missions/proba, ESA 

earthnet online (ESA = European Space Agency) 

• https://directory.eoportal.org/web/eoportal/satellite-missions/p/proba-1  

L’image que vous allez utiliser se trouve dans le dossier 

« \4_HYPERSPECTRAL\HYPERSPECTRAL_IMAGE_CHRIS_PROBA\» et est nommée « 

CH100728_N.BIN ».  Elle a été enregistrée le 28 juillet 2010 au-dessus d’une région agricole 

au Sud-Ouest de Leipzig (Allemagne) en position « NADIR » (« N ») (capteur à la verticale du 

lieu enregistré). L’extension « .BIN » signifie que l’image est codée en binaire.  

Différents fichiers accompagnent ce fichier image : 

https://directory.eoportal.org/web/eoportal/satellite-missions/p/proba-1
https://earth.esa.int/web/guest/missions/esa-operational-eo-missions/proba
https://directory.eoportal.org/web/eoportal/satellite-missions/p/proba-1
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• « QuicklookCEF4_Leipzig_2010-07-28.jpg », une illustration jpeg basse résolution de 

l’image aussi appelé « Quicklook » pour avoir un aperçu rapide de l’image sans devoir 

utiliser un programme spécialisé. 

• « Info Chris wavelengths.xls », fichier Excel listant chacune des 62 bandes de l’image 

avec les longueurs d’ondes et les couleurs visibles approximatives correspondantes 

• « CH100728_N.HDR », fichier texte correspondant au fichier header (entête) créé 

dans le logiciel ENVI 

•  « Readme.txt », fichier texte donnant quelques informations supplémentaires sur 

l’image (nombre de lignes et de colonnes, système de coordonnées, format, etc) 

7.3.2. Manipulations et analyses à partir de l’image hyperspectrale 

7.3.2.1. Compositions colorées de l’image hyperspectrale 

A l’aide des indications ci-dessous, découvrez l’image CHRIS-PROBA via son ouverture dans 
QGIS et la réalisation d’une ou plusieurs compositions vraies couleurs et éventuellement 
une ou plusieurs compositions fausses couleurs.   

 

• Ouvrez le projet QGIS « HYPERSPECTRAL.qgz » préalablement créé pour vous ou 

créez un nouveau projet QGIS par vous-même. 

o Notez que le SCR de l’image CHRIS-PROBA est le système « EPSG:32632 - 

WGS 84 / UTM zone 32N » (clic-droit sur l’image > Propriétés… > Information 

> SCR) (information aussi partiellement disponible dans le fichier texte 

« readme.txt »). Ce SCR a été utilisé comme SCR du projet QGIS (Projet > 

Propriétés… > SCR) 

• Ajoutez l’image « CH100728_N.BIN » dans votre projet QGIS si elle n’est pas encore 

présente dans votre projet 

• Constatez que cette image est composée de 62 bandes spectrales via : 

o Clic-droit sur l’image dans le panneau « Couches » de QGIS > Propriétés… > 

Symbologie > Rendu des bandes raster > Les menus déroulants des 3 canaux 

RGB présentent les 62 bandes spectrales 

• Réalisez une ou plusieurs compositions vraies couleurs de l’image en vous aidant de 

la feuille Excel « Info Chris wavelengths.xls » ou de la Figure 66 ci-dessous pour 

trouver la correspondance entre numéro de bande spectrale et les couleurs Rouge, 

Vert et Bleu.  

o La combinaison R = 21, G = 14, B = 5 est un bon exemple de composition 

vraies couleurs (Figure 66) 



133 
 

o Remarquez que plusieurs combinaisons sont possibles étant donné que 

plusieurs bandes spectrales correspondent à chacune des 3 couleurs Rouge, 

Vert et Bleu (Figure 66).  

• Identifiez rapidement quelques classes d’occupation du sol dont de la végétation 

cultivée (champs cultivés), de la terre (champs nus), de l’eau (lac) et remarquez la 

présence importante de nuages sur l’image.  

  

Figure 66 : Exemple de composition vraies couleurs de l’image hyperspectrale CHRIS PROBA (R = 
21, G = 14, B = 5) (gauche) et table décrivant les 30 premières (sur un total de 62) bandes spectrales 
de l’image CHRIS PROBA avec en particulier les longueurs d’ondes et les couleurs visibles 
approximatives correspondant à chacune des bandes (droite). 

7.3.2.2. Affichage de la signature spectrale de différentes occupations du sol 

A l’aide des indications ci-dessous, constatez la variation des signatures spectrales pour 
différentes occupation du sol et pour les nuages. 

 

Plusieurs extensions de QGIS permettent d’extraire la signature spectrale d’un pixel ou d’un 

groupe de pixels (via un polygone) d’une image, de manière interactive et son affichage sous 

la forme d’un graphique (Figure 67). 

Afin de consulter de manière interactive la signature spectrale (composée par les 62 bandes 

spectrales de l’image CHRIS-PROBA) de différentes occupations du sol présentes au sein de 

l’image : 
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• Installez l’extension QGIS « Temporal/Spectral Profile Tool » qui, après installation, 

est disponible sous la forme du bouton  ou dans le menu « Extension > Profile 

Tool > Temporal/Spectral Profile » (Menu Extension > Installer/Gérer les extensions > 

Recherche et installation de l’extension) 

• (Remarque : une autre extension permettant également de réaliser un graphique de 

la signature spectrale est l’extension « RasterDataPlotting » . Cette extension 

est utilisée dans la section suivante pour la réalisation d’un graphique de type nuage 

de points) 

• Utilisez l’extension QGIS « Temporal/Spectral Profile Tool » pour consulter de 

manière interactive la signature spectrale de différentes occupations du sol 

présentes au sein de l’image (Figure 67) 

 
Sol nu 

 

 
Végétation 

 

 
Eau 

 
Nuage 

Figure 67 : Signatures spectrales obtenues pour 3 occupations du sol et pour les nuages à partir de 
l’image hyperspectrale CHRIS-PROBA composée de 62 bandes spectrales. 
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7.3.2.3. Graphique 2D de bandes spectrales 2 à 2 

A l’aide des indications ci-dessous, réalisez 2 graphiques de type « nuage de points » 
comparant les valeurs des pixels de l’image hyperspectrale pour 2 bandes spectrales 
proches et 2 bandes spectrales éloignées et comprenez leur interprétation.  

 

• Installez l’extension QGIS « RasterDataPlotting » qui, après installation, est 

disponible sous la forme du bouton  (Menu Extension > Installer/Gérer les 

extensions > Recherche et installation de l’extension) 

• Utilisez cette extension pour réaliser 2 graphiques de type « nuage de points » 

(anglais : « scatter plot ») comparant les valeurs des pixels (axes X et Y) de l’image 

hyperspectrale pour (Figure 68): 

o 2 bandes spectrales proches : bandes 1 et 2 par exemple  

o 2 bandes spectrales éloignées : bandes 1 et 42 par exemple 

• Il peut être opportun de réaliser un « Clic-droit > Zoomer sur la couche » à partir de 

l’image hyperspectrale dans le panneau « Couches » afin d’obtenir une meilleure 

représentation graphique.  

• Quelles différences observez-vous entre ces 2 graphiques ? Comment les expliquez-

vous ? 

Le nuage de points du graphique des bandes spectrales 1 et 2 est très « aplati » sur la 

« diagonale X = Y » car les valeurs de pixels de ces 2 bandes sont extrêmement proches ou 

« extrêmement corrélées » (Figure 68, gauche). 2 bandes spectrales proches sont quelque 

part assez redondantes étant donné qu’elles portent une information spectrale similaire.  

Le nuage de points du graphique des bandes spectrales 1 et 42 est très « éclaté » car les 

valeurs de pixels de ces 2 bandes sont « très peu corrélées » (la variation des valeurs de 

pixels de la bande 1 ne correspond pas à une variation similaire des valeurs de pixels de la 

bande 42) (Figure 68, droite). 2 bandes spectrales distantes ne sont pas redondantes car 

elles portent chacune une information spectrale différente/particulière. 2 bandes spectrales 

distantes seront donc plus riche en information et donc plus intéressantes pour caractériser 

une occupation du sol donnée que 2 bandes spectrales proches.  
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Figure 68 : Graphiques de type « nuage de points » (anglais : « scatter plot ») pour l’ensemble de 
l’image CHRIS-PROBA pour les bandes spectrales 1 et 2 (gauche) et 1 et 42 (droite), réalisés avec 
l’extension « Raster Data Plotting » de QGIS  
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7.3.2.4. Cube hyperspectral 

Il n’y a pas de manipulation à réaliser. Comprenez simplement comment interpréter un 
cube hyperspectral.  

 

QGIS ne permet pas de réaliser un cube hyperspectral. Un exemple est simplement présenté 

à la Figure 69.  

Un cube hyperspectral peut être réalisé à partir d’images hyperspectrale aérienne ou 

satellite par exemple. L’axe de la 3ème dimension correspond aux longueurs d’ondes du 

spectre électromagnétique. La couleur des faces du cube de cette 3ème dimension varie en 

fonction de la valeur mesurée par le capteur (par exemple: radiance, réflectance etc) pour 

chaque longueur d’onde. Cette 3ème dimension permet donc de visualiser via une palette 

de couleurs la variation de réflectance (ou autre paramètre) selon les longueurs d’onde pour 

les occupations du sol présentes en bordure du cube.  

 

Figure 69 : Cube hyperspectral. La 3ème dimension du cube (la profondeur) correspond aux longueurs d’ondes 
du spectre électromagnétique. Illustration adaptée depuis : https://www.dronelogx.com/geospatial-
imagery-analysis. 

https://www.dronelogx.com/geospatial-imagery-analysis
https://www.dronelogx.com/geospatial-imagery-analysis
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7.3.2.5. Importance du « Fichier entête » ou « Header file » 

A l’aide des indications ci-dessous, vérifiez par vous-même l’importance du « Fichier 
entête » (anglais «Header file ») accompagnant l’image hyperspectrale en modifiant très 
légèrement l’un de ses paramètres et en constatant les modifications d’affichage induites.  

 

Le « Fichier entête » (anglais « Header file ») est un petit fichier texte accompagnant une 

image, qui contient une série d’information décrivant l’image, et qui permet à un logiciel de 

lire et d’afficher correctement cette image.  

o Ouvrez le « Fichier entête » « CH100728_N.HDR » de l’image CHRIS-PROBA avec le 

bloc note (fichier de type texte) et jetez-y un œil rapide (Figure 70 gauche). 

Remarquez que ce fichier contient notamment les informations sur le nombre de 

colonnes (« samples ») et lignes (« lines ») de pixels de l’image et sur le nombre de 

bandes spectrales (« bands ») de l’image. 

o Supprimez l’image CHRIS-PROBA de votre projet QGIS 

o Modifiez une information du « Fichier entête », par exemple en indiquant 500 lignes 

ou 601 colonnes et enregistrez cette modification. 

o Ajoutez l’image CHRIS-PROBA dans votre projet QGIS 

o Constatez que QGIS n’affiche plus correctement l’image CHRIS-PROBA suite à cette 

modification du « Fichier entête » (Figure 70 centre et droite). 

o Faites la manipulation inverse pour corriger l’erreur introduite et afficher à nouveau 

correctement l’image CHRIS-PROBA dans QGIS. 

   

Figure 70 : « Fichier entête » (anglais : « Header file ») de l’image CHRIS-PROBA contenant 
notamment l’information sur le nombre de colonnes (« samples ») et lignes (« lines ») de pixels de 
l’image (gauche) et affichage de l’image CHRIS-PROBA dans QGIS après modification de ce « Fichier 
entête » en indiquant les informations erronées suivantes : 600 colonnes/500 lignes/ (centre) et 
601 colonnes/700 lignes (droite). 
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8. Classification supervisée d’images 

satellites multispectrales et analyse 

diachronique : méthode simple et 

méthode avancée (dans QGIS) 

 

Objectifs 
pédagogiques 

Maitriser la procédure complète (nombreuses étapes) de réalisation : 

• d’une carte d’occupation du sol par classification supervisée d’une 
image satellite multispectrale (Landsat-5 et Sentinel-2) (avec 
validation par matrice de confusion), 

• d’une analyse diachronique à partir d’images satellites 
multispectrales (avec production d’une matrice de transition). 

 

Données 
& 

Projet QGIS! 

Les données nécessaires à la réalisation de cet exercice sont disponibles 
dans le dossier 
«…\5_CLASSIFICATION_SUPERVISEE_ANALYSE_DIACHRONIQUE\...» (~ 
455 MB). 

Téléchargez ce dossier sur votre ordinateur en local dans votre 
répertoire de travail et décompressez-le. ATTENTION ! Voyez la section 
1.2 page 19 pour plus d’information sur l’accès aux données. 

Ces données sont décrites dans les sections 8.4 page 153 pour les 
données auxiliaires et section 8.5 page 162 pour les images satellites. 

Projet QGIS : « CLASSIF_SUP_ANALYSE_DIA.qgz » situé dans ce même 
dossier. 

 

Logiciel ou 
application 

QGIS 3.34 ou supérieur : la dernière version stable (3.34 LTR en avril 
2024) est conseillée. 
(https://www.qgis.org/fr/site/forusers/download.html) 

 

Temps 
approximatif 

METHODE SIMPLE ~ 4 à 6 heures 

METHODE AVANCEE  ~ 6 à 8 heures 

 

Prérequis 
Il est préférable mais non obligatoire que l’utilisateur ait déjà quelques 
notions de base en SIG (QGIS) et télédétection. 

 

Dernière mise 
à jour 

• 19/04/2024 (légère modification de la méthode simple, nouvelle 
procédure d’installation du plugin SCP) 

 

https://www.qgis.org/fr/site/forusers/download.html
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8.1. INFORMATIONS PREALABLES IMPORTANTES ! 

8.1.1. METHODE SIMPLE & METHODE AVANCEE 

 

Cette section numéro 8 est assez longue (~140 pages au total) et peut être parcourue 
selon 2 CHEMINS METHODOLOGIQUES correspondant à une : 

• METHODE SIMPLE de CLASSIFICATION SUPERVISÉE D’UNE SEULE image satellite (de 

type Landsat-5) (+acquisition et prétraitement de l’image + représentation 3D + 

analyse de séparabilité spectrale des classes + validation + mise en page 

cartographique), SANS ANALYSE DIACHRONIQUE 

o ATTENTION ! POUR LA METHODE SIMPLE : 

▪ Les titres de sections utiles à sa réalisation sont surlignés en vert 

▪ Les étapes méthodologiques utiles à sa réalisation sont encadrées 

d’un halo vert dans le schéma méthodologique global de la Figure 71. 

o Cette méthode simple est présentée sur un total approximatif de 90 pages 

• METHODE AVANCEE de CLASSIFICATION SUPERVISÉE DE PLUSIEURS images 

satellites (de type Landsat-5 et Sentinel-2) reprenant les étapes de la méthode 

simple ET EN ADDITION la réalisation de traitements supplémentaires (masques de 

nuages, construction d’une image désennuagée, reclassification conditionnelle) et la 

réalisation d’une ANALYSE DIACHRONIQUE (matrice de transition, graphiques 

d’évolution du paysage, etc) 

o L’ensemble des sous-sections de cette section 8 sont à considérer pour mener 

à bien la méthode avancée (~140 pages) à l’exception de quelques sections 

qui sont données à titre purement informatif. 

La METHODE AVANCEE est volontairement complexe, ceci afin de montrer une large 

gamme (mais très loin d’être exhaustive) des méthodes potentiellement applicables à ce 

type d’analyse. Sachez cependant que nombre de manipulations peuvent se révéler 

facultatives dans certains cas et que leur utilisation devra donc être adaptée en fonction de 

vos données d’entrée, des objectifs de l’étude (classes d’occupation du sol d’intérêt, 

précision souhaitée), de la difficulté de la classification de la zone d’intérêt, etc. Dans 

certains cas, une classification supervisée d’images satellites ainsi qu’une analyse 

diachronique peuvent donc être conduites beaucoup plus directement si désiré.  
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8.1.2. Traitements déjà réalisés 

Certains traitements de données ont déjà été effectués pour vous et les données résultantes 

sont mises à disposition dans les sous-dossiers du répertoire 

«…\5_CLASSIFICATION_SUPERVISEE_ANALYSE_DIACHRONIQUE\».  

Ces étapes, reprises sous la forme d’encadrés oranges dans la Figure 71, sont clairement 

renseignées tout au long de la procédure et l’utilisateur pourra décider de : 

• Soit, pour gagner du temps : repartir des données « prétraitées » mises à disposition 

• Soit, pour pratiquer l’ensemble de la procédure et un meilleur apprentissage : 

refaire l’ensemble des étapes, indépendamment des données mises à disposition. 

8.2. Introduction et objectifs 

8.2.1. Objectifs  

Cet exercice a pour objectif principal de donner à l’utilisateur les outils méthodologiques 

nécessaires que pour réaliser correctement : 

• Une carte d’occupation du sol par classification supervisée d’image satellite 

multipsectrale haute résolution 

• Une analyse diachronique (méthode avancée seulement) à partir de la classification 

supervisée de 2 images satellites multispectrales. L’analyse diachronique proposée 

permet d’identifier, de localiser et de mesurer la superficie des classes d’occupation 

du sol et d’analyser leur évolution dans le temps. L’analyse ne concerne pas la 

production d’indices paysagers tels que le nombre de taches, la taille des taches, etc. 

Nombre de commentaires sont fournis sur les éléments auxquels il faut faire attention pour 

réaliser une analyse méthodologiquement valide, sur les limitations de l’approche et sur les 

pistes d’amélioration possible.  

8.2.2. Etapes méthodologiques principales 

Les principales étapes de la méthodologie sont reprises ci-dessous et à la Figure 71. Une 

vision plus détaillée de toutes les étapes est disponible via la table des matières disponible 

en début de manuel. Ces étapes comprennent en particulier et chronologiquement :  
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METHODE SIMPLE 
Etapes supplémentaires pour la METHODE 

AVANCEE 

• Acquisition des données à analyser via 
recherche sur internet et téléchargement :  

o 1 image satellite multispectrale 
Landsat-5 

o Modèle Numérique de Terrain 
(MNT) (pour la représentation 3D) 

o Données auxiliaires telles que 
données climatiques, shapefile et 
informations contextuelles 

• Prétraitements sur l’image Landsat-5  
o Sélection des bandes spectrales,  
o Découpage spatiale,  

• Prétraitements sur le raster d’altitude 
o Fusion,  
o Reprojection,   
o Découpage spatiale,  
o Rééchantillonnage  

• Observation des images en 2D et en 3D et 
identification des classes d’occupation du 
sol 

• Sélection des zones d’entrainement (ROI 
de calibration) 

• Classification supervisée 

• Séparabilité spectrale des classes 
 
 
 
 
 
 
 
 
 
 

• Validation de la classification supervisée 
par matrice de confusion 

• Mise en page cartographique 
 

• Acquisition des données à analyser via 
recherche sur internet et téléchargement :  

o 2 images satellites multispectrales 
Sentinel-2 

 
 
 
 
 

• Prétraitements sur les images Sentinel-2 
o Conversion en réflectance, 

sélection des bandes, découpage 
spatiale, rééchantillonnage  

o Gestion des nuages : masque de 
nuages, mosaïquage, etc 

 
 
 
 
 
 
 
 
 
 

• Amélioration de la classification par 
reclassification conditionnelle en fonction 
de l’altitude et de la proximité aux rivières  

• Post-traitements (filtre spatiale,…) 

• Réalisation d’une matrice transition 

• Réalisation de graphiques (camembert et 
histogramme) exprimant l’évolution de 
l’occupation du sol 

 

 



143 
 

 
Figure 71 : Etapes méthodologiques de la section 8 de ce manuel concernant la classification supervisée 
d’images satellites multispectrales et l’analyse diachronique.
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8.2.3. Choix du logiciel : QGIS 3.34 ou version ultérieure 

• Le logiciel QGIS (version 3.34 ou ultérieure), a été sélectionné car il est gratuit et 

permet de réaliser toutes les opérations de la méthode développée dans cette 

section dans un seul environnement, ce qui est assez confortable.  

o QGIS  est disponible ici https://www.qgis.org/fr/site/forusers/download.html 

o La dernière version stable du logiciel est conseillée (3.34 LTR en avril 2024). 

o A télécharger et installer si ce n’est pas encore fait sur votre ordinateur.  

• En particulier, le plugin « Semi-Automatic Classification Plugin (SCP) » de QGIS 

permet de réaliser un grand nombre d’étapes clefs.  

o La dernière version du plugin doit être installée, après installation de QGIS.  

o La procédure d’installation du plugin est renseignée plus loin.  

8.2.4. Contextualisation 

La zone étudiée se situe dans la région de la ville de Kasese en Ouganda (Afrique de l’Est), à 

la frontière Est de la République Démocratique du Congo (RDC) et contient de nombreuses 

zones protégées (Figure 72), dont le « Parc national Rwenzori Mountains » dans la partie 

Nord-Ouest (Figure 72 et Figure 73). 

 
Figure 72 : Localisation de la zone d’étude (rectangle noir) : région de la ville de Kasese en Ouganda 
(Afrique de l’Est) 

Un aperçu rapide de la topographie de la zone d’étude peut être obtenu facilement via 

l’application « Google Earth Pro » (Figure 73) déjà présentée à la section 3 page 33 

(installation et utilisation de « Google Earth Pro »). 

https://www.qgis.org/fr/site/forusers/download.html
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Figure 73 : Aperçu de la zone d’étude dans Google Earth Pro 

Une idée de l’évolution de la couverture forestière dans la zone d’étude (Figure 74) est 

disponible via l’application « Global Forest Change » de la « University of Maryland » 

disponible via le lien ci-dessous et déjà présentée à la section 6.4 page 107. 

• https://earthenginepartners.appspot.com/science-2013-global-forest 

https://earthenginepartners.appspot.com/science-2013-global-forest
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Figure 74 : Aperçu de l’étendue, des pertes et des gains de la couverture forestière entre 2000 et 
2018 dans la zone d’étude via l’application « Global Forest Change » de la « University of 
Maryland ». 
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8.3. Préparation du projet QGIS 

8.3.1. Création d’un nouveau projet QGIS ou ouverture du projet QGIS 

préexistant  

Après avoir lancé l’application « QGIS Desktop » et une fois l’interface de QGIS ouverte, 

choisissez une des 2 méthodes proposées ci-dessous: 

• Soit, pour pratiquer l’ensemble de la procédure :  

o Créez un nouveau projet QGIS via le menu « Projet > Nouveau » 

o Définissez le système de coordonnées du projet QGIS sur base des 

indications fournies à la section suivante (section 8.3.2 page 148). Dans le 

cas de cet exercice (ville de Kasese, Ouganda), utilisez le SCR « EPSG32635 

- WGS84 UTM Zone 35N - projeté » (Menu Projet > Propriétés… > SCR > 

sélection du SCR d’intérêt) 

o Ajoutez dans ce projet les données suivantes disponibles dans le dossier 

« 5_CLASSIFICATION_SUPERVISEE_ANALYSE_DIACHRONIQUE\DATA\DON

NEES_AUXILIARES\ » (ces données sont décrites à la section 8.4 page 153): 

▪ « ne_10m_admin_0_countries.shp » (vecteur) 

▪ « ZONE_ETUDE_KASESE.shp » (vecteur) 

▪ « SRTM_FUSION_EPSG32635_CLIP_90m.tif » (raster) 

▪  « RIVIERES.shp » (vecteur) (Méthode avancée seulement) 

▪ « RIVIERES_TAMPON_60_m.shp » (vecteur) (Méthode avancée 

seulement) 

▪ « RIVIERES_TAMPON_60_m_RASTER.tif » (raster) (Méthode 

avancée seulement) 

o Si ce n’est pas encore fait, installez l’extension QGIS 

« QuickMapServices » et ajoutez le service « Google Satellite » (fond de 

carte correspondant aux images Google satellite) dans votre projet QGIS, 

comme décrit à la section 6.1 page 100.  

o Organisez les différentes données disponibles correctement dans le 

panneau « Couches » et adaptez éventuellement leur symbologie (« clic-

droit sur la couche > Propriétés… > Symbologie ». 

o Sauvegardez ce projet QGIS dans votre répertoire de travail via le menu 

« Projet > Enregistrer sous… » et nommez ce projet (exemple : 

« Classification_votre_nom.qgz ». 
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• Soit, pour gagner du temps : 

o Ouvrez le projet QGIS « CLASSIF_SUP_ANALYSE_DIA.qgz » 

préalablement préparé pour vous (Figure 75) et disponible dans le 

dossier « 5_CLASSIFICATION_SUPERVISEE_ANALYSE_DIACHRONIQUE », 

via le menu « Projet > Ouvrir… ». Ce projet contient déjà une série de 

données correctement organisées et est exprimé dans le bon système de 

coordonnées. Si l’extension QGIS « QuickMapServices » n’est pas encore 

installée sur votre ordinateur, vous devrez l’installer, confer indications à 

la section 6.1 page 100.  

 

Figure 75 : Aperçu du projet QGIS mis à disposition « CLASSIF_SUP_ANALYSE_DIA.qgz » mettant en 
évidence la zone d’étude 

8.3.2. Identification du système de coordonnées à utiliser 

 

Attention ! En plus des consignes données à la section 1.2 page 19 (répertoire 
de travail et noms de fichiers pas trop longs et sans caractère spécial (à, é, è, -, 
etc) ou espace), il est nécessaire, pour le bon fonctionnement de certains outils : 

• Que tous les fichiers de données géographiques (shapefile et images) et 
le projet QGIS soient tous exprimés dans le même Système de 
Coordonnées de Référence (SCR) 

(Comme indiqué ici: https://fromgistors.blogspot.com/p/online-
help.html?spref=scp) 

 

https://fromgistors.blogspot.com/p/online-help.html?spref=scp
https://fromgistors.blogspot.com/p/online-help.html?spref=scp


149 
 

Attention ! Les images satellites Landsat-5 et Sentinel-2 utilisées dans le cadre de cet 

exercice pour la zone d’intérêt (ville de Kasese en Ouganda) sont toutes fournies, lors du 

téléchargement sur internet, dans le SCR « EPSG32635 - WGS84 UTM Zone 35N - projeté ».  

Cette information est disponible (vous pourrez le vérifier une fois les images satellites 

acquises, confer section 8.5 page 162): 

• Soit via les fichiers de métadonnées accompagnant les images lorsqu‘elles sont 

téléchargées de manière classique 

o Par exemple, pour une image Landsat-5, on retrouve cette information dans 

le fichier de type texte qui se termine par « MTL.txt » en fin de texte («    

DATUM = "WGS84", ELLIPSOID = "WGS84", UTM_ZONE = 35 »). 

• Soit via un clic-droit sur les bandes spectrales des images une fois celles-ci ajoutées 

dans QGIS > Propriétés… > Information > SCR 

Nous adopterons donc, dans ce cas-ci,  le SCR mentionné ci-dessus pour l’ensemble du 

projet QGIS:  

• Pour le projet QGIS en tant que tel. Pour définir le  SCR du projet QGIS : 

o Cliquez sur le menu QGIS « Projet > Propriétés…> SCR » et choisissez le SCR 

d’intérêt.  

• Pour les données géographiques images et vecteurs ajoutées dans ce projet. Note : 

si vous deviez changer le SCR d’une donnée géographique qui présente un autre SCR 

que le SCR d’intérêt, utilisez les fonctions de Reprojection suivantes dans QGIS : 

o Pour les vecteurs : menu « Vecteur > Outils de gestion de données > 

Reprojeter une couche… » 

o Pour les rasters (images): menu « Raster > Projections > Projection (warp)… » 

8.3.3. Présentation et installation du plugin « Semi-Automatic 

Classification Plugin » (SCP) 

Le plugin permettant de réaliser une classification supervisée dans QGIS est le « Semi-

Automatic Classification Plugin » (SCP).  Ce plugin présente un grand nombre de 

fonctionnalités et sera utilisé pour la quasi-totalité des étapes de cet exercice. 

La plupart des indications concernant spécifiquement l’utilisation du plugin SCP seront ici 

assez sommaires, dans un but de concision. Le lecteur intéressé pourra se référer au manuel 

officiel de SCP pour plus d’explications (disponible, en anglais seulement, via les liens ci-

dessous) et en particulier aux tutoriaux officiels de SCP numéro 1 et 3.  

Site web officiel de SCP (en anglais) 

• https://fromgistors.blogspot.com/ 

https://fromgistors.blogspot.com/
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Manuel d’utilisateur officiel de SCP (en anglais) 

• https://fromgistors.blogspot.com/p/user-manual.html?spref=scp 

• Ce manuel contient notamment 3 tutoriaux dont : 

o “Tutorial 1: Basic Land Cover Classification” qui explique comment réaliser 

une classification supervisée d’une image satellite Landsat 

o “Tutorial : Accuracy Assessment of a Land Cover Classification” qui explique 

comment évaluer la précision d’une classification d’une image via la 

production d’une matrice de confusion) (ce tutoriel n’est plus accessible 

depuis la page web principale du manuel).  

La page web du plugin QGIS SCP (en anglais) 

• https://plugins.qgis.org/plugins/SemiAutomaticClassificationPlugin/  

 

! Pour installer le plugin SCP dans QGIS sans bug, voici la procédure spéciale à suivre : 

• Avoir installé QGIS (ça c’est déjà fait en principe). 

• Fermer QGIS, ou ne pas l’ouvrir. 

• Etre connecté à internet. 

• Démarrer le programme « OSGeo4W Shell » qui s’est installé en même temps que 

QGIS, disponible dans les programmes de votre ordinateur, dans le dossier QGIS 

QGIS :  

 

• Dans le panneau noir qui apparait (confer image ci-dessous), vous devez coller la 
ligne de code suivante :  

pip3 install --upgrade remotior-sensus scikit-learn torch 
 

o comme illustré ci-dessous, puis cliquer sur ENTER pour exécuter ce code 

https://fromgistors.blogspot.com/p/user-manual.html?spref=scp
https://semiautomaticclassificationmanual.readthedocs.io/en/latest/tutorial_1.html
https://fromgistors.blogspot.com/2019/09/Accuracy-Assessment-of-Land-Cover-Classification.html
https://plugins.qgis.org/plugins/SemiAutomaticClassificationPlugin/
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• Attendre quelques minutes que l’installation se fasse et se termine (10 minutes 

devraient être suffisantes). 

• Lorsque l’installation est terminée, vous pouvez fermer la fenêtre noire. 

• Ouvrir QGIS. 

• Installez, si ce n’est pas encore fait, le plugin « Semi-Automatic Classification 

Plugin » dans QGIS via le menu principal « Extensions » ou « Plugins ». 

o Attention de ne PAS installer « SCP-Plugin » : c’est un autre Plugin !  

o –> Choisissez « Semi-Automatic Classification Plugin » 

 

• Cette procédure d’installation est expliquée avec plus de détails et d’informations sur 

la page web suivante, mais en principe vous n’en avez maintenant plus besoin : 

https://semiautomaticclassificationmanual.readthedocs.io/en/latest/installation_win

64.html  

 

Après installation, les fonctionnalités du plugin sont disponibles via (Figure 76): 

▪ Le menu principal de QGIS « SCP » qui, lors de l’utilisation d’une fonction, ouvre 

automatiquement une nouvelle interface appelée « Semi-Automatic Classification 

Plugin ». 

▪ 2 barres d’outils : une principale et une secondaire. 

https://semiautomaticclassificationmanual.readthedocs.io/en/latest/installation_win64.html
https://semiautomaticclassificationmanual.readthedocs.io/en/latest/installation_win64.html
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▪ Un panneau latéral appelé « Menu SCP », qui peut être ajouté comme panneau près 

du panneau « Couches » de QGIS pour plus de facilité, comme illustré à la Figure 76 

(déplacez le panneau jusqu’à ce qu’il vienne se coller automatiquement au panneau 

« Couches »). 

 

Figure 76 : Menu, barres d’outils, panneau latéral et fenêtre principale du plugin SCP 

Remarques :  

• L’interface du plugin évolue à chaque nouvelle version : il se peut donc que vous 

notiez quelques différences entre les illustrations de ce manuel et l’interface avec 

laquelle vous travaillerez personnellement. A vous de vous adapter.  

• Si vous ne trouvez plus certains parties de l’interface du plugin SCP, vous pouvez 

toujours les faire réapparaitre via le menu principal de QGIS : « SCP > Show plugin ». 
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8.4. Données auxiliaires : présentation, création, 

acquisition et prétraitements 

8.4.1. Données auxiliaires vectorielles 

Les données auxiliaires vectorielles utilisées sont : 

• Shapefile « ZONE_ETUDE_KASESE.shp »  

o Shapefile délimitant la zone d’étude, exprimé dans le Système de 

Coordonnées de Référence (SCR) EPSG 32635 

o Shapefile créé pour cet exercice 

• Shapefile « ne_10m_admin_0_countries.shp » 

o Shapefile des limites administratives des pays du monde, utile pour faciliter la 

localisation relative de la zone d’étude,  

o Shapefile téléchargé via le site web « Natural Earth » 

https://www.naturalearthdata.com/downloads/ > Large scale data, 1:10m 

(meilleure résolution parmi les 3 disponibles sur ce site web : 1 cm = 100 km) 

> Cultural > Admin 0 – Countries > Download countries. A 

dézipper/décompresser après téléchargement et avant l’ajout dans QGIS (si 

vous vouliez le re-télécharger par vous-même).  

• Shapefile « RIVIERES.shp » (Figure 77) (méthode avancée seulement) 

o Shapefile de quelques rivières principales dans la zone d’étude  

o Shapefile créé par numérisation rapide dans QGIS sur base d’une photo-

interprétation du fond de carte « Google Satellite » 

• Shapefile « RIVIERES_TAMPON_60_m.shp » (Figure 77) (méthode avancée 

seulement) 

o Shapefile d’une zone tampon de 60 mètres de part et d’autre des rivières du 

fichier « RIVIERES.shp » 

o Shapefile créé à l’aide de la fonction QGIS « Vecteur > Outils de géotraitement 

> Tampon… » 

https://www.naturalearthdata.com/downloads/
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Figure 77 : Aperçu des rivières numérisées et de leurs zones tampon de 60 m 

8.4.2. Données auxiliaires raster 

8.4.2.1. Raster d’altitude 

Dans le cadre de cette étude, un Modèle Numérique de Terrain (MNT) sera utilisé.  

Un MNT est un raster (image) dont la valeur des cellules ou pixels correspond à une 

information sur l’altitude.  

Un MNT sera utilisé dans le cadre de cet exercice afin de : 

• Réaliser une représentation 3D de la zone étudiée à partir des images satellites 

utilisées (confer section 8.7.5 page 239). 

• Reclassifier les forêts de la zone en « Forêts de basse altitude » et « Forêts de haute 

altitude » (reclassification conditionnelle effectuée pour la « méthode avancée » 

seulement) (confer section 8.9.3 page 268). 

Un MNT à 90 mètres de résolution spatiale découpé sur la zone d’étude et exprimé dans le 

SCR EPSG32635 est disponible dans le dossier 

« \5_CLASSIFICATION_SUPERVISEE_ANALYSE_DIACHRONIQUE\DATA\DONNEES_AUXILIARES 

» sous le nom de  

• « SRTM_FUSION_EPSG32635_CLIP_90m.tif ».  
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Vous pouvez : 

• Soit, pour gagner du temps : simplement utiliser ce MNT prétraité 

• Soit, pour pratiquer l’ensemble de la procédure et un meilleur apprentissage : 

refaire l’ensemble des étapes ayant conduit à la production de ce MNT, comme 

détaillé ci-dessous. 

La procédure suivie pour obtenir ce MNT est décrite ci-dessous. 

8.4.2.1.1. Téléchargement du Modèle Numérique de Terrain (MNT) 

Un MNT mondial à 30 mètres (~1 arc-second) de résolution spatiale est disponible 

gratuitement via le site web de référence suivant : 

• https://earthexplorer.usgs.gov/ (Figure 78) 

• En sélectionnant dans le menu « Data Sets » le type de donnée « Digital Elevation > 

SRTM > SRTM 1 Arc-Second Global » 

 

ATTENTION !  

• Des informations détaillées décrivant comment télécharger des données sur ce site 

web sont données dans la section 8.5.2.3 page 170 ci-dessous, avec pour exemple le 

téléchargement d’une image Landsat-5. Le principe est le même pour le 

téléchargement du MNT. 

• Pour rechercher un MNT, il faut qu’aucune période temporelle ne soit renseignée 

dans les critères de recherche dans l’onglet « Date Range » (image ci-dessous). En 

effet, comme les données MNT ne sont pas associées à une date particulière, le fait 

de spécifier une période dans la fenêtre « Date Range » résulte en l’absence de 

résultat à votre requête de recherche de données MNT.  

https://earthexplorer.usgs.gov/
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Le MNT mondial (donnée très lourde) est mis à disposition au téléchargement sous la forme 

de très nombreux petits morceaux de MNT d’approximativement 111 km * 111 km sur la 

zone d’étude, appelés « tiles » (données plus légères de ~25 Mo chacune (Figure 80)), afin de 

faciliter le téléchargement de MNT pour des régions particulières. La zone d’étude de cet 

exercice-ci est couverte par 4 « tiles » comme illustré aux Figure 78 et Figure 79. La 

résolution spatiale de ce MNT, c’est-à-dire la taille des pixels, est de 1 arc-seconde de côté (1 

seconde d’arc = 1/36000 de degré = 0.00028 degré) ce qui correspond à ~30 mètres. 

 

Figure 78 : Aperçu du positionnement des 4 « tiles » SRTM (MNT) couvrant la zone d’étude sur le 
site web https://earthexplorer.usgs.gov/  

https://earthexplorer.usgs.gov/
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Figure 79 : Aperçu des 4 « tiles » SRTM (MNT) couvrant la zone d’étude sur le site web 
https://earthexplorer.usgs.gov/  

 

 

Figure 80 : Aperçu des 4 « tiles » SRTM (MNT) couvrant la zone d’étude, dans l’explorateur 
Windows après téléchargement 

Après téléchargement, les opérations reprises ci-dessous peuvent être réalisées afin 

d’obtenir un seul fichier raster d’altitude couvrant toute la zone d’étude et exprimé dans le 

même système de coordonnées que les images satellites utilisées dans le cadre de cet 

exercice-ci. 

 

 

 

 

https://earthexplorer.usgs.gov/
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8.4.2.1.2. Ajout des 4 MNT dans QGIS 

• Ajoutez les 4 « tiles » MNT dans votre projet QGIS (via le menu d’ajout d’une coucher 

raster) 

Vous remarquerez que le MNT au Nord-Ouest de la zone d’étude (Figure 79) semble 

présenter quelques mauvaises données en montagne. En effet, au milieu du massif 

montagneux du « Parc national Rwenzori Mountains » (confer section 8.2.4 page 144), qui 

est identifié par des couleurs blanches (le blanc correspondant aux altitudes les plus 

élevées), quelques taches noires présentant une altitude de 0 sont présentes (le noir 

correspondant aux altitudes les plus faibles). Nous ignorerons ce problème potentiel dans le 

cadre de cet exercice. Remarque : ce problème persiste (un peu amoindri) dans la version 

« 3Arc void filled » du MNT. 

8.4.2.1.3. Fusion des 4 MNT   

Afin d’obtenir un seul fichier MNT plus facilement manipulable que 4 « tiles » séparées, il 

faut fusionner les 4 « tiles ». Pour ce faire : 

• Menu QGIS: Raster > Divers > Fusionner…  

• Couches en entrée : sélectionner les 4 MNT 

• Type : conserver Float32, valeur par défaut 

• Fusionné : choisir l’option « Enregistrer vers un fichier… » puis le répertoire de sortie 

(votre répertoire de travail) et donner un nom (par exemple : « SRTM_FUSION.tif »)  

8.4.2.1.4. Reprojection du MNT fusionné dans le bon système de coordonnées 

Afin d’obtenir un MNT dans le même Système de Coordonnées de Référence (SCR) que celui 

qui a été choisi comme SCR à utiliser dans le cadre de cet exercice (pour rappel, c’est le SCR 

EPSG 32635, confer section 8.3.2 page 148), il faut reprojeter le MNT fusionné car celui-ci se 

trouve par défaut dans le SCR « EPSG:4326 - WGS 84 - Géographique » (pour le vérifier : 

cliquez-droit sur la couche MNT fusionnée > Propriétés > Information > SCR).  

Pour reprojeter le MNT fusionné dans le bon SCR : 

• Menu QGIS: Raster > Projections > Projection (warp) 

• Couche en entrée : le MNT unique fusionné résultat de l’étape précédente  

• SCR cible : choisir le système EPSG 32635 

• Reprojeté : choisir l’option « Enregistrer vers un fichier… » puis le répertoire de sortie 

(votre répertoire de travail) et donner un nom (par exemple : « 

SRTM_FUSION_EPSG32635.tif ») 

 

 



159 
 

8.4.2.1.5. Découpage du MNT sur la zone d’étude 

Afin d’obtenir un MNT qui ne couvre que la zone d’étude et qui sera donc plus léger et plus 

facilement manipulable qu’un MNT qui couvrirait une plus grande zone, il convient de 

découper le MNT sur la zone d’étude (Figure 81). Pour ce faire : 

• Menu QGIS: Raster > Extraction > Découper un raster selon une emprise…  

• Couche source : le MNT reprojeté résultat de l’étape précédente 

• Etendue de découpage (xmin, xmax, ymin, ymax) :  

o > Utiliser l’emprise de la couche… : utilisez le shapefile identifiant la zone 

d’étude « ZONE_ETUDE_KASESE.shp », exprimé lui-aussi dans le SCR EPSG 

32635. Attention, il faut que ce shapefile ait une information « emprise » 

dans ses métadonnées :  

▪ Cette information sur l’emprise est disponible via un clic droit sur 

cette couche dans le panneau Couches > Propriétés… > Information > 

Emprise.  

▪ Si cette information n’est pas présente, possibilité de créer cette 

métadonnée via un clic droit sur cette couche dans le panneau 

Couches > Propriétés… > Source > Mettre à jour l’emprise.  

o Si vous n’avez pas de fichier shapefile identifiant votre zone d’étude : 

▪ Soit créez un fichier shapefile de type polygone dans le SCR d’intérêt 

et éditez ce shapefile en y ajoutant un polygone qui couvre votre zone 

d’étude (méthode non détaillée dans ce manuel mais disponible dans 

le manuel QGIS disponible ici : 

https://orbi.uliege.be/handle/2268/190559) 

▪ Soit spécifiez manuellement les valeurs des coordonnées 

géographiques définissant l’étendue de la zone d’étude comme 

indiqué : xmin, xmax, ymin, ymax où x fait référence à la longitude et y 

à la latitude, coordonnées exprimées dans le SCR et ses unités de la 

couche à découper, c’est-à-dire du MNT reprojeté dans ce cas-ci. Pour 

connaitre ces coordonnées, autrement que via le calcul de l’emprise 

proposé ci-dessus, positionnez le curseur de la souris aux extrémités x 

et y de la zone d’étude : les coordonnées du pointeur de la souris 

s’affichent en bas de l’interface QGIS dans la boite « Coordonnée ». 

Ces coordonnées s’affichent dans le SCR du projet QGIS (modifiable via 

le menu Projet > Propriétés… > SCR, choisir dans ce cas-ci EPSG 32635) 

et dans les unités choisies via le menu QGIS « Projet > Propriétés… > 

Général > Affichage des coordonnées > Afficher les coordonnées 

avec » : choisir dans ce cas-ci « Unités de carte (mètres) ». De cette 

manière vous obtenez les coordonnées du pointeur de la souris dans 

le SCR du projet QGIS, qui est le même que le SCR du MNT reprojeté, 

et dans ses unités (des mètres). 

https://orbi.uliege.be/handle/2268/190559
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• Découpé (étendue) : choisir l’option « Enregistrer vers un fichier… » puis le répertoire 

de sortie (votre répertoire de travail) et donner un nom (par exemple : « 

SRTM_FUSION_EPSG32635_CLIP.tif ») 

 

Figure 81 : 4 « tiles » SRTM (MNT) (avec symbologie « RdYlGn ») et étendue de la zone d’étude 
(rectangle noir) (gauche) et MNT après fusion et découpage sur la zone d’étude (avec symbologie 
« wiki-schwarzwald-cont »*) (droite) 

*Remarque : la symbologie « wiki-schwarzwald-cont » est disponible via un clic-droit sur le 

raster > Propriétés… > Symbologie > Rendu des bandes raster >  

• > Type de rendu > Pseudo-couleur à bande unique 

• > Palette de couleurs > Clic-droit sur la palette de couleur > Créer une nouvelle 

palette de couleurs… > Catalogue : cpt-city > OK > Topography > wiki-schwarzwald-

cont 

8.4.2.1.6. Rééchantillonner le MNT à une taille de pixel plus faible 

Afin d’alléger encore plus le MNT à utiliser, et donc de le rendre encore plus 

facilement/rapidement manipulable, il est possible de le rééchantillonner à une taille de 

pixel plus faible. Dans ce cas-ci le MNT d’origine à une taille de pixel de 30 mètres de côté, ce 

qui n’est pas nécessaire dans le cadre de cet exercice. Nous allons donc rééchantillonner le 

MNT à une taille de pixel de 90 mètres de côté, ce qui devrait diviser par 9 le poids 

numérique du MNT (il y a 9 cellules de 30*30 m dans une cellule de 90*90m). Pour ce faire : 

• Menu QGIS: Raster > Conversion > Convertir… 

• Couche en entrée : le raster découpé résultat de l’étape précédente 

• Paramètres avancés > Paramètres additionnels de ligne de commande : -tr 90 90 

(confer détails ici https://gdal.org/programs/gdal_translate.html) 

• Converti : choisir l’option « Enregistrer vers un fichier… » puis le répertoire de sortie 

(votre répertoire de travail) et donner un nom (par exemple : « 

SRTM_FUSION_EPSG32635_CLIP_90m.tif ») 

https://gdal.org/programs/gdal_translate.html
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8.4.2.2. Raster de proximité aux rivières 

Il peut être intéressant de distinguer, dans une carte d’occupation du sol, les « forêts 

classiques » des « forêts riveraines » poussant à proximité des rivières (méthode avancée 

seulement).  

Pour ce faire, il faut un raster indiquant la proximité aux rivières. C’est le rôle du raster 

• « RIVIERES_TAMPON_60_m_RASTER.tif » 

o Ce raster prend une valeur de 1 dans les zones tampon du fichier  

« RIVIERES_TAMPON_60_m.shp » (à 60m de part et d’autre des rivières 

numérisées, confer section 8.4.1 page 153) et une valeur de « NoData » 

ailleurs. 

o Ce raster a été créé via la fonction « Raster > Conversion > Rastérisation 

(vecteur vers raster)… » avec le paramétrage suivant : 

▪ Couche en entrée : « RIVIERES_TAMPON_60_m.shp » 

▪ Valeur fixe : 1 

▪ Unité du raster résultat : Unités géoréférencée 

▪ Largeur/Résolution horizontale : 30 

▪ Hauteur/Résolution verticale : 30 

▪ Emprise du résultat (xmin, xmax, ymin, ymax) : utiliser l’emprise de la 

couche : sélectionner le shapefile délimitant la zone d’étude 

▪ Rasterisé : choisir l’option « Enregistrer vers un fichier… » puis le 

répertoire de sortie (votre répertoire de travail) et donner un nom 
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8.5. Acquisition des images satellites 

8.5.1. Choix des dates des images satellites, notamment pour une analyse 

diachronique  

8.5.1.1. Comparabilité des images vs variations météorologiques 

saisonnières et interannuelles 

Lors du choix des images satellites à utiliser pour la réalisation d’une analyse diachronique 

interannuelle, c’est-à-dire dont le but est de mettre en évidence les changements 

d’occupation du sol se produisant sur plusieurs années, il est important de prendre en 

considération les éléments suivants qui peuvent avoir un impact très important sur 

l’apparence des classes d’occupation  du sol et sur les classes de végétation en particulier: 

• Variations saisonnières (phénologie de la végétation): 

o Dans la plupart des régions du monde, les saisons auront un impact important 

sur l’état de développement de la végétation (ou phénologie de la 

végétation). Par exemple : les forêts décidues dont les feuilles tombent à un 

certain moment, des zones agricoles dont les surfaces alternent entre un sol 

nu, la croissance d’une culture puis la sénescence de cette culture, etc) 

• Variations météorologiques interannuelles 

o Les conditions météorologiques (précipitations, températures) peuvent varier 

fortement d’une année à l’autre (année pluvieuse vs année de sécheresse) et 

donc impacter temporairement mais fortement les conditions de végétation 

dans une zone donnée.  

Afin d’augmenter la comparabilité des images analysées, il faudra donc veiller à ce que 

celles-ci aient été acquises : 

• à une même période/saison de l’année et  

• pour des conditions météorologiques similaires pour les mois précédent l’acquisition. 

Ces considérations sont bien sûr à nuancer en fonction de vos objectifs (intéressé ou pas par 

la classe végétation,…) et de la zone étudiée (impact saisonnier plus ou moins important : 

régions tempérées ou régions sahéliennes vs régions tropicales). 

8.5.1.2. Saison/période vs classes d’occupation du sol 

Le choix d’une saison/période de l’année doit également être réfléchi en fonction des 

classes d’occupation du sol à identifier. En effet, certaines occupations du sol ne seront pas 
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distinguables à certaines périodes de l’année alors qu’elles le seront parfaitement à d’autres 

périodes. Par exemple : 

• La culture de colza sera  

o facilement identifiable au moment de sa floraison qui présente de très 

nombreuses fleurs jaunes → les parcelles de colza en floraison apparaissent 

en jaune sur les images satellites en composition vraies couleurs, 

o beaucoup moins facilement identifiable avant (aspect similaire à d’autres 

plantes vertes) ou après la floraison.  

• En région sahélienne, les arbres seront beaucoup plus facilement identifiables 

lorsque le couvert herbacé est mort mais que les arbres portent encore des feuilles 

vertes (contraste feuillage de l’arbre/background-sol plus important). 

8.5.1.3. Disponibilité des images vs couverture nuageuse 

Il faudra également prendre en compte la disponibilité d’images de qualité suffisantes 

conditionnée essentiellement par la couverture nuageuse qui peut être très persistante 

dans certaines régions du monde à certaines périodes de l’année, voire toute l’année (non 

disponibilité d’images sans nuage pendant des semaines, mois, voire des années…). 

Certaines caractéristiques géographiques locales, telle la présence d’une montagne en zone 

tropicale, associées à une heure précise de la journée (heure de passage du satellite), 

contribueront à la non disponibilité d’image sans nuage dans certaines zones.  

8.5.2. Recherche, choix et téléchargement des images satellites dans le 

cadre de cet exercice 

8.5.2.1. Analyse à faire avant le téléchargement des images satellites 

L’objectif de l’étude est de réaliser une analyse diachronique sur l’évolution à long terme 

de la région de Kasese. Il convenait dès lors d’identifier une image suffisamment ancienne et 

une image récente.  

Imaginons que nous voulons réaliser l’étude en comparant les périodes suivantes : 

• Période « historique » : 1985-1995 

• Période récente : 2015-2019 

Ces périodes sont ici très larges (5-10 ans), ceci afin de faciliter notre recherche d’images 

satellites de qualité (sans ou avec peu de nuages). En fonction des caractéristiques 

météorologiques de votre zone d’étude, vous pourrez adapter la largeur de la fenêtre 

temporelle de recherche.  
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8.5.2.1.1. Recherche et identification des capteurs satellites 

Dans un premier temps il faut trouver une / des images satellites correspondant à la période 

d’intérêt / à chacune des 2 périodes d’intérêt. Pour ce faire il est indiqué de se renseigner 

sur : 

• les capteurs satellites actifs durant ces périodes et leurs caractéristiques techniques, 

• l’accessibilité des images produites : gratuité ?, prix ?, restriction d’utilisation ?.  

Une recherche exhaustive ne sera pas menée ici et notre choix se portera sur 1 / 2 capteurs 

multi-spectraux de haute résolution spatiale parmi les plus connus et disponibles pour la 

période / chacune des 2 périodes. Nous choisirons : 

• Une image Landsat-5 (satellite américain) comme image « historique ». Les images 

Landsat-5 sont disponibles entre 1984 et 2013. (Méthode simple et méthode 

avancée) 

• Une image Sentinel-2 (satellite européen) comme image récente. Les images 

Sentinel-2 sont  disponibles depuis 2015 jusqu’actuellement. (Méthode avancée 

uniquement) 

Un aperçu des périodes couvertes par les différents satellites Landsat 1 à 9 est disponible 

ici : 

• https://www.usgs.gov/media/images/landsat-missions-timeline 

 

https://www.usgs.gov/media/images/landsat-missions-timeline
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Des ressources de références concernant ces images sont : 

o Landsat-5 :  

o https://www.usgs.gov/land-resources/nli/landsat/landsat-5?qt-

science_support_page_related_con=0#qt-science_support_page_related_con 

o Sentinel-2 :  

o https://sentinels.copernicus.eu/web/sentinel/missions/sentinel-2  

D’autres capteurs auraient bien sûr pu être mobilisés. Pour information, des listes de 

capteurs satellites sont disponibles ici : 

• https://webapps.itc.utwente.nl/sensor/default.aspx?view=allsensors 

• https://www.satimagingcorp.com/satellite-sensors/ 

• https://www.indexdatabase.de/db/s.php  

8.5.2.1.2. Analyse des conditions climatiques et météorologiques 

L’analyse des conditions climatiques et météorologiques de la région pourra nous aider à 

faire un choix d’images pertinent, comme déjà expliqué à la section 8.5.1 pages 162 et 

suivantes.  

Le diagramme climatique de la région de Kasese est repris à la Figure 82. Cette figure nous 

apprend que la température est constante tout au long de l’année mais qu’il y a 2 saisons 

de précipitations plus importantes, entre mars et mai et entre août et novembre, ce qui 

peut avoir un impact sur les conditions de végétation. Une analyse diachronique 

interannuelle évitera donc par exemple de se baser sur une comparaison d’une image de 

janvier (saison plus sèche) avec une image d’octobre (fin de saison pluvieuse) car ce type de 

comparaison serait fortement impacté par l’évolution saisonnière des conditions de 

végétations elle-même liée aux conditions de précipitations.  

 

https://www.usgs.gov/land-resources/nli/landsat/landsat-5?qt-science_support_page_related_con=0#qt-science_support_page_related_con
https://www.usgs.gov/land-resources/nli/landsat/landsat-5?qt-science_support_page_related_con=0#qt-science_support_page_related_con
https://sentinels.copernicus.eu/web/sentinel/missions/sentinel-2
https://webapps.itc.utwente.nl/sensor/default.aspx?view=allsensors
https://www.satimagingcorp.com/satellite-sensors/
https://www.indexdatabase.de/db/s.php
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Figure 82 : Diagramme climatique de la ville de Kasese en Ouganda, centre de la zone d’étude. 
Source : https://fr.climate-data.org/ 

Une série temporelle multi-annuelle des précipitations pour la région de Kasese sur la 

période 1981-2019 est présentée à la Figure 83 sous la forme de déviations par rapport à la 

moyenne des précipitations totales annuelles. Ce graphique a été obtenu très facilement à 

partir de l’application « Climate Engine » (https://clim-engine.appspot.com/climateEngine) 

en utilisant les données de précipitations « CHIRPS - Pentad ». Ce graphique permet 

d’identifier les années plutôt sèches, normales ou pluvieuses, ce qui peut constituer une 

première observation intéressante. Notez cependant que, dans ce cas-ci, étant donné la 

double saison de précipitations annuelles dans la zone d’étude, ce graphique, présentant des 

totaux annuels, n’est pas extrêmement pertinent car il ne reflète en rien la possible variation 

de la répartition des précipitations au cours de l’année et en particulier pendant les 

quelques mois précédant l’acquisition des images satellites qui seront utilisées pour réaliser 

l’analyse diachronique. Par exemple, une année pourrait être considérée comme plutôt 

sèche alors que le déficit pluviométrique serait dû uniquement aux mois postérieurs à la 

date d’acquisition de l’image satellite à utiliser. Remarquez que généralement les 

températures conditionnent moins le développement de la végétation que les 

précipitations. Notez enfin qu’il est toujours bon de questionner la qualité et la fiabilité des 

données météorologiques utilisées.  

 

Figure 83 : Déviations par rapport à la moyenne des précipitations totales annuelles dans la région 
de Kasese, obtenues à partir de l’application « Climate Engine » utilisant les données de 
précipitations « CHIRPS - Pentad » sur la période 1981-2019. Source : https://clim-
engine.appspot.com/climateEngine 

https://fr.climate-data.org/
https://clim-engine.appspot.com/climateEngine
https://clim-engine.appspot.com/climateEngine
https://clim-engine.appspot.com/climateEngine
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Un graphique des précipitations mensuelles des mois précédant la date d’acquisition des 2 

images satellites à comparer (Figure 84) est donc plus pertinent pour s’assurer que les 

conditions météorologiques de ces années ne soient pas un facteur de variation trop 

important de l’occupation du sol. Par exemple, dans le cas de la Figure 84-gauche, une 

analyse diachronique basée sur des images satellites acquises aux alentours de la période 

correspondant à la mesure 35 (confer les graphiques) pour les années 1984 et 1996 pourrait 

présenter un biais de l’occupation du sol lié au fait que les semaines précédant cette période 

(cercle noir sur le graphique) présente des précipitations relativement différentes entre 

1984 (plus sec) et 1996 (plus humide), bien que cet exemple-ci ne soit pas un exemple très 

marqué. 

 

Figure 84 : Comparaisons des précipitations dans la région de Kasese pour différents couples 
d’années : à gauche, 2 années relativement contrastées en termes de total de précipitations 
annuels, et à droite, les 2 années considérées pour l’analyse diachronique menée dans le cadre de 
cet exercice-ci. Source : données extraites de « Climate Engine » 
(https://app.climateengine.org/climateEngine) et mises en graphique dans Excel.  

Enfin, l’analyse d’une série temporelle d’un indice de végétation, tel quel le NDVI, le FAPAR, 

etc, peut nous renseigner sur la saisonnalité des conditions de végétation, et donc, de 

manière indirecte, sur les conditions météorologiques, que ce soit de manière générale 

(comportement moyen) ou pour des années particulières que nous voudrions comparer. La 

Figure 85 montre l’évolution de l’indice de végétation fAPAR tel que calculé à partir des 

capteurs SPOT-VEGETATION et PROBA-V pour la région de Kasese entre 1999 et 2020. Cette 

figure a été produite à partir de l’application web présentée à la section « 6.6 Time series 

viewer SPOT-VGT & PROBA-V » page 117. Cette figure nous apprend que la région de Kasese 

est caractérisée par une double saison de végétation annuelle avec la saison d’avril-mai 

présentant généralement un pic de fAPAR très légèrement supérieur à celui de la saison de 

septembre à novembre. Cette évolution trouve son origine dans la variation intra-annuelle 

des conditions de précipitations comme discuté ci-dessus et illustré à la Figure 82. Cette 

application ne permet cependant pas de remonter avant 1999, ce qui ne nous permet pas 

d’évaluer la comparabilité météorologique (indirectement) d’une année dans la période 

1985-1995 avec une année dans la période 2015-2019. Notez enfin les 2 limitations 

suivantes à l’utilisation de ce type d’information: 

https://app.climateengine.org/climateEngine
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• La qualité/fiabilité des données mises à disposition par ce type d’application doit 

être questionnée étant donné que les valeurs de ce type d’indices, produits de cette 

manière, peuvent être très fortement impactées par une couverture nuageuse 

persistante.  

• S’il y a eu un changement important de la nature de l’occupation du sol dans la zone 

étudiée (exemple : déforestation massive, urbanisation, etc), ce changement pourra 

impacter la valeur des indices de végétation et ceux-ci ne seront donc plus le reflet 

des seules variations des conditions météorologiques. 

 

Figure 85 : Aperçu de l’évolution de l’indice de végétation fAPAR (des capteurs SPOT-VEGETATION 
et PROBA-V) pour la région de Kasese entre 1999 et 2020. Source : https://proba-v-
mep.esa.int/applications/time-series-viewer/app/app.html  

L’importance (/la non-importance) de cette analyse des conditions climatiques et 

météorologiques dans la procédure d’identification des images satellites est à mettre en 

relation avec : 

• l’impact potentiel que ces conditions peuvent avoir OU PAS sur les classes 

d’occupation du sol dont vous voulez étudier l’évolution, 

• la disponibilité des images satellite pour les périodes que vous désirez comparer. 

Dans le cas où des images satellites correspondant à des années météorologiquement 

comparables n’ont pas pu être utilisées, l’analyse de ces conditions météorologiques peut 

aussi être utilisée à posteriori afin d’expliquer éventuellement certains changements 

d’occupation du sol observés.  

https://proba-v-mep.esa.int/applications/time-series-viewer/app/app.html
https://proba-v-mep.esa.int/applications/time-series-viewer/app/app.html


169 
 

8.5.2.2. Remarque méthodologique sur la recherche et le téléchargement 

des images satellites : site web vs plugin SCP de QGIS  

 

Attention! Différentes méthodes sont possibles pour rechercher, 
télécharger et prétraiter les images satellites! 

 
Les images Landsat-5 et Sentinel-2 peuvent être recherchées et téléchargées de 2 manières : 

• Soit via les sites web de référence pour ces 2 types d’image,  (confer les 2 sections 
8.5.2.3 et 8.5.2.4 ci-dessous). 

• Soit directement à partir du plugin SCP dans QGIS via connexion aux sites web 
renseignés ci-dessus à travers le plugin SCP (confer section 8.5.4 ci-dessous). 
 

Notez que pour certains prétraitements à faire sur les images avec le plugin SCP (création 
d’un jeu de bandes, sélection des bandes d’intérêt, rééchantillonnage automatique, etc) 

• Si le téléchargement est effectué indépendamment de SCP, via les sites web de 
référence, ces prétraitements devront constituer une étape de traitement à part 
entière, dans QGIS (confer section 8.6 page 198). 

• Si le téléchargement est effectué via SCP dans QGIS, ces prétraitements peuvent se 
faire automatiquement dans la foulée du téléchargement (confer section 8.5.4 ci-
dessous). 

 
Attention ! Dans le cadre de ce manuel, voici la méthode proposée, afin de ne pas perdre 
trop de temps :  

• Recherche des images Landsat-5 et Sentinel-2 d’intérêt: cette recherche se fera via 
les sites web de référence qui sont plus conviviaux que le plugin SCP (confer les 2 
sections 8.5.2.3 et 8.5.2.4 ci-dessous), puis pour 

• Landsat-5 (méthode simple et méthode avancée):  
o Téléchargement de l’image sur le site web de référence (car via le plugin SCP, 

il y a régulièrement des bugs). 
o Les prétraitements de l’image se feront via le plugin SCP dans QGIS. 

• Sentinel-2 (méthode avancée seulement): les images déjà téléchargées et déjà 
prétraitées sont directement mises à disposition des étudiants car ces étapes peuvent 
prendre un certain temps (10-15 minutes par image Sentinel-2). Ces images sont 
disponibles dans le dossier « …\DATA\IMAGES\SENTINEL_2\ » et commencent par le 
préfixe « 30m_clip_RT… ». 

o Les prétraitements préalablement faits sur les images Sentinel-2 sont:  
▪ Téléchargement 
▪ Correction DOS1  dans SCP 
▪ Découpage spatial sur la zone d’étude 
▪ Sélection des bandes 2, 3, 4, 5, 8, 11 (430 Mo pour 6 bandes) 
▪ Rééchantillonnage des bandes à 30 m (108 Mo pour 6 bandes) 

Dans les sections suivantes, des consignes reprises sous le titre « ! Méthode proposée dans le 
cadre de ce manuel » vous indiqueront la marche à suivre.  
 
Cependant, des INDICATIONS EXHAUSTIVES pour réaliser les 2 méthodes de recherche, 
téléchargement et prétraitements des images satellites, via site web de référence OU via le 
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plugin SCP, sont données, à toutes fins utiles, dans les sections suivantes : 

• Recherche et téléchargement des images satellites via les sites web de référence : 
sections 8.5.2.3 et 8.5.2.4 pages 170 et 180 respectivement 

• Téléchargement des images avec prétraitements dans la foulée via le plugin SCP 
dans QGIS : section 8.5.4 page 188 

• Prétraitements des images satellites non couplés au téléchargement via le plugin 
SCP dans QGIS : section 8.6 page 198 

 

 

8.5.2.3. Recherche et téléchargement de l’image Landsat-5 via le site web 

« EarthExplorer » et décompression de l’image 

! Méthode proposée dans le cadre de ce manuel :  

• Faire la recherche et le téléchargement de l’image Landsat-5 sur le site web de 
référence. 

 
Remarque : si vous rencontriez un problème de téléchargement de l’image Landsat-5, 
sachez que celle-ci est mise à disposition en format compressé  dans le dossier de formation 
et sous le nom 
« \5_CLASSIFICATION_SUPERVISEE_ANALYSE_DIACHRONIQUE\DATA\IMAGES\LANDSAT_5\ 
LT05_L2SP_173060_19870807_20201014_02_T1.tar ». Si vous choisissiez d’utiliser cette 
image fournie plutôt que de suivre la procédure proposée dans le cadre de ce manuel, 
rendez-vous à la section 8.6 page 198 pour la suite de la procédure. 

 

8.5.2.3.1. Recherche de l’image Landsat-5 via le site web « Earth Explorer » 

Le site web de référence pour rechercher et télécharger une image Landsat est le suivant : 

• https://earthexplorer.usgs.gov/ (Figure 86) 

https://earthexplorer.usgs.gov/
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Figure 86 : Site web https://earthexplorer.usgs.gov/ utilisé ici pour la recherche des images 
Landsat 

La recherche d’une image satellite sur ce site peut se faire librement, sans création de 

compte. 

Le téléchargement d’une image satellite à partir de ce site, que ce soit directement à partir 

du site web OU via le plugin SCP, nécessite par contre que vous : 

• Vous créiez un  compte via le « EROS Registration System (ERS) » disponible ici : 

https://ers.cr.usgs.gov/, et ensuite, que vous (Figure 87) 

• Vous loguiez sur le site https://earthexplorer.usgs.gov/ à l’aide de vos identifiant et 

mot de passe (Figure 86). 

https://earthexplorer.usgs.gov/
https://ers.cr.usgs.gov/
https://earthexplorer.usgs.gov/
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Figure 87 : Page du site web https://ers.cr.usgs.gov/ permettant de créer un compte personnel 
nécessaire pour pouvoir télécharger les images satellites Landsat 

Les critères à utiliser pour la recherche d’une image satellite Landsat-5 sur le site web « 

Earth Explorer » sont dans ce cas-ci (Figure 88): 

• Onglet « Search Criteria » 

o Période : 01/01/1985 - 31/12/1995 

o Mois : juin-juillet-août 

o Cloud cover : < 30 %. Ceci permettra de n’obtenir que les images présentant 

une couverture nuageuse de moins de 30% et de cette manière ne pas avoir 

trop d’images trop ennuagées, et donc inutilisables, dans les résultats de la 

requête 

o Lieu : le lieu peut être précisé de nombreuses façons, dont la plus simple est 

de dessiner un carré ou un point à l’endroit de la zone d’étude de manière 

interactive sur l’interface spatiale. Dans ce cas-ci cependant, il vous est 

proposé d’utiliser plutôt les coordonnées de référence de la zone dans le 

système de référence de Landsat-5 : confer ci-dessous l’onglet « Additional 

Criteria > WRS Path and Row »   

• Onglet « Data Set »:  

o Landsat Collection 2 Level-2 > Landsat 4-5 TM C2 Level-2 

▪ Remarque : le level-2, en comparaison avec le level-1, présente le gros 

avantage de fournir des images qui ont déjà subi une correction 

atmosphérique et qui correspondent à des réflectances de surface. 

Plus d’informations disponibles ici https://d9-wret.s3.us-west-

2.amazonaws.com/assets/palladium/production/s3fs-

https://ers.cr.usgs.gov/
https://d9-wret.s3.us-west-2.amazonaws.com/assets/palladium/production/s3fs-public/atoms/files/Landsat-C1vsC2-2021-0430-LMWS.pdf
https://d9-wret.s3.us-west-2.amazonaws.com/assets/palladium/production/s3fs-public/atoms/files/Landsat-C1vsC2-2021-0430-LMWS.pdf
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public/atoms/files/Landsat-C1vsC2-2021-0430-LMWS.pdf ou via les 

boutons « info » des collections sur le site web 

 

• Onglet « Additional Criteria »:  

o WRS Path and Row : WRS = « Worldwide Reference System », un système de 

coordonnées de référence pour les images Landsat. pour Landsat-5 le WRS-2 

est à utiliser. Plus d’information sur ce système ici : 

https://www.usgs.gov/faqs/what-worldwide-reference-system-wrs?qt-

news_science_products=0#qt-news_science_products et ici 

https://landsat.gsfc.nasa.gov/the-worldwide-reference-system/ . Pour notre 

zone d’étude, utiliser les valeurs suivantes : 

▪ WRS_Path : 173 

▪ WRS_Row : 60 

 

  

https://d9-wret.s3.us-west-2.amazonaws.com/assets/palladium/production/s3fs-public/atoms/files/Landsat-C1vsC2-2021-0430-LMWS.pdf
https://www.usgs.gov/faqs/what-worldwide-reference-system-wrs?qt-news_science_products=0#qt-news_science_products
https://www.usgs.gov/faqs/what-worldwide-reference-system-wrs?qt-news_science_products=0#qt-news_science_products
https://landsat.gsfc.nasa.gov/the-worldwide-reference-system/
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Figure 88 : Critères de recherches utilisés sur le site https://earthexplorer.usgs.gov/ pour trouver 
l’image Landsat-5 utilisée dans le cadre de cet exercice 

 

Ces critères de recherche résultent en 7 images Landsat-5 dont la plus intéressante est 

l’image du 7 août 1987 qui présente très peu de nuage sur la zone d’étude (Figure 89). Un 

aperçu géolocalisé des images est disponible via le bouton « Show Browse Overlay » 

 

https://earthexplorer.usgs.gov/
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Figure 89 : Résultat de la recherche d’une image Landsat-5 sur la zone d’étude sur le site 
 https://earthexplorer.usgs.gov/  

! Méthode proposée dans le cadre de ce manuel : une fois l’image d’intérêt trouvée, passez 
à la section suivante de ce manuel afin de faire le téléchargement de l’image à partir du site 
web.  

 

8.5.2.3.2. Téléchargement de l’image Landsat-5 via le site web « Earth Explorer » 

! Méthode proposée dans le cadre de ce manuel : suivre les indications de cette section 
pour faire le téléchargement de l’image à partir du site web. 

 

Le téléchargement d’une image satellite ne sera possible que si vous vous loguez sur le site 

https://earthexplorer.usgs.gov/ après vous être créé un compte via le « EROS Registration 

System (ERS) » disponible ici  https://ers.cr.usgs.gov/, comme déjà indiqué plus haut en 

début de section 8.5.2.3.1 page 170.  

Une fois l’image d’intérêt trouvée, le téléchargement direct s’effectue via le bouton 

« Download Options »  disponible auprès de l’aperçu de chacune des images résultant 

de la recherche.  

Dans la fenêtre « Download Options » qui apparait (Figure 90), choisissez « Product 

Options » puis le premier bouton gris qui correspond au « Product Bundle » (paquet) qui permet de 

https://earthexplorer.usgs.gov/
https://earthexplorer.usgs.gov/
https://ers.cr.usgs.gov/
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télécharger tous les fichiers dans un dossier compressé (cela évite de télécharger des fichiers 

individuels/séparés comme ce que permettent les autres options de téléchargement).  

 

 

Figure 90 : Options de téléchargement d’une image Landsat-5 sur le site web 
https://earthexplorer.usgs.gov/.   

Le téléchargement peut prendre quelques minutes. 

8.5.2.3.3. Décompression de l’image Landsat-5 téléchargée via le site web « Earth 

Explorer » 

 

https://earthexplorer.usgs.gov/
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Les images sont téléchargées sous la forme d’un dossier compressé 

« LT05_L2SP_173060_19870807_20201014_02_T1.tar » qu’il faudra donc décompresser 

avant de pouvoir les utiliser dans QGIS. 

Si vous n’avez pas de logiciel de décompression, il vous est conseillé d’utiliser le logiciel 

gratuit « 7-Zip » disponible ici : https://www.7-zip.org/. 

Après décompression, les fichiers contenus dans ce dossier sont présentés à la figue ci-

dessous, et en particulier : 

• Les bandes spectrales B1 à B7 (la B6 est la bande infrarouge thermique). 

• La bande « Quality Band » « QA_PIXEL » renseignant sur la qualité de chaque pixel 

(confer section 8.6.11.2 page 222). 

• Le fichier de métadonnées « …MTL.txt ». 

• Un aperçu de l’image « ….jpeg ». 

 

Figure 91 : Contenu du dossier « .tar » d’une image Landsat-5 après décompression. Parmi ces 
fichiers, notamment, les bandes spectrales B1 à B7, la « Quality Band » « QA_PIXEL », les 
métadonnées « …MTL.txt » et un aperçu de l’image « ….jpeg » 

https://www.7-zip.org/
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Afin de libérer de la place sur votre disque dur, vous pouvez supprimer : 

• Les fichiers qui ne seront pas utilisés dans le cadre de cet exercice, à savoir les 10 

fichiers dont le nom contient « _ST_ » dans l’image ci-dessus. Le dossier restant fait 

+/- 400 MB. (Ces fichiers ont déjà été supprimés dans le dossier de formation 

téléchargeable sur ORBI). 

• Le dossier compressé original après obtention des images décompressées (ou le 

garder en backup).  

Evitez les répertoires trop longs en renommant/réorganisant éventuellement les dossiers 

après décompression. 

Remarque : 

• Si vous ne voyez pas les extensions des fichiers dans votre explorateur Windows, 

vous pouvez les faire apparaitre en modifiant les propriétés d’affichage des fichiers 

dans l’explorateur Windows via les « Options des dossiers » disponibles via les 

fenêtres d’exploration Windows et en décochant l’option « Cacher les extensions de 

types de fichier connu » (Figure 92).  



179 
 

  

ou 

 

Figure 92 : Fenêtre « Options des dossiers » d’une fenêtre d’exploration Windows permettant de 
faire apparaitre les extensions de fichiers de types connus  en décochant l’option « Cacher les 

extensions de types de fichier connu » (image du dessus) ou en cochant l’option « extension des 
noms de fichiers » (image du dessous) 
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8.5.2.4. Recherche, téléchargement et décompression des images Sentinel-2 

via le site web « SciHub » (NON mis à jour !) 

! Méthode proposée dans le cadre de ce manuel :  

• Ne faire que la recherche des images Sentinel-2 (section 8.5.2.4.1), pas leur 
téléchargement (section 8.5.2.4.2) car les images téléchargées et prétraitées sont 
mises à votre disposition dans le dossier de formation 
« 5_CLASSIFICATION_SUPERVISEE_ANALYSE_DIACHRONIQUE\DATA\IMAGES\SENTIN
EL_2\ » en format « .tif » (confer la section 8.5.2.2 page 169). Cette recherche a pour 
seul but de vous familiariser avec la recherche d’une image satellite sur le site web 
« SciHub ». 

• Si, plutôt que de suivre la procédure proposée dans le cadre de ce manuel, vous 
choisissiez de télécharger et prétraiter ces images par vous-même, rendez-vous à une 
des sections suivantes, selon la procédure que vous choisirez: 

o Section 8.5.2.4.2 page 185 pour un « Téléchargement des images Sentinel-2 
via le site web « Scihub » » 

o Section 8.5.4 page 188 pour un « Téléchargement des images avec 
prétraitements dans la foulée via le plugin SCP dans QGIS » 

o Section 8.6 page 198 pour un « Prétraitements des images satellites non 
couplés au téléchargement via le plugin SCP dans QGIS » 

 

8.5.2.4.1. Recherche des images Sentinel-2 via le site web « Scihub » 

Le site web de référence pour rechercher et télécharger une image Sentinel-2 est le 

suivant (Figure 93) : 

• https://scihub.copernicus.eu/dhus/#/home  

https://scihub.copernicus.eu/dhus/#/home
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Figure 93 : Page d’accueil du site web « Copernicus Open Access Hub » disponible ici 
https://scihub.copernicus.eu/dhus/#/home »  et permettant l’accès aux images Sentinel-2 
notamment. 

La recherche d’une image satellite sur ce site peut se faire librement, sans création de 

compte. 

Le téléchargement d’une image satellite à partir de ce site, que ce soit directement à partir 

du site web OU via le plugin SCP, nécessite par contre que vous : 

• Vous créiez un  compte via le bouton de login  > Sign up, et ensuite que vous 

• Vous loguiez via le bouton de login  > LOGIN à l’aide de vos identifiant et mot de 

passe. 

Les critères à utiliser pour la recherche d’une image satellite Sentinel-2 sur le site web « 

SciHub » sont dans ce cas-ci (Figure 94): 

• Lieu : le lieu d’intérêt doit être identifié en se déplaçant dans l’interface  via la 

roulette de la souris (zoom) et le bouton , et un rectangle peut être dessiné sur 

la zone d’intérêt via le bouton . 
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• La période et le type de produit (satellite) doivent être paramétrés via le panneau 

latéral de gauche affichable via le bouton . Dans ce cas-ci, les critères suivants ont 

été utilisés : 

o Période : entre le 1er juin 2018 et le  31 août 2018 

o Type de produit : Mission : Sentinel-2 

 

Figure 94 : Site web « Copernicus Open Access Hub » paramétré pour rechercher une image 
Sentinel-2 dans la zone d’étude pour la période d’intérêt. Panneau latéral de gauche = critères de 

recherche d’une image (période, produit (satellite, etc), couverture nuageuse, etc) 

Les résultats de la recherche d’images sont présentés comme à la Figure 95. 
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Figure 95 : Résultats de la recherche d’image Sentinel-2 dans le « Copernicus Open Access Hub » 

La liste des images résultantes peut être explorée à la recherche de la meilleure image.  

Des informations détaillées sur une image sont disponibles via le bouton  

(Figure 96). 
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Figure 96 : Aperçu de l’image Sentinel-2 du 07 juillet 2018 

Face à la difficulté de trouver des images satellites présentant une couverture nuageuse 

suffisamment faible que pour permettre une analyse de qualité suffisante, il peut être 

judicieux de procéder à un mosaïquage de 2 ou plusieurs images, chacune partiellement 

ennuagées, et acquises dans un intervalle de temps relativement restreint (à moduler en 

fonction des objectifs de l’étude) (Figure 97), afin de reconstruire une image 

« désennuagée » à partir des zones non-ennuagées de chacune des images. Cette méthode 

de « mosaïquage temporel » est proposée dans la section 8.6.8 page 210.  

Les 2 images Sentinel-2 qui seront utilisées à cette fin dans le cadre de cet exercice (Figure 

97) sont les images du : 

• 12 juin 2018 

• 07 juillet 2018 
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Image Sentinel-2 du 12 juin 2018 Image Sentinel-2 du 7 juillet 2018 

Figure 97 : Aperçu des 2 images Sentinel-2, toutes 2 partiellement ennuagées, utilisées dans le 
cadre de cet exercice 

8.5.2.4.2. Téléchargement des images Sentinel-2 via le site web « Scihub » 

Une fois identifiée, une image peut être téléchargée via le bouton . 

Les images sont téléchargées sous la forme de dossiers compressés « .zip » qu’il convient de 

décompresser avant l’intégration de l’image dans QGIS. Ce dossier contient un nombre 

important de sous-dossiers et fichiers et il ne sera pas détaillé ici.  

 

 

8.5.3. Présentation des caractéristiques techniques des images 

sélectionnées 

Dans le cadre de cet exercice, 3 images satellites sont retenues (Figure 98): 

• 1 image Landsat-5 du 7 août 1987 (méthode simple et méthode avancée) 

• 2 images Sentinel-2 des 12 juin et 07 juillet 2018 (méthode avancée uniquement) 
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Landsat-5, 7 août 1987 Sentinel-2, 12 juin 2018 Sentinel-2, 7 juillet 2018 

Figure 98 : les 3 images satellites retenues dans le cadre de l’analyse proposée dans cet exercice. 
Seule une partie de l’image Landsat-5 est montrée. 

Les caractéristiques techniques les plus importantes des 3 images utilisées sont reprises 

dans les Figure 99, Figure 100 et Figure 101. 

Numéro de la bande Longueur d’onde (µm) Nom de la bande Résolution spatiale (m) 

Band 1 0.45-0.52 Blue 30 

Band 2 0.52-0.60 Green 30 

Band 3 0.63-0.69 Red 30 

Band 4 0.76-0.90 Near Infrared (NIR) 30 

Band 5 1.55-1.75 Shortwave Infrared (SWIR) 1 30 

Band 6 10.40-12.50 Thermal 120 (30)* 

Band 7 2.08-2.35 Shortwave Infrared (SWIR) 2 30 

Figure 99 : Caractéristiques des bandes spectrales des images Landsat-5 Thematic Mapper 
™. (Source : https ://www.usgs.gov/faqs/what-are-band-designations-landsat-satellites ?qt-news_science_products=0#qt-

news_science_products) 
* La bande TM 6 a été acquise avec une résolution spatiale de 120 mètres, mais elle a été 

rééchantillonnée à 30 mètres de résolution spatiale. 

Numéro de la bande Longueur d’onde (µm) Nom de la bande Résolution spatiale (m) 

Band 1  443 Coastal aerosol 60 

Band 2 490 Blue 10 

Band 3 560 Green 10 

Band 4 665 Red 10 
Band 5 705 Vegetation red edge  20 

Band 6 740 Vegetation red edge 20 

Band 7 783 Vegetation red edge 20 

Band 8 842 NIR 10 

Band 8A 865 Narrow NIR 20 

Band 9 940 Water vapour 60 

Band 10 1375 SWIR – Cirrus 60 

Band 11 1610 SWIR 20 

Band 12 2190 SWIR 20 

Figure 100 : Caractéristiques des bandes spectrales des images Sentinel-2 (Source : 

https ://sentinel.esa.int/web/sentinel/user-guides/sentinel-2-msi/resolutions/spatial)  
 

https://www.usgs.gov/faqs/what-are-band-designations-landsat-satellites?qt-news_science_products=0#qt-news_science_products
https://www.usgs.gov/faqs/what-are-band-designations-landsat-satellites?qt-news_science_products=0#qt-news_science_products
https://sentinel.esa.int/web/sentinel/user-guides/sentinel-2-msi/resolutions/spatial
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La Figure 101 ci-dessous reprend les caractéristiques principales de 3 images satellites 

utilisées dans cet exercice. 

 Landsat-5 (1987) Sentinel-2 (2018) 

Nom du fichier téléchargé LT05_L2SP_173060_19870807_2

0201014_02_T1 

S2A_MSIL1C_20180612T080611_N0206_

R078_T35NRA_20180612T102410 

 

S2B_MSIL1C_20180707T080609_N0206_

R078_T35NRA_20180707T120150 

Nom du satellite LANDSAT-5 TM Sentinel-2 

Lieu dans le système WRS 
Landsat (Path, Row) et 
« Tile » de Sentinel-2 

WRS_PATH = 173 
WRS_ROW = 60 

 Tile T35NRA 

Système de coordonnées EPSG 32635 
WGS 84 / UTM zone 35N 

EPSG 32635  
WGS 84 / UTM zone 35N 

Etendue spatiale 
approximative d’une 
image/tile 

170 km north-south by 183 
km east-west 

100 km * 100 km 

Date d’acquisition 7 août 1987 12 juin 2018 
7 juillet 2018 

Résolution spatiale 30 m 10 m – 20 m – 60 m  

Nombre de bandes 
spectrales 

7 12 

Couverture nuageuse Partielle Partielle 

Format original des images 
lors du téléchargement 

.tif .jp2 

Poids numérique du dossier 
compressé/décompressé 
contenant une image 

138 Mo / 460 Mo 782 Mo / 782 Mo 

Site web de référence pour 
le téléchargement 

https://earthexplorer.usgs.g
ov/ 

https://scihub.copernicus.eu/d
hus/#/home 

Page web reprenant les 
caractéristiques techniques 
des images 

https://www.usgs.gov/land-
resources/nli/landsat/landsat-5?qt-
science_support_page_related_con=0#qt-
science_support_page_related_con  

https://sentinel.esa.int/web/sentinel/user-
guides/sentinel-2-msi  

Figure 101 : Caractéristiques principales des 3 images utilisées dans cet exercice 

https://earthexplorer.usgs.gov/
https://earthexplorer.usgs.gov/
https://scihub.copernicus.eu/dhus/#/home
https://scihub.copernicus.eu/dhus/#/home
https://www.usgs.gov/land-resources/nli/landsat/landsat-5?qt-science_support_page_related_con=0#qt-science_support_page_related_con
https://www.usgs.gov/land-resources/nli/landsat/landsat-5?qt-science_support_page_related_con=0#qt-science_support_page_related_con
https://www.usgs.gov/land-resources/nli/landsat/landsat-5?qt-science_support_page_related_con=0#qt-science_support_page_related_con
https://www.usgs.gov/land-resources/nli/landsat/landsat-5?qt-science_support_page_related_con=0#qt-science_support_page_related_con
https://sentinel.esa.int/web/sentinel/user-guides/sentinel-2-msi
https://sentinel.esa.int/web/sentinel/user-guides/sentinel-2-msi
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8.5.4. Téléchargement des images avec prétraitements dans la foulée via 

le plugin SCP dans QGIS (NON mis à jour) 

! Méthode proposée dans le cadre de ce manuel :  

• Landsat-5 : NE PAS utiliser les indications reprises dans cette section pour 
télécharger et prétraiter l’image Landsat-5 via le plugin SCP dans QGIS.  

• Sentinel-2 : à ne pas faire pour les images Sentinel-2 car ces images prétraitées sont 
mises à votre disposition dans le dossier de formation « 
5_CLASSIFICATION_SUPERVISEE_ANALYSE_DIACHRONIQUE\DATA\IMAGES\SENTINE
L_2\ » en format « .tif » (confer la section 8.5.2.2 page 169) (méthode avancée 
uniquement) 

 
 

Ouvrez ou reprenez votre projet QGIS tel que préparé selon les indications de la section 

« 8.3 Préparation du projet QGIS » page 147. 

Le téléchargement et les prétraitements des images identifiées dans la section précédente 

via les sites web de référence (« SciHub » et « EarthExplorer ») peut se faire directement via 

le plugin SCP de QGIS, en particulier via : 

• Menu QGIS: SCP > Télécharger de produits (3 onglets) (Figure 102 à Figure 105) 

 

Figure 102 : Interface de l’outil « Menu SCP > Télécharger de Produits », onglet « Rechercher » 

Ce menu permet de ne télécharger qu’une partie des bandes spectrales des images 

satellites, ce qui est bien pratique afin de ne pas télécharger de bandes inutiles. Dans le 

cadre de cet exercice, seules les bandes spectrales suivantes seront téléchargées : 

• Landsat-5 : 1, 2, 3, 4, 5 et 7 (pas la bande 6) 
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• Sentinel-2 : 2, 3, 4, 5, 8, 11 (pas les bandes 1, 6, 7, 8A, 9, 10, 12) 

Cette sélection de bandes se justifie ici par le fait que : 

• La bande 6 de Landsat (bande thermique acquise à 120 m) et les bandes 1 (Coastal 

aerosol), 9 (Water vapour) et 10 (SWIR – Cirrus) de Sentinel-2 (à 60 m) ne sont pas 

d’une grande utilité pour la classification des classes d’occupation du sol.  

• Les bandes 6, 7, 8A, 12 de Sentinel-2 couvrent une gamme de longueur d’ondes 

similaire aux autres bandes retenues. 

• Cela permet de réduire la taille du jeu de données  

• Cela permet d’accélérer les temps de traitements sur ces données 

• Pour Landsat-5, cette sélection de bandes correspond à un paramètre de 

visualisation prédéfini dans SCP (SCP > Jeu de bandes > Paramètres rapides > Landsat 

4-5 TM) comme vous pourrez vous en rendre compte un peu plus loin.  

Ce menu permet aussi d’appliquer dans la foulée du téléchargement certains prétraitements 

(confer ci-dessous). 

La procédure à suivre pour le téléchargement et le prétraitement des images via SCP dans 

QGIS est reprise ci-dessous. Elle est à exécuter une fois pour l’image Landsat-5 et une fois 

pour les 2 images Sentinel-2. Attention, il faut être connecté à internet !  

8.5.4.1. Connexion aux sites web sources des images satellites via le plugin 

SCP dans QGIS 

• Menu SCP > Télécharger de Produits > Identifiants (Figure 103) 

o A paramétrer comme indiqué dans la Figure 103 en utilisant vos identifiants 

et mots de passe personnels. La procédure d’obtention de identifiants et 

mots de passe a déjà été expliquée aux sections 8.5.2.3.1 page 170 et 

8.5.2.4.1 page 180. Un bref rappel est donné ci-dessous.  

o Identifiant pour télécharger l’image Landsat-5 

▪ Se créer un compte ici https://ers.cr.usgs.gov/  

▪ Correspond à l’« EROS Registration System (ERS) » utilisé notamment 

pour accéder au site web https://earthexplorer.usgs.gov/ 

o Identifiant pour télécharger les images Sentinels-2 

▪ Se créer un compte ici https://scihub.copernicus.eu/dhus/#/self-

registration  

▪ Le « Service » à indiquer dans l’interface est 

https://scihub.copernicus.eu/apihub  

https://ers.cr.usgs.gov/
https://earthexplorer.usgs.gov/
https://scihub.copernicus.eu/dhus/#/self-registration
https://scihub.copernicus.eu/dhus/#/self-registration
https://scihub.copernicus.eu/apihub


190 
 

 

Figure 103 : Onglet « Identifiant » du « Menu SCP > Télécharger de Produits > Identifiants » 

8.5.4.2. Recherche d’images via le plugin SCP dans QGIS 

• Menu SCP > Télécharger de Produits > Rechercher (Figure 104) 

o A paramétrer comme indiqué dans la Figure 104. 

o Choisissez le bon type de « Produits » (capteur d’intérêt) 

o Indiquez une gamme de dates correspondant à la fenêtre temporelle 

d’intérêt, et si vous connaissez déjà la date précise de l’image à télécharger, 

mentionnez 2 fois cette même date (dans les 2 menus « depuis/jusqu’à ») afin 

de ne faire apparaitre dans les résultats de la recherche que l’image d’intérêt. 

o Le bouton  permet d’ajouter les coordonnées de la zone 

d’intérêt interactivement: 

▪ Cliquez sur ce bouton 

▪ Cliquez ensuite dans l’interface de QGIS avec  

• un clic gauche sur le coin supérieur gauche de la zone d’intérêt 

et avec  

• un clic droit sur le coin inférieur droit de la zone d’intérêt 

▪ pour créer un rectangle rouge identifiant la zone de recherche 

d’images. Les coordonnées géographiques correspondantes 

apparaissent dans la fenêtre « Rechercher ». 

o Cliquez sur le bouton de « Chercher »  qui, après un certain temps de 

recherche, fera apparaitre dans la fenêtre « Liste de produits », les images 

correspondant aux critères de recherche (Figure 104).  

o ATTENTION !! AVANT de procéder au téléchargement, il est très important de 

ne laisser dans cette fenêtre « Liste de produits » QUE la ou les images que 

vous voulez effectivement télécharger car TOUTES les images présentes dans 

cette liste seront téléchargées. Si votre requête de recherche d’images a 

résulté en une liste de plusieurs images et que vous laissez ces images dans la 

liste, elles seront toutes téléchargées, ce qui risque de prendre un temps plus 
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ou moins important et de résulter en un bug de QGIS ou en une saturation de 

votre disque dur, en fonction du nombre d’images concernées. Pour 

supprimer de la liste les images que vous ne souhaitez pas télécharger, 

sélectionnez-les dans la liste, puis cliquez sur le bouton . 

o Spécificités aux images Sentinel-2 

▪ Le filtre « T35NRA » permet de ne rechercher que les images Sentinel-

2 correspondant à cette « tile » 

▪ Faites la recherche pour les 2 images Sentinel-2 (2 dates) l’une après 

l’autre pour avoir en définitive les 2 images d’intérêt dans la liste des 

produits  

▪ ATTENTION ! EN DATE DU 31 mars 2020, il n’est plus possible de 

rechercher de cette manière des images Sentinel-2 remontant à avant 

décembre 2018 (archives de plus de 1 an et 4 mois) (confer 

https://scihub.copernicus.eu/userguide/LongTermArchive). Vous 

pouvez cependant essayer. Peut-être que la situation a changé entre-

temps. Sinon préférez la solution proposée dans la section 8.5.2.4 

page 180 avec téléchargement directement depuis le site web de 

référence. Vous pourrez alors faire les prétraitements comme indiqué 

dans la section 8.6 page 198. Une autre option est d’utiliser des 

images Sentinel-2 plus récentes.  

 

https://scihub.copernicus.eu/userguide/LongTermArchive
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Figure 104 : Menu « Rechercher » du plugin SCP dans QGIS paramétré pour la recherche des 
images Landsat-5 (haut) et Sentinel-2 (bas, avec l’ancienne interface de SCP) utiles à cet exercice 
avec affichage des images résultant des recherches 

8.5.4.3. Options de téléchargement des images via le plugin SCP dans QGIS 

• Menu SCP > Télécharger de Produits > Options de téléchargement 

o Cochez uniquement les bandes d’intérêt pour cet exercice comme expliqué 

ci-dessus (section 8.5.4 page 188) et indiqué dans la Figure 105, sans oublier 

les données auxiliaires (qui contiennent notamment la précieuse information 

sur la couverture nuageuse). 

 

Figure 105 : Options de téléchargement du plugin SCP 

• Menu SCP > Télécharger de Produits > Ligne « Télécharger » en bas de l’interface 

(Figure 104) 

o Décochez toujours « Seulement si les aperçus sont chargés en couche » car 

cette option semble empêcher tout téléchargement,  

o Cochez « Prétraitement des images » pour appliquer les prétraitements qui 

seront sélectionnés dans la section suivante 
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o Cochez « Charger les bandes dans QGIS » pour charger automatiquement les 

bandes dans QGIS après téléchargement et prétraitements 

• ! NE PAS ENCORE LANCER LE TELECHARGEMENT ! Il faut d’abord paramétrer les 

prétraitements comme indiqué dans la section suivante. 
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8.5.4.4. Prétraitement  des images dans la foulée du téléchargement via le 

plugin SCP dans QGIS 

• Menu SCP > Prétraitement  

o Ce menu permet de paramétrer les prétraitements à appliquer 

automatiquement aux images téléchargées si la case « Prétraitement des 

images » est cochée dans l’interface de téléchargement 

o Paramétrez comme indiqué à la Figure 106 

▪ Choisir le bon onglet en fonction du type de produit sur lequel 

appliquer les prétraitements 

▪ « Appliquer la correction atmosphérique DOS1 » : permet une 

transformation des DN (Digital Number) en réflectance.  

▪ « Créer un jeu de bandes… »  permet de créer un « Jeu de bandes » 

qui sera disponible dans le menu SCP > Jeu de bandes (confer section 

8.6.2 page 200 pour plus d’explications sur cette notion de « Jeu de 

bandes ») 

▪ Remarque : pour Sentinel-2, l’application d’un prétraitement 

rééchantillonne les bandes de 20 m à 10 m, ce qui alourdi donc l’image 

prétraitée. 

▪ Pour plus d’information sur ces prétraitements, le lecteur est renvoyé 

à la documentation en ligne https://fromgistors.blogspot.com/p/user-

manual.html  

 

 

Figure 106 : Paramétrisation des prétraitements à appliquer aux images Landsat-5 et Sentinel-2  

https://fromgistors.blogspot.com/p/user-manual.html
https://fromgistors.blogspot.com/p/user-manual.html
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8.5.4.5. Téléchargement des images avec prétraitement dans la foulée via le 

plugin SCP dans QGIS 

• Menu SCP > Télécharger de Produits >  

o Lancez le téléchargement et les prétraitements via le bouton   

o Sélectionnez le répertoire de sortie (un nouveau répertoire sera créé pour 

chaque image).  

▪ Landsat-5 : répertoire « …\DATA\IMAGES\LANDSAT_5\ » 

▪ Sentinel-2 : répertoire « …\DATA\IMAGES\SENTINEL_2\ » 

o Le téléchargement/prétraitement peut prendre plusieurs minutes (voir la 

barre de progression du téléchargement dans l’interface principale de QGIS. 

Par défaut, une petite musique accompagne le début et la fin de l’opération) 

▪ 3 minutes pour l’image Landsat-5 

▪ 10-15 minutes par image Sentinel-2 

Les données téléchargée ET prétraitées devraient se charger automatiquement dans 

l’interface de QGIS à la fin de l’opération (Figure 107).  

• Réorganisez l’ordre des bandes téléchargées dans le panneau « Couches » de QGIS 

afin de faciliter la visualisation des données dans l’interface de visualisation. Il vous 

est conseillé de placer les bandes d’une image donnée dans le « groupe » de couches 

préexistant dans le projet QGIS mis à votre disposition et portant le nom du type 

d’image considérée, soit « LANDSAT5_19870807 »  ou 

« SENTINEL2 » . Remarque : un « groupe de couches » peut être 

créé via la bouton  disponible dans le panneau « Couches ».  

 

Figure 107 : Interface de visualisation QGIS et panneau « Couches » contenant les 6 bandes 
Landsat-5 prétraitées (préfixe « RT_ ») et réorganisées dans le « groupe » « LANDSAT5_19870807 » 

Les données sont également enregistrées dans le répertoire choisi ci-dessus, sous la forme 

de 2 dossiers par image (exemple à la Figure 108 pour Landsat-5): 
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• Un dossier pour l’image brute et les données auxiliaires 

o Landsat-5 : 120 Mo 

o Sentinel-2 : ~500 Mo 

• Un dossier pour l’image prétraitée (dossier avec suffixe « _con » ou « _converted ») 

o Landsat-5 : 289 Mo 

o Sentinel-2 : 1.24 Go par image (bandes 2, 3, 4, 5, 8, 11, toutes les bandes 

considérées ont été ré échantillonnées à 10m) 

 

Figure 108 : Répertoire « LANDSAT_5 » dans l’explorateur Windows après téléchargement avec 
prétraitement dans la foulée via le plugin SCP dans QGIS, contenant les bandes originales 
décompressées (en haut) et prétraitées (en bas, dossier « converted » avec préfixe « « RT_ ») 

Le nom des fichiers prétraités commencent par le préfixe « RT_ ». 

Enfin, comme demandé, des « Jeu de bandes » ont été créés pour chaque image prétraitée 

(Figure 109). Pour le vérifier : 

• Menu SCP > Jeu de bandes (« Band set 1, Band set 2, etc). 
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Figure 109 : Divers « Jeux de bandes » (« Band set ») visibles dans le plugin SCP > menu « Jeu de 
bandes » après téléchargement et prétraitements des images avec création d’un jeu de bandes, 
pour Landsat-5 (en haut) et Sentinel-2 (avec ici plus de bandes que recommandé dans ce manuel) 
(en bas, avec une ancienne interface du plugin SCP).  

L’utilité et la gestion d’un « Jeu de bandes » sont décrites dans la section 8.6.2 page 200. 
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8.6. Prétraitements des images satellites non couplés au 

téléchargement via le plugin SCP dans QGIS 

Les prétraitements ont pour objet de préparer les images avant la réalisation des 

traitements thématiques (classification supervisée et analyse diachronique dans ce cas-ci).  

8.6.1. Conversion de radiance vers réflectance / correction atmosphérique 

DOS1 et création d’un « Jeu de bandes » (NON mis à jour) 

! Méthode proposée dans le cadre de ce manuel : cette section ne doit pas être réalisée ! 
(confer la section 8.5.2.2 page 169) 

• Ni pour Landsat-5 (car ce prétraitement n’est pas utile car l’image Landsat-5 a déjà 
subi une correction atmosphérique avant son téléchargement depuis le site web de 
référence),  

• Ni pour Sentinel-2 (car cela prend beaucoup de temps et les images prétraitées sont 
mises à disposition dans le dossier « …\DATA\IMAGES\SENTINEL_2\)   

 

Cette section présente la procédure à suivre dans le plugin SCP pour réaliser la conversion 

des valeurs de pixels depuis des valeurs de radiance vers des valeurs de réflectance / 

correction atmosphérique DOS1 et la création d’un « Jeu de bandes » sur les images 

Landsat-5 et Sentinel-2 dans le cas où des images n’ayant pas encore subi de correction 

atmosphérique ont été directement téléchargées via les sites web source présentés dans la 

section 8.5.2 et non via le plugin SCP. 

Voici la procédure à suivre pour appliquer ces prétraitements dans SCP. 

• Menu SCP > Prétraitement > Landsat OU Sentinel-2  

o Configurer l’interface comme illustrée dans la Figure 110 (ancienne interface 

de SCP) 

o Cliquez sur  et sélectionnez le répertoire contenant les bandes Landsat ou 

Sentinel-2 : 

▪ ressemblant à ceci pour Sentinel-2 : 

• \S2B_MS~1\S2B_MS~1.SAF\GRANULE\L1C_T35NRA_A006968_

20180707T082024\IMG_DATA 

▪ → les bandes apparaissent dans le tableau de l’interface 

o Cliquez sur  pour sélectionner le fichier de métadonnées : “…MTL.txt” 

pour Landsat-5 OU “MTD_MSIL1C.xml” pour Sentinel-2 

o Cochez l’option “Appliquer correction atmosphérique DOS1 

https://semiautomaticclassificationmanual.readthedocs.io/en/latest/_images/semiautomaticclassificationplugin_open_dir.png
https://semiautomaticclassificationmanual.readthedocs.io/en/latest/_images/semiautomaticclassificationplugin_open_file.png
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o Cliquer sur  et sélectionnez le répertoire de sortie qui peut être le 

même que celui des images en entrée  

▪ 1 min 30 pour toutes les bandes Landsat5 

▪ 6 min pour toutes les bandes d’une image Sentinel-2 

o Les bandes converties sont automatiquement chargées dans QGIS (nom de 

fichier commençant par « RT_ »). 

o Cette opération ne rééchantillonne pas les bandes et conserve donc les 

résolutions spatiales originales des différentes bandes.  

 

 

Figure 110 : Menu « SCP > Pré-traitement > Sentinel-2 » paramétré pour un prétraitement à 
appliquer sur toutes les bandes spectrales de Sentinel-2 (dans le cadre de cet exercice, il est 
conseillé de ne pas travailler avec toutes les bandes) (cette illustration correspond à l’ancienne 
interface de SCP). 
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8.6.2. Création d’un « Jeu de bandes » et affichage des images dans QGIS 

! Méthode proposée dans le cadre de ce manuel (confer la section 8.5.2.2 page 169) :  

• Landsat-5 : utilisez les indications de cette section pour créer un « Jeu de bandes » à 
partir des bandes de l’image Landsat-5 décompressées. 

• Sentinel-2 : utilisez les indications de cette section pour créer un « Jeu de bandes » 
pour chaque image Sentinel-2 fournies dans le dossier 
« …\DATA\IMAGES\SENTINEL_2 ».   

• Visualisation des images d’un « Jeu de bandes »: une fois les « Jeux de bandes » 
créés, affichez-les dans QGIS en suivant les indications ci-dessous. Par soucis de 
rapidité, inutile de  

o « Créer un raster virtuel de band » 
o « Créer un raster assemblant les bandes »  

Et optez plutôt pour la méthode de création d’un  
o « Virtual band set » 

 

Cette étape ne constitue pas à proprement parler un « prétraitement » mais est présentée 

ici pour respecter la logique chronologique du chemin méthodologique proposé. 

Une fois les images décompressées et éventuellement transformées en réflectance (si 

nécessaire) (sections 8.5.2 et 8.6.1) elles peuvent être affichées dans QGIS. 

Le plugin SCP permet la création/utilisation de « Jeux de bandes » pour faciliter  

• la visualisation des images multi-bandes et  

• l’application d’un même (pré-)traitement sur l’ensemble des bandes en une seule 

opération. 

Cette section explique comment créer un « Jeu de bandes » et comment l’utiliser pour la 

visualisation des images dans QGIS. 

8.6.2.1. Création d’un « Jeu de bandes » 

• Ajouter les images au projet QGIS, via la manière traditionnelle d’ajouter des 

données raster dans QGIS  > Raster. 

• Menu : SCP > Jeu de bandes ou bouton   

o Utilisez le bouton  « Ajouter des bandes chargées dans QGIS » pour 

sélectionner (cocher) les bandes spectrales à partir desquelles créer un jeu de 

bandes.  

▪ Landsat-5 : bandes 1, 2, 3, 4, 5, 7 

▪ Sentinel-2 : bandes 2, 3, 4, 5, 8, 11 (pour ne pas travailler sur toutes les 

bandes et par là alléger les traitements) 

https://semiautomaticclassificationmanual.readthedocs.io/en/latest/_images/semiautomaticclassificationplugin_bandset_tool.png
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o Via le menu « Paramètres rapides » ou « Band quick settings », si votre « Jeu 

de bandes » correspond à l’un des paramétrages prédéfinis (par exemple si 

votre jeu de bandes pour une image Landsat-5 reprend les bandes 1, 2, 3, 4, 

5, 7 (pas la bande 6)), choisissez le paramétrage prédéfini correspondant (par 

exemple  ) pour l’appliquer à votre 

« Jeu de bandes », ce qui aura pour effet de classer les bandes dans le bon 

ordre et d’y ajouter une série d’informations, dont les longueurs d’ondes 

correspondantes (cette information sur les longueurs d’ondes est réutilisée 

lors de la création des graphiques de signature spectrale : confer section 

8.8.7.1 page 261). Remarque, pour les images Sentinel-2, le paramétrage 

rapide correspond aux bandes 2, 3, 4, 5, 6, 7, 8, 8A, 11, 12. Sinon vous pouvez 

entrer ces informations manuellement via un double-clic sur la case à éditer.  

▪ ATTENTION ! Cet outil n’ordonne pas toujours parfaitement les 

bandes! Vérifiez toujours le résultat et corrigez l’ordre des bandes le 

cas échéant avec les flèches ou le bouton  qui sera utile dans 

certains cas mais pas dans tous 

o Il est possible de créer plusieurs jeux de bandes via le bouton de création de 

nouveaux jeux de bandes  

Un exemple de jeu de bandes pour l’image Landsat-5 est présenté ci-dessous. 
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Cette même interface (menu SCP > Jeu de bandes) permet également de créer un raster 

virtuel et/ou un raster assemblant les bandes comme détaillé ci-dessous. Ces opérations ne 

sont cependant pas nécessaires et ne seront pas commentées dans le cadre de ce manuel. 

• Cochez « Créer un raster virtuel de band » : crée un raster virtuel permettant de 

réaliser des compositions colorées de l’image sans créer un vrai raster qui prendrait 

de la place sur votre disque dur (cela crée un petit fichier se terminant par 

« Bvirt_rast.vrt » qui vient aussi s’ajouter dans l’interface QGIS) 

• Cochez « Créer un raster assemblant les bandes » (layerstack): crée un vrai raster 

multi-bandes permettant de réaliser des compositions colorées de l’image MAIS qui 

prendra de la place sur votre disque dur (cela crée un fichier image unique multi-

bandes se terminant par « Bstack_raster.tif » qui vient aussi s’ajouter dans 

l’interface de QGIS) 

• Lancez l’opération via le bouton  

• Sélectionnez le répertoire de sortie  

8.6.2.2. Affichage d’une composition colorée des images satellites 

Pour visualiser une composition colorée des images satellite dans QGIS, plusieurs possibilités 

existent : 

Si vous avez créé un « jeu de bandes » comme indiqué à la section précédente ou qu’un 

« jeu de bandes » est disponible dans le plugin SCP, vous pourrez l’utiliser pour créer un 

« Jeu de bandes virtuel » ou « Virtual band set » via le plugin SCP. Ce « Virtual band set » 

permettra d’alterner facilement/rapidement des compositions colorées d’un même raster et 

de réaliser des améliorations de contraste. Pour ce faire : 
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• Menu SCP > Jeu de bandes : 

o Activer le « Jeu de bandes » d’intérêt pour lequel créer un « Virtual band 

set » via le bouton « Band set definition » . 

Si vous avez un seul jeu de bande, vous n’aurez aucun choix. Vous pouvez 

aussi renommer (sans accent, etc) votre jeu de bandes si vous voulez 

(facultatif).  

• Dans l’interface principale de QGIS > panneau Couches : cliquez à l’endroit où vous 

désirez que votre virtual band set vienne s’ajouter. 

• Dans l’interface principale de QGIS > Barre d’outils SCP > boutons 

 (ou via le menu SCP > Outils basic > Liste RGB) > inscrire 

manuellement (ou sélectionner) la/les compositions colorées souhaitées (ex : 3-2-1 

ou 5-3-2) dans le menu déroulant (confer image ci-dessous). 

▪ ATTENTION ! Les numéros font référence à l’ordre des bandes dans la table 

du « Jeu de bandes » actif (numéros dans la marge gauche de cette table) ET 

PAS AUX NUMEROS OFFICIELS DES BANDES SPECTRALES ! En conséquence, si 

vous voulez visualiser une composition « vraies couleurs » ou « couleurs 

naturelles » (confer section 8.7.4.1 page 236), vous devrez indiquer dans le 

menu déroulant présenté ci-avant les numéros de lignes du jeu de bandes qui 

correspondent aux bandes spectrales des longueurs d’onde Rouge, Verte et 

Bleue, dans cet ordre.  

▪ Après un petit délai, le « Virtual band set X » vient s’ajouter dans le panneau 

« Couches » de QGIS (« X » fait référence au numéro du « Jeu de bandes » 

dans le menu « Jeu de bandes »).  

▪ Attention, si vous avez plusieurs « Virtual band set X » la modification de la 

composition colorée via le menu déroulant ne s’applique QUE sur le jeu de 

bandes actif/sélectionné dans le menu « Jeu de bandes » ! 

▪  permettront d’appliquer des améliorations de contrastes qui seront 

calculées sur la partie de l’image actuellement visible dans l’interface de 

visualisation spatiale de QGIS (vous pouvez zoomer ou dézoomer sur l’image 

avant d’appliquer l’amélioration de contraste pour voir l’impact sur cette 

opération). 
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Figure 111 : Affichage d’une composition fausses couleurs de l’image Landsat-5 dans QGIS via la 
réalisation d’un « virtual band set » via un jeu de bandes créé dans le plugin SCP de QGIS.  

Si vous travaillez sur un des 2 type de fichiers « Bvirt_rast.vrt » ou « Bstack_raster.tif » 

(confer section précédente, ce type de fichier n’est pas nécessaire et ne sera pas commenté 

dans le cadre de ce manuel) notez les options de symbologie suivantes : 

• Modification de la symbologie raster (choix des bandes, amélioration de contraste, 

etc) via un  

o clic-droit sur la couche > Propriétés… > Symbologie à adapter…  

• Amélioration de contraste très utile qui adapte la symbologie automatiquement en 

fonction de la zone du raster visualisée dans le menu :  

o Rendu des bandes raster > Paramètres de valeurs Min/Max > Statistiques de 

l’emprise > Emprise actualisée  

• Application d’exactement la même symbologie à 2 images différentes et donc les 

rendre comparable visuellement, il suffit de : 

o Appliquer une symbologie donnée à une image  

o Cliquer-droit sur cette image dans le panneau Couches de QGIS > Styles > 

Copier le style  

o Cliquer-droit sur l’image à laquelle appliquer le style dans le panneau Couches 

de QGIS > Styles > Coller le style  
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8.6.3. Découpage spatial de l’image sur la zone d’intérêt (en anglais : « 

Spatial subset », « clip », « crop ») 

! Méthode proposée dans le cadre de ce manuel : (confer la section 8.5.2.2 page 169) :  

• Landsat-5: effectuez un découpage spatial sur l’image Landsat-5 à l’aide de cette 
section 

• Sentinel-2 : à ne pas faire car les images mises à disposition dans le dossier 
« …\DATA\IMAGES\SENTINEL_2\... » sont déjà découpées spatialement (car sinon 
elles sont trop volumineuses)   

 

Les images satellites téléchargées couvrent parfois une zone plus grande que la zone 

d’intérêt. Dans ce cas, il convient, afin de réduire la taille des données manipulées et par là 

d’accélérer la vitesse des traitements et de réduire la place que prendront les données 

générées sur votre disque dur, de découper spatialement l’image pour ne conserver que la 

zone d’intérêt. 

Cette opération se déroule en 2 temps dans SCP : 

• Définition d’un jeu de bandes à découper (si le jeu de bandes existe déjà, pas 

besoin de le recréer): 

o Confer section 8.6.2.1 ci-dessus  

• Découpage spatial d’un « Jeu de bandes » créé préalablement (Figure 112): 

o Menu : SCP > Prétraitement > Découper des bandes rasters 

▪ Sélectionnez le numéro du « Jeu de bandes » à découper (le numéro 

du jeu est disponible via le menu « Jeu de bandes ») 

▪ Préfixe de sortie : « clip_ » : le préfixe qui sera utilisé pour le nom des 

bandes découpées. 

▪ Pour définir la zone à découper: 

• Utilisez, dans le cadre de cet exercice, le shapefile 

« ZONE_ETUDE_KASESE.shp ». Attention le shapefile doit être 

dans le même système de coordonnées que les bandes raster à 

découper ! 

• Une autre possibilité serait de délimiter la zone de manière 

interactive en cliquant sur  puis, en cliquant, dans la 

fenêtre de visualisation spatiale de QGIS, avec un clic-gauche 

sur le coin supérieur gauche de la zone à délimiter, et avec un 

clic-droit sur le coin inférieur droit de la zone à délimiter. Ou 

entrer les coordonnées manuellement.  

o Cliquez sur  et sélectionnez le répertoire de sortie qui peut être le 

même que celui des images en entrée  

https://semiautomaticclassificationmanual.readthedocs.io/en/latest/_images/semiautomaticclassificationplugin_pointer_tool.png
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▪ ~ 10 secondes pour 6 bandes Landsat-5 (37 Mo) 

▪ ~ 2min30 pour 6 bandes 2-3-4-5-8-11 Sentinel-2 en résolution 

originale (10 et 20 m) (430 Mo) 

▪ (~ 4min30 pour 10 bandes Sentinel-2 à 10 m (650 Mo)) 

o Les bandes converties sont automatiquement  

▪ enregistrées dans le répertoire de sortie 

▪ chargées dans QGIS (nom de fichier commençant par le préfixe 

« clip_ »). 

• Attention ! Veillez à organiser correctement vos données dans 

le panneau « Couches » de QGIS, éventuellement à l’aide du 

bouton  « Ajouter un groupe »  

• Visualisation du « Jeu de bandes » découpé spatialement 

o Confer les indications de la section 8.6.2 page 200. 

 

Figure 112 : Menu de SCP permettant de réaliser un découpage spatial sur un « Jeu de bandes » 
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8.6.4. Regroupement/assemblage des bandes spectrales individuelles 

d’une image dans un fichier image  unique multi-bandes (anglais : 

layer stacking) 

Ce prétraitement ne sera pas utilisé dans le cadre de cet exercice. Il est mentionné à titre 

d’information.   

Lorsque les différentes bandes spectrales d’une image satellite sont disponibles séparément, 

sous la forme de fichiers indépendants il peut être pratique, avant de faire d’autres 

traitements, de combiner les différentes bandes spectrales en une seule image unique multi-

bandes qui sera de la sorte plus facilement manipulable car l’ensemble des traitements 

pourront s’appliquer simultanément sur l’ensemble des bandes spectrales regroupées. 

Cette combinaison de bandes spectrales peut se faire via une opération 

d’assemblage/regroupement/collage des bandes (anglais : « Layer stacking »). 

Outils dans QGIS: 

• Fonction SCP : SCP > Pré-traitement > Assembler les bandes raster 

• Fonction QGIS : Raster > Divers > Fusionner… > et cocher « Placer chaque fichier en 

entrée dans une bande séparée » ; 

Le layerstack a pour conséquence de rééchantillonner toutes les bandes concernées à la 

même résolution spatiale. 

Si l’outil le permet, classez les bandes spectrales dans le bon ordre avant l’assemblage et 

choisissez la résolution spatiale de l’image résultante. Il est conseillé, dans le cas des images 

LANDSAT, d’utiliser 30 m de résolution spatiale, même si vous considérez dans l’assemblage 

une bande de meilleure résolution spatiale (exemple : la bande 8 des images LANDSAT8 qui 

est à 15m). Attribuer une plus haute résolution spatiale ne fera qu’alourdir fortement votre 

image et sera probablement inutile. Vous pouvez aussi exclure la bande à 15 m. 

8.6.5. Pan-sharpening 

Ce prétraitement ne sera pas utilisé dans le cadre de cet exercice. Il est mentionné à titre 

d’information.   

La technique de pan-sharpening est une méthode qui permet de fusionner une bande 

spectrale de plus haute résolution spatiale (par exemple, la bande panchromatique des 

images LANDSAT à 15m) avec une ou plusieurs bandes spectrales de moins haute résolution 

spatiale (par exemple, les autres bandes des images LANDSAT à 30m) afin d’obtenir une 

image qui présente à la fois la meilleure résolution spatiale (15m) et les qualités spectrales 

des bandes à 30m. L’image résultante facilite la photo-interprétation de l’image. 
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Menu QGIS : Traitement > Boite à outils > GDAL > Divers raster > Pansharpening  

8.6.6. Rééchantillonnage des images vers une plus faible résolution 

spatiale (anglais : resampling) 

! Méthode proposée dans le cadre de ce manuel : (confer la section 8.5.2.2 page 169) :  

• Landsat-5: à ne pas faire. Un rééchantillonnage de l’image Landsat-5 n’est pas 
nécessaire dans le cadre de cet exercice car les pixels ont une résolution spatiale de 
30 mètres et l’image n’est pas trop lourde.  

• Sentinel-2 : à ne pas faire car les images mises à disposition dans le dossier 
« …\DATA\IMAGES\SENTINEL_2\... » ont déjà été rééchantillonnées à 30 mètres (car 
sinon elles sont trop volumineuses). Elles ont été rééchantillonnées avec la méthode 
décrite dans cette section.  

 

Le rééchantillonnage consiste notamment au changement de la taille des pixels d’un raster 

pour par exemple en diminuer la résolution spatiale ou pour harmoniser la taille des pixels 

des différentes bandes spectrales constituant un raster unique multi-bandes. 

Dans le cadre de cet exercice, il s’est avéré que les images Sentinel-2 à 10m de résolution 

spatiale sont assez lourdes à traiter et que certains traitements, en particulier la 

classification, prennent beaucoup trop de temps à cette résolution spatiale. 

Il a donc été décidé de rééchantillonner les images Sentinel-2 à 30 m de résolution spatiale 

(pour obtenir une taille de pixel similaire à celle de l’image Landsat-5). 

La fonction de rééchantillonnage n’est pas directement disponible dans SCP. L’on pourra 

donc utiliser une fonction de rééchantillonnage du menu principale de QGIS.  

Pour rééchantillonner toutes les bandes d’une image Sentinel-2 à 30 m dans QGIS (Figure 

113): 

• Menu QGIS: Raster > Conversion > Convertir… 

• Cliquer sur le bouton « Exécuter comme processus de lot… » en bas de l’interface de 

la fonction afin de pouvoir appliquer en une seule fois le traitement sur toutes les 

bandes spectrales de l’image Sentinel-2 considérée 

• Cliquer sur  « Basculer en mode avancé »  

• Couche en entrée > … Sélectionner des fichiers > Sélectionnez toutes les bandes 

spectrales sur lesquelles appliquer le rééchantillonnage 

o Bandes 2, 3, 4, 5, 8, 11 (2-3-4-8 à 10 m et 5-11 à 20 m) des images Sentinel-2 

découpées spatialement 

• Paramètres avancés > Paramètres additionnels de ligne de commande : indiquer «  -

tr 30 30 » (confer détails ici https://gdal.org/programs/gdal_translate.html), puis « Auto-

remplissage…  > Remplir » pour remplir toutes les lignes avec cette même information 

https://gdal.org/programs/gdal_translate.html
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• Converti > … > Choisir le répertoire et donner un préfixe de nom, par exemple « 30m_ » > 

Remplir avec les valeurs du paramètre > Couche en entrée : ceci aura pour effet de nommer 

les bandes rééchantillonnées avec le préfixe « 30 m_ » suivi du nom de la bande en entrée. 

• Vérification de la paramétrisation 

• Décochez « Charger les couches » 

• Exécutez (quelques secondes pour les 6 bandes Sentinel-2, 106 Mo) 

• Ajoutez manuellement les bandes produites dans votre projet QGIS 

 

Figure 113 : Rééchantillonnage de 6 bandes d’une image Sentinel-2 à 30 mètres (-tr 30 30) via le 
traitement par lot de la fonction « Convertir… » de QGIS 

8.6.7. Mosaïquage de 2 images voisines 

Ce prétraitement ne sera pas utilisé dans le cadre de cet exercice. Il est mentionné à titre 

d’information.   

Lorsque la zone d’étude est couverte par plusieurs images voisines, il peut être intéressant 

de les fusionner/mosaïquer afin d’obtenir une seule grande image couvrant toute la zone et 

plus facilement manipulable.  

• Fonction QGIS : Raster > Divers > Fusionner… > 
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8.6.8. Mosaïquage de 2 images Sentinel-2 superposées pour 

réduire/supprimer la couverture nuageuse 

! Méthode proposée dans le cadre de ce manuel : (confer la section 8.5.2.2 page 169) :  

• Landsat-5: cette image n’est pas concernée par cette section 

• Sentinel-2 : suivez les indications de cette section pour mosaïquer les 2 images 
Sentinel-2    

 

8.6.8.1. Concept de reconstruction d’image dés-ennuagée  

Face à la difficulté de trouver des images satellites présentant une couverture nuageuse 

suffisamment faible que pour permettre une analyse de qualité suffisante, il peut être 

judicieux de procéder à un mosaïquage de 2 ou plusieurs images, chacune partiellement 

ennuagée sur des zones différentes, et acquises dans un intervalle de temps relativement 

restreint (à moduler en fonction des objectifs de l’étude), afin de reconstruire une image à 

partir des zones non-ennuagées de chacune des images.  

Dans le cas de cet exercice, les 2 images Sentinel-2 les moins ennuagées identifiées pour 

l’étude présentent tout de même une couverture nuageuse relativement importante et 

gênante pour l’analyse diachronique. Il convient dès lors de les mosaïquer afin de produire 

une image présentant une couverture nuageuse réduite.  

Le mosaïquage permet de remplacer les parties d’une image sur lesquelles un masque (de 

nuages par exemple) a été appliqué, par les pixels d’une autre image (idéalement, sans 

nuage aux endroits masqués) pour former une image avec une couverture nuageuse 

amoindrie (Figure 114).  
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Figure 114 : Principe de mosaïquage d’une image masquée (image A) avec une autre image (image 
B) 

Dans ce cas-ci l’image du  

• 20180612 sera l’image de base  

• 20180707 sera utilisée pour remplacer les pixels masqués de l’image 20180612 
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Sentinel-2 20180612 Sentinel-2 20180707 
Figure 115 : Composition vraies couleurs des 2 images Sentinel-2 (au-dessus) avec affichage de la 
couche vectorielle de masque de nuages « MSK_CLOUDS_B00.gml » fournie avec les images avec 
les nuages denses (opaques) en bleu et les cirrus (voile léger) en vert (en-dessous). 

Il est clairement visible que ce désennuagement ne sera pas total (partie nord-ouest de 

l’image). Il peut alors être utile d’utiliser des masques de nuages améliorés (confer plus loin)! 

Ce type de mosaïquage à fin de désennuagement est aussi documenté dans le « Basic 

tutorial 2 » officiel de SCP, disponible ici : 

▪ https://fromgistors.blogspot.com/p/user-manual.html?spref=scp 

8.6.8.2. Les grandes étapes du mosaïquage 

• Téléchargement des images (déjà fait plus haut) 

• Création d’un masque de nuages pour une image 

• Application du masque de nuages sur l’image (ce qui remplace les valeurs de pixels 

ennuagés par « Nodata ») 

• Mosaïquage de l’image masquée par la deuxième image 

8.6.8.3. Création d’un masque de nuage 

! Méthode proposée dans le cadre de ce manuel : (confer la section 8.5.2.2 page 169) :  

• Landsat-5: pas concernée par cette section 

• Sentinel-2 : comme le fichier vectoriel de masque fourni avec l’image Sentinel-2 du 
12 juin 2018 est très mauvais, utilisez le fichier de masque amélioré produit pour 
vous et disponible dans le répertoire 
« …\DATA\IMAGES\SENTINEL_2\SENTINEL_2_MASQUE_NUAGES_20180612.tif ». 
Les explications concernant la méthode de création de ce masque amélioré sont 
données ci-dessous pour information. 

 

La création d’un masque de nuages peut se faire de différentes manières : 

• Via l’utilisation d’une couche d’information renseignant sur la présence de nuage et 

accompagnant l’image satellite (méthode la plus simple, à privilégier si l’information 

est disponible et de bonne qualité) 

• Via l’identification des nuages par classification supervisée : il peut être envisagé de 

réaliser une « pré-classification supervisée » rapide dont le seul objectif serait 

l’identification des zones ennuagées à masquer. La réflectance des nuages se 

distinguant généralement assez facilement de celles des classes d’occupation du sol, 

cette classification pourra probablement être rapide et précise.  

• Réaliser un masque de nuage manuellement par édition d’une couche vectorielle de 

polygone par exemple. Ceci peut constituer une solution pratique si les zones 

ennuagées sont facilement numérisables (peu de nuages). Par contre cette solution 

https://fromgistors.blogspot.com/p/user-manual.html?spref=scp
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devra très vite fastidieuse avec l’augmentation du nombre et la complexité de la 

forme des nuages à masquer 

• Une combinaison de ces techniques 

8.6.8.3.1. Création d’un masque de nuages à partir d’un fichier vectoriel de masque 

existant 

Les images Sentinel-2 sont toujours accompagnées d’une bande d’information appelée 

« MSK_CLOUDS_B00.gml » qui est un fichier vectoriel identifiant très grossièrement les 

endroits ennuagés sur l’image (Figure 115). Ce fichier est décrit ici 

https://earth.esa.int/web/sentinel/technical-guides/sentinel-2-msi/level-1c/cloud-masks. 

Nous pouvons y lire que le fichier vectoriel peut prendre 2 valeurs : dense (opaque) ou cirrus 

(léger voile) (Figure 115 et Figure 116), valeurs reprises dans la table d’attributs de la couche 

vectorielle. 

 

Figure 116 : Aperçu de la table d’attributs du fichier vectoriel de masque de nuage d’une image 
Sentinel-2 avec présence des 2 types de nuages : CIRRUS et OPAQUE 

Remarquez à la Figure 115 que pour l’image Sentinel-2 20180707 ce masque est 

particulièrement imprécis ! Cela constituerait une faiblesse/limitation de l’approche si ce 

masque était utilisé. Dans une situation réelle, il est indiqué d’identifier la couverture 

nuageuse de manière plus précise. Dans le cadre de cet exercice le masque de nuages 

réellement utilisé sera celui créé selon la méthode de la section 8.6.8.3.2 page 215. La suite 

de cette section-ci est donnée pour info.  

Pour créer un masque de nuages pour l’image 20180612 à partir de la couche vectorielle de 

masque fournie avec l’image: 

• Chargez dans QGIS comme fichier vectoriel le fichier « MSK_CLOUDS_B00.gml » 

disponible dans le dossier de téléchargement de l’image Sentinel-2 (si 

téléchargement depuis le site web de référence). Ce fichier est disponible dans le 

sous-dossier (par exemple) 

« S2A_MS~1\S2A_MS~1.SAF\GRANULE\L1C_T35NRA_A015519_20180612T082541\

QI_DATA\ ». Ce fichier identifie une partie seulement de la couverture nuageuse de 

https://earth.esa.int/web/sentinel/technical-guides/sentinel-2-msi/level-1c/cloud-masks
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l’image. Remarquez que sur la zone d’étude, il n’y a que des nuages 

« opaques/denses » et pas de « cirrus ». 

• L’exporter au format shapefile : clic-droit sur le fichier « MSK_CLOUDS_B00 

MaskFeature » dans le panneau Couches de QGIS > Exporter > Sauvegarder les 

entités sous… > Choisir le format shapefile, le répertoire de sortie et le nommer par 

exemple « MASQUE_NUAGE_20180612.shp » et l’ajouter dans le projet QGIS. 

• Menu SCP > Pré-traitement > Vecteur vers raster >  

o (attention éviter répertoire long/ avec espace) 

o Sélectionner un vecteur: cliquez sur  pour rafraichir la liste de couches 

disponibles et sélectionnez le masque créé à l’étape précédente « 

MASQUE_NUAGE_20180612.shp » 

o Cochez « Utilisez une valeur constante » et indiquez « 1 » pour que le raster 

de masque produit prenne une valeur de 1 pour les nuages 

o Sélectionnez le raster de référence : cliquez sur , puis sélectionnez une 

bande de l’image Sentinel-2 découpée spatialement correspondant au 

masque utilisé, par exemple 

« clip_RT_L1C_T35NRA_A015519_20180612T082541_B02.tif » pour créer un 

raster de la même taille et aligné sur le raster Sentinel-2. 

o Lancez via , sélectionnez un répertoire et nommez le raster de masque, 

par exemple « MASQUE_NUAGE_20180612.tif » (~10 secondes) 

Le raster de masque de nuages est produit et prend une valeur de « 1 » pour les nuages et 

« NoData » pour les autres zones (consultable via l’outil  de QGIS). 

 

https://semiautomaticclassificationmanual.readthedocs.io/en/latest/_images/semiautomaticclassificationplugin_run.png
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8.6.8.3.2. Création d’un masque de nuages par classification des nuages dans l’image à 

masquer 

Méthode par classification supervisée 

Un masque de nuage peut être réalisé par classification des nuages présents sur l’image à 

masquer.  

Cette étape de classification est décrite à la section 8.8.8 page 263 vu qu’il s’agit 

essentiellement d’un processus de classification puis raffinement de la classification.  

Dans le cadre du TP, vous utiliserez simplement la couche de masque résultant de cette 

étape qui a déjà été faite pour vous et qui est disponible dans le répertoire 

« …\DATA\IMAGES\SENTINEL_2\SENTINEL_2_MASQUE_NUAGES_20180612.tif ». 

Méthode par seuillage 

Une méthode de seuil aurait également pu être utilisée. Elle consiste à simplement 

reclassifier les pixels d’une bande en-dessous/au-dessus d’une valeur seuil vers une 

constante. Dans ce cas-ci, on pourrait par exemple reclassifier la bande bleu, celle qui 

présente le plus de contraste entre sol et nuages, en identifiant la meilleure valeur seuil 

permettant de faire cette distinction entre sol et nuage. Ceci peut se faire facilement via la 

calculatrice raster : 

• Explications disponibles ici 

https://docs.qgis.org/3.4/en/docs/user_manual/working_with_raster/raster_analysi

s.html#raster-calculator 

• Exemple de formule : ( "B02@1" <= 0.18 ) * "B02@1" 

o où 0.18 est la valeur seuil.  

o Si B2 <= 0.18 (ce qui correspond au sol), alors B2 conserve ses valeurs de pixel 

o Si B2 > 0.18 (ce qui correspond aux nuages), alors B2 prend une valeur de 0 

• Mais lors de tests, QGIS crash lorsque l’on travaille sur une taille de raster originale 

(30 m de résolution spatiale) avec x ligne et x colonnes. Cela fonctionne avec un 

nombre de cellules de raster en sortie de 500*500 (pas avec 1000*1000).  

https://docs.qgis.org/3.4/en/docs/user_manual/working_with_raster/raster_analysis.html#raster-calculator
https://docs.qgis.org/3.4/en/docs/user_manual/working_with_raster/raster_analysis.html#raster-calculator
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8.6.8.4. Appliquer le masque de nuages sur une image 

! Méthode proposée dans le cadre de ce manuel : (confer la section 8.5.2.2 page 169):  

• Landsat-5: pas concernée par cette section 

• Sentinel-2 : image 20180612 seulement 
 

Pour appliquer un masque de nuages, existant sous la forme d’un raster uni-bande dont 

la/les valeurs de pixels correspondant aux zones à masquer sont clairement définies, sur 

toutes les bandes de l’image 20180612 présentes dans le Jeu de bandes de cette image: 

• Menu SCP > Jeu de bandes 
o Assurez-vous d’avoir un « Jeu de bandes » qui correspond à l’image sur 

laquelle appliquer le masque, sinon créez-le. Dans ce cas-ci un « Jeu de 
bandes » comprenant les 6 bandes de l’image Sentinel-2 20180612 
découpées spatialement et rééchantillonnées à 30 m.  

• Menu SCP > Prétraitement > Masque nuage  
o Jeu de bandes : mettre le numéro du Jeu de bandes sur lequel appliquer le 

masque (Jeu de l’image 20180612 découpée spatialement)  

o Sélectionner la classification : cliquez sur , puis sélectionnez le raster de 
masque créé à la section précédente « MASQUE_NUAGE_20180612.tif » 

o Valeurs de classe du masque : « 1 » 
o Utiliser un buffer en taille de pixel : décochez pour accélérer le traitement  

o Cliquez sur  et choisissez le répertoire (~1 minute)  

• Visualisez le résultat dans QGIS : les endroits masqués prennent une valeur de 
« NoData » (transparent dans QGIS)  

 

Figure 117 : Application d’un masque de nuages sur une image dans SCP. Remarque : le nom du 
fichier correspondant à ce masque et fourni dans le dossier de cet exercice est en fait 
« SENTINEL_2_MASQUE_NUAGES_20180612.tif » (différent de ce qui est indiqué dans cette 
figure). (Ancienne interface de SCP) 
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8.6.8.5. Mosaïquer l’image masquée et la deuxième image 

Pour remplacer les pixels « NoData » de l’image 20180612 masquée par les pixels de l’image 

20180707 : 

• Menu SCP > Jeu de bandes > Ajouter un nouveau Jeu de bandes via le bouton    > 

Y ajouter les bandes masquées « masque_clip_RT_... 20180612…» 

• Menu SCP > Jeu de bandes > Assurez-vous d’avoir un Jeu de bandes qui correspond à 

l’image qui sera utilisée pour remplacer les pixels masqués de l’image 20180612, soit 

un jeu de bandes pour l’image 20180707 découpée spatialement, sinon créez-le 

• Menu SCP > Prétraitement > Mosaïque de Jeu de bandes 

o Entrez le numéro du Jeu de bandes contenant les bandes masquées 

20180612, suivi d’une virgule, suivi par le numéro du Jeu de bandes 

contenant les bandes  de remplacement (20180707) 

o Préfixe « mosaique » (possibilité d’utiliser plusieurs rasters).  

o Cliquez sur  et sélectionner le répertoire de sortie (~1 minute) 

 

Figure 118 : Fonction de mosaïquage de l’outil SCP (ancienne interface de SCP) 

Les bandes sont ajoutées automatiquement au projet QGIS.  

Visualisez une composition colorée du résultat : 

o Créez un nouveau « Jeu de bandes » correspondant à l’image mosaïquée  

o Créez un « Virtual band set » 

Et comparez l’image mosaïquée avec les images initiales (Figure 119). 

https://semiautomaticclassificationmanual.readthedocs.io/en/latest/_images/semiautomaticclassificationplugin_add_bandset_tool.png
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 A 

 
Image Sentinel-2 20180612 

 B 

Image Sentinel-2 20180707 

 

 C 

 
Image Sentinel-2 20180612 après 
application du masque de nuages vectoriel 
fourni avec l’image et remplacement des 
pixels de ce masque par les pixels de l’image 
Sentinel-2 20180707 via la technique du 
mosaïquage  
 
 

 D 

Image Sentinel-2 20180612 après 
application du masque de nuages amélioré 
(masque obtenu par classification des 
nuages et raffinement) et remplacement des 
pixels de ce masque par les pixels de l’image 
Sentinel-2 20180707 via la technique du 
mosaïquage  

Figure 119 : Comparaison des 2 images Sentinel-2 initiales avec les images résultant du 
mosaïquage. Les images mosaïquées présentent une couverture nuageuse amoindrie.  

L’image résultant du mosaïquage reste partiellement ennuagée, et ceci pour 2 raisons : 

o Certaines parties de l’image sont ennuagées dans les 2 images initiales  
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o Le masque de nuage créé à partir du masque vectoriel fourni avec l’image 20180612 

ne masque pas tous les nuages, ce qui a pour conséquence qu’une partie d’entre eux 

se retrouvent dans l’image résultant du mosaïquage (C). 

o Ceci constitue une grosse limitation de la méthode car ces pixels ne seront pas 

masqués et produiront un biais dans la matrice de transition ! 

8.6.9. Création de néocanaux (indices de végétation, ACP, etc) 

Cette opération ne sera pas utilisée dans le cadre de cet exercice. Elle est mentionnée à titre 

d’information.   

En fonction des objectifs de la classification et de la difficulté de classifier correctement les 

classes d’occupation du sol d’intérêt sur base des bandes spectrales simples d’une image 

satellite, il peut s’avérer utile de calculer des néocanaux. 

Un néocanal est une nouvelle couche d’information (une nouvelle bande raster) calculée à 

partir des bandes spectrales disponibles dans une image et qui permet, idéalement, de faire 

ressortir certaines informations non directement ou moins facilement accessibles à partir 

des bandes spectrales de base. 

Ces néocanaux peuvent être par exemple : 

• Des indices de végétations (par exemple, le NDVI, calculables avec la calculatrice 

raster de QGIS) 

• Les indices de « Tasseled Cap » 

• Les premières composantes d’une Analyse en Composante Principale (ACP) 

• …  

8.6.9.1. Calcul de divers indices 

Cette opération ne sera pas utilisée dans le cadre de cet exercice. Elle est mentionnée à titre 

d’information.   

Menu SCP > Calcul de bandes 

Menu QGIS Raster > Raster Calculator  

8.6.9.2. Analyse en Composantes Principales (ACP) 

Cette opération ne sera pas utilisée dans le cadre de cet exercice. Elle est mentionnée à titre 

d’information.   

Menu SCP > Traitement de bande > ACP 



220 
 

8.6.10. Géoréférencement  

Cette opération ne sera pas utilisée dans le cadre de cet exercice, car pas nécessaire. Elle est 

mentionnée à titre d’information.   

Le géoréférencement est l’opération qui permet de positionner correctement une image 

dans l’espace et de lui attribuer un système de coordonnées géographiques. 

Lors d’une analyse diachronique consistant en la comparaison, pixel par pixel, des 

changements d’occupation du sol s’étant produit entre 2 images acquises à 2 dates 

différentes, il est évidemment très important que les images à comparer soient parfaitement 

géoréférencées l’une par rapport à l’autre, c’est-à-dire que les pixels de l’image initiale 

superposant les pixels de l’image finale correspondent à une même zone, pixel par pixel.  

Il est nécessaire de vérifier si le géoréférencement relatif des 2 images est suffisant ou pas. 

Ceci peut simplement se faire via analyse visuelle dans QGIS via : 

• Zoom in important (observation à grande échelle) afin de contrôler avec précision le 

position relative des images 

• Cocher/décocher les images pour alterner leur visibilité 

• L’extension « Map Swipe Tool » 

Il se peut que le géoréférencement initial des images téléchargées soit suffisant que pour 

réaliser correctement une analyse diachronique.  

Si le géoréférencement relatif des images n’est pas suffisant, il faudra procéder au 

géoréférencement des images.  Différentes techniques existent, principalement : 

• Géoréférencement avec points de calage (en anglais : Ground Control Point (GCP)) 

• Géoréférencement « image-to-image » : géoréférencement d’une image 

relativement à une autre. 

La plupart du temps la précision de localisation spatiale des images LANDSAT ou Sentinel-2 

est suffisante par défaut et ne requière pas de géoréférencement. Mais mieux vaut toujours 

vérifier ! 

8.6.10.1. Géoréférencement par point de calage ou GCP 

Cette technique ne sera pas expliquée dans ce manuel mais le lecteur intéressé pourra se 

référer aux: 

• Manuel de travaux pratiques sous QGIS disponible ici 

https://orbi.uliege.be/handle/2268/190559 

• Tutoriel QGIS en ligne disponible ici : 

https://orbi.uliege.be/handle/2268/190559
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o https://docs.qgis.org/3.4/fr/docs/training_manual/forestry/map_georeferenc

ing.html?highlight=g%C3%A9or%C3%A9f%C3%A9rencement 

8.6.10.2. Géoréférencement de type « image à image » 

Non documenté dans ce manuel.  

 

 

8.6.11. Masque de nuages multi-dates, applicable à chacune des 2 images 

de l’analyse diachronique, Landsat-5 et Sentinel-2 mosaïquée 

! Méthode proposée dans le cadre de ce manuel : (confer la section 8.5.2.2 page 169) :  

• Landsat-5: réalisation d’un masque de nuage à partir de la bande BQA 

• Sentinel-2 : réalisation d’un masque par produit des masques améliorés individuels  

• Landsat-5 et Sentinel-2 : fusion/addition des masques relatif à chaque image et 
application du masque fusionné/somme sur Landsat-5 et Sentinel-2 mosaïquée  

8.6.11.1. Principe de création d’un masque de nuages multi-dates 

Il est parfois intéressant/nécessaire de masquer une partie des images à analyser qui 

autrement gêneraient l’analyse, typiquement lorsque : 

• des nuages, et parfois leurs ombres projetées au sol, sont présents sur l’image 

• une partie de l’image ne doit pas être analysée (par exemple : à l’extérieur des 

limites d’un parc naturel pour lequel une analyse spécifique au parc est souhaitée) 

Lors d’une analyse diachronique de l’évolution de l’occupation du sol, afin que les 2 images 

classifiées restent comparables, un même masque devra être appliqué sur les 2 images. Ce 

masque correspondra donc à la somme des masques créés pour chacune des deux images. 

Les étapes à suivre seront donc : 

• Création du masque relatif à chacune des 2 images 

• Fusion des 2 masques par addition des masques 

• Application du masque fusionné (ou « masque somme ») à chacune des images  

https://docs.qgis.org/3.4/fr/docs/training_manual/forestry/map_georeferencing.html?highlight=g%C3%A9or%C3%A9f%C3%A9rencement
https://docs.qgis.org/3.4/fr/docs/training_manual/forestry/map_georeferencing.html?highlight=g%C3%A9or%C3%A9f%C3%A9rencement
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Figure 120 : Principe de la création d’un masque de nuages multi-dates 

 

8.6.11.2. Création d’un masque de nuages pour l’image Landsat-5 

L’image Landsat-5 est accompagnée d’une bande raster « BQA » (Band QUALITY) 

renseignant sur la qualité de chaque pixel. Plus d’information sont disponibles ici par 

exemple : 
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• https://www.usgs.gov/land-resources/nli/landsat/landsat-collection-1-level-1-

quality-assessment-band?qt-science_support_page_related_con=0#qt-

science_support_page_related_con 

“The Collection 1 Level-1 QA band can be stretched to emphasize the light and dark pixels 

for an immediate survey of a scene's general quality conditions.” 

• Visualisez le raster avec une symbologie « Palette/valeurs uniques » et un dégradé de 

couleurs 

Section “Landsat 4-5 TM, Landsat 7 ETM+ Level-1 Possible Attributes, Pixel Values, and Pixel 

Value Interpretations”, 2ème table: 

 

On peut notamment résumer très grossièrement une partie de l’information contenue dans 

cette table comme ceci:  

• [704-764] = cloud 

• [928-972] = cloud shadow 

• [1696-1740] = snow 

 Symbologie raster “Pseudo-couleur 

à bande unique” 

 

Figure 121 : Visualisation dans QGIS de la bande BQA de l’image Landsat-5 renseignant sur la 
couverture nuageuse 

https://www.usgs.gov/land-resources/nli/landsat/landsat-collection-1-level-1-quality-assessment-band?qt-science_support_page_related_con=0#qt-science_support_page_related_con
https://www.usgs.gov/land-resources/nli/landsat/landsat-collection-1-level-1-quality-assessment-band?qt-science_support_page_related_con=0#qt-science_support_page_related_con
https://www.usgs.gov/land-resources/nli/landsat/landsat-collection-1-level-1-quality-assessment-band?qt-science_support_page_related_con=0#qt-science_support_page_related_con
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Une analyse attentive devrait être opérée afin de déterminer les pixels à conserver / à ne 

pas conserver.  

Dans ce cas-ci nous allons considérer que les pixels de la bande BQA ayant une valeur entre 

[704 - 972] sont impactés par les nuages et sont donc à masquer.  

Pour créer le masque de nuage correspondant, il suffit de reclassifier les valeurs du raster 

avec: 

• Utilisez la fonction « r.reclass » qui dépend de GRASS et disponible dans Traitement > 

Boite à outils ». Attention ! Il faut activer l’extension « GRASS GIS provider » pour que 

cette fonction soit disponible. 

o Documentation ici https://grass.osgeo.org/grass70/manuals/r.reclass.html  

• Paramétrage comme à la Figure 122. 

• Règles de reclassification à indiquer : 

o 704 thru 972 = 1 

o *= 2 

• Nommez le masque raster reclassifié « MASQUE_NUAGE_LANDSAT5_BQA.tif » par 

exemple 

Le masque prend une valeur de 1 pour les nuages et 2 ailleurs. 

 

Figure 122 : Fonction r.reclass de GRASS dans QGIS pour créer le masque de nuages de l’image 
Landsat-5 à partir de son fichier BQA 

Pour obtenir un masque sur la zone d’étude uniquement, le découper spatialement : 

• Raster > Extraction > Découper un raster selon une emprise… 

ZONE_ETUDE_KASESE.shp 

• Raster en sortie : « MASQUE_NUAGE_LANDSAT5_BQA_CLIP.tif » 

https://grass.osgeo.org/grass70/manuals/r.reclass.html
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8.6.11.3. Création d’un masque de nuages pour l’image Sentinel-2 mosaïquée 

Le masque de nuage à considérer pour l’image Sentinel-2 mosaïquée correspond à 

l’intersection des masques de nuages améliorés des 2 images mosaïquées (20180612 et 

20180707) eux-mêmes créés selon la méthode présentée à la section 8.8.8 page 263.  

 

Figure 123 : Principe de construction d’un masque de nuages commun à 2 masques de nuages (noir 
= NoData, blanc = valeur de 1) 

 

 

Pour obtenir ce masque de nuages correspondant à l’image mosaïquée : 
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• Ouvrir dans QGIS les 2 rasters correspondant aux masques de nuages améliorés des 2 

images Sentinel-2, dont les valeurs de pixels sont de 1 pour les nuages et 2 ailleurs. 

Ces 2 masques ont déjà été produits pour vous et sont disponibles dans le répertoire 

« …\ DATA\IMAGES\SENTINEL_2\ » sous les noms de : 

o SENTINEL_2_MASQUE_NUAGES_20180612.tif (repris sous le nom 

« MASQUE_NUAGE_20180612.tif » dans l’illustration ci-dessous) 

o SENTINEL_2_MASQUE_NUAGES_20180707.tif (repris sous le nom 

« MASQUE_NUAGE_20180707.tif dans l’illustration ci-dessous) 

• Utiliser la calculatrice raster de QGIS pour faire le produit des 2 masques : 

o Raster > Raster Calculator… >  

• Appelez le raster résultant « MASQUE_NUAGE_2018_0612_0707_PRODUIT.tif » par 

exemple 

• Les 4 valeurs possibles sont : 

o 1 * 1 = 1 → Nuage * Nuage = Nuage commun aux 2 images 

o 1 * 2 = 2 → Nuage * Autre = Autre 

o 2 * 1 = 2 → Autre * Nuage = Autre 

o 2 * 2 = 4 → Autre * Autre = Autre 

Le raster résultant prendra donc une valeur de 1 dans ce cas-ci pour les nuages commun aux 

2 images Sentinel-2, et 2 ou 4 dans les autres situations. 

 

Figure 124 : Produit des 2 masques de nuages améliorés des 2 images Sentinel-2, dans la 
calculatrice raster de QGIS, pour produire le masque de nuages commun aux 2 images Sentinel-2 
(remarque : le nom des masques dans cette illustration ne correspond pas aux noms des masques 
mis à disposition dans le dossier de cet exercice comme indiqué plus haut) 
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• Pour faciliter la suite des opérations, ce raster peut être reclassifié selon les règles 

reprises dans la figure ci-dessous afin de garder une valeur de 1 pour les nuages 

communs aux 2 images et une valeur de 2 ailleurs 

o Traitement > Boite à outils > r.reclass (dépend de GRASS) 

o Raster en sortie = 

« MASQUE_NUAGE_2018_0612_0707_PRODUIT_reclass.tif » 

 

Figure 125 : Utilisation de la fonction GRASS « r.reclass » pour reclassifier le raster de masque de 
nuages commun aux 2 images Sentinel-2 

8.6.11.4. Création du « masque fusionné » ou « masque somme » de nuages 

applicable aux images Landsat-5 et Sentinel-2 

• Réaliser une somme des 2 masques (valeurs : 1 = nuage ; 2 = autre) produits aux 

sections précédente via la calculatrice raster de QGIS (Raster > Raster Calculator…) 

o « MASQUE_NUAGE_2018_0612_0707_PRODUIT_reclass.tif » 

o « MASQUE_NUAGE_LANDSAT5_BQA_CLIP.tif » 

• Le raster résultant prend les valeurs suivantes : 

o 2 : nuages communs aux 2 images 

o 3 : nuages sur une seule des 2 images 

o 4 : absence de nuage sur les 2 images  

• Nom du raster résultant : 

o « MASQUE_NUAGE_SOMME_2_L5_S2.tif » 
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8.6.11.5. Application du « masque fusionné » ou « masque somme » à 

chacune des 2 images 

Le « masque somme » doit ensuite être appliqué sur chacune des 2 images à considérer pour 

l’analyse diachronique, pour les rendre comparables, soit les images : 

• Landsat-5 : clip_RT_LT05_L1TP_173060_19870807_20170211_01_T1_1987-08-07_... 

• Sentinel-2 : mosaique_masque_30m_clip_RT_T35NRA_20180612T080611_... 

• Menu SCP > Jeu de bandes 
o Assurez-vous d’avoir un Jeu de bandes qui correspond à chacune des 2 images 

sur lesquelles appliquer le « masque somme », sinon créez-les 

• Menu SCP > Prétraitement > Masque nuage  
o Jeu de bandes : mettre le numéro du Jeu de bandes sur lequel appliquer le 

masque 
o Sélectionner la classification: sélectionner le « 

MASQUE_NUAGE_SOMME_2_L5_S2.tif » 
o Valeurs de classe du masque: Attention ! Mettre 2,3 (confer section 

précédente) 
o Décochez buffer 
o Préfixe : masque_som 

o Cliquez sur , sélectionnez le répertoire 

Les images masquées avec le masque somme prenne une valeur de NoData aux endroits 
masqués. 

 

Figure 126 : Application du « masque somme » sur un jeu de bandes (ancienne interface de SCP) 
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Landsat-5 avec masque somme 

 
Sentinel-2 mosaïquée avec masque somme 
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8.7. Observation des images et identification des classes 

d’occupation du sol 

8.7.1. De l’importance de l’observation des images 

Il est très important de prendre le temps d’analyser visuellement une image avant de se 

lancer dans le processus de classification en tant que tel et ceci afin de bien comprendre 

l’information que l’image contient et de répondre notamment aux questions suivantes:  

• Quelles sont les différentes classes d’occupation du sol présentes ? 

• Sont-elles visuellement différentes les unes des autres ?  

• Y a-t-il des nuages sur l’image ? 

• Certains pixels correspondent-ils à des codes spécifiques ayant une signification 

particulière (NoData,…) ? 

Les sections suivantes discutent de ces aspects et présentent diverses méthodes facilitant 

l’analyse visuelle de l’image.  

8.7.2. Identification des classes d’occupation du sol 

Lors de l’identification des classes d’occupation du sol, il faut identifier et faire la distinction 

entre (exemple dans les Figure 127 et Figure 128) : 

• Les classes objectifs ou MACRO-CLASSES : ce sont les classes d’intérêt que vous 

désirez analyser et/ou faire apparaitre dans la représentation cartographique finale 

et qui seront donc reprises dans la légende de la carte d’occupation du sol produite. 

Ces macro-classes peuvent englober plusieurs sous-classes spectrales qui 

correspondent à des signatures spectrales différentes. Ce sont ces macro-classes qui 

feront l’objet de la validation par matrice de confusion et qui seront étudiées dans la 

matrice de transition. 

• Les sous-classes ou CLASSES SPECTRALES : ce sont les classes d’occupation du sol qui 

présentent des signatures spectrales  « différentes ». Ce sont les classes spectrales 

qui seront utilisées pour le processus de classification par les algorithmes de 

classification se basant sur la valeur des pixels. Il s’agit donc de définir autant de 

classes spectrales qu’il existe de classes d’occupation du sol présentant des 

signatures spectrales bien différentes. Ces « sous-classes spectrales » pourront être 

fusionnées en « macro-classes » après la classification pour une meilleure 

représentation cartographique (confer ci-dessous la section 8.10 page 270). 
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Figure 127 : Notions de « macro-classe » et « classes spectrale ». Source : 

https://semiautomaticclassificationmanual.readthedocs.io/en/latest/remote_sensing.html#

classes-definition 

 

Macro-classes ou 
Classes objectifs ou 
Classe de la légende 
de la carte finale 

Sous-classes ou classes spectrales composant les macro-classes et 
utilisée par l’algorithme de classification supervisée 

Forêt Forêt de feuillu (ex : vert clair) 
Forêt de résineux (ex : vert foncé) 

Zones agricoles Parcelles agricoles présentant un sol nu (ex : brun) 
Parcelles agricoles présentant une culture x (ex : colza en fleur, jaune) 
Parcelles agricoles présentant une culture y (ex : prairie, vert) 
… 

Zones construites Routes (ex : gris) 
Toits d’ardoise (ex : noir) 
Toits de tuiles (ex : rouge) 

… … 
Figure 128 : Exemple simplifié de relation entre les classes d’occupation du sol représentées sur 
une carte et les classes spectrales correspondantes ayant été utilisées lors du processus de 
classification supervisée 

Lors d’une analyse diachronique, les classes d’occupation du sol rencontrées dans les 

différentes images à comparer (images acquises à différentes dates), peuvent différer en 

partie (voire totalement dans une situation extrême). Par exemple, la 1ère image pourrait 

présenter une zone forestière unique qui aurait été transformée totalement en zone agricole 

et bâtit dans la 2ème image.  

https://semiautomaticclassificationmanual.readthedocs.io/en/latest/remote_sensing.html#classes-definition
https://semiautomaticclassificationmanual.readthedocs.io/en/latest/remote_sensing.html#classes-definition
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Lors de l’identification/sélection des classes spectrales à analyser, veillez à ne pas être trop 

ambitieux et à ne pas surestimer la capacité de classification/distinction précise des 

différentes classes d’occupation du sol par la méthode de classification que vous allez 

utiliser… et donc à ne pas vouloir distinguer l’indistinguable ! Une classification d’image a 

ses limites, qui sont parfois (souvent) bien vite atteintes… Il vous faudra donc trouver le juste 

compromis entre le nombre de classes à identifier et la précision de classification 

atteignable pour chacune de ces classes.  

En outre, si, pour une raison ou l’autre, vous ne pouvez pas attribuer avec certitude une 

classe d’occupation du sol à certains pixels, cela constituera une limitation à la 

méthodologie de classification. Une classification de qualité est parfois impossible et il faut 

l’accepter!  

Un exemple de difficultés de classification qui pourraient être rencontrés est la 

difficulté/impossibilité de discerner différents types de végétation (forêt jeune vs forêt 

adulte, culture de maïs ou de pomme de terre, etc) car ils présenteraient des signatures 

spectrales trop similaires. 

En particulier, lors de cette étape d’identification des classes d’occupation du sol, en plus 

d’identifier les « macro-classes » et les « classes spectrales », veillez à créer des classes 

spectrales pour : 

• Les nuages, si ceux-ci ne sont pas masqués 

• Les pixels sans valeurs « No data » et/ou pixels de « background » qui sont parfois 

caractérisés par une valeur « code » spécifique (exemple : -9999, 255, etc) 

• Les pixels non photo-interprétables : il peut être indiqué dans certains cas de créer 

une/des classes spectrales «inconnu_1 », « inconnu_2 », etc, pour autant qu’elles 

correspondent à une signature spectrale particulière. 

Dans le cas de cet exercice, les figures ci-dessous reprennent les macro-classes et sous-

classes spectrales proposées pour chacune des 2 types d’images (Landsat-5 et Sentinel-2). 

Notez que par soucis de concision, de simplicité et de rapidité ce nombre de classes a été 

volontairement réduit.  

8.7.3. Présentation de la description des classes d’occupation du sol 

Remarquez que lors de la présentation d’une méthodologie de classification supervisée, 

dans un rapport scientifique, un mémoire de fin d’étude, etc, il est bienvenu, voire 

nécessaire, de définir le plus précisément possible chacune des classes d’occupation du sol 

utilisée (macro-classes et sous-classes spectrales), par souci de clarté et transparence 

méthodologique.  
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Cette description des classes utilisée peut se faire via un tableau comme celui repris à la 

Figure 129 (bien que les définitions soient ici assez sommaires). Remarquez cependant que 

les couleurs des différentes classes apparaissant à l’écran peuvent fortement changer en 

fonction de l’amélioration de contraste appliquée. Idéalement, il faudrait donc renseigner les 

paramètres de l’amélioration de contraste utilisée, ce qui ne sera pas fait ici. 

Macro-classe Sous-classe 
spectrale 

Définition de la 
classe en 
composition 
vraies couleurs 

Aspect typique de la 
classe en 
composition vraies 
couleurs Rouge-Vert-
Bleu de l’image 
Landsat-5 

Aspect typique de la 
classe en 
composition fausses 
couleurs Proche 
infrarouge-Rouge-
Vert de l’image 
Landsat-5 

Aspect typique de la 
classe en 
composition vraies 
couleurs d’une 
image très haute 
résolution (Google 
Earth Pro par 
exemple) 

Forêt dense Forêt dense 
Forêt dense, vert 
foncé 

   

Forêt peu 
dense 

Forêt peu 
dense 

Forêt peu dense, 
vert 
intermédiaire 

   

Couvert 
végétal faible 

Couvert 
végétal 
faible 

Couvert végétal 
faible, vert clair 

   

Eau 

Eau bleue Eau bleue 

   

Eau verte Eau verte 

   

Roche Roche 
Roche, présente 
en montagne 

   

Sol nu 

Sol nu beige Sol nu beige 

   

Sol nu brûlé 
mauve clair 

Sol nu brûlé 
mauve clair 

  

/ 
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Sol nu brûlé 
mauve 
foncé 

Sol nu brûlé 
mauve foncé 

   

Ville Ville et bâtit Ville et bâtit 

   

Figure 129 : Exemple de description des « macro-classes » et « classes spectrales » des classes 
d’occupation du sol pouvant être utilisées lors de la classification supervisée de l’image Landsat-5 
utilisée dans le cadre de cet exercice. 

Une autre manière de présenter les classes d’occupation du sol étudiée, peut-être plus 

représentative et informative, est de présenter quelques extraits/morceaux de l’image 

satellite à classifier, en composition vraies couleurs, à grande échelle (zoom in) et annotée 

de numéros renvoyant à une légende identifiant les classes (Figure 130).  
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Figure 130 : Exemple de présentation des macro-classes d’occupation du sol utilisées lors d’une 
classification supervisée d’une partie de l’île de Negros aux philippines. Source : 
https://orbi.uliege.be/handle/2268/33068, page 61. 

https://orbi.uliege.be/handle/2268/33068
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8.7.4. Observation des images en 2D 

Voici ci-dessous une liste non exhaustive de techniques de visualisation d’image permettant 

d’en améliorer l’analyse visuelle. 

8.7.4.1. Visualiser l’image en composition vraies et fausses couleurs 

Les notions de composition « vraies couleurs » et composition « fausses couleurs » ont 

déjà été présentée à la section « 4.8.1 Composition « vraies couleurs » et composition 

« fausses couleurs » » page 48 et suivantes. 

La méthode de création et d’affichage d’une composition vraies ou fausses couleurs via le 

plugin SCP dans QGIS a déjà été présentée à la section 8.6.2 page 200, et en particulier à la 

section « 8.6.2.2 Affichage d’une composition colorée des images satellites » page 202. 

• Visualiser l’image en « composition vraies couleurs » ou « couleurs naturelles » 

(Figure 131-gauche) lorsque cela est possible, c’est-à-dire lorsque les 3 bandes 

spectrales correspondant aux longueurs d’onde du Rouge, du Vert et de Bleu (RGB, 

Red Green Blue) sont disponibles. Ce type de composition permet d’établir 

facilement, intuitivement, une correspondance entre les couleurs apparaissant sur 

l’image et les couleurs des classes d’occupations du sol telles qu’elles nous 

apparaissent dans le monde réel. Ce type de composition facilitera la reconnaissance 

des classes d’occupation du sol en particulier pour une personne qui ne serait pas 

habituée à l’interprétation de diverses compositions fausses couleurs. 

• Visualiser l’image en « composition fausses couleurs » (Figure 131-droite), c’est-à-

dire dans une composition colorée différente de la composition vraies couleurs. Les 

bandes spectrales en dehors du spectre du visible, essentiellement dans l’infrarouge, 

permettent parfois de distinguer d’avantages de classes spectrales que les seules 

bandes du visible en apportant des informations spectrales supplémentaires. Par 

exemple, la Figure 132 montre qu’une composition fausses couleurs utilisant de 

l’infrarouge peut faciliter la distinction entre 2 types de forêt (feuillue vs résineuse) 

qui en composition vraies couleurs sont assez similaires (sur base d’une méthode de 

visualisation par défaut sans amélioration de contraste). 
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Vraies couleurs RGB = B3-B2-B1 Fausses couleurs RGB = B4-B7-B3 

Figure 131 : Image Landsat-5 TM en composition « vraies couleurs » (à gauche) et en composition 
« fausses couleurs » (un exemple parmi les nombreuses possibles) (à droite), toutes deux avec 
amélioration de contraste. 

 

  
Figure 132 : Exemple de visualisation d’une zone forestière présentant 2 types de forêts, forêt 
feuillue au Nord-Ouest, et forêt résineuse (conifères) au Sud-Est, pendant la saison de végétation, 
en composition vraies couleurs (gauche) et fausses couleurs (Infrarouge-Rouge-Vert) (droite). 
Source : Image sentinel-2 d’une région au Sud de la ville de Namur en Belgique en juillet 2019 
affichée dans le viewer « TERRASCOPE » https://viewer.terrascope.be/terrascope/. 

https://viewer.terrascope.be/terrascope/
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8.7.4.2. Amélioration de contraste 

L’amélioration de contraste  consiste en une transformation virtuelle des données afin 

d’utiliser toute la gamme d’intensité de couleur disponible pour visualiser les données à 

l’écran. Cette amélioration ne modifie donc pas vos données sources (la valeur des pixels). 

Elle ne fait qu’attribuer différemment la palette de couleurs disponibles à votre image afin 

de faire ressortir certains éléments plus clairement. 

La notion d’amélioration de contraste a déjà été présentée en détails à la section 4.8.2.1 

page 51 et à la Figure 18 page 51. 

L’exemple de la Figure 133 montre l’utilité d’améliorations de contraste calculées à partir de 

différentes zones de l’image :  

• l’image de gauche permet la distinction claire de différentes classes d’occupation du 

sol dans la zone montagneuse du Nord-Ouest (classes de forêt et de roche) mais est 

assez « surexposée » ailleurs. 

• l’image de droite permet la distinction claire de différentes classes d’occupation du 

sol dans la zone de plaine du centre (végétation, sol nu, eau) mais est très « sous-

exposée » dans la partie Nord-Ouest en montagne. 

  
Figure 133 : Comparaison de 2 améliorations de contraste de l’image Landsat-5 en « composition 
vraies couleurs Rouge-Vert-Bleu » sur la zone d’étude et focalisant l’amélioration sur la zone 
montagneuse du Nord-Ouest (image de gauche) ou sur la zone de plaine du centre (image de 
droite). 
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8.7.5. Observation multi-temporelle 

L’analyse de la dynamique/variation saisonnière (ou simplement temporelle) des classes 

d’occupation du sol à l’aide de plusieurs images acquises à différentes période de l’année 

(ou à différents moments) peut également aider à l’identification précise de certaines classes 

d’occupation du sol, comme illustré à la Figure 134 qui montre : 

• une variation importante de la réflectance pour une forêt décidue (à feuilles 

caduques) entre l’été (forêt verte) et l’hiver (forêt brune) 

• une constance de la réflectance pour une forêt à feuilles persistantes, verte en été 

et en hiver 

Remarque : certaines techniques de classification de l’occupation du sol se basent 

spécifiquement sur le comportement spectro-temporel de ces classes pour mieux les 

identifier (utilisation de plusieurs images acquises à différents moments de l’année). 

Ce type d’observation et d’analyse ne seront pas réalisés dans le cadre de ce manuel.  

 
Eté, forêt à feuilles persistantes verte et forêt 

décidue verte 

 
Hiver, forêt à feuilles persistantes verte et forêt 

décidue brune 
Figure 134 : Exemple de visualisation en composition vraies couleurs d’une zone forestière 
présentant 2 types de forêts, forêt feuillue décidue (feuilles caduques) au Nord-Ouest, et forêt 
résineuse à feuilles persistantes (conifères) au Sud-Est, pendant la saison de végétation en été (à 
gauche) et en hiver (à droite). Source : Images sentinel-2 d’une région au Sud de la ville de Namur 
en Belgique affichées dans le viewer « TERRASCOPE » https://viewer.terrascope.be/terrascope/. 
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8.7.6. Observation des images en 3D via une représentation du relief 

naturel  

Une représentation 3D du relief naturel du paysage à classifier (Figure 136) peut aider 

l’opérateur à mieux comprendre l’organisation de ce paysage et par là l’aider dans sa tâche 

de photo-interprétation ayant pour but final l’identification des différentes classes 

d’occupation du sol.  

Pour visualiser une couche d’information sous la forme d’une représentation 3D du relief 

naturel, il est nécessaire d’avoir à disposition une couche d’information correspondant à ce 

relief naturel, souvent appelée Modèle Numérique de Terrain (MNT) (en anglais : Digital 

Elevation Model (DEM)). 

Dans le cadre de cet exercice le MNT utilisé est celui présenté à la section 8.4.2.1 page 154 

ci-dessus. 

QGIS propose 2 outils pour la visualisation 3D : 

• Menu : Vue > Vue 3D > Nouvelle Vue Cartographique 3D (Figure 135) 

o Lors de son ouverture, cet outil bug parfois en affichant le message suivant : 

« L'étendue du projet n'est pas valable. Veuillez ajouter ou activer une couche 

à rendre. ». Dans ce cas, allez dans le menu principal de QGIS « Projet > 

Propriétés… > Paramètres de la vue > et cochez le menu comme dans l’image 

ci-dessous (« Définir l’emprise… ») + cliquez sur le bouton « Etendue du 

canevas de carte » + cliquez sur « Appliquer ». Ensuite, retournez dans le 

menu « Nouvelle Vue Cartographique 3D » et poursuivre la procédure ci-

dessous.  

 

o Ensuite, dans le menu : Vue > Vue 3D > Nouvelle Vue Cartographique 3D  

▪ Option > Configurer > Terrain >  

• Type : choisir « DEM (Raster layer) » (MNT) 

• Elevation : choisir un MNT de la zone, dans ce cas-ci, comme 

indiqué dans la figure ci-dessous  
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• Echelle verticale : facteur multiplicateur de l’altitude pour faire 

ressortir le relief 

• Améliorer la résolution éventuellement. 

• OK 

▪ Faire pivoter la vue dans le plan horizontal grâce à la flèche bleu  

▪ Agrandir/élargir éventuellement la fenêtre de la vue 3D vers la gauche 

et vers le bas pour mieux visualiser la vue 3D (qui parfois n’est pas 

visible du tout par défaut).  

▪ S’assurer que l’image à visualiser en 3D soit l’image visible (cochée) la 

plus supérieure dans le panneau « Couches » de QGIS.  

 

Figure 135 : Interface de construction d’une vue 3D avec la « Vue Cartographique 3D » de QGIS 

• L’extension (à installer) QGIS2threejs, qui après installation (via le menu Extension > 

Installer/Gérer les Extensions), est disponible dans le menu « Internet > QGIS2threejs 

> QGIS2threejs Exporter ». Cette extension, en plus de permettre une représentation 

3D, permet également d’exporter cette représentation sous la forme de webmap 

(carte au format web, interactive (zoomable et orientable en 3D)) 
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Figure 136 : Représentation 3D en vraies couleurs de la zone d’étude pour l’image Landsat-5 (au-
dessus) et Sentinel-2 mosaïquée (en-dessous) produites avec la Vue Cartographique 3D de QGIS 
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8.7.7. Utilisation de données complémentaires pour la photo-

interprétation d’une image 

La photo-interprétation (reconnaissance des différentes occupations du sol par analyse 

visuelle) d’une image est parfois difficile : 

• Soit parce que l’image ne présente pas une qualité suffisante (résolution spatiale et 

spectrale adéquate), 

• Soit à cause d’un manque d’expérience du photo-interpréteur ou d’un manque de 

connaissance de la zone.  

La photo-interprétation peut être facilitée grâce à l’utilisation de données complémentaires 

sur la zone étudiée. MAIS ATTENTION ! Il faut que ces données complémentaires soient 

pertinentes pour décrire la zone A LA DATE CORRESPONDANT A LA DATE D’ACQUISITION 

DE L’IMAGE SATELLITE. Par exemple, il sera probablement inutile d’utiliser une donnée 

complémentaire décrivant l’occupation du sol en 2020 si l’image satellite à photo-interpréter 

date de 1980 (40 ans d’écart) et que l’occupation du sol a subi beaucoup de modifications 

entre-temps.  

Voici quelques exemples de données complémentaires :  

• Images satellites de « Google Earth Pro » (exemple sur la zone d’étude à la Figure 73 

page 145). « Google Earth Pro » dispose d’images satellites à très haute résolution 

spatiale pour une partie sans cesse grandissante de la planète et permet d’accéder 

assez facilement à des images satellites d’archive en composition vraies couleurs via 

l’outil « Images d’archive » (confer section 3 page 33 pour une présentation détaillée 

de « Google Earth Pro »). La très haute résolution spatiale permettra parfois de 

mettre un nom précis sur des classes d’occupation du sol qui, à plus faible résolution 

spatiale (exemple : sur une image Landsat à 30 m ou une image Sentinel-2 à 10 m), se 

distinguent spectralement (couleurs différentes) mais sont difficilement 

reconnaissables (Figure 137 ci-dessous). 

• Cartes topographiques 

• Une enquête de terrain avec relevé GPS 

• Divers documents donnant des informations sur l’occupation du sol de la zone. 
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Très haute résolution spatiale : ~20 cm 

Forêts feuillue et résineuse reconnaissables 

 
Haute résolution spatiale : 10 m 

Forêts feuillue et résineuse non reconnaissables 
Figure 137 : Exemple de visualisation d’une zone forestière présentant 2 types de forêts, forêt 
feuillue au Sud-Est (cimes rondes), et forêt résineuse (conifères) au Nord-Ouest (cimes pointues), 
pendant la saison de végétation, en composition vraies couleurs, en très haute résolutions spatiale 
(~20 cm) (à gauche, dans Google Earth Pro) et à 10 m de résolution spatiale (à droite, Sentinel-2 
dans le viewer TERRASCOPE) (Sud de la ville de Namur en Belgique). 
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8.8. Classification supervisée par maximum de 

vraisemblance 

8.8.1. La classification supervisée par maximum de vraisemblance, une 

méthode de classification parmi d’autres 

Dans le cadre de cet exercice, la méthode de classification supervisée par maximum de 

vraisemblance (méthode de classification par pixel) sera utilisée.  

Sachez cependant qu’il existe un grand nombre d’autres techniques de classification 

d’images, par exemple : 

• Classification supervisée versus classification non supervisée 

o Classification supervisée 

▪ L’opérateur supervise le processus de classification : en particulier il 

définit lui-même les classes  

▪ Exemples : maximum de vraisemblance, distance minimum, Support 

Vector Machine (SVM), neural network, etc 

o Classification non supervisée : 

▪ Les classes sont définies automatiquement par l’algorithme de 

classification et une signification leur est attribuée à posteriori 

▪ Exemples : K-mean, ISODATA 

• Classification par pixel versus classification par objet 

o Classification par pixel : chaque pixel de l’image est classifié sur base de ses 

valeurs (dans les différentes bandes spectrales), indépendamment des autres 

pixels de l’image 

o Classification par objet : dans un premier temps, l’image est segmentée, 

c’est-à-dire qu’elle est découpée en « objets » ou groupe de pixels contigus 

spectralement homogènes (groupe de pixels voisins présentant des valeurs 

similaires) (Figure 138). Dans un 2ème temps ces « objets spectraux » sont 

classifiés sur base de leurs propriétés qui sont à la fois spectrales (valeurs des 

pixels) mais aussi de forme (compacte, allongé, etc), de taille (superficie), de 

relation entre différents niveaux de segmentation (un grand objet peut en 

contenir plusieurs petits), de relation entre objets voisins, etc.  
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Figure 138 : image aérienne d’un verger (arbres = boules vertes, sol = pixels gris) : image originale 
(à gauche) et image après segmentation (à droite). 

• Les arbres de décisions : classification via un ensemble de règles successives souvent 

binaires qui se ramifient tel un arbre (Figure 139) 

• … 

 

Figure 139 : Principe de l’arbre de décision pour classifier une image satellite multispectrale  

Notez également qu’une classification d’image peut utiliser des indices dérivés des bandes 

spectrales de l’image à classifier (NDVI, fAPAR, etc) et faire intervenir une série de données 

auxiliaires autres que l’image à classifier comme l’altitude, l’exposition, la pente et toute 

autre information spatiale (Figure 139).  
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8.8.2. La classification supervisée : un processus itératif  

La mise au point d’une méthode de classification supervisée pour un cas particulier 

nécessitera en général de réaliser une série de tests et de corriger itérativement la méthode 

en fonction de la qualité des résultats obtenus. Cette méthode par essais-erreurs peut être 

dirigée essentiellement par : 

• Les résultats de la matrice de confusion obtenue lors de la validation: si la matrice de 

confusion présente une confusion (erreurs de classification) trop importante entre 2 

classes, 

• L’analyse de la séparabilité spectrale des classes spectrales : si, à travers cette 

analyse, l’opérateur se rend compte de l’impossibilité de distinguer avec 

suffisamment de précision 2 classes spectrales,  

Dans ces cas, une amélioration de la classification pourrait provenir de : 

• La fusion des classes spectrales qui ne sont pas suffisamment séparables 

• La subdivision de classes spectrales en classes spectrales plus spécifiques, dans le cas 

où la classe spectrale initiale est trop large 

• Le développement d’une stratégie complémentaire/alternative de 

classification faisant appel par exemple à: 

o des données auxiliaires (autres images satellites ou autres données) ou  

o une autre méthode de classification (arbre de décision, autre algorithme de 

classification, etc) 

• La vérification et la correction éventuelle des ROI (« Region Of Interest ») de 

calibration et de validation pour s’assurer que ceux-ci correspondent bien 

uniquement aux classes spectrales qu’ils sont censés représenter.  

8.8.3. Sélection des « ROI – Region Of Interest » de calibration ou aires 

d’entrainement  pour chaque classe : bonnes pratiques 

La sélection des aires d’entrainement ou, en anglais, « ROI - Region Of Interest », de 

CALIBRATION consiste en l’identification de pixels spectralement représentatifs de chaque 

classe spectrale identifiée précédemment (confer section 8.7 page 230). Ces aires 

d’entrainement permettront de « calibrer » votre classification. Les ROI sont généralement 

sélectionnés à l’écran par, le plus souvent, la création d’un ou plusieurs « polygones » pour 

chaque classe spectrale. Cependant des outils de dessins de type « ligne » ou « point » 

peuvent également être utilisés si nécessaire. Les ROI peuvent également être directement 

importés si par exemple ils ont été créés préalablement en format compatible avec un SIG 

(shapefile, etc) lors d’une enquête de terrain avec relevé GPS. Les ROI de calibration seront 

utilisés pour calculer une série de statistiques (variables selon l’algorithme de classification 
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choisi) caractérisant chaque classe spectrale, typiquement la moyenne, l’écart-type, les 

minimum et maximum et de la sorte obtenir la « signature spectrale » de chaque classe 

spectrale à partir des différentes bandes spectrales de l’image considérée. 

Les aires d’entrainement doivent être représentatives de chaque classe spectrale 

considérée. Voici quelques conseils pour la sélection des aires d’entrainement : 

• Les ROI décrivant une classe spectrale donnée doivent être spectralement 

(relativement) homogènes : ils ne peuvent pas s’étendre sur plusieurs classes 

différentes (Figure 140-gauche et centre) et ne peuvent pas inclure de 

« mixels » (pixel mixte couvrant plusieurs classes d’occupation du sol). Typiquement 

les pixels se trouvant à l’interface de 2 classes d’occupation du sol sont à éviter. Par 

exemple, lors de la sélection des ROI sur un fleuve, ne pas considérer des pixels à 

cheval ou se trouvant top proche de la berge car leur réflectance sera/risque d’être 

influencée par la berge (Figure 140-droite). 

 
Figure 140 : Exemples de mauvaises zones d’entrainement ou ROI couvrant plusieurs classes 
d’occupation du sol différentes ou incluant des « mixels » ou « pixels mixtes ». 

• Il est souvent préférable que ces aires d’entrainement soient bien réparties sur toute 

l’image. En effet, ceci permettra de prendre en compte : 

o Les éventuels légers gradients de luminosité entre les différentes zones de 

l’image (conditions atmosphériques, relief/exposition,…) 

o Une légère différence spectrale entre une même classe d’occupation du sol 

dans des régions différentes (gradient ou classes pédologiques, variation des 

espèces végétales ou de leur état de développement, etc). 

o … 
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• Il faut sélectionner un nombre suffisant de pixels dans les ROI d’une classe spectrale 

donnée pour qu’ils soient REPRESENTATIFS de la classe spectrale considérée. Le 

nombre de pixels nécessaire dépendra donc de la complexité spectrale de chaque 

classe et de la complexité de l’image. Par exemple : 

o Cas simple : une image ne comprenant comme occupation du sol que 2 

classes spectralement contrastées, par exemple le désert et la mer, sera 

extrêmement facile à classifier et cela pourra se faire avec peu de pixels (une 

seule petite ROI par clase, contenant peu de pixels, suffira probablement vu la 

différence spectrale très prononcée entre ces 2 classes d’occupation du sol).  

o Cas complexe : à l’inverse une image présentant un mélange de végétation 

naturelle et cultivée de différent types et à différents stades de 

développement sera plus difficile à classifier car les classes d’occupation du 

sol sont plus nombreuses, elles se ressemblent plus entre-elles et elles 

présentent peut-être chacune une plus grande hétérogénéité spectrale. Dans 

ce cas il sera nécessaire d’utiliser plus de pixels par classe afin que ces pixels 

soient bien représentatifs de toutes les légères variations d’une classe 

spectrale donnée et permettent de différencier au mieux les classes les unes 

des autres. 

• Le nombre de pixels de calibration pour une classe spectrale devrait idéalement 

respecter la règle suivante : 

o Un nombre de pixel supérieur à 10 * n où n est le nombre de bandes 

spectrales considérées (Source : Cindy Schmidt, ARSET Applied Remote 

Sensing Training, Land Cover Classification from Satellite Imagery, 

http://arset.gsfc.nasa.gov). Le nombre optimal de pixels pour chaque classe 

est compris entre 10n et 100n selon l’aide en ligne d’ArcGIS (Source : 

https://desktop.arcgis.com/fr/arcmap/latest/extensions/spatial-

analyst/image-classification/image-classification-using-spatial-analyst.htm).   

• La courbe de la distribution du nombre de pixels en fonction de leur réflectance  

(pour une bande spectrale donnée) pour une classe spectrale (Figure 141) doit être 

uni-modale (ou s’en rapprocher). Si elle est multimodale, ceci constitue une 

indication que les pixels utilisés correspondent à plusieurs classes spectralement 

distinguables avec autant de classes qu’il y a de modes dans la courbe. Un mode ou 

une bosse dans la courbe identifie un sous-groupe de pixels qui présentent des 

valeurs de réflectance similaires entre eux mais différentes des autres 

modes/bosses/groupes de la courbe (dans la longueur d’onde considérée). Il est en 

http://arset.gsfc.nasa.gov/
https://desktop.arcgis.com/fr/arcmap/latest/extensions/spatial-analyst/image-classification/image-classification-using-spatial-analyst.htm
https://desktop.arcgis.com/fr/arcmap/latest/extensions/spatial-analyst/image-classification/image-classification-using-spatial-analyst.htm
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général préférable de créer une classe spectrale par mode/bosse/groupe de la 

courbe (mais ceci pourrait être nuancé en fonction des « classes objectif » de la 

classification). 

 

Figure 141 : Courbes de la distribution de la fréquence des valeurs de pixels unimodale (vert) et tri-
modale (bleue). Axe X = valeurs des pixels, par exemple proportionnelles à de la réflectance. Axe y 
= Nombre de pixels. 

• S’il y a des nuages et qu’ils n’ont pas fait l’objet d’un masquage préalable, faites une 

classe spectrale « Nuages ». 

8.8.4. Création des ROI de calibration dans SCP 

8.8.4.1. Préalables à la création de ROI 

8.8.4.1.1. Définir le « Jeu de bandes » à considérer pour la création des ROI 

 

ATTENTION ! Avant de créer des ROI, il faut créer un « Jeu de bandes » et que ce jeu soit 
repris dans l’onglet actif du menu « SCP > Jeu de bandes » : de cette manière, les 
« signatures spectrales » seront calculées sur ce « Jeu de bandes ». 

 

Si ce n’est pas encore fait, créez le « Jeu de bandes » se rapportant à l’image à classifier 

via le menu QGIS : 

▪ SCP > Jeu de bande 

Ce « Jeu de bandes » doit inclure toutes les bandes spectrales utiles à la classification de 

l’image.  

La création d’un « Jeu de bandes » a déjà été expliquée en détails à la section 8.6.2 page 

200. 

• Cliquez sur l’onglet de ce « Jeu de bandes » pour l’activer via le menu « SCP > Jeu de 

bandes » 
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Facultatif : 

▪ Classez les bandes du « Jeu de bandes » par ordre croissant via le bouton  

▪ Dans le menu « Paramètres rapides », si votre « jeu de bandes » correspond au type 

d’image, au nombre et aux numéros de bandes et à l’ordre des bandes tels que défini 

dans les valeurs prédéfinies du ce menu, vous pouvez éventuellement sélectionner le 

paramétrage rapide correspondant à l’image sur laquelle vous travaillez. Ceci 

permettra d’ajouter automatiquement au jeu de bandes les informations sur les 

longueurs d’onde centrales (et ses unités) de chaque bande spectrale. Ces 

informations seront utilisées ultérieurement lors de la réalisation des graphiques des 

signatures spectrales (section 8.8.7 page 260). Vérifiez après-coup que les longueurs 

d’ondes ajoutées sont bien correctes, et le cas échéant, corrigé, éventuellement 

manuellement.  

Une fois le « jeu de bandes » créé, affichez une composition colorée de l’image satellite à 

classifier  dans QGIS comme indiqué à la section 8.6.2.2 page 202. 

8.8.4.1.2. Paramétrage des préférences SCR de QGIS 

 

ATTENTION ! Avant de créer des ROI, il faut paramétrer les « Préférences » du projet QGIS 
pour définir le Système de Coordonnées de Référence (SCR) qui sera attribué par défaut 
aux fichiers vectoriels nouvellement créés. 

 

Lors de la création d’un fichier de ROI dans SCP, qui est un fichier vectoriel, le système de 

coordonnées de ce fichier sera automatiquement défini sur base des « Préférences » 

paramétrées de votre projet QGIS.  

Pour éviter un bug lors de la création des ROI dans SCP, il faut que le fichier vectoriel de ROI 

automatiquement créé par SCP soit exprimé dans le même SCR que l’image à classifier et 

que le projet QGIS lui-même (confer à ce propos la remarque importante de la section 8.3.2 

page 148). 

Paramétrez les préférences de votre projet QGIS comme souhaité via le menu QGIS 

« Préférences » (Figure 142) : 

• Préférences > Options > SCR > SCR pour les couches > SCR par défaut pour les 

couches : indiquer : « SCR du projet : EPSG : 32635… » (l’EPSG 32635 est valable 

pour l’exemple du manuel. A adapter si vous travaillez sur une autre zone d’étude 

utilisant un autre SCR). 

• Préférences > Options > SCR > SCR pour les couches > Quand une nouvelle couche 

est créée ou… : indiquer « Utiliser le SCR du projet ». 

https://semiautomaticclassificationmanual.readthedocs.io/en/latest/_images/semiautomaticclassificationplugin_order_by_name.png
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Figure 142 : Paramétrage du menu QGIS « Préférences > Options > SCR > SCR pour les couches » 
avant la création de ROI avec le plugin SCP. 

 

8.8.4.2. Création d’un fichier de ROI dans SCP 

ATTENTION ! Voir aussi les étapes préalables à la création de ROI à la section précédente : 

section 8.8.4.1 page 250. 

Pour rappel, en cas de nécessité consultez l’aide en ligne, notamment la page dédié à la 

description du panneau « SCP Dock » ou « Menu SCP » disponible ici : 

• https://semiautomaticclassificationmanual.readthedocs.io/en/latest/scp_dock.html#  

Pour créer un fichier de ROI avec le plugin SCP de QGIS :  

• Allez dans le panneau « SCP Dock » ou « Menu SCP » > Entrée données entrainement 

> Créez une nouvelle donnée d’entrainement via le bouton  > Enregistrez dans 

votre répertoire de travail et donnez un nom, par exemple 

« ROI_LANDSAT_5_CALIBRATION.scp » (Figure 143). 

Une couche vectorielle temporaire de polygones portant le nom attribué s’ajoute 

automatiquement dans le panneau « Couches » de QGIS.  

Attention, pour éviter toute perte de données, il ne faut pas éditer cette couche avec les 

fonctions traditionnelles d’édition de QGIS mais uniquement via les outils du plugin SCP.  

 

https://semiautomaticclassificationmanual.readthedocs.io/en/latest/scp_dock.html
https://semiautomaticclassificationmanual.readthedocs.io/en/latest/_images/semiautomaticclassificationplugin_new_file.png
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Figure 143 : Panneau « Menu SCP » du plugin SCP avec une série de ROI créés en vue de la 
classification de l’image Landsat-5 (remarque : une classe spectrale « Nuages » aurait dû être 

ajoutée à la liste des classes spectrales) 

Pour dessiner une première ROI : 

• Affichez une composition colorée de l’image à classifier dans l’interface de 

visualisation spatiale de QGIS. Cette composition colorée doit provenir du « Jeu de 

bandes » repris dans l’onglet actuellement actif dans le menu « SCP > Jeu de bandes 

» 

• Zoomez sur la zone d’intérêt où une ROI doit être créée 

La création des ROI peut se faire via 2 outils de dessin: 

• En dessinant manuellement un polygone via le bouton   

o Clics gauche pour dessiner le polygone et clic droit pour terminer le polygone. 

Pour créer un ROI multipart, c’est-à-dire composé de plusieurs polygones, 

cliquez sur la touche « CTRL » du clavier avant chaque nouveau polygone. 

« CTRL Z » pour supprimer le dernier polygone créé.  

• En utilisant l’outil « Automatic region growing algorithm » 

 dont la description des différents 

boutons apparait à leur survol  

Ces boutons créent une « ROI temporaire » qu’il faudra ensuite sauvegarder.  

 

 

https://semiautomaticclassificationmanual.readthedocs.io/en/latest/_images/semiautomaticclassificationplugin_manual_ROI.png
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Pour attribuer une classe à une ROI temporaire : 

• Fenêtre « Menu SCP » > Entrée données entrainement > ROI & Liste des signatures > 

et compléter « MC ID » et « Nom de MC », « C ID » et « Nom de C ». 

• MC = « Macro Classe » 

o MC ID : un numéro unique pour chaque macro classe. Plusieurs ROI peuvent 

avoir le même MC ID. 

o Nom de MC : nom de la MC 

• C = « Classe spectrale » 

o C ID : un numéro unique pour chaque classe spectrale. Plusieurs ROI peuvent 

avoir le même C ID (auquel cas ils seront tous considérés pour définir la 

signature spectrale de la classe « C ID ») 

o Nom de C : nom de la classe spectrale 

• Cette attribution peut se faire également après la sauvegarde de la ROI temporaire 

en cliquant-gauche 2 fois espacées sur la case à modifier dans le tableau des ROI. 

Remarque : les lettres reprises dans la colonne « Type » dans le panneau des ROI signifie : 

• R = seulement un ROI polygone, sans signature spectrale calculée 

• S = seulement une Signature spectrale, sans polygone 

• R&S = ROI polygone et Signature spectrale 

Pour sauvegarder une ROI temporaire : 

• Clic sur  (à cliquer après chaque dessin de ROI pour la sauvegarder et pouvoir 

passer à la ROI suivante). 

Pour supprimer une ROI :  

• La sélectionner dans la table des ROI puis clic sur  

Pour fusionner des ROI : 

• Les sélectionner dans la table des ROI puis clic sur . Cette fonction n’est 

probablement pas utile pour la classification en tant que telle mais se révèle 

intéressante si vous désirez réaliser un graphique des signatures spectrales avec une 

seule signature par classe spectrale (confer section 8.8.7 page 260).  

Pour définir les couleurs des macro-classes et classes spectrales : 

• Double-clic sur la couleur et ensuite choix de la couleur.  

Conseils pour faciliter la création des ROI : 

https://semiautomaticclassificationmanual.readthedocs.io/en/latest/_images/semiautomaticclassificationplugin_save_roi.png
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• Changer de compositions colorées et appliquer des améliorations de contraste afin 

de de mieux distinguer les classes d’occupation du sol différentes (confer section 

8.7.4 page 236) 

• L’utilisation de données auxiliaires dont un fond de carte d’images satellites à très 

haute résolution spatiale comme celles fournies par le service « Google Satellite » via 

le plugin « QuickMapServices » (confer section 6.1 page 100) peut se révéler utile 

pour faciliter la photo-interprétation de l’image satellite. Attention toutefois au 

décalage temporel entre la date de l’image satellite à analyser et celle des images du 

service « Google Satellite » (confer section 8.7.7 page 243). 

En cas d’erreur ou de bug du plugin SCP pendant la création de ROI : 

• Si un message d’erreur apparait lors de la création ou sauvegarde d’une ROI et que 

vous ne comprenez pas ce qui pose problème, une solution radicale est de supprimer 

le fichier de ROI en cours de création, dans l’interface QGIS et dans l’explorateur 

Windows, et de recommencer la procédure en créant un nouveau fichier de ROI 

portant un autre nom, avec éventuellement fermeture/réouverture du projet QGIS 

entre-temps si nécessaire. 

8.8.4.3. Sauvegarde / rappel de ROI 

Les ROI créées pour un « Jeu de bandes » peuvent être sauvegardées et rappelées 

ultérieurement dans le même projet QGIS ou un autre projet QGIS, sur le même « jeu de 

bandes », ou sur un autre « Jeu de bandes » qui aurait les mêmes caractéristiques 

spectrales, la même étendue et le même système de coordonnées de référence (SCR).   

Pour sauvegarder des ROI : 

• Lorsque « Sauvegarde auto » est coché 

o Les ROI supplémentaires qui sont créés et enregistrés via le bouton  sont 

automatiquement sauvegardés dans le fichier de ROI « .scp » en cours 

d’utilisation 

o ATTENTION ! Mais il vaut mieux également sauver le projet QGIS pour que 

les modifications apportées à la liste des signatures des ROI soient 100% 

enregistrées dans le fichier de ROI « .scp » (extrait du manuel de SCP : 

« Changes in the ROI Signature list are applied to the file Training input only 

when the QGIS project is saved. »). 

o Attention ! Si vous effacez les ROI de la table de ROI, cela les effacera 

automatiquement du fichier de ROI courant et ils ne seront pas récupérables 

• Le bouton « Créer une nouvelle donnée d’entrainement via le bouton  > 

Enregistrer dans votre répertoire de travail et donnez un nom » 

o Permet d’enregistrer le fichier de ROI « .scp » en cours d’utilisation 

https://semiautomaticclassificationmanual.readthedocs.io/en/latest/_images/semiautomaticclassificationplugin_new_file.png
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▪ sous le nom courant,  

• ce qui est inutile si « Sauvegarde auto » est coché,  

• mais sera utile si « Sauvegarde auto » n’est pas coché 

▪ sous un autre nom 

o ATTENTION ! L’utilisation de cet outil semble parfois déboucher sur un 

message d’erreur « Warning [22]: The coordinate system of training input is 

different from the input image. Please create a new training input”. Ce 

message apparait lorsque, après avoir créé un nouveau ROI1.scp via le bouton 

 ET avoir créé un ou plusieurs polygones ROI dans ce fichier ROI1.scp, l’on 

tente de soit créer un autre ROI2.scp avec  ou d’ouvrir un ROI3.scp 

préexistant avec le bouton . Une solution est de fermer le projet QGIS et de 

le ré-ouvrir : vous pourrez alors ré-ouvrir des ROI.scp préexistant sans 

problème ou en créer un nouveau.  

Pour rappeler des ROI créés et sauvegardés précédemment ou changer de jeu de ROI 

lorsque plusieurs jeux de ROI sont disponibles :  

• Utilisez le bouton « Ouvrir un fichier de données d’apprentissage  » 

8.8.5. Prévisualisation de la classification 

Une prévisualisation de la classification peut être réalisée pour une petite zone de l’image 

afin d’avoir un aperçu très rapide de la qualité de la classification pour une zone donnée  

avant de lancer la classification sur l’ensemble de l’image (étape qui peut prendre plus de 

temps) (Figure 144). 

Remarque : les signatures spectrales des classes spectrales doivent avoir été calculées 

(confer section 8.8.4.2 page 252). 

Pour obtenir une prévisualisation de la classification : 

▪ Menu SCP > Traitement de bande > Classification > (Figure 145 section suivante). 

o Sélectionner le numéro du jeu de bandes sur lequel s’applique la classification 

o Choisir MC ID ou C ID en fonction du type de classe à utiliser pour la 

prévisualisation 

o Choisir l’algorithme de classification 

▪ Dans le menu « Classification preview » de la barre d’outils SCP

  

o Cliquez sur  puis sur l’endroit de l’image pour lequel vous voulez pré-

visualiser la classification et la prévisualisation apparait (Figure 144) 

https://semiautomaticclassificationmanual.readthedocs.io/en/latest/_images/semiautomaticclassificationplugin_new_file.png
https://semiautomaticclassificationmanual.readthedocs.io/en/latest/_images/semiautomaticclassificationplugin_new_file.png
https://semiautomaticclassificationmanual.readthedocs.io/en/latest/_images/semiautomaticclassificationplugin_preview.png
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o Découvrez éventuellement l’utilité des autres boutons de prévisualisation en 

les testant 

o A tester avec MC ID puis C ID coché 

 

Figure 144 : Aperçu de la classification pour une partie de l’image grâce à l‘outil de prévisualisation 
de la classification du plugin SCP (et ancienne interface de paramétrisation de la classification dans 
le plugin SCP). 

8.8.6. Application de la classification  

Vient enfin l’étape tant attendue… l’application de la classification sur l’ensemble de l’image. 

Pour ce faire : 

• Menu SCP > Traitement de bande > Classification > interface à paramétrer comme 

désiré, et dans le cadre de cet exercice (Figure 145) :  

o Sélectionner le numéro du jeu de bandes sur lequel s’applique la classification 

o Cochez « MC ID » pour que la classification représente les MC et pas les 

classes spectrales. 

o Choisir la méthode par « Maximum de vraisemblance » (si vous voulez, à 

vous de tester les autres méthodes et de comparer la qualité des résultats) 

o Laissez les autres paramètres par défaut. 

o Cliquez sur  

o Choisir le répertoire et donner un nom à l’image en sortie 
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Figure 145 : Menu SCP > Traitement de bande > Classification. Aperçu de l’interface 2024 de 
paramétrisation de la classification dans le plugin SCP. 

La classification se réalise.  

• Landsat-5 : ~4 minutes 

Attention ! L’algorithme de « maximum de vraisemblance » peut ne pas fonctionner pour les 

classes dont les ROI présentent une variance spectrale de 0. 

L’algorithme de classification selon le maximum de vraisemblance (« Maximum Likelihood ») 

est appliqué à tous les pixels de l’image sur base des paramètres statistiques décrivant 

chaque signature spectrale obtenue. La comparaison entre les valeurs de chaque pixel et les 

signatures spectrales des différentes classes déterminera la probabilité d’appartenance du 

pixel à chacune des classes. La classe présentant la probabilité maximum sera attribuée au 

pixel considéré. 

• Visualisez l’image classifiée, automatiquement ajoutée dans QGIS (Figure 146 et 

Figure 147) 

• Comparez visuellement l’image classifiée avec l’image de base pour évaluer la qualité 

de la classification et identifier les erreurs éventuelles de votre classification, ce qui 

vous permettra de l’améliorer éventuellement. L’extension QGIS (à installer) « 

MapSwipe Tool » (confer section 5.2 page 72) peut éventuellement faciliter cette 

comparaison visuelle.  
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Figure 146 : Premier essai de classification (de mauvaise qualité) de l’image Landsat-5  

 

Figure 147 : Premier essai de classification (de mauvaise qualité) de l’image Sentinel-2 mosaïquée  
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8.8.7. Etude de la séparabilité spectrale des classes spectrales 

La séparabilité spectrale des différentes classes spectrales peut être analysée afin de 

quantifier/d’objectiver le caractère séparable ou non séparable de ces classes. 2 méthodes 

sont disponibles dans QGIS : 

• L’examen graphique des signatures spectrales de chaque classe spectrale  

• Une série d’indices de séparabilité spectrale 

Documentation officielle disponible ici : 

• https://fromgistors.blogspot.com/p/user-manual.html?spref=scp  

https://fromgistors.blogspot.com/p/user-manual.html?spref=scp
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8.8.7.1. Graphique des signatures spectrales 

Un graphique des signatures spectrales peut se réaliser en  

• Sélectionnant les ROI d’intérêt dans l’onglet « Entrée données d’entrainement »du 

panneau « Menu SCP » 

• Puis en cliquant sur le bouton « Ajouter les signatures spectrales surlignées au 

graphique »   pour créer les graphiques des signatures spectrales 

Une fenêtre « SCP : Graphique signature spectrale » s’ouvre et son onglet « Graphique » 

présente les signatures spectrales (Figure 148). Le bouton  permet d’ajuster le graphique 

correctement. 

Si plusieurs ROI appartiennent à la même classe spectrale, leurs signatures spectrales 

peuvent être fusionnées via le bouton  du panneau « Menu SCP » et les ROI d’origine 

décochés dans la table des ROI. Un ROI « merged… » apparaîtra pour les remplacer (Figure 

148). Lors de l’examen des signatures spectrales et de l’analyse des indices de séparabilité 

spectrale, veiller à décocher/ne pas considérer les ROI non pertinents si certains sont 

remplaçables par leur signature spectrale fusionnée.  

 

Figure 148 : Signatures spectrales de différentes classes d’occupation du sol dans le plugin SCP de 
QGIS (après fusion des ROI correspondant à une même classe spectrale) 
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8.8.7.2. Indices de séparabilité spectrale 

4 méthodes de mesures de la séparabilité spectrale sont proposées dans le plugin SCP : 

 

Pour calculer la séparabilité spectrale : 

• Dans la fenêtre « SCP : Graphique signature spectrale », cliquez sur le bouton 

« Distance spectrale »  pour obtenir une table avec les indices exprimant la 

séparabilité spectrale des classes (Figure 149). 

 

Figure 149 : Indices de séparabilité spectrale des classes 2 à 2 
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8.8.8. Classification rapide des nuages en vue de la réalisation d’un 

masque de nuages amélioré 

! Méthode proposée dans le cadre de ce manuel :  

• Landsat-5 : à ne pas faire 

• Sentinel-2 : la méthode décrite dans cette section a été utilisée pour créer les 2 
masques de nuages améliorés pour les 2 images Sentinel-2. Ces masques sont 
disponibles dans le dossier « …\DATA\IMAGES\SENTINEL_2\ » et s’appellent 
SENTINEL_2_MASQUE_NUAGES_20180612.tif et 
SENTINEL_2_MASQUE_NUAGES_20180707.tif et prennent pour valeurs 1 pour les 
nuages et 2 pour le reste. 

 

Comme mentionné à la section 8.6.8.3 page 212, un masque de nuages peut être réalisé par 

classification de l’image présentant les nuages et devant être masquée.  

Voici, pour information, la procédure qui a été suivie pour réaliser les masques de nuages 

améliorés des images Sentinel-2. 

Classification des nuages : 

• Pour une question de rapidité d’exécution de la classification et d’efficacité, seule la 

bande présentant le contraste le plus marqué entre le sol et les nuages sur les images 

concernées, soit la bande 2 de Sentinel-2 (la bande du bleu) est utilisée. 

• La bande 2 de réflectance, découpées spatialement et rééchantillonnées à 30 m est 

utilisée 

• Attention ! Il faut créer un jeu de bandes avec la bande 2 et que ce jeu soit l’onglet 

actif dans le menu Jeu de bandes de SCP : de cette manière, les « signatures 

spectrales » seront calculées sur ce Jeu de bandes 

• Avant la création des ROI, il peut être utile de réaliser une amélioration de contraste 

qui permette de distinguer les différentes occupations du sol 

• 2 Macro-classes sont créées : NUAGE et AUTRES 

• Quelques ROI sont créés pour la macro-classe (MC ID) nuage avec l’outil « growing 

region » afin de bien couvrir l’ensemble des nuages y compris les bords de nuages, 

avec le même identifiant de classe spectrale (C ID) (Figure 150) 

• Un grand ROI est créé rapidement pour chacune des autres classes avec comme MC 

ID « AUTRE » et un C ID différent pour chaque classe spectrale différente (lac, forêt, 

champs, ville) (Figure 150) 

• La méthode de classification utilisant MC ID (NUAGE/AUTRE) avec l’algorithme du 

« Plus proche voisin » est utilisée 
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• Un aperçu de la classification peut être utilisé pour vérifier la qualité obtenue. L’outil 

« Map swipe tool »  (plugin de QGIS) peut être utile pour comparer la 

classification avec l’image de départ 

• La classification est ensuite produite et sa qualité vérifiée visuellement (~1 minute) 

 

Figure 150 : Création des ROI de calibration pour la classification des nuages (ancienne interface de 
SCP) 

La classification, si réussie, permet d’identifier les nuages beaucoup mieux que le masque de 

nuages fourni avec les images Sentinel-2 1C. Cette classification ne sera cependant 

certainement pas parfaite. Il convient dès lors de la raffiner, en fonction des défauts qu’elle 

présente (trop ou trop peu de pixels classifiés comme nuage). 

Pour raffiner cette classification, les techniques suivantes ont été utilisées (à adapter selon 

la qualité de classification obtenue): 

• Menu QGIS Raster > Analyse > Tamiser… (Figure 151) 

o A utiliser lorsque des pixels isolés sont à faire changer de classe : certains 

pixels clairs (villes, lit de rivière) et souvent isolés sont parfois identifiés 

comme nuages.  

o Cet outil permet de faire disparaitre les petites tâches de pixels (trop petites 

que pour être un nuage) d’une classe dans une autre classe voisine (très 

rapide) (valeur seuil de 8 et connectivité de 8) → les pixels isolés classifiés 

comme NUAGE deviennent AUTRE. 

o (la fonction similaire de SCP (cribler/sieve) prend trop de temps à s’exécuter) 
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Figure 151 : Outils de tamisage de QGIS (pour fusionner les petits groupes de pixels isolés avec la 
classe voisine majoritaire)  

 

• Menu SCP > Post-traitement > Dilater la classification (Figure 152) 

o permet de faire « gonfler » une classe. A utiliser par exemple si les bords de 

nuages ne sont pas bien identifiés mais les centres de nuages oui.  

o paramétrage : taille de pixel = 5 et nombre de pixels voisins = 8. Dans le raster 

résultant : 1 = masque, 2 = pas masque. Ce raster peut être appliqué comme 

masque sur les bandes spectrales d’une image, comme indiqué à la section 

8.6.8.4 page 216.  

 

Figure 152 : Outil de dilation de classification utilisé pour dilater la classe nuage (ancienne interface 
de SCP) 
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L’image résultante est inspectée visuellement pour estimer la qualité d’identification des 

nuages.  

Faire des tests en modifiant le paramétrage si le résultat n’est pas satisfaisant.  

L’identification des nuages est de loin meilleure à celle fournie dans le fichier vectoriel initial 

(Figure 153). 

 

 
Image Sentinel-2 20180707 bande bleue 

 
Image Sentinel-2 20180707 bande bleue 
avec masque de nuages vectoriel fourni 

avec l’image 

 
Classification de l’image Sentinel-2 

20180707 bande bleue en NUAGE / AUTRE 

 
Dilatation de la classification de l’image 

Sentinel-2 20180707 bande bleue en NUAGE 
/ AUTRE 

Figure 153 : Elaboration du masque de nuages améliorés pour l’image Sentinel-2 20180612 

 
Sentinel-2 20180612 

 
Sentinel-2 20180707 

 
Figure 154 : Masques de nuages améliorés résultant de la classification et raffinement pour les 2 
images Sentinel-2 
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8.9. Amélioration de la classification par reclassification 

conditionnelle et données auxiliaires  

8.9.1. Introduction 

Une classification existante peut être modifiée/améliorée par reclassification de certains 

pixels sur base d’une comparaison avec les valeurs de pixels d’autres rasters. 

Dans le cadre de cet exercice, nous appliquerons 2 reclassifications conditionnelles (Figure 

155): 

• Reclassification de « forêt normale » en « forêt d’altitude » 

o Les pixels classifiés comme « forêt » seront reclassifiés en « forêt d’altitude » 

si les pixels correspondant du raster d’altitude ont une valeur > 2400 m 

o Un raster d’altitude sera utilisé (MNT SRTM) 

• Reclassification de « forêt normale » en « forêt riveraine » 

o Les pixels classifiés comme « forêt » seront reclassifiés en « forêt riveraine » 

(proche des cours d’eau) si les pixels correspondant du raster de proximité 

aux rivières = 1, ce qui signifie que ces pixels sont à ≤ 60 m d’une rivière 

o Un raster exprimant la proximité aux rivières (zone tampon de 60 m) sera 

utilisé 

Reclassification conditionnelle multi-temporelle (non effectuée dans le cadre de cet 

exercice) : 

Il peut être intéressant dans certains cas de reclassifier une classification sur base d’une 

autre classification de la même zone mais d’une autre date. Par exemple la classe « forêt » 

de la classification correspondant au temps 2 pourrait être reclassifiée en : 

• « forêt ancienne » si une forêt existait déjà au temps 1 (40 ans plus tôt par exemple) 

• « forêt jeune » s’il n’y avait pas de forêt au temps 1 

8.9.2. Préparation des données auxiliaires contenant les paramètres utiles 

à la reclassification conditionnelle 

Dans le cadre de cet exercice, ces données auxiliaires ont déjà été préparées et sont 

présentées aux sections suivantes : 

• Section 8.4.2.1 Raster d’altitude, page 154 

• Section 8.4.2.2 Raster de proximité aux rivières, page 161 
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8.9.3. Reclassifications conditionnelles en pratique 

Pour reclassifier des pixels d’une classification en fonction des valeurs que prennent un ou 

plusieurs autres rasters, utilisez le : 

• Menu QGIS SCP > Calcul de bande > Règles de décision (Figure 155) 

Il faut que les rasters contenant les paramètres utiles à la reclassification conditionnelle 

soient présents dans le projet QGIS et donc visible dans la « Liste de bandes » de cette 

fenêtre.  

La colonne « Valeur » contient la nouvelle valeur à appliquer au raster reclassifié si la 

condition reprise dans la colonne « Règle » et basée sur d’autres rasters est vérifiée. 

La reclassification est en générale très rapide et un raster reclassifié est créé. 

• Adaptez la symbologie du raster reclassifié en attribuant une couleur pertinente aux 

éventuelles classes nouvellement créées (confer section 4.8.2.1 page 51) en utilisant 

une symbologie de type « Palette/Valeurs uniques » 

 (Figure 156).  

 

Figure 155 : Reclassification conditionnelle d’une classification avec l’outil « Règles de décision » de 
SCP (raster19 = la classification, raster59 = MNT et raster29 = raster de proximité aux rivières (zone 
tampon de 60 m) (ancienne interface de SCP) 
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Figure 156 : Classification avant (gauche) et après (droite) reclassification conditionnelle faisant 
apparaitre les forêts d’altitude (vert clair en montagne) et les forêts riveraines (encadré)  

 

Figure 157 : 1ère classification de l’image Sentinel-2 mosaïquée avec reclassification conditionnelle 
pour les forêts d’altitude et riveraines 
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8.10. Post-traitements d’une image classifiée pour en 

améliorer le rendu visuel ou la raffiner 

Plusieurs opérations de post-traitement peuvent être appliquées sur une image classifiée en 

vue d’en améliorer le rendu visuel, de corriger certaines erreurs ou de parfaire la 

classification, par exemple : 

• Pour changer les couleurs de certaines classes 

o Clic droit sur la classification dans le panneau « Couches » de QGIS > 

Propriétés… > Symbologie  

o Choisissez des couleurs intuitives pour chacune des classes (par exemple : 

vert foncé pour la classe « forêt », bleu pour la classe « eau », etc.) 

• Pour fusionner différentes classes 

o SCP > Post-traitement > Reclassification  

• Pour éditer un raster 

o SCP > Post-traitements > Editer raster 

• Pour diminuer l’effet poivre et sel typique d’une classification par pixel* (Figure 

158) 

o SCP > Post-traitements >  

▪ Cribler la classification : pour fusionner les pixels isolés avec la classe 

majoritaire environnante 

o Menu QGIS Raster > Analyse > Tamiser… 

• Pour éroder ou dilater frontières de groupes de pixels d’une classe* 

o SCP > Post-traitements >  

▪ Eroder la classification : pour éroder/réduire les frontières de groupes 

de pixels d’une classe 

▪ Dilater la classification : pour dilater les frontières de groupes de pixels 

d’une classe 

*Attention, l’application de ce type de filtre modifie la classe attribuée à certains pixels et 

donc mène à une classification en définitive moins en phase avec l’appartenance spectrale 

de ces pixels aux classes spectrales telle que définie par l’algorithme de classification utilisé 

(par exemple : l’algorithme de classification par maximum de vraisemblance). Ce type de 

filtre peut être utile si l’opérateur désire « lisser visuellement » la classification ou 

« raffiner » la classification si le filtre est considéré comme une règle de classification à part 

entière. 
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Figure 158 : Exemple de l’effet de l’application d’un filtre majoritaire ou tamisage sur une 
classification: à gauche : classification originale avec petits groupes de pixels isolés (=effet 
ressemblant à un mélange de grains de poivre et de sel); à droite : classification filtrée (filtre 
majoritaire) ou tamisée avec les petits groupes de pixels isolés qui ont été fusionnés dans la classe 
majoritaire voisine (outils utilisé : « Tamiser » de QGIS avec un seuil de 4).  
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8.11. Evaluation de la précision de la classification par 

« matrice de confusion » ou « table de contingence » 

8.11.1. Considérations générales sur l’évaluation de la qualité d’une 

classification  

8.11.1.1. Evaluation de la qualité d’une classification et notions de calibration 

vs validation  

La qualité d’une classification peut être évaluée par 2 méthodes principales (Figure 159): 

• Une comparaison visuelle entre la classification et une donnée de référence qui peut 

être l’image ayant servi à la classification, une autre classification, une autre données 

qui contient une information sur l’occupation du sol.  

o Avantage : rapide, peut donner un rapide aperçu général de la qualité de la 

classification 

o Désavantage : peut être assez subjective et difficile à mener en détails si la 

zone à observer est grande et les classes nombreuses et présentant une 

configuration spatiale complexe, par exemple via l’enchevêtrement de 

nombreuses petites classes sous forme de zones irrégulières (versus 

répartition claire de peu de classes sous forme de grandes zones régulières) 

• L’utilisation d’une « matrice de confusion » ou « table de contingence » 

o Avantage : est plus objective car elle permet de quantifier la précision 

obtenue à travers une série d’indicateurs chiffrés (précision globale, précision 

classe par classe, etc) (confer plus loin). A la condition que l’échantillonnage 

soit correctement réalisé, la matrice de confusion permettra une estimation 

de la qualité réelle de la classification (pas de sous-/sur-estimation de la 

qualité) 

o Désavantage : prend plus de temps à réaliser car il faut créer/échantillonner 

les zones de validation et leur attribuer une classe 

Lors de la réalisation d’une classification supervisée avec estimation de la qualité de la 

classification par matrice de confusion, 2 types de ROI (Region Of Interest) sont créés, ce qui 

entraine généralement une certaine confusion dans la compréhension des apprenants. Il est 

important de bien comprendre la distinction entre (Figure 159): 

• Les ROI de CALIBRATION : elles sont utilisées pour CALIBRER la classification, c’est-à-

dire pour calculer les signatures spectrales de chaque classe spectrale qui seront 

ensuite utilisées pour attribuer une classe à chacun des pixels de l’image au moment 

de la classification 
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• Les ROI de VALIDATION : elles sont utilisées pour VALIDER/ESTIMER LA QUALITE de 

la classification, via la production d’une matrice de confusion, et par COMPARAISON 

(au sein des ROI de validation) entre: 

o l’occupation du sol « classifiée » ou « prédite » de la CLASSIFICATION et  

o l’occupation du sol associée aux zones de validation lors de la création des 

ROI de VALIDATION 

La matrice de confusion est donc calculée UNIQUEMENT sur base des zones de l’image 

classifiée identifiées dans les ROI de VALIDATION, d’où l’importance que celles-ci soient 

suffisamment nombreuses que pour être représentatives de la qualité de l’ensemble de la 

classification.  
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Figure 159 : Principes de calibration et validation d’une classification supervisée  
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8.11.1.2. Stratégies d’échantillonnage des zones de validation (ROI de 

validation) 

Stratégies d’échantillonnage  

Diverses stratégies de sélection (échantillonnage) des zones de validation existent : 

• Echantillonnage dirigé : les points sont positionnés à des endroits choisis par 

l’opérateur. Cette méthode n’est pas idéale car l’opérateur aura naturellement  

tendance à choisir pour la validation des zones qu’il peut facilement photo-

interpréter et qui sont probablement plus facilement classifiables que d’autres. Ceci  

aura pour conséquence de fausser les résultats de la validation en présentant une 

précision de classification surestimée. Il est préférable que les points soient 

positionnés aléatoirement.  

• Echantillonnage aléatoire simple : les points sont positionnés aléatoirement dans 

l’espace 

• Echantillonnage aléatoire stratifié (méthode utilisée dans le cadre de cet exercice) : 

un certain nombre de points, en partie proportionnel à la superficie de chaque classe, 

est  positionné aléatoirement au sein de chaque classe 

• Echantillonnage régulier ou systématique sous forme de grille régulière ou de 

transects : les points sont positionnés selon une grille ou un transect (ligne) 

• Echantillonnage spatialement conditionné par l’accessibilité des zones sur le 

terrain : par exemple, positionnement des points le long de/à proximité des voies de 

communication (route, chemin, rivière) ou en évitant des zones d’insécurité, ou trop 

difficilement accessibles.  

Le choix de la méthode d’échantillonnage sera notamment dépend de la possibilité/facilité 

de photo-interpréter l’image et de faire des relevés de terrain. Si la photo-interprétation 

n’est pas possible/suffisante, une enquête de terrain peut être effectuée. Des considérations 

d’ordre logistiques peuvent alors rentrer en ligne de compte : nombre de jours, budget, 

hommes, équipement disponibles, etc. 

Représentativité des zones de validation 

Il faut veiller à ce que les zones de validation soient suffisamment nombreuses et réparties 

de manière homogène sur la carte AFIN QUE CELLES-CI PERMETTENT DE CALCULER UNE 

MATRICE DE CONFUSION QUI SOIT BIEN REPRESENTATIVE DE LA PRECISION DE 

CLASSIFICATION DE L’ENSEMBLE DE L’IMAGE. Par exemple, si vous utilisez une seule petite 

zone de validation pour une classe donnée et que par chance tous les pixels de cette zone 

sont bien classés, la précision de classification obtenue pour cette classe par la matrice de 

confusion sera de 100% alors qu’il est probable que d’autres pixels appartenant à cette 

classe à d’autres endroits de l’image soient eux mal classifiés. Dans ce cas votre zone de 
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validation ne sera pas représentative de l’ensemble de la classe d’occupation du sol et 

l’estimation de la précision de classification de cette classe sera donc faussée.  

Classe inconnue ? 

S’il existe des zones de validation pour lesquelles la classe d’occupation du sol réelle n’est 

pas connue (photo-interprétation trop difficile, pas d’information venant du terrain, etc) il 

devient impossible d’en réaliser la validation. A l’opérateur alors d’estimer si ces zones sont 

négligeables (par exemple parce qu’elles couvrent un très faible pourcentage de la surface 

de l’image), ou pas, et de documenter les limitations de la méthode de validation utilisée. 

Outils d’échantillonnage dans QGIS 

• Outils de base de QGIS : plusieurs fonctions de QGIS permettent de générer des 

points positionnés aléatoirement « Points aléatoires… » ou selon une grille « Points 

réguliers » (voir le menu « Traitement > Boite à outils > Création de vecteurs »). 

• Plugin SCP : la fonction « Création de ROI multiples » du plugin SCP permet de 

générer un certain nombre de points positionnés aléatoirement au sein d’une classe 

d’occupation du sol d’un raster (confer section 8.11.2). 

8.11.1.3. De la qualité d’une classification 

Il n’y a pas vraiment de règle absolue définissant une valeur seuil à atteindre qui 

caractériserait une bonne/mauvaise classification.  

La qualité de la classification devra être appréciée au cas par cas en fonction : 

• Des objectifs de la classification  

o Toutes les classes sont-elles réellement d’intérêt ou d’égale importance? 

o Quel niveau de précision souhaitez-vous atteindre ? Globalement et classe 

par classe.  

o Parfois il est important qu’une classe donnée ne contienne aucun intrus, 

c’est-à-dire que l’on soit certain que tous les pixels classifiés dans cette classe 

appartiennent effectivement (dans la réalité) à cette classe (0% d’erreur de 

commission), mais il peut être toléré que certains pixels appartenant 

effectivement (dans la réalité) à cette classe soient classés dans une autre 

classe (erreur d’omission), et inversement.  

• De la difficulté de la classification 

o Une classification plus ambitieuse tentant d’identifier des classes plus 

précises (par exemple, différencier différents types de végétation verte : 

bananier, palmier, couvert herbacé, autres cultures) sera plus difficile à 

réaliser, et obtiendra donc une précision de classification moindre, qu’une 
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classification simpliste ne considérant que quelques classes fortement 

contrastées (par exemple, les classes sol nu, végétation, eau) 

• Du nombre de classes considérées 

o Une précision globale de 50% pour une classification ne considérant que 2 

classes, équivaut à une classification aléatoire des pixels (1 chance sur 2 

d’être correctement classifié) 

o Une précision globale de 50% pour une classification considérant 10 classes, 

représente déjà un certain niveau de qualité de classification 

• De la surface relative des différentes classes 

o Par exemple, une petite imprécision sur une classe couvrant 90% de la zone 

étudiée aura peut-être plus d’importance qu’une grande imprécision sur une 

classe ne couvrant que 5% de la zone. 

8.11.2. Validation par échantillonnage stratifié aléatoire  

8.11.2.1. Ressources complémentaires 

Pour un tutoriel plus complet et plus détaillé sur la validation par échantillonnage stratifié 

aléatoire avec le plugin SCP de QGIS, le lecteur est renvoyé au tutoriel officiel du plugin 

SCP « Tutorial : Accuracy Assessment of a Land Cover Classification » disponible ici : 

• https://fromgistors.blogspot.com/2019/09/Accuracy-Assessment-of-Land-Cover-

Classification.html  

8.11.2.2. Les grandes étapes 

• Calcul du nombre de ROI de validation par classe (en partie proportionnel à la 

superficie des classes)  

• Création des ROI de validation aléatoirement positionné au sein de chaque classe 

• Attribution des classes à ces ROI de validation par photo-interprétation (ou autre 

méthode) 

• Calcul de la matrice de confusion et autres statistiques 

• Interprétation de la matrice de confusion et autres statistiques 

8.11.2.3. Calcul du nombre de points de validation par classe  

Une méthode pour calculer le nombre de points de validation total à considérer ainsi que 

leur répartition par classe est proposée dans le tutoriel qui est disponible ici : 

• https://fromgistors.blogspot.com/2019/09/Accuracy-Assessment-of-Land-Cover-

Classification.html  

https://fromgistors.blogspot.com/2019/09/Accuracy-Assessment-of-Land-Cover-Classification.html
https://fromgistors.blogspot.com/2019/09/Accuracy-Assessment-of-Land-Cover-Classification.html
https://fromgistors.blogspot.com/2019/09/Accuracy-Assessment-of-Land-Cover-Classification.html
https://fromgistors.blogspot.com/2019/09/Accuracy-Assessment-of-Land-Cover-Classification.html
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Dans le cadre de cet exercice, par soucis de simplification et de rapidité, une approche 

simplifiée est proposée.  

Le nombre de point total à utiliser pour la validation (N) sera arbitrairement fixé à 100 (ce 

qui peut être considéré comme très peu). Dans une situation réelle il faudra suivre les 

recommandations du tutoriel de SCP pour calculer le nombre de points total (N) ! 

La répartition de ces 100 points au sein des différentes macro-classes que l’on veut valider 

se fera selon la règle proposée dans le tutoriel de SCP, à savoir : 

𝑁𝑖 = (

𝑁
𝑐 + 𝑁 ∗𝑊𝑖

2
) 

Où : 

• Ni est le nombre de point de validation d’une classe i donnée 

• N est le nombre de points de validation total  

• c le nombre de macro-classes à valider 

• Wi le pourcentage surfacique de chaque classe dans l’image classifiée 

Ni correspond à la valeur moyenne entre une distribution égale du nombre de points entre 

chaque classe (N/c) et une distribution directement proportionnelle à la superficie de 

chaque classe (N*Wi). 

Par exemple, pour l’image Landsat-5 : 

• N = 100 

• c = nombre de MC = 8 (ne pas considérer la classe « 0 - Unclassified »)  

• Wi peut être obtenu via le  

o Menu SCP > Post-traitement > Rapport de classification 

▪ Sélectionner la classification à valider 

▪ Lancer le calcul et choisir le répertoire de sortie + donner un nom au 

fichier texte csv produit, par exemple 

« Rapport_de_classification_Landsat5.csv » 

▪ Wi correspond à la colonne « Percentage % » du fichier csv produit. 

• Le nombre de pixels par classe (Ni) peut ensuite être facilement calculé selon la 

formule reprise ci-dessus et implémentée dans la feuille Excel « Calcul 

échantillonnage stratifié pour validation.xlsx » disponible dans le dossier « DATA » 

de cet exercice (Figure 160). Vous adapterez cette feuille Excel en fonction du 

nombre de classes considérées, de leur Wi et éventuellement du N que vous avez 

choisi ou calculé.  
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Figure 160 : Calcul du nombre de points de validation par classe directement en partie 
proportionnel à la superficie de chaque classe (échantillonnage stratifié) dans la feuille Excel « 
Calcul échantillonnage stratifié pour validation.xlsx » 

8.11.2.4. Création des points de validation 

• Créez un nouveau « Jeu de bandes » qui contient l’image classifiée à valider 

o Menu : SCP > Jeu de bandes (confer indications à la section 8.6.2 page 200) 

o Remarque : en général, une image classifiée est un raster contenant une seule 

bande 

• Créez un nouveau fichier de ROI qui recevra les ROI de validation 

o Fenêtre « Menu SCP » > Entrée données entrainement >  > choisir le 

répertoire et donner un nom, par exemple 

« ROI_LANDSAT_5_VALIDATION.scp » 

• Créez les points de ROI localisés aléatoirement au sein de chacune des classes 

o Barre outils SCP : mettre « Min » et « Max » à 1 : cette valeur, définissant la 

taille min et max des ROI de validation à créer, sera automatiquement 

considérée lors de la création des ROI par l’outil de « création de ROI 

multiples » (confer ci-dessous). Dans ce cas-ci nous voulons générer des ROI 

de taille = 1 pixel.  

 

o Fenêtre « Menu SCP » > Entrée données d’entrainement > ROI & Liste des 

signatures : renseigner “MC ID” = 0, “Nom de MC” vide, “C ID” = 0, et “Nom 

https://semiautomaticclassificationmanual.readthedocs.io/en/latest/_images/semiautomaticclassificationplugin_new_file.png
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de C” vide. Ces valeurs seront automatiquement reprises pour tous les ROI de 

validation générés dans l’étape suivante. Ces valeurs devront être ensuite 

éditées via photo-interprétation. Indiquer une valeur de 0 ou vide permettra 

de distinguer plus facilement les ROI déjà édités de ceux non encore édités.  

 

o SCP > Outils basic > Création de ROI multiples  (Figure 161) 

▪ Paramétrez la fenêtre comme désiré pour la création des ROI de 

validation d’une classe donnée. Un exemple est donné dans la Figure 

161 et sa légende.  

• « Nombre de points » correspond au Ni calculé précédemment.  

▪ Cliquez sur  ce qui créé les points et les affiche dans la 

table 

▪ Répéter l’opération pour toutes les macro-classes en adaptant à 

chaque fois le nombre de points à créer et la valeur du raster de 

classification qui désigne la classe concernée (Figure 160) 

▪ Décocher « Calculer les signatures » (car pas besoin) 

▪ Lancer la création 

▪ (Attention ! Il faut que la classification et le projet QGIS soient dans le 

même SCR !, Confer section 8.3.2 page 148) 

▪ Les points créés viennent s’ajouter dans la Fenêtre « Menu SCP » > 

Entrée données d’entrainement > ROI & Liste des signatures avec dans 

la colonne « Type » : ROI ( = sans signature spectrale calculée) (Figure 

162) mais avec un « MC ID » et « C ID »  = 0 et sans « Nom ». 
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Figure 161 : Fenêtre « SCP > Outils basic > Création de ROI multiples ». La paramétrisation de cet 
exemple a créé 14 points dans la classe correspondant à une valeur de pixel de 6 dans le raster de 
la classification qui est repris dans le « Jeu de bandes » numéro 3. 

8.11.2.5. Attribution des classes aux ROI de validation via photo-

interprétation (ou autre technique) 

• Affichez dans QGIS une composition colorée de l’image utilisée pour produire la 

classification à valider ou une autre source d’information qui pourrait être utilisée 

pour attribuer les classes aux ROI de validation 

• Fenêtre « Menu SCP » > Entrée données d’entrainement > ROI & Liste des 

signatures (Figure 162) 

o Pour zoomer automatiquement sur un ROI pixellaire de validation, faire un 

clic-droit sur le ROI puis Zoom to, ou double-cliquez sur une ligne de la table 

des ROI de validation.  

o Dé-zoomez ensuite jusqu’à être capable d’identifier par photo-interprétation 

la classe correspondante à ce pixel 

o Encodez le « MC ID » (et « C ID » éventuellement, ce qui n’est pas nécessaire 

si vous faites une validation sur les MC uniquement) dans la table des ROI 

pour le ROI considéré en cliquant UNE FOIS de plus sur la cellule à éditer. 

Attention ! Une fois le « MC ID » (et « C ID ») encodé et validé, la ligne 

correspondante vous donnera l’impression de disparaitre, mais elle va en fait 

automatiquement se déplacer tout en bas du tableau des ROI où vous pourrez 

la retrouver (les lignes du tableau sont automatiquement reclassées sur base 

du « MC ID »).  

o Répétez l’opération pour tous les ROI de validation 
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o Si un pixel est un mixel (pixel composé de plusieurs occupations du sol) une 

solution approximative est de considérer la classe la plus importante en 

surface dans le pixel 

o Si la photo-interprétation n’est pas possible, soit attribuez la classe la plus 

probable, soit attribuez un nouveau code MC ID qui identifiera les pixels non 

photo-interprétables (méthode non encore testée). 

o Le fichier de ROI est sauvegardé automatiquement si la case correspondante 

est cochée. 

 

Figure 162 : Attribution des identifiants des macro-classes (« MC ID ») aux points de validation 
(générés de manière aléatoire stratifiée) par photo-interprétation. Les points de validation 
correspondent aux pixels noirs dans l’interface de visualisation spatiale de QGIS.  Dans cette 
illustration, seuls 2 ROI de validation ont déjà reçu un MC ID (de 3 et 5). 

8.11.2.6. Création de la matrice de confusion (avant et après regroupement 

des classes et/ou post-traitements) 

Pour créer la matrice de confusion 

• SCP > Post-traitement > Précision 

o Paramétrer comme dans la Figure 163 

▪ Vecteur de référence = le nom du fichier de ROI de validation 

o Lancez et choisir le répertoire de sortie et donner un nom, par exemple 

« Validation_Précision_Landsat5 » qui sera utilisé pour produire : 
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▪ Un fichier CSV contenant la matrice de confusion et les statistiques 

dérivées (Figure 164): à interpréter ! Confer sections suivantes. 

▪ (Une image d’erreur dont la valeur des pixels correspond à un code 

d’erreur « ErrorMatrixCode » tel qu’identifié dans le fichier CSV.) 

o Les résultats de l’analyse de précision apparaissent aussi dans la partie 

« Sortie » de l’interface du menu « Precision » (Figure 164). 

 

Figure 163 : Paramétrage de la création de la matrice de confusion 

 

Figure 164 : Matrice de confusion produite et les statistiques dérivées. (Remarque : cette matrice 
de confusion n’a pas été créée avec un N (nombre de points de validation théorique total (confer 
section 8.11.2.3)) = 100 mais avec un N = 50 lors d’un essai préalable. Normalement un N = 100 
aurait dû être utilisé pour cette illustration pour être raccord avec le reste des explications). 
(Ancienne interface de SCP) 
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La matrice exprimée en « pixel count », c’est-à-dire en nombre pixels, est plus facilement 

interprétable pour une première approche.  

La matrice « area based error matrix » est exprimée en pourcentage de la surface totale de 

l’image classifiée et c’est cette matrice qui est utilisée pour dériver les paramètres 

d’évaluation de la précision de la classification dans SCP. Quelques informations sont 

disponibles à ce propos dans la documentation officielle en ligne.  

La manière d’interpréter une matrice de confusion est présentée en détails dans la section 

suivante 8.11.2.7 page 285.  
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8.11.2.7. Matrice de confusion : construction et interprétation, un exemple 
illustré 

Considérons une image satellite couvrant une zone d’étude caractérisée par 3 types d’occupation 

du sol à identifier par classification: 

• Eau (rivière, étang) 

• Prairie 

• Forêt 

L’image est classifiée et des zones de validation (ou « Ground truth Region Of Interest ») sont 

créées pour chacune des classes d’occupation du sol (Figure 165). Ces zones correspondent à des 

régions pour lesquelles l’occupation du sol est connue avec certitude, soit via photo-

interprétation, soit via enquête de terrain avec relevés GPS par exemple. La précision de la 

classification de l’ensemble de l’image est ensuite évaluée  en comparant, dans ces zones de 

validation, l’occupation du sol réelle (définie par l’opérateur) avec celle identifiée par le processus 

de classification. 

 
Figure 165 : Image classifiée de la zone d’étude. Les encadrés noirs correspondent aux zones de 
validation ou « Ground truth Region Of Interest ». Les classes auxquelles sont assignées chacune de ces 
zones de validation sont mentionnées au-dessus des encadrés. 
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La matrice de confusion (ou « table de contingence ») (Figure 166) permet d’évaluer la précision 

de la classification (de manière globale et pour chacune des classes). Elle est calculée à partir des 

pixels correctement/incorrectement classifiés dans les zones de validation mais est sensée être 

représentative de la précision de la classification de l’ensemble de l’image. D’où l’importance de 

créer suffisamment de zones de validation, correctement réparties sur l’ensemble de l’image, et 

reprenant l’ensemble des réalités spectrales de chacune des classes de l’image (exemple : créer 

des zones de validation de la classe forêt dans les différents massifs forestiers de l’image qui 

présentent probablement de petites nuances spectrales (variation de l’exposition, des essences, 

de l’ensoleillement, etc). 

Les zones utilisées pour la validation sont : 

• 2 zones de validation pour la classe « Eau », composées de 17 pixels au total 

• 4 zones de validation pour la classe « Prairie », composées de 33 pixels au total 

• 4 zones de validation pour la classe « Forêt », composées de 30 pixels au total 

La matrice de confusion associée à cette classification est reprise à la Figure 166. 

 Zones de validation 

C
la

ss
if

ic
at

io
n

 

 Eau Prairie Forêt Total 
Erreurs de 

commission 
Précision 

d’utilisation 

Eau 17 0 1 18 1/18   (6%) 17/18 (94%) 

Prairie 0 27 3 30 3/30  (10%) 27/30 (90%) 

Forêt 0 6 26 32 6/32  (19%) 26/32 (81%) 

Total 17 33 30 80   

Erreurs 
d’omission 

0/17 
(0%) 

6/33 
(18%) 

4/30 
(13%) 

 
Erreur globale : 
10/80 (12,5%) 

 

Précision de 
production 

17/17 
(100%) 

27/33 
(82%) 

26/30 
(87%) 

  
Précision globale :  

70/80 (87,5%) 
Figure 166 : Matrice de confusion associée à la classification de la Figure 165. 

 
La structure (dans cet exemple-ci) de la matrice de confusion est la suivante : 

• Une colonne de la matrice fait référence aux zones de validation de la classe identifiée par 
cette colonne et permet de calculer l’erreur d’omission de cette classe 

• Une ligne de la matrice fait référence aux pixels classifiés dans la classe identifiée par cette 
ligne (dans les zones de validation de l’ensemble des classes) et permet de calculer l’erreur 
de commission de cette classe 

• La diagonale de la matrice de confusion représente tous les pixels correctement classifiés : 
pixels déclarés (par la création des zones de validation) comme appartenant à une classe 
et classifiés par le logiciel dans cette classe 

• La somme des totaux par lignes ou par colonnes correspondent à la somme des pixels de 
l’ensemble des zones de validation de l’ensemble des classes. 
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Les erreurs d’omission : 

L’erreur d’omission d’une classe donnée est calculée en divisant le nombre total de pixels 
incorrectement classifiés dans les zones de validation de cette classe (« omis » de la classe 
étudiée) par le nombre total de pixels des zones de validation de cette classe. Dans la matrice de 
confusion, ce calcul s’effectue sur base de la colonne correspondant à la classe étudiée. 

• « Eau » : 0 pixel n’ont été mal classifiés sur les 17 pixels des zones de validation de la classe 
« Eau », soit 0/17 = 0% d’erreur d’omission (0% des pixels des zones de validation de la 
classe « Eau » n’ont été omis de la classe « Eau ») 

• « Prairie » : 6 pixel ont été mal classifiés (dans la classe « Forêt ») sur les 33 pixels des 
zones de validation de la classe « Prairie », soit 6/33 = 18% d’erreur d’omission (18% des 
pixels des zones de validation de la classe « Prairie » ont été omis de la classe « Prairie » 
(et classifié dans la classe « Forêt ») alors qu’ils auraient du être classifiés dans la classe 
« Prairie ») 

• « Forêt » : 4 pixel ont été mal classifiés (dans les classes « Eau » et « Prairie») sur les 30 
pixels des zones de validation de la classe « Forêt », soit 4/30 = 13% d’erreur d’omission 
(13% des pixels des zones de validation de la classe « Forêt » ont été omis de la classe 
« Forêt » (et classifié dans les classes « Eau » et « Prairie») alors qu’ils auraient du être 
classifiés dans la classe « Forêt ») 

Les précisions de production : 

La précision de production d’une classe donnée est calculée en divisant le nombre total de pixels 
correctement classifiés dans les zones de validation de cette classe par le nombre total de pixels 
des zones de validation de cette classe. Elle est égale à (1-l’erreur d’omission). 
 
La précision de production mesure la probabilité que le processus de classification ait classifié un 
pixel se trouvant dans une zone de validation d’une certaine classe dans cette classe. 

Autrement dit : 
Probabilité qu’un pixel qui appartient réellement (dans le monde réel) à une classe « a » ait été 
classifié dans cette classe « a ».  

Autrement dit : 
« En tant que producteur d’une classification (celui qui réalise la classification), je me demande, 
pour un pixel appartenant réellement à la classe « a » (dans le monde réel), quelle est la 
probabilité qu’il ait été classifié dans la classe « a » ? » 

Les erreurs de commission : 

L’erreur de commission  d’une classe donnée est calculée en divisant le nombre total de pixels 
incorrectement classifiés dans cette classe dans les zones de validation des autres classes (erreur 
« commise dans les autres classes ») par le nombre total de pixels classifiés dans cette classe sur 
l’ensemble des zones de validation de l’ensemble des classes. Dans la matrice de confusion, ce 
calcul s’effectue sur base de la ligne correspondant à la classe étudiée. 

• « Eau » : 1 pixel a été mal classifié (en tant que « Eau ») alors qu’il appartient (d’après les 
zones de validation) à d’autres classes (ici, la classe « Forêt »), sur un total de 18 pixels 
classifiés dans la classe « Eau » dans l’ensemble des zones de validation de l’ensemble des 
classes, soit 1/18 = 6% d’erreur de commission (6% des pixels classifiés dans la classe 
« Eau » appartiennent en réalité à d’autres classes (ici la classe « Forêt») 
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•  « Prairie » : 3 pixels ont été mal classifiés (en tant que « Prairie ») alors qu’ils 
appartiennent (d’après les zones de validation) à d’autres classes (ici, la classe « Forêt »), 
sur un total de 30 pixels classifiés dans la classe « Prairie » dans l’ensemble des zones de 
validation de l’ensemble des classes, soit 3/30 = 10% d’erreur de commission (10% des 
pixels classifiés dans la classe « Prairie » appartiennent en réalité à d’autres classes (ici la 
classe « Forêt») 

• « Forêt » : 6 pixels ont été mal classifiés (en tant que « Forêt ») alors qu’il appartiennent 
(d’après les zones de validation) à d’autres classes (ici, la classe « Prairie »), sur un total de 
32 pixels classifiés dans la classe « Forêt » dans l’ensemble des zones de validation de 
l’ensemble des classes, soit 6/32 = 19% d’erreur de commission (19% des pixels classifiés 
dans la classe « Forêt » appartiennent en réalité à d’autres classes (ici la classe « Prairie») 

Les précisions d’utilisation : 

La précision d’utilisation d’une classe donnée est calculée en divisant le nombre total de pixels 
correctement classifiés dans cette classe dans l’ensemble des zones de validation de cette classe 
par le nombre total de pixels classifiés dans cette classe dans l’ensemble des zones de validation 
de l’ensemble des classes. Elle est égale à (1-l’erreur de commission). 
 
La précision d’utilisation mesure la probabilité qu’un pixel appartienne réellement à une certaine 
classe lorsque le processus de classification a classifié ce pixel dans cette classe. 

Autrement dit : 
Probabilité qu’un pixel qui a été classifié dans une classe « a » appartienne réellement (dans le 
monde réel) à cette classe « a ». 

Autrement dit : 
« En tant qu’utilisateur d’une classification (celui qui lit/utilise la classification), je me demande, 
pour un pixel classifié dans une classe « a », quelle est la probabilité qu‘il appartienne réellement 
(dans le monde réel)  à la classe « a ». » 

Erreur globale de la classification : 

L’erreur globale de la classification est calculée en divisant le nombre de pixels mal classifiés dans 
l’ensemble des zones de validations de l’ensemble des classes par le nombre de pixels de 
l’ensemble des zones de validation de l’ensemble des classes. L’erreur globale = (1-la précision 
globale). 

• Erreur globale : 10 pixels mal classifiés dans l’ensemble des zones de validation de 
l’ensemble des classes divisé par les 80 pixels de l’ensemble des zones de validation de 
l’ensemble des classes = 12.5 % d’erreur globale. 

Précision globale de la classification : 

La précision globale de la classification est calculée en divisant le nombre de pixels correctement 
classifiés dans l’ensemble des zones de validation de l’ensemble des classes par l’ensemble des 
pixels de l’ensemble des zones de validation de l’ensemble des classes. 

• Précision globale : 70 pixels correctement classifiés dans l’ensemble des zones de 
validations de l’ensemble des classes divisé par les 80 pixels de l’ensemble des zones de 
validation de l’ensemble des classes = 87.5 % de précision globale. La précision globale = 
(1- l’erreur globale) 

Plus d’infos sur les matrices de confusion : Centre Canadien de télédétection 
http://cct.rncan.gc.ca/glossary/index_f.php?id=3124 
 

http://cct.rncan.gc.ca/glossary/index_f.php?id=3124
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8.12. Matrice de transition  

8.12.1. Définition de la matrice de transition 

Une matrice de transition permet de mettre en évidence quantitativement, en termes de 

superficies, l’évolution de l’occupation du sol à partir de 2 images classifiées pour chaque 

combinaison possible de 2 classes.  

8.12.2. Création de la matrice de transition 

• SCP > Post-traitement > Classification croisée  

(Remarque : le menu SCP > Post-traitement > Changement d’occupation des sols produit les 

mêmes résultats mais moins bien présentés, sans matrice) 

Les sorties sont : 

• Une matrice de transition  

• Une image de changement dont les valeurs de pixels correspondent à un code 

identifiant une des combinaisons possibles de changement d’une classe à l’autre 
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Figure 167 : Matrice de transition entre les images Landsat-5 et Sentinel-2 (ancienne interface de 
SCP) 

8.12.3. Interprétation de la matrice de transition  

Il est également important de noter que sur une période aussi longue que sur la période 

considérée dans cet exercice, soit +/- 20 ans, il y a certainement eu des changements 

d’occupation du sol importants intermédiaires qui ne seront évidemment pas mis en 

évidence par l’analyse diachronique basée sur 2 dates seulement. Il faut donc être conscient 

que la représentation de la dynamique de l’occupation du sol dans la région étudiée est 

représentée de manière limitée, limitée aux 2 images utilisées. En 20 ans on pourrait très 

bien imaginer qu’une forêt adulte ait été mise à blanc juste après l’acquisition de la première 

image et qu’une jeune forêt ait eu le temps de repousser suffisamment que pour que cette 

jeune forêt ne soit pas spectralement distinguable d’une forêt adulte. Dès lors, la matrice de 

transition ne pourra pas mettre en évidence cette dynamique « cachée ».  

8.12.4. Mise en relation des précisions de classification et de l’ampleur des 

changements détectés 

Il peut être intéressant de nuancer l’ampleur des changements/évolutions détectés pour 

chacune des classes en fonction de leur précision de classification dans chacune des 2 

images comparées. Par exemple, comment interpréter une faible variation de superficie 

d’une classe pour laquelle une imprécision de classification relativement importante est 

observée. Le changement observé est-il réellement significatif ou bien est-il du uniquement 

ou en grande partie à une imprécision de classification dans l’une ou les deux images ?  
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8.13. Graphiques exprimant l’évolution de l’occupation du 

sol 

2 types de graphiques sont typiquement utilisés pour représenter les résultats issus d’une 

analyse diachronique de l’occupation du sol d’une région. 

Ces graphiques peuvent facilement être réalisés à partir des résultats du menu : 

• SCP > Post-traitement > Rapport de classification  

Les fichiers CSV pourront être éventuellement édité/remanié et les graphiques réalisés : 

• Dans QGIS : avec le plugin Dataplotly (un peu limité) 

• Dans MS-Excel ou OpenOffice-Calc (https://www.openoffice.org/fr/Produits/) (plus 

de possibilités) 

La feuille Excel utilisée pour produire les graphiques ci-dessous est fournie dans le répertoire 

« …\5_CLASSIFICATION_SUPERVISEE_ANALYSE_DIACHRONIQUE\DATA\GRAPHIQUES DE 

TRANSITION.xlsx » 

 

https://www.openoffice.org/fr/Produits/
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8.13.1. Histogramme par classe 

Double bâtonnet pour chaque classe.  

Idéalement une barre d’erreur devrait accompagner chaque bâtonnet.  

 

Figure 168 : Graphique de type histogramme qui permet de comparer l’évolution des pourcentages 
de la superficie totale de la zone d’étude des différentes classes d’occupation du sol entre 2 dates. 

8.13.2. Camembert par classe 

Idéalement une information sur l’erreur  devrait accompagner chaque valeur.  

 

Figure 169 : Graphique de type camembert qui permet de comparer l’évolution des pourcentages 
de la superficie totale de la zone d’étude des différentes classes d’occupation du sol entre 2 dates. 
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8.14. Réalisation de cartes d’occupation du sol - Mise en 

page cartographique 

Les images classifiées, ayant subi  éventuellement l’un ou l’autre post-traitement, pourront 

ensuite faire l’objet d’une mise en page cartographique si celles-ci doivent être présentées 

dans un rapport par exemple.  

La mise en page cartographique consiste en l’habillage des images classifiées à l’aide d’une 

série d’éléments tels légende, barre d’échelle, flèche du Nord, graticule de 

géoréférencement, carte de localisation ou rectangle d’emprise et éléments textuels tels 

titre, auteur, date de création de la carte, système de coordonnées, source et date des 

données, etc 

L’interface de mise en page cartographique d’un projet QGIS est accessible via le menu : 

• Projet > Nouvelle mise en page… > Créer un titre de mise en page 

Pour plus d’information et indications sur la mise en page cartographique, le lecteur est 

invité à consulter 

• la section « Edition cartographique » du manuel de travaux pratiques dans QGIS 

disponible ici https://orbi.uliege.be/handle/2268/190559. 

Lors de l’insertion des cartes issues de l’analyse diachronique dans un rapport, veiller à ce 

que: 

• Vos cartes soient de bonne résolution et parfaitement lisibles (qualité de l’image) 

• Vos cartes soient suffisamment grandes : n’hésitez pas à utiliser une page entière 

par carte 

• Vos cartes soient facilement comparables visuellement en vous assurant, dans le cas 

où une carte est représentée par page, qu’elles apparaitront sur 2 pages en vis-à-vis 

dans votre document. 

https://orbi.uliege.be/handle/2268/190559
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8.15. Discussion et limitations de l’approche 

Quelques éléments importants sont brièvement repris ci-dessous : 

• Les difficultés de photo-interprétation peuvent déboucher sur des erreurs de 

classification et de validation. En particulier, certains pixels mixtes ou « mixel » 

peuvent être difficilement photo-interprétables et constituer de facto une limitation 

dans la possibilité de classification 

• Gardez à l’esprit qu’il est très important que les zones de validation soient 

représentatives de chacune des classes d’occupation du sol afin que la matrice de 

confusion soit effectivement représentative de la précision de classification 

réellement obtenue sur l’ensemble de l’image classifiée.  

• Les masques de nuages ne sont pas toujours évidents à réaliser (bordures de nuages, 

petits nuages, voiles nuageux, etc) ce qui peut induire des erreurs de classification  
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9. Analyse de données SAR SENTINEL-1 

(télédétection active) pour la 

cartographie d’inondation dans SNAP (en 

anglais) 

 

Objectifs 
pédagogiques 

• Se familiariser à l’utilisation du logiciel SNAP, logiciel de référence 
de l’Agence Spatiale Européenne (ESA - European Space Agency) 
pour le traitement des données issues de la constellation de 
satellites « Sentinel »  

• Découvrir quelques traitements spécifiques aux données de type 
RADAR 

• Utiliser des données RADAR (télédétection active) multi-dates pour 
cartographier une inondation 

 

Données 

Les données nécessaires consistent simplement en 2 images Sentinel-1 
(~ 1.09 GB). Pour vous les procurer :  

• Soit téléchargez ces 2 images directement à partir du site web de 
référence comme indiqué dans la section « 9.4 Download of the 2 
Sentinel-1 images (not in the video) » page 298 de ce manuel 
(conseillé) 

• Soit, si cela ne fonctionne pas, téléchargez ces 2 images à partir 
d’ORBI (https://orbi.uliege.be/handle/2268/240835) en 
sélectionnant le dossier « 
\6_SAR_INONDATIONS\MYANMAR_SENTINEL1_SNAP\...» 

Placez les images téléchargées ou le dossier 
« 6_SAR_INONDATIONS.zip » dans votre répertoire de travail, et 
décompressez ce dossier si vous l’avez téléchargé. ATTENTION ! Voyez la 
section 1.2 page 19 pour plus d’information sur l’accès aux données. 

 

Logiciel ou 
application 

SNAP ( https://step.esa.int/main/download/snap-download/)  
ATTENTION ! Le logiciel SNAP de l’ESA, gratuit, nécessite pour certaines 
opérations une certaine « puissance » de l’ordinateur que nombres « 
d’ordinateurs étudiants » n’ont pas, ce qui résulte parfois en des temps 
de traitements à rallonge, voire des bugs. 

 

Temps 
approximatif 

~ 1h30 à 2h00 

https://orbi.uliege.be/handle/2268/240835
https://step.esa.int/main/download/snap-download/
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Prérequis 
Aucun. Cependant, certaines connaissances théoriques préalables sur la 
télédétection RADAR permettront à l’apprenant de mieux comprendre 
les manipulations réalisées.  

 
# Télédétection active, RADAR, SAR, Sentinel 1, SNAP 

9.1. Tutoriel source: “ESA Echoes in Space - Hazard: Flood 

mapping with Sentinel-1 (ESA EO College)” 

Cette section se base sur le tutoriel vidéo (chaine YouTube “EO College”) intitulé « ESA 

Echoes in Space - Hazard: Flood mapping with Sentinel-1 (ESA EO College)” du 5 novembre 

2017 dans lequel Dr. Chris Stewart explique comment dériver une carte d’inondation (flood 

map) à partir de 2 images Sentinel-1 en utilisant le logiciel gratuit de l’ESA « SNAP ». Ce 

tutoriel vidéo est disponible ici : 

• https://www.youtube.com/watch?v=derOXkPCH80  

Cette section propose une transcription adaptée de la vidéo, augmentée de quelques 

commentaires et illustrations supplémentaires (aussi disponible ici : 

https://orbi.uliege.be/handle/2268/240620) 

9.2. Objective (video timing: 0 min 00 sec) 

• To map flooded area with Sentinel-1 data by a simple technique: using an image 

before the flood (called the “Archive image”) and an image during the flood (called 

the “Crisis image”) to distinguish between: 

o Flooded area 

o Permanent water bodies 

9.3. Technical description of the 2 Sentinel-1 images used 

• 2 Sentinel-1 images over a part of Myanmar, with the following technical features: 

o Remarque 

▪ The filename conventions of Sentinel products are available here : 

https://sentinel.esa.int/web/sentinel/user-guides/sentinel-1-

sar/naming-conventions  

o Pass ascending 

▪ Part of the satellite orbit trajectory going from South to North poles, 

information available in the Metadata, confer Figure 175 page 303 

https://www.youtube.com/watch?v=derOXkPCH80
https://orbi.uliege.be/handle/2268/240620
https://sentinel.esa.int/web/sentinel/user-guides/sentinel-1-sar/naming-conventions
https://sentinel.esa.int/web/sentinel/user-guides/sentinel-1-sar/naming-conventions
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o Mode VV 

▪ Polarization mode of the SAR signal: Vertical emitted by the sensor 

and Vertically received by the sensor 

o Sensor mode IW 

▪ Interferometric Wide acquisition mode (Figure 170): confer here for 

more information: https://sentinel.esa.int/web/sentinel/user-

guides/sentinel-1-sar/acquisition-modes 

o Product type GRD 

▪ Ground Range Detected 

▪ More information here: 

https://sentinel.esa.int/web/sentinel/missions/sentinel-1/data-

products 

▪ Remarque: in GRDH (confer image filename), the H stands for the 

resolution class, which is High (H) in this case) 

 

Figure 170 : Sentinel-1 Product Modes (Source : https://sentinel.esa.int/web/sentinel/user-
guides/sentinel-1-sar/acquisition-modes) 

https://sentinel.esa.int/web/sentinel/user-guides/sentinel-1-sar/acquisition-modes
https://sentinel.esa.int/web/sentinel/user-guides/sentinel-1-sar/acquisition-modes
https://sentinel.esa.int/web/sentinel/missions/sentinel-1/data-products
https://sentinel.esa.int/web/sentinel/missions/sentinel-1/data-products
https://sentinel.esa.int/web/sentinel/user-guides/sentinel-1-sar/acquisition-modes
https://sentinel.esa.int/web/sentinel/user-guides/sentinel-1-sar/acquisition-modes
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9.4. Download of the 2 Sentinel-1 images (not in the video) 

• Go to the “Copernicus Open Access Hub” https://scihub.copernicus.eu/dhus/#/home 

• Create an account and then log in 

• Search and download the 2 images 

o You can use the image name (confer below) without “.zip” extension in the 

search menu to easily find the images, one by one (Figure 171) 

o The 2 images used are (table below): 

Image timing Date Image filename 

Archive image before the 
flood 

2015 03 
20 

S1A_IW_GRDH_1SSV_20150320T114745_201
50320T114810_005115_0066FA_82D7.zip 

Crisis image during the flood 2015 09 
04 

S1A_IW_GRDH_1SSV_20150904T114747_201
50904T114812_007565_00A772_B9FD.zip 

 

 

Figure 171 : Copernicus Open Access Hub with one of the 2 Sentinel-1 images identified over 
Myanmar 

https://scihub.copernicus.eu/dhus/#/home
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9.5. SNAP software - Download and installation (not in the 

video) 

• You can download the free SNAP software here:  

o https://step.esa.int/main/download/snap-download/ 

o Choose the « Sentinel Toolboxes » or “All Toolboxes”  in the table and the 

download adapted to your operating system 

• Install SNAP on your computer and make the updates after installation 

 

Figure 172 : Outlook of the SNAP (STEP) software download web page 

 

https://step.esa.int/main/download/snap-download/


300 
 

9.6. Opening of the 2 Sentinel-1 images in SNAP (video 

timing: 0 min 30 sec) 

• Simply drag and drop the zip images to the “Product Explorer” tab of SNAP (there is 

no need to unzip the images!)  

• In the “World View” tab, you can see that the images are over a part of Myanmar 

• In the “Product Explorer” tab, expand for each image the sub-folder “Bands > 

Amplitude_VV” and double-clic on “Amplitude_VV” which will open the images in 

the viewer 

o Open first the Archive image → in viewer 1 

o Open then the Crisis image → in viewer 2 

• Remarque: notice that there are 2 bands per image, Amplitude and Intensity. 

Definition: 

o Amplitude_VV image 

▪ “A SAR signal contains amplitude and phase information. Amplitude is 

the strength of the radar response” (source: 

https://sentinel.esa.int/web/sentinel/user-guides/sentinel-1-

sar/product-overview/interferometry).  

▪ “Measure of the strength of a signal, and in particular the strength or 

height of an electromagnetic wave (units of voltage).” (source: 

https://earth.esa.int/handbooks/asar/CNTR5-2.html)  

o Intensity_VV image 

▪ Intensity = Amplitude_VV * Amplitude_VV 

• Observe the images (Figure 174): 

o You can zoom or move into the images by using the mouse wheel or the 

panning tool  

o In the crisis image: 

▪ Flooded area: appears darker because of a low backscatter due to 

specular reflection over the smooth water surfaces: the signal get 

reflected away from the sensor.  

▪ The surrounding areas: are much rougher and look brighter. 

▪ Images distortion is visible in the mountain areas of the image due to 

the layover and foreshortening effects (Figure 173) 

Foreshortening Layover 

https://sentinel.esa.int/web/sentinel/user-guides/sentinel-1-sar/product-overview/interferometry
https://sentinel.esa.int/web/sentinel/user-guides/sentinel-1-sar/product-overview/interferometry
https://earth.esa.int/handbooks/asar/CNTR5-2.html
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Figure 173 : Illustration of the Foreshortening and Layover effects: geometric distortions in 
mountainous regions (Source: https://earth.esa.int/web/guest/missions/esa-operational-eo-
missions/ers/instruments/sar/applications/radar-courses/content-2/-
/asset_publisher/qIBc6NYRXfnG/content/radar-course-2-slant-range-ground-range#sixteen) 

9.7. Main steps of the workflow described in this section 

(video timing: 2 min 18 sec) 

• Make a spatial subset of the images around the river over the flooded areas 

• Apply a “multilooking” in order to reduce the speckle, and this also reduces the 

dimension of the images and speed up the processing time 

• Apply a calibration which is essential to compare 2 images: to go from Digital 

Numbers (DN) to a physical quantity which is in this case “sigma0 backscatter” 

• Apply a terrain correction to project the images onto a map system and also to 

correct for the distortions due to the terrain 

• Combine the 2 images in a RGB composite in order to distinguish between flooded 

areas and permanent water bodies 

https://earth.esa.int/web/guest/missions/esa-operational-eo-missions/ers/instruments/sar/applications/radar-courses/content-2/-/asset_publisher/qIBc6NYRXfnG/content/radar-course-2-slant-range-ground-range#sixteen
https://earth.esa.int/web/guest/missions/esa-operational-eo-missions/ers/instruments/sar/applications/radar-courses/content-2/-/asset_publisher/qIBc6NYRXfnG/content/radar-course-2-slant-range-ground-range#sixteen
https://earth.esa.int/web/guest/missions/esa-operational-eo-missions/ers/instruments/sar/applications/radar-courses/content-2/-/asset_publisher/qIBc6NYRXfnG/content/radar-course-2-slant-range-ground-range#sixteen
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9.8. Visual analysis of the 2 images side by side (video 

timing: 3 min 09 sec) 

• Menu: Window > Tile evenly 

• You should synchronize the 2 windows (and optionally the mouse pointer) by using, 

in the “Navigation” tab of the bottom left panel, the 2 related tools button 

 

Figure 174 : The archive/normal situation (left) and crisis/flood (right) Sentinel-1 images over 
Myanmar displayed evenly in SNAP interface  
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9.9. Analysis of images Metadata (video timing: 3 min 15 

sec) 

• In the “Product Explorer” tab, open the subfolders “Metadata > Abstracted 

Metadata” and double-click on it to open it (Figure 175). You can see that: 

o Both images were acquired in the same geometry which is essential for flood 

mapping:  

▪ PASS = ASCENDING: satellite ascending 

▪ incidence_near (30.9°) & incidence _far (46.1°): same incidence angle  

o PRODUCT_TYPE = GRD 

o ACQUISITION_MODE = IW 

o mds1_tx_rx_polar = VV (and no info for mds2…, mds3…, mds4…) 

o etc 

• There is a shift in Azimuth (in the North-South direction, the 2 images do not 

perfectly cover the same area) but this is not a problem 

• To know what image is open in what tab: look at the number  between [] both in the 

“Product Explorer” tab and in the visualization windows 

 

Figure 175 : Outlook of some Abstracted Metadata of one Sentinel-1 image. The […] means that 
some metadata are skipped from this illustration 
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9.10. Spatial subset of the images, on an area common to 

the 2 images, where the main floods occur (video 

timing: 3 min 53 sec) 

• Identify in the navigation tab an area which is common to both images: zoom and 

pan in order to display that common area in the viewers (Figure 174) 

• Click, in the geographical interface, on the image you want to process in order to 

select/active it, in order to use this image current extent for the spatial subset 

• Menu: Raster > Subset (video timing: 4 min 03 sec) 

o The subset corresponds to the extent of the viewer. You can visually check 

that in the tool interface 

o Click OK 

o Repeat the operation for both images 

 

Figure 176 : Spatial subset of Sentinel-1 image 

• The outputs appear automatically in the “Product Explorer” as virtual files/image.  

• They then have to be saved to real file (real image) with either 

o Select the file in the “Product Explorer” tab, then File > Save Product > 

o or Right click on the file in the “Product Explorer” tab, then > Save Product 

• Say Yes to BEAM-DIMAP format 

• Give a Shorter filename than the original long filename: 
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o Keep the most important information: date product, processing level etc 

o Remove the automatically created prefix (“subset_0_of_”) 

o And give also a suffix “crop” (or “subset”) in order to easily identify the 

output image as the subset image  

o Select your working directory where to store the output images  

o The output filenames of the 2 images are, in the video: 

▪ S1A_IW_GRDH_1SSV_20150320T114745_crop.zip 

▪ S1A_IW_GRDH_1SSV_20150904T114747_crop.zip 

o Click on Save 

• The 2 subseted images are now present in you working directory 

 

9.11. Intermediate steps: closing/opening images (video 

timing: 6 min 00 sec) 

• Close all images in the “Product explorer” tab 

o Right click in the left panel > Close All Products 

• Open only the 2 subset images in SNAP  

o Drag and drop them to the “Product explorer” tab from your working 

directory 
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9.12. Multilooking (video timing: 6 min 30 sec) 

• Purpose: to reduce the speckle and reduce the dimension of the image to speed up 

the processing time. This will also result in a loss of accuracy (spatial resolution) but 

this is not a problem in this particular case because the flooded area is large and we 

are not particularly interested in having a high resolution flood map. 

• Menu: Radar > SAR Utilities > Multilooking (this directory is a bit different than in 

the tutorial video due to different SNAP software versions) (Figure 177) 

o In the “I/O Parameters” window 

▪ Keep default added suffix “ML” in the output filename 

▪ Select your working directory as output directory 

o In the “Processing Parameters” window 

▪ Set the Number of Range/Azimuth Looks to 3 by 3 

o Click on Run 

o Repeat the process for the other image 

  
Figure 177 : Parametrization of the Multilooking tool of SNAP 

•  (Remarque: after this operation, the subseted images cannot be synchronized well 

with the original images because a size reduction has been applied, reason why all 

products were closed in the previous “intermediate steps”) 
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9.13. Radiometric Calibration (video timing: 7 min 35 sec) 

• Calibration is essential to enable the comparison of the 2 images 

• Calibration transforms Digital Numbers (DN) to a physical quantity which is in this 

case “sigma0 backscatter” 

• Definition:  

o “Backscatter: […] The normalised measure of the radar return from a 

distributed target is called the backscatter coefficient, or sigma nought , and 

is defined as per unit area on the ground.”  

o “Sigma Nought: Scattering coefficient, or the conventional measure of the 

strength of radar signals reflected by a distributed scatterer, usually 

expressed in dB. It is a normalised dimensionless number, comparing the 

strength observed to that expected from an area of one square meter.” 

o (Source: https://sentinel.esa.int/web/sentinel/user-guides/sentinel-1-

sar/definitions) 

• Menu: Radar > Radiometric > Calibrate (Figure 178) 

o In the “I/O Parameters” window 

▪ Select the “ML” images as input 

▪ Keep default added suffix “Cal” in the output filename 

▪ Select your working directory as output directory 

o In the “Processing Parameters” window 

▪ Check “Output sigma0 band” (= ratio instant/receive backscatter per 

unit area in ground range)  

o Click on Run 

o Repeat the process for the other image  

  
Figure 178 : Parametrization of the Radar Radiometric Calibration tool of SNAP 

https://sentinel.esa.int/web/sentinel/user-guides/sentinel-1-sar/definitions
https://sentinel.esa.int/web/sentinel/user-guides/sentinel-1-sar/definitions
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9.14. Intermediate steps: visualization (video timing: 8 min 

22 sec) 

• Visualize the 2 sigma0 images in the viewer 

o Double-click on each calibrated images in the “Product Explorer” window to 

open them in the SNAP viewer (“Sigma0_VV” is the name of the calibrated 

images) 

o Menu: Window > Tile Evenly to display the images side by side 

 

Figure 179 : Subseted, Multilooked and Radiometrically Calibrated (Sigma0_VV) Sentinel-1 images 
displayed side by side 

• Many pixels are quite dark 

• Select the flood image in the viewer 

• Go to the Colour Manipulation window (bottom left panel):  

o Most of the pixels have low backscatter value 

o Few pixels have very high value 

• Convert values from linear scale to non-linear logarithmic scale decibel (dB) to get a 

better visualization and an histogram easier to manipulate  
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o Right click on the band to convert (Sigma0_VV) > Linear to/from dB > Yes to 

create a new virtual band 

o Repeat that for the other image 

• Open the 2 converted images in dB by double-clicking on them  

• Menu: Window > Tile evenly (you can rearrange the windows if you want) (Figure 

180) 

• In dB, there is a much better distinction between land and water pixels 

• We can see 2 peaks in the dB images histograms: 

o 1 small low values peak for pixels over water 

o 1 big high values peak for land pixel 

• Close all images from the viewer but keep the images in the “Product Explorer” tab 

 

Figure 180 : Comparison of the Sigma0_VV Sentinel-1 images before (above) and after (below) the 
“Linear to/from dB” image histogram conversion for the archive (left) and flood (right) images 
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9.15. Terrain Correction (video timing: 10 min 22 sec) 

• Purpose: 

o To project the image into a coordinates system, and  

o To correct for distortion due to the mountainous terrain 

• Menu: Radar > Geometric > Terrain correction > Range-Doppler Terrain Correction 

> all parameters by default > Run (default suffix = TC) (Figure 181) 

o In the “I/O Parameters” window 

▪ Select the “ML_cal” images as input 

▪ Keep default added suffix “TC” in the output filename 

▪ Select your working directory as output directory 

o In the “Processing Parameters” window 

▪ Keep all default parameters (WGS84 map projection) 

o Click on Run 

o Repeat the process for the other image 

  
Figure 181 : Parametrization of the Range Doppler Terrain Correction tool of SNAP 
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9.16. Visualization of the terrain corrected images (video 

timing: 11 min 32 sec) 

• Convert the “TC” bands to dB (confer method explained above) 

• Convert the virtual created dB bands to real file 

o Right click on the dB band > convert band 

• Save to dB band to file 

o Select the dB band > Main menu File > Save Product: this saves the dB band 

to the image 

• Visualize the dB terrain corrected bands 

o The image has been projected into a coordinate system: the TC image 

orientation has changed! (Figure 182) 

o In order to be able to compare the non TC an TC images visually, you have to 

unsynchronize the views with the dedicated button in the “Navigation” tab 

(bottom left panel), and then open each image in a window that you can 

display side by side. You will maybe have to unzoom a lot from one of the two 

images to adjust the visualization.  

o There is no more distortion in the mountain area (Figure 183) 

o (You could also do a contrast stretch with the “Color Manipulation” tab 

(bottom left panel) to highlight only the pixels over the land) 
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Figure 182 : Comparison of the archive Sentinel-1 images before (left) and after (right) the Terrain 
Correction: change of the image orientation due to the projection into a coordinate system  

 

Figure 183 : Comparison of the archive Sentinel-1 images before (left) and after (right) the Terrain 
Correction for a mountainous area: the geometric distortion have been corrected 



313 
 

9.17. Combination of the Archive and Crisis images to 

produce a RGB composite of the flooded area, 

preliminary step: images stack (video timing: 13 min 

25 sec) 

• Purpose of the RGB composite: to enable the distinction of permanent water bodies 

and flooded areas.  

• Remarque: The RGB composite is effectively produced in the section 9.19 page 316. 

• Application of a stack by simply using the products geolocation 

o Menu: Radar > Coregistraction > Stack Tools > Crate Stack tabs 

o In window “1-ProductSet-Reader” 

▪ Click on the “Add opened” button > and keep only the TC file by 

removing unwanted files or open only the 2 images of interest with 

the Add button 

o In window “2-CreateStack” 

▪ Choose “Product Geolocation” for “Initial offset method” 

▪ ([…Remarque: for interferometry, a much more precise geolocalization 

method should be used…]) 

o In window “3-Write” 

▪ Remove part of the filename which is not common to both images: the 

acquisition dates 

o Select Run 

o Close window 
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Figure 184 : Parametrization of the « Create Stack » tool of SNAP 
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9.18. Overlay of the stacked images for visual comparison of 

the 2 images (optional) 

•  (This step is not really necessary in the general workflow) (video timing: 15 min 33 

sec) 

o We get the stack image file which is one single image file that contains 4 

layers coming from the 2 archive and crisis images in the “Bands” subfolder 

o Open the 2 images in dB  

o Apply a contrast stretch with the histogram focused on the higher pixel 

values peak 

o To overlay the 2 images in the same viewer: 

▪ Click on the Archive image in the viewer to select it 

▪ Go to “Layer manager” (right panel) > + icon >Image of Band / Tie-

point Grid > Next > overlay the 2nd image in dB (Crisis image) on the 

first one > Finish 

o You can then compare both images by checking unchecking one image in the 

right panel “Layer manager” or by playing with the transparency slider at the 

bottom of the “Layer manager” 

 

Figure 185 : Overlay of the 2 TC dB images in 1 viewer and use of the « Layer Manager » panel 
allowing to check/uncheck one of the 2 overlaid layers as well as applying a transparency in order 
to compare the 2 images 
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9.19. RGB composite image (video timing: 16 min 50 sec) 

• Purpose: to distinguish between flooded area and permanent water bodies 

• Select the name of the stack file in the “Product Explorer” window 

• Menu: Window > Open RGB window 

o Red band: select Archive image 

o Green and Blue bands: select Crisis image 

o Click OK 

o View the flood map (Figure 186) 

 

 

Figure 186 : RGB composite using, in the Red band, the Archive image, and in the Green and Blue 
bands, the Crisis image 
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9.20. Interpretation of the RGB composite image (video 

timing: 17 min 28 sec) 

• The RGB composite image is presented in Figure 186. 

• Flooded areas 

o Appears in red because, given the selected RGB composite above, where 

floods occur,  

▪ the Archive image (in the red channel) has higher backscatter (no 

flood) than  

▪ the Crisis image (in the green and blue channel) (low backscatter for 

flooded areas)  

o So for flooded areas, there is a high value in the red channel and low value in 

the green and blue channels. 

• Non-flooded land 

o Appears in tones of gray as there is approximately the same backscatter for 

the 2 images (no difference), and that that “same” information is associated 

to all 3 channels 

• Permanent water bodies 

o Appears as uniform dark areas as there is a low backscatter values for both 

Archive and Crisis images, both associated to the 3 RGB channels   

• Some part of the land are cyan 

o This translates a higher response in the green and blue channels 

corresponding to the crisis image, than in the Archive image. This may be due 

to particular ground cover which is not related to flood. 
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9.21. Exportation of the RGB composite of the flood map in 

another format and visualization of the result in 

GOOGLE EARTH PRO (video timing: 19 min 22 sec)  

• (Menu: File > Export > Geotiff). This step is not done in the video. This is just an 

example.  

• The visualization of the RGB composite of the flood map in GOOGLE EARTH PRO is 

presented in (Figure 187). 

• Right click on the view > Export View as Google Earth KMZ 

o Record the output in your working directory and call it for example “Flood” 

o Browse to you working directory where the file “Flood.kmz” has been saved 

o If you have Google Earth Pro installed on your computer, you can simply 

double-click on this file and it will automatically open in Google Earth at the 

right position.  

o (If you do not have Google Earth Pro installed on your computer, you can get 

it here for example: https://www.google.com/intl/fr_ALL/earth/versions/ 

(bottom of page)) 

o You can then compare the flood map with Google Earth Pro imagery and 

also check the registration (georeferencing) of the flood map, which is good 

in this case (by deselecting the layer or playing with the layer transparency). 

In Google Earth Pro you can also apply an oblique view and ask for a 3D 

rendering of the natural relief (that can be exaggerated: menu Tools > 

Options > 3D View > Relief > and set the elevation factor to 3). 

https://www.google.com/intl/fr_ALL/earth/versions/
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Figure 187 : Outlook of the RGB composite flood map overlaid in Google Earth Pro with an oblique 
3D view 
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9.22. Autre tutoriel: Satellite Remote Sensing of Flood 

Monitoring and Management (NASA ARSET) 

Ce tutoriel en anglais présente différentes méthodes d’identification des zones inondées à 

parti d’images SAR Sentinel-1 dans le logiciel SNAP et Google Earth Engine. Les méthodes 

proposées sont : 

• Composition RGB multi-temporelle dans SNAP (même méthode que dans la section 9 

de ce manuel). 

• Classification par seuillage simple dans SNAP 

• Classification supervisée par « random forest » dans SNAP 

• Classification par seuillage simple dans Google Earth Engine 

La page principale du workshop de 2 jours est : 

• https://arset.gsfc.nasa.gov/water/workshops/india2018 

Documents particulièrement intéressants : 

• SAR Applications for Flood Mapping / SAR Application for Mapping the Kerala Floods, 

tutoriel SNAP + Sentinel-1, PDF : 

https://arset.gsfc.nasa.gov/sites/default/files/disasters/IndiaFlood18/sar_hands_on_

india-final.pdf  

• Rappel théorique utile sur le SAR : 

https://arset.gsfc.nasa.gov/sites/default/files/disasters/IndiaFlood18/D2P2-

Overview-SAR-final.pdf 

 

https://arset.gsfc.nasa.gov/water/workshops/india2018
https://arset.gsfc.nasa.gov/sites/default/files/disasters/IndiaFlood18/sar_hands_on_india-final.pdf
https://arset.gsfc.nasa.gov/sites/default/files/disasters/IndiaFlood18/sar_hands_on_india-final.pdf
https://arset.gsfc.nasa.gov/sites/default/files/disasters/IndiaFlood18/D2P2-Overview-SAR-final.pdf
https://arset.gsfc.nasa.gov/sites/default/files/disasters/IndiaFlood18/D2P2-Overview-SAR-final.pdf
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10. Cartographie d’inondations par 

télédétection RADAR (Sentinel-1) et 

multispectrale (Sentinel-2) 

 

Objectifs 
pédagogiques 

• Découvrir et utiliser l’application web de référence EO BROWSER 

pour évaluer l’ampleur d’inondations à partir de l’analyse visuelle 

de données satellites Sentinel-1 (RADAR) et Sentinel-2 

(multispectrale) et réaliser des illustrations dérivées dont des 

« time-lapse » (animation vidéo) traduisant la dynamique de ces 

inondations. 

• Se rendre compte de la complémentarité des données spectrales 

(ex : Sentinel-2) et RADAR (ex : Sentinel-1) 

• Découvrir très brièvement le service “Emergency Management 

Service (EMS) – Mapping » du programme Copernicus. 

 

Données Aucune 

 

Logiciel ou 
application 

• EO BROWSER : 
o https://www.sentinel-hub.com/explore/eobrowser/  

• Copernicus Emergency Management Service (EMS) – Rapid 
Mapping :  

o https://emergency.copernicus.eu/mapping/list-of-
activations-rapid 

 

Temps 
approximatif 

~ 30 minutes 

 

Prérequis 
Quelques connaissances théoriques sur la télédétection multispectrale et 
RADAR vous permettront de mieux comprendre cette section, bien 
qu’elles ne soient pas indispensables pour sa réalisation.  

 

Consignes 
évaluation 

Sont surlignées en jaune et en italique dans le texte ci-dessous, des consignes qui 
pourraient servir à l’évaluation potentielle de la bonne réalisation de cette section, à 
travers la production d’un petit rapport. 

 
# inondations, radar, sentinel-1, multispectral, sentinel-2, EOBROWSER, Copernicus 
Emergency Management Service (EMS) – Rapid Mapping 

https://www.sentinel-hub.com/explore/eobrowser/
https://emergency.copernicus.eu/mapping/list-of-activations-rapid
https://emergency.copernicus.eu/mapping/list-of-activations-rapid
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10.1. Accès à l’application EO BROWSER 

• Rendez-vous sur la page web de l’application EO BROWSER disponible ici (Figure 

188): 

o https://www.sentinel-hub.com/explore/eobrowser/ 

• Descendez légèrement sur cette page et utilisez le menu « START EXPLORING ! »  

• Créez-vous un compte EOBROWSER: bouton Login > Sign Up > finalisez cette 

procédure d’enregistrement > Loguez-vous 

 

 

Figure 188 : Page d’accueil du site web EO BROWSER 

10.2. Visualisation de zones irriguées sur une image RADAR 

Sentinel-1 

• Dans EO BROWSER, recherchez une image RADAR Sentinel-1 sur une zone de 

cultures irriguées et remarquez que les parcelles irriguées apparaissent dans une 

couleur similaire à celle des masses d’eau (bleu en mode de visualisation « Enhanced 

visualization » (Figure 189). 
o Insérez la capture d’écran correspondante dans votre rapport 

https://www.sentinel-hub.com/explore/eobrowser/
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Figure 189 : Exemple de visualisation d’un périmètre irrigué (parcelles agricoles irriguées) dans le 
Sud du Myanmar, à 40 km à l’Est de Yangon (Rangoun) 
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10.3. Visualisation d’une zone inondée sur une image 

RADAR Sentinel-1 et sur une image multispectrale 

Sentinel-2 

• L’importante inondation en amont de la ville de Khartoum au Soudan en septembre 

2020 est utilisée dans cette section à titre d’exemple. Vous pouvez éventuellement 

effectuer la même démarche pour une autre inondation. 

• Aperçu contextuel de terrain ici (ne visionnez pas les vidéos dans toute leur longueur. 

Visionnez quelques courts extraits pour vous faire une petite idée de la situation sur 

le terrain):  

o https://www.youtube.com/watch?v=m7vN5RaAITw  

o https://www.youtube.com/watch?v=WQVjrtA4jQI  

  
Figure 190 : inondation à Khartoum (Soudan) en septembre 2020 

• Localisation générale de la ville de Khartoum (Soudan) 

o https://www.google.be/maps/@16.3735079,30.8845826,6.18z 

• Cartographie de l’inondation par comparaison de la situation avant/pendant 

disponible sur le site web NASA EARTH OBSERVATORY : 

o https://earthobservatory.nasa.gov/images/147288/record-flooding-in-sudan  

o L’outil swipe permet de comparer facilement les situations avant (2016) 

versus pendant (2020) l’inondation en amont de la ville de Khartoum à partir 

d’images satellites Landsat-8. 

https://www.youtube.com/watch?v=m7vN5RaAITw
https://www.youtube.com/watch?v=WQVjrtA4jQI
https://www.google.be/maps/@16.3735079,30.8845826,6.18z
https://earthobservatory.nasa.gov/images/147288/record-flooding-in-sudan
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23 septembre 2016 (avant l’inondation) 

 
2 septembre 2020 (pendant l’inondation) 

 

• Cartographie de l’inondation par UNITAR (United Nations Institute for Training and 

Research) 

o https://www.unitar.org/maps/map/3107  

o “This map illustrates satellite-detected surface waters over Khartoum, Al-

Jazirah and White Nile states in Sudan as observed from Sentinel-2 image 

acquired on 30 Aug 2020.” 

https://www.unitar.org/maps/map/3107
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Figure 191 : Cartographie des zones inondées (en rouge) aux alentours de la ville de Khartoum 
(Soudan) le 30 août 2020 à partir d’une image Sentinel-2 

• Visualisation de l’inondation dans l’application EO BROWSER :  

o Cherchez des images Sentinel-1 et Sentinel-2 sur la zone inondée, par 

exemple des images datant de fin août / début septembre 2020 sur 

Khartoum. 

▪ Utilisez la meilleure option de visualisation pour chaque type d’image  
▪ Insérez les 2 captures d’écran correspondantes dans votre rapport (Sentinel-1 et 

Sentinel-2)  
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2 octobre 2016 - Sentinel-1 

 
11 septembre 2020 - Sentinel-1 

 
8 janvier 2017 - Sentinel-2 

(pas de donnée Sentinel-2 2016 dans EO 
BROWSER) 

 
9 septembre 2020 - Sentinel-2 

Figure 192 : Le Nil Blanc en amont de la ville de Khartoum (Soudan) tel que vu par Sentinel-1 (en 
haut) et Sentinel-2 (en bas) en absence de crue (à gauche) et en période de crue (à droite) 

 

o Réalisez 2 « time-lapse » (animation vidéo) de fréquence hebdomadaire sur 

base d’images Sentinel-1 et Sentinel-2 sur la zone inondée, sur une période 

de 5 mois précédant l’inondation et incluant la période d’inondation, par 

exemple entre début mai et mi-septembre 2020 sur Khartoum, pour mettre 

en évidence l’évolution spatio-temporelle de l’inondation. 
▪ Insérez une capture d’écran de la création d’un time-lapse dans votre rapport.  

▪ Téléchargez les 2 time-lapse (Sentinel-1 et Sentinel-2) et placez-les dans votre 

dossier pour l’évaluation.  

▪ Commentez brièvement les avantages et inconvénients des 2 types d’images utilisés 

pour réaliser le suivi de l’évolution d’une inondation.  

10.4. Emergency Management Service - Mapping : EMS 

Copernicus 
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• Notez l’existence du service Copernicus Emergency Management Service (EMS) – 

Rapid Mapping :  

o https://emergency.copernicus.eu/mapping/list-of-activations-rapid 

• Et jetez un œil au type de cartes produites par ce service. Par exemple, la carte sur 

les inondations de 2020 au Niger : 

o https://emergency.copernicus.eu/mapping/ems-product-

component/EMSR466_AOI01_DEL_PRODUCT_r1_RTP01/1  

10.5. Déformations géométriques des images RADAR 

Sentinel-1 liées au relief 

Cette section n’a pas de rapport direct avec la détection des inondations par télédétection 

RADAR. Il est donné à titre complémentaire.  

• Dans EO BROWSER, recherchez une image Sentinel-1 sur une zone montagneuse de 

votre choix qui met en évidence les effets de déformations géométriques typiques 

des images RADAR et produisez une vue 3D à l’aide du bouton « cube » disponible à 

droite de l’interface (via un clic-droit maintenu enfoncé sur l’interface de 

visualisation 3D avec déplacement simultané de la souris) (confer Figure 193 et 

Figure 194)  
o Insérez les 2 captures d’écran correspondantes (2D et 3D) dans votre rapport 

 

Figure 193 : Exemple de déformations géométriques observées sur une image Radar Sentinel-1 en 
zones montagneuses (Nord de la Géorgie)  

https://emergency.copernicus.eu/mapping/list-of-activations-rapid
https://emergency.copernicus.eu/mapping/ems-product-component/EMSR466_AOI01_DEL_PRODUCT_r1_RTP01/1
https://emergency.copernicus.eu/mapping/ems-product-component/EMSR466_AOI01_DEL_PRODUCT_r1_RTP01/1
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Figure 194 : Exemple de représentation 3D dans EOBROWSER à partir d’une image Radar Sentinel-1 
en zones montagneuses (Nord de la Géorgie) 
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11. SPIRITS : Analyse d’une série temporelle 

d’images NDVI basse résolution dans 

SPIRITS 

 

 

Objectifs 
pédagogiques 

Vous initier à l’utilisation et aux concepts d’un logiciel de référence 
(SPIRITS) pour le traitement des séries temporelles d’images satellites 
basse résolution. En particulier 

• Télécharger et prétraiter une série temporelle d’images 
(décompression, renommage, importation, etc) 

• Réaliser des traitements en lot/en série (dont production de 
cartes, extraction de statistiques par zone, etc) 

• Lissage temporel des images (filtre temporel)  

• Calcul d’images d’anomalie des conditions de végétation 

• Calcul d’images de paramètres phénologiques 

 

Données 

Les données nécessaires à la réalisation de cet exercice ET les données 
résultant des opérations à faire dans cet exercice sont toutes disponibles 
dans le dossier «…\7_SERIE_TEMPORELLE_SPIRITS\ 
TIME_SERIES_ANALYSIS\...» (~ 1.2 GB). 

Téléchargez ce dossier sur votre ordinateur en local dans votre 
répertoire de travail et décompressez-le. ATTENTION ! Voyez la section 
1.2 page 19 pour plus d’information sur l’accès aux données. 

ATTENTION ! Pour le bon fonctionnement de l’ensemble des outils pré-

paramétrés mis à votre disposition dans ce dossier, il est IMPORTANT 

que vous placiez le dossier « TIME_SERIES_ANALYSIS » à la racine du 

disque C de votre ordinateur pour obtenir le répertoire 

« C:\TIME_SERIES_ANALYSIS\... ». 

 

Logiciel ou 
application 

SPIRITS (https://mars.jrc.ec.europa.eu/asap/download.php) 

ATTENTION ! Ce logiciel est déjà inclus dans le dossier mis à disposition 
« TIME_SERIES_ANALYSIS\SPIRITS\SpiritsExtract_152\ ». Pas besoin de 
le re-télécharger donc ! De plus il n’y a pas de procédure d’installation. Il 
doit simplement être disponible dans le répertoire dans lequel il se 
trouve actuellement.  

 

https://mars.jrc.ec.europa.eu/asap/download.php
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Temps 
approximatif 

~ 4 à 6 heures 

 

Prérequis Aucun 

 
# série temporelle, basse résolution spatiale, indice de végétation 

 

 

11.1. Contenu du dossier de l’exercice 

Le contenu du  dossier « 7_SERIE_TEMPORELLE_SPIRITS » utilisé dans le cadre de cet 

exercice est présenté à la Figure 195.  

 
Figure 195 : Présentation du contenu du dossier nécessaire à cet exercice 

ATTENTION ! Pour le bon fonctionnement de l’ensemble des outils pré-paramétrés mis à 

votre disposition dans ce dossier, il est IMPORTANT que vous placiez le dossier 

« TIME_SERIES_ANALYSIS » à la racine du disque C de votre ordinateur pour obtenir le 

répertoire « C:\TIME_SERIES_ANALYSIS\... ». 

ATTENTION ! Le dossier « SENEGAL » contient déjà une série de données et de fichiers de 

paramétrage qui seront produits au cours de l’exercice. Même si ces données sont mises à 

votre disposition, il vous est conseillé, pour un bon apprentissage, de refaire toutes les 

étapes de l’exercice par vous-même comme indiqué dans les sections suivantes. Considérez 

donc ces données comme l’exemple auquel il faut arriver. Libre à vous d’utiliser directement 

les fichiers de paramétrages mis à disposition si vous estimez avoir compris comment les 

paramétrer et si vous voulez aller plus vite.  
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11.2. Introduction et motivation 

Contextualisation : 

Le monitoring  mondial des conditions de végétation à l’aide de séries temporelles d’images 

satellites basse résolution permet de mettre en place un système d’avertissement précoce 

par rapport aux « hotspots » mondiaux d’anomalies de productions agricole.  

Pour en savoir plus, jetez un œil rapide au site web suivant (Figure 196): 

o https://mars.jrc.ec.europa.eu/asap/ 

o https://mars.jrc.ec.europa.eu/asap/about.php 

o ASAP is an online decision support system for early warning about hotspots 

of agricultural production anomaly (crop and rangeland), developed by the 

JRC for food security crises prevention and response planning anticipation. 

 

Figure 196 : Page d’accueil du site web https://mars.jrc.ec.europa.eu/asap/.  

En particulier pour le Sénégal : 

o https://mars.jrc.ec.europa.eu/asap/country.php?cntry=217 

Notez aussi le « Warning explorer » disponible ici : 

o https://mars.jrc.ec.europa.eu/asap/wexplorer/ 

https://mars.jrc.ec.europa.eu/asap/
https://mars.jrc.ec.europa.eu/asap/about.php
https://mars.jrc.ec.europa.eu/asap/
https://mars.jrc.ec.europa.eu/asap/country.php?cntry=217
https://mars.jrc.ec.europa.eu/asap/wexplorer/
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o A explorer en quelques minutes 

A travers cet exercice vous mènerez une analyse qui vous permettra notamment de : 

• Produire des cartes d’anomalie des conditions de végétation sur le Sénégal pour 

l’année 2002 : ce type d’analyse, si menée en temps réel lors d’une période de 

sécheresse par exemple, pourrait permettre d’objectiver, de quantifier et de 

cartographier le mauvais état relatif des conditions de végétation en tout lieu du 

Sénégal et par là contribuer au déclanchement d’un éventuel processus d’aide 

alimentaire d’urgence et/ou permettre l’activation d’indemnisation des agriculteurs 

impactés, via un système d’assurances agricoles.  

• Produire des images de paramètres phénologiques de la végétation (dates de 

début/fin de la saison de végétation, valeur maximum du NDVI, etc). Ce type 

d’images permet de caractériser les conditions de végétation au cours d’une saison 

et peuvent être utilisées par exemple dans un modèle de prévision des rendements 

agricoles.  

11.3. Grandes étapes 

• Télécharger les images 

• Importer les images dans SPIRITS 

• Visualiser les images + production de cartes en série 

• Extraction de statistiques par zone + visualisation 

• Lissage temporel des images + visualisation  

• Calcul d’anomalie de végétation + visualisation 

• Calcul des paramètres phénologiques  + visualisation 

11.4. Téléchargement des données 

11.4.1. Commande des images NDVI via le « Copernicus Global Land 

Service » 

Série d’images NDVI à 1 km de résolution spatiale issue de 2 capteurs : 

• SPOT-VEGETATION : 1/4/1998 jusque 2014 

• PROBA-V : 2014 jusque maintenant 

https://land.copernicus.eu/global/ 

https://land.copernicus.eu/global/
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• Choisir « Vegetation » : https://land.copernicus.eu/global/themes/vegetation 

 

• Choisir « NDVI » : https://land.copernicus.eu/global/products/ndvi 

Jeter un œil à : 

• Définition du NDVI 

• Section « NDVI characteristics » pour le NDVI 1km 

o Access 

o Algorithm 

https://land.copernicus.eu/global/themes/vegetation
https://land.copernicus.eu/global/products/ndvi
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o Technical 

 

Dans l’onglet « Access » cliquer sur « Near-real time products » 

 

Arriver sur 

https://land.copernicus.vgt.vito.be/PDF/portal/Application.html#Browse;Root=513186;Colle

ction=1000085;Time=NORMAL,NORMAL,-1,,,-1,, 

https://land.copernicus.vgt.vito.be/PDF/portal/Application.html#Browse;Root=513186;Collection=1000085;Time=NORMAL,NORMAL,-1,,,-1,,
https://land.copernicus.vgt.vito.be/PDF/portal/Application.html#Browse;Root=513186;Collection=1000085;Time=NORMAL,NORMAL,-1,,,-1,,
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• S’enregistrer via « Register » 

o Bien noter son « user name » et « password » 

o Finaliser la procédure d’enregistrement  
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• Une fois inscrit, se loguer : bouton « Login » en haut à droite 

• Définir les critères de recherche d’images : 

o Taper « Senegal » + Go dans le menu de recherche géographique pour définir 

le ROI du Sénégal 

▪ (ou une zone un peu plus large pour avoir une marge autour du 

Sénégal, pour un meilleur style des cartes ?) 

o Collection : « NDVI 1km V2.2 Global » 

o Date : depuis le 01/04/1998 jusque maintenant 

• Cliquer sur « Search » 

• Arriver sur la page présentant les images correspondant aux critères de recherche 

o 774 produits disponibles le 5/10/2019 

o Nombre d’images en détail : 

▪ 1998 : à partir de 19980401 = 9 * 3 = 27 images 

▪ 1999-2018 = 20 * 36 = 720 images 

▪ 2019 : jusque 20190921 = 9*3 = 27 images 

▪ TOTAL : 774 images 

 
ATTENTION ! CONVENTION POUR LES NOMS DES IMAGES NDVI ! 
 
Remarquez que le nom des fichiers d’images NDVI contient l’information sur la période 
correspondante à l’enregistrement des valeurs présentes dans l’image (une décade, 10 
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jours). Cette information est encodée comme suit : 

• YYYYMMDD,  

• par exemple 19980401, 

• où les 4 premiers chiffres correspondent à l’année, les 2 suivants au mois et les 2 
derniers à la décade 1, 2 ou 3 du mois sous le format 01, 11, 21 respectivement. 

 
Cette convention reste valide pour l’ensemble de l’exercice, y compris dans le logiciel 
SPIRITS. 
 

 

 

• Cliquer sur « Select all xxx products » pour sélectionner toutes les images (774 

produits disponibles le 5/10/2019) (si tel est votre but) 

• Cliquer sur « Prepare custom order… »  

• Paramétrer la fenêtre qui s’ouvre “Order item details” comme ci-dessous : 

o Description : comme vous voulez 

o Format : GeoTIFF 

o Coordinates = celles du Sénégal (automatique) 

o Bands : seulement « NDVI » 
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• Cliquer sur “Order now” 

• Arriver à 

 

• Choisir “FTP (PULL)” 

• Cliquer sur “Submit” et arriver au tableau présentant le résumé des commandes 

effectuées avec la colonne “status” : 

o In production = votre commande est en préparation (il a fallu +/- 1h40 pour 

préparer une commande de 774 images NDVI 1km sur le Sénégal (sans time 

grid). 

o Completed = votre commande est prête pour être téléchargée 



340 
 

 

Une fois votre commande prête, vous recevrez un email avec les instructions à suivre pour 

le téléchargement. 

11.4.2. Téléchargement via « FileZilla Client » des images NDVI commandée  

Lorsque votre commande est prête, les images peuvent être téléchargées via le logiciel 

« FileZilla Client ».  

• Installer le logiciel « FileZilla Client », disponible ici https://filezilla-project.org/ 

• Ouvrir FileZilla Client et se connecter en indiquant comme: 

o HOST : ftp.copernicus.vgt.vito.be 

o Username : votre nom d’utilisateur créé dans le portail du « Copernicus 

Global Land Service » 

o Password : votre mot de passe créé dans le portail du « Copernicus Global 

Land Service » 

 

• Télécharger les 774 images  

o depuis le serveur de données, à droite dans l’interface de Filezilla :  

▪ ouvrir le répertoire qui correspond au nom de votre commande que 

vous voulez télécharger et sélectionner, dans la partie inférieure 

droite de l’interface, tous les dossiers à télécharger 

o vers votre ordinateur, à gauche dans l’interface de Filezilla 

▪ ouvrir le répertoire dans lequel télécharger les images : 

• « C:\TIME_SERIES_ANALYSIS\DOWNLOADED_NDVI_IMAGES\ZI

PPED\” 

▪ y faire glisser les images à télécharger : ceci lance le téléchargement 

o La longueur du téléchargement dépendra de la qualité de votre connexion 

internet : entre 2-3 minutes à plusieurs heures 

https://filezilla-project.org/
ftp://ftp.copernicus.vgt.vito.be/


341 
 

 

Les images téléchargées sont présentes dans le dossier 

« C:\TIME_SERIES_ANALYSIS\DOWNLOADED_NDVI_IMAGES\ZIPPED » : 

• 774 dossiers contenant les images NDVI  

• allant de 19980401 à 20190921 

• 164 Mo 

11.4.3. Dé-compression des images téléchargées 

Les images téléchargées s’organisent comme dans la figure ci-dessous : 1 dossier par image, 

contenant lui-même un dossier compressé (zip), contenant lui-même un dossier nommé sur 

base de la date de l’image, contenant lui-même enfin l’image NDVI.tiff.  
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Pour pouvoir utiliser ces images, il faut les décompresser ou dézipper. Cela pourra se faire 

manuellement pour chaque image, mais cela prendrait beaucoup de temps.  

Un fichier de commande DOS a été créé pour dé-zipper toutes les images en un seul clic. Ce 

fichier est dans le répertoire « C:\TIME_SERIES_ANALYSIS\DOWNLOADED_NDVI_IMAGES\ »  

et s’appelle « UNZIP_NDVI_IMAGES.bat ». Un fichier de commande est un simple fichier 

texte mais avec l’extension « .bat » ou « .cmd ». Il permet notamment d’exécuter des 

logiciels par ligne de commande. 

• Ouvrir ce fichier avec un éditeur de texte :  

o clic droit > ouvrir avec  > votre éditeur de texte, ou  

o clic droit > edit with Notepad++ (si Notepad++ n’est pas installé sur votre 

ordinateur, il est recommandé de l’installer : c’est un éditeur de texte 

pratique et performant. Disponible gratuitement ici : https://notepad-plus-

plus.org/downloads/ ) 

 

• Lire et comprendre le code. 

• Modifier éventuellement le code de ce fichier de commande pour le faire 

correspondre à l’organisation de vos données dans vos répertoires sur votre 

ordinateur 

• Ce fichier de commande utilise la version pour ligne de commande du logiciel de (dé-) 

compression de fichiers 7-zip. Celui-ci peut être téléchargé ici : 

o https://www.7-zip.fr/download.html 

▪ télécharger la version « 7-Zip en ligne de commandes » 

https://notepad-plus-plus.org/downloads/
https://notepad-plus-plus.org/downloads/
https://www.7-zip.fr/download.html
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▪ description des commandes (pour information) ici : 

https://sevenzip.osdn.jp/chm/cmdline/commands/extract.htm 

▪ une fois téléchargé, le décompresser et le placer dans le répertoire 

voulu pour obtenir ceci : 

« C:\TIME_SERIES_ANALYSIS\DOWNLOADED_NDVI_IMAGES\7zip_co

mmand_line\7za920\7za.exe » comme indiqué dans le fichier de 

commande 

Une fois votre fichier de commande correctement paramétré, vos images et le logiciel 7-zip 

correctement placé dans vos répertoires, 

• Double-cliquer sur le fichier de commande « UNZIP_NDVI_IMAGES.bat » pour 

l’exécuter, ce qui aura pour effet de décompresser toutes les images NDVI et de les 

placer dans le répertoire voulu, à savoir 

« C:\TIME_SERIES_ANALYSIS\DOWNLOADED_NDVI_IMAGES\UNZIPPED\ » 

• l’exécution prend moins d’une minute pour les 774 images 

• Attention, vérifier le nombre d’images décompressées qui doit être égale à 774 

dans ce cas. Il se peut que certaines images ait été mal téléchargées à partir de 

FileZilla sans pour autant recevoir un message d’erreur, et résulter en un dossier 

compressé corrompu non décompressable. Dans ce cas le nombre d’images 

décompressées sera inférieur au nombre attendu. Si tel est le cas, identifier les 

images manquantes et relancer le téléchargement + décompression.  

ATTENTION ! 2 images ont une structure de nom de fichier différente des autres, avec la 

mention « V2.2.2 » alors que tous les autres sont en « V2.2.1 », confer image ci-dessous.  

 

https://sevenzip.osdn.jp/chm/cmdline/commands/extract.htm


344 
 

 
 

 

Comme ceci peut provoquer un bug lors de l’importation dans SPIRITS (étape ultérieure), il 

faut : 

• Renommer ces 2 images en remplaçant  « V2.2.2 » par « V2.2.1 » dans les images 

copiées. 

Remarquez aussi que : 

• Les images SPOT-VEGETATION couvrent la période 19980401 jusque 20131221 (les 

images existantes de SPOT-VEGETATION pour 2014 ne sont pas mises à disposition). 

• Les images PROBAV couvrent la période 20140101 jusqu’actuellement 

→ Vos images décompressées sont prêtes pour être utilisées dans SPIRITS ! 

11.4.4. Téléchargement des fichiers vectoriels shapefile 

Le fichier des pays du monde peut être téléchargé sur Natural Earth : 

• https://www.naturalearthdata.com/downloads/ 

o Choisir « Cultural 10m ») 

Le fichier des départements du Sénégal: 

• Provient du projet « Alerte précoce et prévision des productions agricoles » (Ap3A) 

du Centre Régional Agrhymet (CRA) à Niamey, Niger 

• Il contient 35 départements 

• (Remarque : ce fichier shapefile contient plusieurs polygones différents pour 2 

départements : Dakar (2 = 1 contient + 1 île) et Foundiougne (5 = continent + 4 îles) et 

ces polygones sont repris comme autant d’enregistrements dans la table d’attributs 

du shapefile. Cela n’est pas idéal car cela va générer des statistiques différentes pour 

ces différentes entités, sauf si elles sont trop petites que pour être reprises dans 

l’image rastérisée des départements (confer plus bas). Il conviendrait de soit les 

supprimer (si entités petite et négligeable), soit créer un « polygone multiple » c’est-à-

dire un enregistrement unique dans la table d’attributs qui correspond à plusieurs 

polygones.)  

https://www.naturalearthdata.com/downloads/
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11.5. Aperçu des données dans QGIS (facultatif) 

Installer QGIS : confer https://qgis.org/fr/site/  

Ouvrir les données dans QGIS et voir à quoi elles ressemblent. 

11.6. Utilisation de SPIRITS 

Les indications reprises dans cette section se basent en partie sur les documents suivants: 

• Manuel officiel de SPIRITS 

• Tutorial officiel de SPIRITS 

• Document pédagogique réalisé par Abdoul-Hamid MOHAMED SALLAH 

11.6.1. Téléchargement et installation de SPIRITS 

Spirits est un logiciel développé par le JRC pour l’analyse de séries temporelles d’images 

basse résolution de différents types.  

! SPIRITS (logiciel, manuel et tutorial officiels) a déjà été téléchargé et décompressé pour 

vous et se trouvent dans le dossier “C:\TIME_SERIES_ANALYSIS\SPIRITS\ ». 

SPIRITS peut être téléchargé gratuitement ici : 

• https://mars.jrc.ec.europa.eu/asap/download.php 

• Version 1.5.2, February 2018. 

• Est disponible également à cette adresse un jeu de données exemple qui est utilisé 

dans le tutoriel officiel (non fourni dans le cadre de ce cours étant donné le volume 

de ce jeu de données) 

Une fois SPIRITS téléchargé, il n’y a pas de procédure d’installation. Il suffit de le 

décompresser à l’endroit voulu.  

“Important note: SPIRITS requires a Java virtual machine (JVM) to run. If not already 

installed, users can download Java version 1.7 or higher.” Java peut être téléchargé 

gratuitement via le lien ci-dessous. Après téléchargement, installez JVM.  

• https://www.java.com/fr/download/  

11.6.2. Démarrage de SPIRITS et découverte de l’interface 

Pour démarrer SPIRITS : 

https://qgis.org/fr/site/
https://mars.jrc.ec.europa.eu/asap/download.php
https://www.java.com/fr/download/
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• Double cliquer sur 

« C:\TIME_SERIES_ANALYSIS\SPIRITS\SpiritsExtract_152\Spirits.jar » et attendre 

quelques secondes 

• (Remarque : si « Spirits.jar » n’était pas associé au bon programme de lancement par 

défaut, et ne s’ouvrait donc pas correctement, il faut associer « spitis.jar » à 

« javaw.exe »  qui peut probablement être trouvé dans un répertoire ressemblant à 

ceci : « C:\Program Files\Java\jre1.8.0_171\bin\javaw.exe ».) 

 

11.6.3. Création d’un projet SPIRITS 

Pour créer un projet SPIRITS : 

• « File > Projects > Select > » puis spécifier le répertoire 

« C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL » 

o Cela a pour effet de créer le dossier « SpiritsProjectData » dans le répertoire 

« SENEGAL ».  Ce dossier contient une série d’information relative à ce projet 

SPIRITS. 

o Cette commande « Select » peut aussi être utilisée pour sélectionner un 

projet pré-existant 
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Le répertoire à utiliser pour cet exercice dans 
SPIRITS est le répertoire : 
 
“C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\” 
 
Il contient un ensemble de sous-dossiers qui 
renfermeront chacun un type de fichiers ayant 
une utilité spécifique dans SPIRITS.  
 
 

 
 

Pour paramétrer correctement votre projet SPIRITS : 

• « File > Projects > Define > » 

o Adapter les répertoires comme dans l’image ci-dessous 
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Abréviation Nom des 
fichiers 

Fonction 

TNT Task files Permet d’exécuter un scénario (.SNS) sur une période donnée 

SNS Scenario files Contient la paramétrisation nécessaire pour effectuer une action 
(ex : importation des fichiers avec certaines valeurs des 
paramètres de cette fonction) 

UNT User Tool files / 

LNL List of files Dossier contenant des fichiers texte contenant des listes de 
fichiers… 
Liste de quoi… ? 
Utile pour… ? 

CNC Chart files Dossier contenant des templates de graphiques 

QNQ Quick Look files Dossier contenant les « map template » ou mise en page de carte 
prédéfinie 

DATA Image diles Dossier contenant les images NDVI avec 1 sous-dossier par 
traitement (importation, lissage temporel,…) 

VAR VAR/MTA files / 

RUM RUM files RUM veut dire: “Regional and Unmixed Mean values” et désigne 
les valeurs qui sont extraites des images par région, par exemple 
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la valeur moyenne du NDVI par zone d’intérêt (ex : par 
département du Sénégal).   

SPX Specification 
files (*.SPX) 

Paramétrage aditionel de certaines fonctions 

PNG PNG files Dossier contenant des images n’étant pas les images satellites 
analysées: 

• cartes produites 

• graphique 

• logo et autres illustrations à faire apparaitre sur une carte 

• … 

TXT TXT files Dossier contenant des fichiers texte. Par exemple les fichiers 
utilisés pour définir la structure de la base de données qui 
accueillera les statistiques calculées.  

VEC Vector files Dossier contenant les fichiers vectoriels (shapefile) utilisés pour la 
mise en page cartographique ou fichiers devant être rastérisé 
pour l’extraction de statistiques. 

RST Spatial 
Reference Set 
files 

Dossier contenant les régions d’intérêts rastérisées (en format 
raster) car SPIRITS a besoin de ce format raster pour pouvoir faire 
l’extraction. 

 

11.6.4. Importation des images dans SPIRITS et conversion de leur format 

SPIRITS a besoin d’images en format « ENVI » (fichier image « .img » + fichier entête 

« .hdr »). Il faut donc convertir les images téléchargées, actuellement en format « .tif » vers 

le format « ENVI ». Pour ce faire, utiliser le menu : 

• « Import/Export > Import > Generic importer > Scenario > » 

Il faut créer 2 scénario différents car les noms des images SPOT VGT (1998-2013) et PROBA-

V (2014-2019) ne sont pas les mêmes : 

 
• Ensuite : 

• Soit, créer 2 scénarios comme dans l’image ci-dessous. La partie de l’interface 

non montrée (…) peut rester vide.  

• Soit, pour aller plus vite ouvrir le scénario pré-enregistré pour vous via la 

commande « File > Open > » de la fenêtre « Generic Import Scenario » et 

choisir le scénario suivant : 

• Noms des scénarios : 

• Nom du scenario pour importer les images SPOT VEGETATION: 

• “IMPORT_and_CONVERT_VGT_tiff_to_img_ENVI.sns” 
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• Nom du scenario pour importer les images PROBA-V: 

• “IMPORT_and_CONVERT_PROBAV_tiff_to_img_ENVI.sns” 

• La seule différence entre ces 2 scénarios se situe au niveau du suffixe des 

« input files ».  

• Par convention, pour l’output : 

• Préfixe = cgls (= Copernicus Global Land Service) 

• Suffixe = i (=NDVI) 

• Une partie des infos de la rubrique « Spectral » peuvent être trouvée sur la 

page présentée précédemment : 

https://land.copernicus.eu/global/products/ndvi 

 

Website SPIRITS : Generic 
import scenario 

Signification  

PHYSICAL MIN = -
0.08 → DIGITAL MIN 
= 0 
 
DIGITIAL MAX = 250 

Vlo et Vhi Plus petite et plus grande valeurs de DN 
dans la gamme de valeurs significatives (en 
dehors de cette gamme, ce sont des 
« Flags » (confer plus bas)) 

Offset = -0.08 Vint : scaling 
intercept  

Intercepte dans la formule de conversion 
des DN en NDVI 

Scaling : 1/250 = 
0.004 

Vslo : scaling slope  Pente dans la formule de conversion des DN 
en NDVI 

Specific values Flags Valeurs codes utilisées pour spécifier une 
donnée manquante ou mauvaise, la 
présence de nuage, ombre, neige, glace, 
mer, océan, etc 

 

 
 

NDVI = SCALING * DN + OFFSET 
NDVI = 1/250 * DN - 0.08  
NDVI = 0.004 * DN - 0.08 

Par exemple : 0.32 = 0.004 * 100 - 0.08 

https://land.copernicus.eu/global/products/ndvi
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(…) 
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Figure 197 : Principe de la conversion des DN (Digital Number des pixels) en valeurs de NDVI 

• Sauver le scénario (ou File > Save as) 

 

• Importer et convertir les images en utilisant les 2 scénarios créés ci-dessus : 

• « Import/Export > Import > Generic importer > Time series  > » 
• Soit 

• ouvrir les scénarios préétablis (confer ci-dessus) 
• préciser les dates de début et de fin pour l’exécution de 

chaque scénario 
• SPOT-VGT : 19980401 jusque 20131221 (9 minutes) 
• PROBA-V : 20140101 jusque 20190921 (3 minutes) 

• Soit, pour aller plus vite, ouvrir les Task files (TNT) correspondant pré-
enregistrés pour vous : 

• « GENERIC_IMPORT_SPOT_VGT_1998_2013.tnt » 
• « GENERIC_IMPORT_PROBAV_2014_2019.tnt » 

• Exécuter 
 
Le panneau des tâches s’active et il est possible de suivre l’avancement de l’importation. 
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• Après exécution de l’importation, vérifier que l’exécution s’est opérée 
correctement : 

• Via l’onglet « Results »  
• point noir : OK 
• point rouge : ERROR 

• Via le nombre de fichiers présents dans le dossier dans lequel les images ont 
été importées (dossier 
« C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\DATA\SEN\NDVI_1km_V2.2.1 
») 

• 774 images * 3 fichiers/image = 2322 fichiers doivent être présents 
 

→ La série complète d’images NDVI a été importée dans SPIRITS dans le format ENVI. Elle 
se trouve dans le répertoire 
« C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\DATA\SEN\NDVI_1km_V2.2.1 ».  

 
Chaque image est composée d’un triple fichier : 

• img : l’image en tant que telle 

• hdr : fichier en-tête, fichier texte nécessaire dans le format ENVI (confer image ci-
dessous). il contient les informations nécessaires à la bonne lecture du fichier dans 
SPIRITS. 

• xml : métadonnées 
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La description détaillée du « header file » est faite dans le manuel officiel de SPIRITS à la 
page 21. 
 
En particulier, il est important de bien comprendre la signification de la ligne « values » : 
confer image ci-dessous : 

 
 
 

11.6.5. Visualisation d’une série d’images NDVI 

Une fois les images importées, SPIRITS peut facilement effectuer toutes sortes de 

traitements sur l’ensemble des images. 

Dans un premier temps, vous allez visualiser vos images via la création en chaine 

(automatique) de carte pour chaque image. 
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11.6.5.1. Création d’un « map template » ou template de carte (QNQ) 

Pour créer des cartes en chaine, il faut d’abord créer un « map template », c’est-à-dire une 

mise en page cartographique. Elle pourra être ensuite utilisée pour l’ensemble des images. 

• Analysis > Maps > Create Template 

Pour gagner du temps, ouvrez un map template préalablement préparé pour vous : 

• File > Open > naviguer vers « C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\QNQ\ 

Map_SEN_NDVI_SIMPLE.qnq » 

• Explorez et comprenez les différents paramètres de mise en page cartographique.  

o Faites éventuellement l’une ou l’autre modification, et, le cas échéant, 

sauvegardez votre nouveau map template via le menu : 

▪ File > Save as > naviguer vers 

« C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\QNQ\ 

Map_SEN_TEMPLATE_VOTRE_NOM.qnq » 

o Remarque : 

▪ Les éléments de texte à faire apparaitre dans le titre ou ailleurs sur la 

carte (onglet « text ») et comme titre de la légende (onglet « legend > 

Title ») peuvent utiliser des variables dont les codes sont expliqués dans 

l’onglet « legend » via le bouton « Title parameters » (par exemple pour 

faire apparaitre la bonne date ou le bon capteur sur chaque carte) 

 

11.6.5.2. Production d’une série de cartes à partir d’un « map template » 

Une fois le « map template » réalisé, il peut être utilisé pour produire une série de carte 

automatiquement. Pour ce faire : 

• Analysis > Maps > Maps Series > Time series 

La fenêtre “Create Quick Look” s’ouvre 

• Soit paramétrez la fenêtre comme vous voulez en réutilisant le map template (QNQ) 

créé dans la section précédente et sauvegarder cette tâche comme un nouveau 

« task files » (TNT) 

• Soit, pour gagner du temps, ouvrez le TASK FILES (TNT) 

« CREATE_MAPS_SEN_NDVI_2013_2015.tnt » préalablement créé pour vous. 

Modifiez éventuellement les dates de début et de fin selon la période pour laquelle 

vous voulez produire des cartes (et dans ce cas, sauvegardez votre nouveau TNT (File 

> Save as)). 



356 
 

• Cliquer sur « Execute » pour produire la série de cartes. 

 

Après exécution de la création de cartes en série, vérifier que l’exécution s’est opérée 

correctement : 

• Via l’onglet « Results »  
• point noir : OK 
• point rouge : ERROR 

• Via le nombre de fichiers présents dans le dossier dans lequel les cartes ont été 
créées (dossier 
« C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\PNG\SENEGAL_MAPS_NDVI ») 

 

• Visualisez les cartes produites dans le répertoire de sortie 

« C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\PNG\SENEGAL_MAPS_NDVI » 

o Faire défiler rapidement toutes les images dans un visionneur d’images (ex : 

Microsoft Office Picture Manager) afin de visualiser une animation montrant 

l’évolution des conditions de végétation sur la zone étudiée.  

o Remarque : il est possible de créer une animation au format GIF via le logiciel 

GIMP, par exemple pour mettre sur un site web (confer la fin de la section 

6.2). 
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11.6.6. Extraction de statistiques à partir des images NDVI 

11.6.6.1. Création de la structure de la base de données 

Avant de pouvoir extraire des statistiques à partir de l’image, il faut définir quelques 

variables de la base de données qui sera produite. Pour ce faire, utiliser les menus suivants : 

• Analysis > Database > (confer image ci-dessous) 

o Sensors >: 

o Variable >: 

o Regions >: 

o Classes >: 

 

Pour « SENSORS » : 

• Soit ajouter manuellement les 3 informations demandées (confer image ci-dessous) 

• Soit importer le fichier texte préalablement fait pour vous contenant ces 

informations.  

o Il se trouve dans le répertoire 

« C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\TXT\SENSORS.txt” 

o Attention à bien paramétrer l’importation ! 

o comme dans ce cas-ci il s’agit d’un mélange de 2 capteurs (SPOT VGT et 

PROBAV) il sera indiqué « CGLS_VGT_PROBAV » 
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Pour « VARIABLES » : définir 2 variables : 

• Soit ajouter manuellement les 3 informations demandées pour chaque variable 

(confer image ci-dessous) 

• Soit importer le fichier texte préalablement fait pour vous contenant ces 

informations.  

o Il se trouve dans le répertoire 

« C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\TXT\VARIABLES.txt” 

• Attention à bien paramétrer l’importation ! 

o NDVI = NDVI « normal » 

o sNDVI = NDVI ayant subi un lissage temporel (ceci sera expliqué dans la 

section 11.6.7 page 378) 
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o Les autres variables déjà présentes dans ce fichier texte correspondent à des 

variables phénologiques et seront utilisée ultérieurement (confer section 

11.6.9 page 391 et suivantes) 

 

Pour « REGIONS » : 

• Pas possible d’importer de « Regions sets » → faire un ajout manuel (confer image ci-

dessous). Ceci correspond à la région générale : on lui donne un nom. 

• Importer ensuite les « Regions in Regions set » à partir du shapefile des 

départements du Sénégal qui est dans le dossier 

« C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\VEC\Senegal_deps.shp » 

o Confer le paramétrage dans l’image ci-dessous 

o Ceci correspond aux sous-régions dans la région générale : on indique à quoi 

correspondent les régions qui seront utilisées pour l’extraction de 

statistiques : on leurs donne des noms.  
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o Notez que la colonne du shapefile appelée « SNNIV3_ID », qui varie de 1 à 35 

et qui identifie chacun des départements du Sénégal par un identifiant 

unique, est utilisée comme identifiant des régions dans la base de données. 

 

Figure 198 : Aperçu du shapefile sur le Sénégal et sa table d’attributs avec 35 départements avec 
les identifiants de 1 à 35 dans la colonne « SNNIV3_ID » 
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Figure 199 : Importation des « Regions » dans SPIRITS à partir du shapefile « Senegal_deps.shp » 

Pour « Classes » : 

• pas d’importation :→ ajout manuel 

• paramétrage : confer image ci-dessous 

• The Classes Set containing the (land use/land cover) Classes used in the extraction 

(page 243 du manuel official de SPIRITS) 
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En résumé, les 4 éléments de la base de données sont créés : 
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11.6.6.2. Création de l’image raster des zones d’intérêt pour l’extraction des 

statistiques 

Pour pouvoir faire l’extraction des statistiques des images NDVI par zones d’intérêt (les 

départements du Sénégal), SPIRITS a besoin que ces zones d’intérêt lui soit fournies en 

format raster (image, matrice). SPIRITS ne peut utiliser directement un fichier vectoriel 

shapefile.  

Il faut donc créer une image raster à partir du fichier vectoriel des départements du Sénégal. 

Cette image doit être compatible en termes de système de coordonnées, résolution spatiale 

et étendue avec les images sur lesquelles l’utiliser (images NDVI dans notre cas). 

Pour plus d’information sur cette étape se référer au tutorial officiel de SPIRITS, page 61 

« Exercise 4-6 Rasterize Shapefiles ». 

Pour ce faire: 

• Import / Export > Vectors > Rasterize SHP-File 

Dans la fenêtre “Rasterize SHP” qui s’ouvre: 

• Soit paramétrer la fenêtre comme indiqué dans l’image ci-dessous et sauvegarder 

éventuellement votre « Task file » (TNT) 

• Soit, pour gagner du temps, ouvrir (File > Open) le « Task file » (TNT) préalablement 

établi pour vous 

« C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\TNTRasterize_SEN_DEPS_for_NDVI

.tnt » 

o « Framing » : 

▪ Peut être spécifié sur base d’un header file d’une image NDVI qui doit 

être analysée avec l’image rasterizée 

o « Parameters » :  

▪ Attributes : la valeur à donner aux pixels de l’image rastérisée. Dans 

notre cas, cela correspond aux identifiants des départements du 

Sénégal (SNNIV3_ID) qui varie de 1 à 35. Notez que c’est cette même 

valeur qui a été utilisée lors de la création des identifiants des régions 

de la base de données dans la section précédente.  

▪ Rasterized data type : 8 Byte : permet des valeurs de 0 à 255, ce qui 

convient dans notre cas puisque les id varient de 1 à 35.  

▪ No data flag : la valeur à donner aux pixels de l’image rastérisée 

lorsque il n’y a pas de données correspondante dans le shapefile (en 

dehors du Sénégal dans ce cas-ci). Mettre la valeur de 0 (une autre 

valeur de votre choix, différente de 1 à 35, pourrait convenir aussi). 

o « Adapt HDR » : 
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▪ confer image ci-dessous 

• Cliquer sur « Execute » pour lancer la rastérisation  

• Vérifier le résultat : 

o Dans le panneau « Results » de SPIRITS (point noir) 

o Dans le dossier 

« C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\DATA\SEN\RASTERIZED\ 

SEN_DEPATEMENTS_RASTERIZED.img » (présence de la couche) 

o Dans QGIS ou un autre logiciel : afficher l’image rastérisée (facultatif) 
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Figure 200 : Visualisation du fichier « SEN_DEPATEMENTS_RASTERIZED.img » dans le logiciel ENVI 
avec palette de couleurs « EOS A ». 

11.6.6.3. Extraction des statistiques sur les valeurs de NDVI à partir des 

images 

Spécifications de l’extraction de statistiques : choix de la méthode (SPU) 

Plusieurs méthodes d’extraction des valeurs des images par zone sont proposées dans 

SPIRITS. Un fichier de « spécification » doit être établi afin de spécifier le type de méthode 

qui sera utilisé.  

Dans notre cas, la méthode la plus simple sera utilisée : 

• « no land use classification », soit une valeur moyenne par zone (par département) 

(= regional means ("Overall Mean")) sans tenir compte de l’occupation du sol. 

Pour plus d’information sur les autres méthodes, voir les pages 249 et 251 du manuel officiel 

de SPIRITS : 

• « Hard classification method : one mean value per class per region” (“class” = classe 

d’occupation du sol) 

• “Area fractions method: one mean value per class per region, weighted by the AFI of 

that class.” (AFI = Area Fraction Images) 

Création d’un SPU 
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• Analysis > Database > Extract > Specification 

Paramétrer le SPU : 

• Soit paramétrer le SPU comme indiqué dans l’image ci-dessous et sauvegarder 

éventuellement votre scénario 

• Soit, pour gagner du temps, ouvrir (File > Open) le « fichier de spécifications » (SPU) 

préalablement établi pour vous 

« C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\SPX\SPU_EXTRACT_RUM_SEN_NDVI.

spu » 

 

Création du scenario d’extraction 

Avant de procéder à l’extraction, un scenario d’extraction doit être créé. Celui-ci permet de 

préciser d’autres paramètres de l’extraction.  

Pour ce faire : 

• Analysis > Database > Extract > Scenario 

Paramétrer le scénario : 

• Soit paramétrer le scénario comme indiqué dans l’image ci-dessous et sauvegarder 

éventuellement votre scénario 

• Soit, pour gagner du temps, ouvrir (File > Open) le « scénario » (SNS) préalablement 

établi pour vous 

« C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\SNS\RUM_Extract_scenario_NDVI_SE

N » 
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ATTENTION ! Remarque importante ! 

Les ID du « Region Sets » de la base de données (« Region Sets » appelé « DPTS_SEN » dans 

ce cas-ci et préalablement construit à partir du shapefile des départements du Sénégal avec 

des ID de 1 à 35) doivent correspondre aux ID de l’image utilisée pour l’extraction de 

statistiques (l’image rastérisée à partir du shapefile des départements du Sénégal dans ce 

cas-ci « SEN_DEPATEMENTS_RASTERIZED.img »). C’est cette correspondance qui permet de 

placer les valeurs extraites dans les bonnes « cases » correspondantes de la base de 

données.  

 “In case the extracted data will be uploaded into the projects RUM database, the ID's in this 

Regions IMG must agree with the Id's of the Regions contained in the selected Regions Set 

from the database: this Id is one of the links between the data extracted by the Extract RUM 

tool and the data imported into the RUM database.” (page 246, SPIRITS official manual) 

 

 

 

Extraction des statistiques des images par zone d’intérêt 

L’extraction peut enfin se faire. Pour ce faire : 
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• Analysis > Database > Extract > Time series 

Paramétrer la tâche d’extraction : 

• Soit paramétrer la tâche d’extraction comme indiqué dans l’image ci-dessous et 

sauvegarder éventuellement votre « Task file » (TNT) 

• Soit, pour gagner du temps, ouvrir (File > Open) le « Task file  » (TNT) préalablement 

établi pour vous 

« C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\SNS\EXTRACT_RUM_SEN_NDVI_1998

_2019.tnt » 

 

• Cliquer sur “Execute” (temps d’exécution: 8 minutes) 

• Vérifier le résultat : 

o Dans le panneau « Results » de SPIRITS (point noir) 

o Dans le dossier 

“C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\RUM\SEN\NDVI\ » (présence 

des fichiers de résultat) 
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11.6.6.4. Visualisation des profils temporels de NDVI par région 

Maintenant que les statistiques ont été calculées, extraites, et stockées dans la base de 

données du projet SPIRITS, il est possible de la consulter, notamment via la création de 

graphiques. 

Pour consulter la base de données produite : 

• Analysis > Database > Browse  

Pour visualiser un profil temporel de l’évolution du NDVI entre 1998 et 2019 pour une 

région donnée : 

• Sélectionner la région et parcourir les onglets « Table », « Chart Preview » et « Matrix 

Preview » 
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Dagana, Podor, Louga : forte variabilité inter-annuelle : Nord du Sénégal, faibles 

précipitations !  

Remarquer la variabilité du pic de NDVI d’une année à l’autre, en particulier pour 2002 où le 

pic est faible. 
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Dakar et Pikine : décroissant. Urbanisation ?  

 

Ziguinchor : élevé et régulier : sud du Sénégal, bien arrosé.  
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Source: Analysis of mean climate conditions in Senegal (1971–98), S Fall, D Niyogi, FHM 

Semazzi - Earth Interactions, 2006, journals.ametsoc.org, 

http://landsurface.itap.purdue.edu/publications-protected/J41.pdf 

http://landsurface.itap.purdue.edu/publications-protected/J41.pdf
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Pour visualiser un profil temporel de l’évolution du NDVI entre 1998 et 2019 pour une 

région donnée avec superposition des années: 

• Cliquer sur « New Chart » 

o Explorer les options de mise en page des graphiques 

o Possibilité d’ouvrir ou sauvegarder un template degraphique (CNC) via « File > 

Open » ou « File > Save as », dans le répertoire 

« C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\CNC\ ».  

o Ouvrir par exemple le template « NDVI_DAGANA_2002 lissé.cnc » 

o Possibilité d’exporter en PNG (File > Export PNG) 
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Bruit du signal NDVI et lissage temporel 

On peut remarquer que le signal NDVI « brut », celui utilisé pour l’extraction des statistiques, 

présente une certaine irrégularité dans son évolution intra-annuelle : il y a un certain bruit 

du aux conditions atmosphériques changeantes d’une décade à l’autre. 

Pour diminuer l’impact des conditions atmosphériques sur le signal et de la sorte produire 

un signal qui traduit mieux les conditions de végétation réelles, il est possible d’effectuer 

un « lissage temporel » du signal NDVI. Ceci sera fait dans la section suivante.  
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11.6.7. Lissage temporel des images NDVI et extraction des statistiques 

11.6.7.1. Concept du lissage temporel d’images satellites 

La figure ci-dessous illustre le concept de lissage temporel d’images satellites.  

La courbe d’évolution temporelle du NDVI dérivée de chacun des pixels de l’image (courbe 

noire « Original » sur le graphique) présente un certain bruit. Cette courbe correspond à 

l’évolution du NDVI pour un pixel donné sur la série d’images NDVI utilisée.  

Cette courbe peut être lissée via de nombreuses méthodes (courbe rouge « S-G filter » sur le 

graphique (algorithme de Savitzky-Golay)).  

Les valeurs de NDVI lissées (courbe rouge) sont ensuite utilisées pour produire de nouvelles 

images de NDVI lissées temporellement.  

 

Source: Construction of smooth daily remote sensing time series data: a higher spatio 

temporal resolution perspective, Zhuokun Pan, Yueming Hu, Bin Cao, 2017, DOI 

10.1186/s40965-017-0038-z, https://link.springer.com/content/pdf/10.1186%2Fs40965-

017-0038-z.pdf  

11.6.7.2. Lissage temporel des images NDVI 

Pour appliquer un lissage temporel à la série d’images NDVI : 

• Processing > Temporal> Smoothing > Smooth 

 

Paramétrer la tâche de lissage temporel : 

• Soit paramétrer la tâche de lissage temporel comme indiqué dans l’image ci-dessous 

et sauvegarder éventuellement votre « Task file » (TNT) 

https://link.springer.com/content/pdf/10.1186%2Fs40965-017-0038-z.pdf
https://link.springer.com/content/pdf/10.1186%2Fs40965-017-0038-z.pdf
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• Soit, pour gagner du temps, ouvrir (File > Open) le « Task file  » (TNT) préalablement 

établi pour vous 

« C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\TNT\SMOOTH_NDVI_TEMPORALY_SE

N_1998_2019.tnt » 

o Suffixe k : par convention, qui signifie qu’il s’agit d’un NDVI lissé 

temporellement 

o Output flags : choisir dans ce cas-ci « Copy UNI-flags » car nos images 

respectent ce système. Confer manuel officiel de Spirits page 25 section 

« 2.3.2. The UNIflags system ». 
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• Cliquer sur « Execute » pour lancer le lissage temporel (temps d’exécution : 1 minute) 

• Vérifier le résultat : 

o Dans le panneau « Results » de SPIRITS (point noir) 

o Dans le dossier 

« C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\DATA\SEN\NDVI_1km_V2.2.1

_SMOOTHED\ » (présence des images) 

Remarque : en principe, il faudrait s’assurer que la technique de lissage utilisée produit 

l’effet escompté et le cas échéant modifier le paramétrage du lissage jusqu’à obtenir l’effet 

escompté. Le signal lissé peut être observé visuellement avec, par exemple, la méthode de 

visualisation graphique présentée dans la section 11.6.6.4 page 371 et suivantes. 

11.6.7.3. Extraction des statistiques sur les images NDVI lissées 

temporellement 

Une fois les images lissées temporellement, elles peuvent être utilisées pour extraire les 

statistiques désirées (valeurs moyenne de NDVI par zone par exemple).  

Le même type d’opération a déjà été effectué précédemment sur les images NDVI brutes 

dans la section 11.6.6 page 358 et suivantes. 
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• Création de la structure de la base de données :  

o créer une variable sNDVI (smoothed NDVI) : déjà fait à la section 11.6.6.1. 

• Création du scenario d’extraction à partir du scénario précédant: 

o Analysis > Database > Extract > Scenario 

o Soit 

▪ File > Open > RUM_Extract_scenario_NDVI_SEN.sns 

▪ Modifier le Scénario comme indiqué dans l’image ci-dessous et 

sauvegarder éventuellement votre scénario 

o Soit, pour gagner du temps,  

▪ Ouvrir (File > Open) le « scénario » (SNS) préalablement établi pour 

vous « 

C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\SNS\RUM_Extract_scen

ario_NDVI_SMOOTHED_SEN.sns » 

o Attention à : 

▪ « input path »: smoothed NDVI 

▪ « output path »: NDVI_SMOOTHED 

▪ « suffix » : k (k = par convention, qui signifie qu’il s’agit d’un NDVI lissé 

temporellement) 

▪ « Variable » : sNDVI 
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• Extraction des statistiques des images NDVI lissées temporellement par zone 

d’intérêt 

o Analysis > Database > Extract > Time series 

o Paramétrer la tâche d’extraction : 

▪ Soit paramétrer la tâche d’extraction comme indiqué dans l’image ci-

dessous et sauvegarder éventuellement votre « Task file » (TNT) 

▪ Soit, pour gagner du temps, ouvrir (File > Open) le « Task file  » (TNT) 

préalablement établi pour vous « 

C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\SNS\EXTRACT_RUM_SE

N_NDVI_SMOOTHED_1998_2019.tnt » 

o Cliquer sur “Execute” (temps d’exécution: 7 minutes) 

o Vérifier le résultat : 

▪ Dans le panneau « Results » de SPIRITS (point noir) 

▪ Dans le dossier  

▪ “C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\RUM\SEN\NDVI_SMOO

THED\ » (présence des fichiers de résultat) 

 

• Visualisation des profils temporels de NDVI par région 

Une fois les statistiques extraites à partir des images lissées temporellement, elles peuvent 

être explorées, via des graphiques notamment, comme similairement fait pour les images 

NDVI brutes à la section 11.6.6.4 page 371 mais en choisissant cette fois la variable 

« sNDVI » !  

Exemple pour Dagana dans l’image ci-dessous (images NDVI lissées temporellement mais 

l’option de lissage du graphique n’a pas été utilisée ici).  
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Ces images temporellement lissées sont de meilleure qualité que les images brute dans le 

sens où elles expriment mieux le comportement réel de la végétation à travers le temps car 

elles sont moins impactées par les variations des conditions atmosphériques.  

11.6.8. Création de carte d’anomalie 

Pour créer une carte d’anomalie, plusieurs méthodes existent : confer le tutoriel officiel de 

SPIRITS page 84.  

Dans le cadre de cet exercice nous allons créer une carte d’anomalie du NDVI pour chaque 

décade de l’année 2002 pour le Sénégal en comparant le NDVI de chaque décade de l’année 

2002 à la valeur moyenne observée sur toute la série d’images disponibles (1998-2019) pour 

chaque décade. Cette valeur moyenne sera appelée « Long Term Average » (LTA). Les étapes 

à suivre sont : 

• Calcul du LTA 

• Calcul des images d’anomalie 

• Visualisation des images d’anomalie 

11.6.8.1. Calcul de « Long Term Average » (LTA) des images NDVI 
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Pour calculer les images NDVI décadaires « Long Term Average » pour le Sénégal pour la 

période 1999-2018 (1998 et 2019 ne sont pas considérées vu que ces séries ne sont pas 

complètes) : 

• Processing > Temporal > Long-term statistics 

• Ensuite, 

o Soit paramétrer l’outil LTA comme indiqué dans la fenêtre ci-dessous, 

sauvegarder éventuellement le paramétrage dans un « task file » (TNT), et 

exécuter l’outil 

o Soit ouvrir (File > Open) le « task file » (TNT) préalablement établi pour vous 

disponible dans le répertoire 

« C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\TNT\LTA_1999_2018.tnt » 

et l’exécuter (temps d’exécution : 2 minutes) 

o Remarquez que ce sont les images temporellement lissées qui sont utilisées 

pour calculer le LTA. 

 

• Vérifier le résultat : 

o Dans le panneau « Results » de SPIRITS (point noir) 

o Dans le dossier 

“C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\DATA\SEN\NDVI_1km_V2.2.1_
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SMOOTHED_LTA\ » (présence de 36 images (72 fichiers (img+hdr)), soit 1 par 

décade, pour chaque type de résultat demandé (mean, median, etc)) 

▪ ATTENTION ! Les résultats de l’analyse « Long Term Average » utilisent 

un code année allant de 1950 à 1964 qui a une signification précise : 

confer illustration ci-dessous. 

▪ Les images de la valeur moyenne auront comme code année « 1962 » 

 

Source : page 168 of SPIRITS official manual 

Ces images LTA ne seront pas visualisées dans cet exercice. 

Référence dans le tutoriel officiel de SPIRITS : page 82. 

11.6.8.2. Calcul d’anomalie du NDVI via la méthode « Relative difference » 

Reference dans le tutoriel officiel de SPIRITS : page 84 et 87. 

La différence relative se calcule comme suit:  

• Différence_relativey,p   =   (valeury,p - LTAp) / LTAp 

• Exemple :      -75%         =   (    0.2      - 0.8   ) / 0.8 

avec y= year, et p= period in the year (dekad).  

La différence relative correspond donc à la variation en % par rapport à « la situation 

moyenne » (LTA mean, ou LTA median), pour la période étudiée. Par exemple,  

• Si pour un endroit et une décade donnés, on observe un NDVI de 0.2 et que le LTA 

NDVI correspondant est de 0.8, alors on obtient une différence relative de (0.2-

0.8)/0.8 = -0.6/0.8 = -75%, c’est-à-dire que le NDVI est de 75% inférieur à la LTA.  
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• Si NDVI = 0.8 et LTA = 0.2, alors la RD = (0.8-0.2)/0.2 = 300%, soit un NDVI supérieur 

de 300% à la LTA.  

Pour calculer une anomalie de type « Relative Difference » : 

• Processing > Temporal > Anomalies > Time series > et création  d’un “New” 

scenario (bouton “New”) 

• Ensuite, 

o Soit paramétrer le  « Difference scenario » comme indiqué dans la fenêtre ci-

dessous, sauvegarder éventuellement le « scenario file » (SNS) 

o Soit ouvrir (File > Open) le « scenario file » (SNS) préalablement établi pour 

vous disponible dans le répertoire 

« C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\SNS\ 

RELATIVE_DIFFERENCE_SNDVI_SEN_2002_LTA_1999_2018.sns »  

 

 

Ensuite : 

• Soit paramétrer la tâche de la fenêtre « Difference » comme indiqué ci-dessous, et 

éventuellement sauvegarder le « task file » (TNT) 
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o Dans « Time Series », indiquer l’année (ou les années) pour lesquelles calculer 

des images d’anomalie.  

• Soit ouvrir (File > Open) le “task file” (TNT) 

“RELATIVE_DIFFERENCE_SNDVI_SEN_2002_LTA_1999_2018 » 

• Exécuter la tâche (temps d’exécution : 10 secondes) 

 

• Vérifier le résultat : 

o Dans le panneau « Results » de SPIRITS (point noir) 

o Dans le dossier 

“C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\DATA\SEN\NDVI_1km_V2.2.1_

RELATIVE_DIFFERENCE_2002\ » (présence des 72 fichiers (36 images (1 par 

décade))) 

11.6.8.3. Visualisation des images d’anomalie de NDVI 

Une fois les images d’anomalies produites, elles peuvent être visualisées via la réalisation 

d’un map template (confer les indications données à la section 11.6.5 page 354). 

• Analysis > Maps > Create template 

Pour gagner du temps, utiliser le map template préalablement créé pour vous et disponible 

dans le dossier « C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\QNQ\ 

Map_SEN_TEMPLATE_RELATIVE_DIFFERENCE_2002.qnq ». Posez-vous cependant la 

question du meilleur choix des couleurs de la légende et des classes de valeurs à utiliser : 

• Pour le choix des couleurs, s’intéresser à la gamme de variation des valeurs des 

images d’anomalie, accessible via le header file de ces images : 

o  
o Minimum = (0.01*25) - 1.25   = 0.25 - 1.25 = -1, soit - 100%, ce qui correspond 

bien à la limite théorique inférieur de la différence relative. 

o Maximum = (0.01*250) - 1.25 =  2.5 - 1.25 = 1.25, soit + 125%. !! Cette valeur 

maximale constitue une limitation dans la représentation des anomalies 
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positives (confer l’exemple (extrême) chiffré ci-dessus où on arrive à une DR 

de +300%). (confer à ce propos le tutoriel officiel de SPIRTIS page 85 et le 

manuel de SPIRITS page 170 : il est probable que les valeurs dépassant cette 

limite supérieure soient automatiquement converties vers cette limite 

supérieure). 

 

Cette carte d’anomalie (ci-dessus) de fin août 2002 (20020821) met bien en évidence les 

valeurs de NDVI très inférieure à la moyenne LTA (-50% à -70%), en particulier dans 

l’extrême nord du Sénégal (département de Dagana). 

Une fois le « map template » réalisé, vous pouvez l’enregistrer et l’utiliser pour produire 

toutes les cartes d’anomalie pour toutes les 36 décades de 2002. Pour ce faire : 

• Analysis > Maps > Map series > Time series 
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Ensuite: 

• Soit paramétrer la fenêtre “Create Quick Look” comme dans l’image ci-dessous, 

sauvegarder éventuellement le task file et exécuter la tâche 

• Soit, pour gagner du temps, ouvrez (File > Open) le « task file » (TNT) créé 

préalablement pour vous et disponible dans le répertoire 

« C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\TNT\ 

RELATIVE_DIFFERENCE_SNDVI_SEN_2002_LTA_1999_2018.tnt », et exécutez-le 

(temps d’exécution : 30 secondes). 

 

• Vérifier le résultat : 

o Dans le panneau « Results » de SPIRITS (point noir) 

o Dans le dossier “ C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\PNG\SENEGAL 

NDVI RELATIVE DIFFERENCE 2002\ » (présence des 36 cartes pour les 36 

décades de 2002) (confer image ci-dessous (cartes rognées ici)). 
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L’ensemble de ces cartes d’anomalie (ci-dessus) pour 2002 mettent bien en évidence les 

valeurs de NDVI qui sont en majorité inférieures à la moyenne LTA (couleur rouge), en 

particulier dans l’extrême nord du Sénégal en juillet, août et septembre. 

Notez la possibilité de créer des cartes d’anomalie sur des périodes d’un mois via 

l’agrégation temporelle préalable des images NDVI et le calcul de LTA mensuel. Une carte 

mensuelle a l’avantage (par rapport à une carte décadaire) de représenter via une seule 

image les conditions de végétation pour un mois complet (il faudrait 3 images décadaires 

aussi non). 
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11.6.9. Analyse des variables phénologiques 

11.6.9.1. Présentation du concept d’extraction de variables phénologiques à 

partir de courbes d’évolution du NDVI 

Une série de paramètres peuvent être calculés à partir d’une courbe d’évolution du NDVI 

correspondant à une saison de végétation (courbe rouge dans la figure ci-dessous par 

exemple). Par exemple : 

• Les dates de début/de fin de la saison de végétation et les valeurs de NDVI associées 

(4 paramètres) 

• La longueur de la saison (période), l’amplitude du NDVI entre le début et la fin de la 

saison, différente surfaces (intégrales) sous la courbe de NDVI, etc 

 

Ces paramètres ont une connotation « phénologique », c’est-à-dire qu’ils peuvent être 

utilisés pour caractériser le développement « phénologique » de la végétation.  

La phénologie de la végétation correspond typiquement à la succession d’événements 

périodiques déterminée par les variations saisonnières du climat, tels que par exemple la 

floraison, la feuillaison, la fructification, la coloration des feuilles des végétaux, la 

sénescence.  

Ces paramètres peuvent être utilisés dans des modèles qui tentent de caractériser l’état de 

la végétation ou encore de prédire les rendements agricoles par exemple.  
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11.6.9.2. Calcul des variables phénologiques à partir des images NDVI 

temporellement lissées (résultat = des images correspondant à des 

paramètres phénologiques) 

Dans SPIRITS, la fonction « Pheno » accessible via le menu  

• « Processing > Temporal > Times Statistics »  

permet de calculer 12 « paramètres phénologiques ». Ils sont décrits dans la figure ci-

dessous. Remarque : le « Pok » n’est pas à proprement parlé un « paramètre 

phénologique » ! 

 

Figure 201 : Paramètres phénologiques calculables dans SPIRITS avec la fonction « Pheno » 
accessible via le menu « Processing >Temporal > Times Statistics ». Source : page 146 du manuel 
officiel de SPIRITS. 

Paramétrer la tâche de calcul des 12 « paramètres phénologiques » : 

Attention, malheureusement, cet outil doit être exécuté autant de fois qu’il n’y a d’années 

à traiter et le paramétrage adapté à chaque année (confer Figure ci-dessous).  
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Afin que le calcul des paramètres phénologiques soit le moins possible impacté par la longue 

saison sèche qui caractérise la plupart des départements du Sénégal, il est possible de définir 

une fenêtre temporelle dans laquelle calculer ces paramètres phénologiques. Cette fenêtre 

temporelle devrait idéalement être adaptée en fonction des différences de dynamique des 

saisons de végétation dans les différents départements, si ces différences sont significatives. 

Ces considérations dépassent cependant le cadre de cet exercice de découverte de SPIRITS. 

Dans le cadre de cet exercice nous nous contenterons de définir une fenêtre temporelle 

identique pour tous les départements, entre avril (0401, décade 10) et décembre (1221, 

décade 36) de chaque année, période qui semble d’ailleurs inclure complétement la saison 

de végétation dans le centre et le nord du Sénégal sur base des graphiques présentés à la 

section 11.6.6.4 page 371. 

Pour paramétrer le calcul des paramètres phénologiques : 

• Soit paramétrer la tâche de calcul des paramètres phénologiques comme indiqué 

dans l’image ci-dessous et sauvegarder éventuellement votre « Task file » (TNT) 

• Soit, pour gagner du temps, ouvrir (File > Open) les « Task file  » (TNT) préalablement 

établis pour vous, pour chaque année, par exemple pour 1998 

« C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\TNT\PHENO_NDVI_SMOOTHED_SEN

_1998.tnt » 

• Attention aux paramètres « FIRST img date » et « LAST img date » : indiquer 

YYYY0401 et YYYY1221 respectivement en remplaçant « YYYY » par l’année à traiter.  
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• Cliquer sur « Execute » pour lancer le calcul des paramètres phénologiques (temps 

d’exécution : 4 secondes par année) 

• Vérifier le résultat : 

o Dans le panneau « Results » de SPIRITS (point noir) 

o Dans le dossier 

« C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\DATA\SEN\NDVI_1km_V2.2.1

_PHENO\ » (présence de 528 fichiers = 22 années (1998-2019) * 12 

paramètres (= 12 images par saison) * 2 fichiers (header + img). 

• Remarque : pour 2019, étant donné la série incomplète (qui s’arrête à 20190911), les 

paramètres phénologiques ne sont pas comparables à ceux des autres années ! 

Le résultat de cette analyse correspond donc à 12 images par saison, avec pour une saison, 

1 image par paramètre phénologique.  

Comprendre aussi le header file des images values :… 
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11.6.9.3. Visualisation des images correspondant aux paramètres 

phénologiques 

Une fois les images des paramètres phénologiques produites, il est opportun de les visualiser 

pour : 

• s’assurer d’interpréter correctement leurs valeurs (variable selon le type de 

paramètre) 

• comprendre la répartition spatio-temporelle de ces paramètres (variation spatiale et 

inter-annuelle) 

Pour visualiser les images de paramètres phénologiques, des « map template » peuvent être 

créé selon la même procédure que détaillée dans la section 11.6.5.1 page 355. 

Pour créer ces « map template » : 

• Analysis > Maps > Create template  

Modifier les paramètres de mise en page, en particulier : 

• L’image à mettre en page doit être sélectionnée 

• Les flags doivent être importés 

• Le titre de la légende et de la carte doivent correspondre à la variable représentée 

(utiliser les variables codées par « %chiffre_de_la_variable ») 

• ATTENTION !!! La symbologie (onglet « Colours ») doit être adaptée au type de 

variable présente  dans chaque type d’image et à leurs valeurs! Cliquer sur « Auto » 

puis modifier comme désiré. Notez que les valeurs de la variable apparaissent dans 

les 2 premières colonnes de l’onglet « Colours » : « From » et « Till » et que les Digital 

Numbers (DN = valeurs digitales des pixels) associés (« Digital ») sont présents dans la 

3ème colonne. Il est très important de bien comprendre la signification de ces 

valeurs !!  

o Pour les paramètres Dmn, Dmx, Dup, Ddn :  

▪ Ces valeurs correspondent à des pourcentages de la période 

considérée dans l’analyse. Par exemple si la date de la valeur 

maximale (Vmx) est la décade 25 et que la fenêtre temporelle utilisée 

va de début avril (décade 10) à fin décembre (décade 36) (et que le 

« reference date » est laissée vide), on obtient une valeur de Dmx de 

(25-10)/(36-10) = 58%, c’est-à-dire que la Dmx correspond à une date 

légèrement ultérieure à la moitié de la fenêtre temporelle considérée 

dans l’analyse. 

▪ Sur base du header file de ces images, on voit que la gamme 

potentielle des valeurs de DN varie de 0 à 200, mais avec un « scaling 

factor » de 0.5, ce qui ramène la gamme potentielle des valeurs de 
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date exprimée en pourcentage de 0 à 100 (200*0.5=100). Les valeurs 

de DN réellement observées varient, dans le cas de l’exemple ci-

dessous, entre 4 et 196, soit entre 2% et 98%. 

 

 

• Sur cette base une symbologie allant de 0 à 100% par pas de 10% semble 

adaptée (confer image ci-dessus). Cependant cette symbologie ne met pas 

clairement en évidence la variabilité spatiale de la variable représentée. 

On voit dans l’exemple ci-dessous que très peu de pixels sont concernés 

par les faibles valeurs. Il convient dès lors d’adapter la symbologie pour 

avoir une plus grande variation  de couleurs pour les valeurs plus élevées.  

• Afin d’adapter au mieux la symbologie, il faut se faire une meilleure idée 

de la distribution des valeurs des pixels. Cela peut se faire via la création 
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d’un histogramme (graphique de la fréquence de distribution des valeurs 

de pixels) via l’outil : 

o Analysis > Images > Histogram > Tool  

 

• et l’analyse du fichier texte en sortie (malheureusement, aucun graphique 

de type histogramme n’est produit !) 
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• Sur lequel on peut voir que il n’y a que ~ 2.5% de pixels (colonne CUM%) 

qui présentent des valeurs de DN ≤ 89 (colonne V = valeurs de DN) (valeur 

de % de date associée = 44.5, colonne Y) 

• → la symbologie peut être adaptée pour appliquer la plus grande 

variabilité de couleurs aux DN compris entre 90 et 190 (valeurs de % de 

dates associées = 45-95, colonne Y) : confer image ci-dessous : 

l’amélioration est légère !  
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• Le rétrécissement de la gamme de valeurs à la gamme 50% à 75% 

augmente le contraste mais les pixels hors de cette gamme ne sont plus 

colorés (confer image ci-dessous). 
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• Remarque : la symbologie à 3 couleurs présente un bug : elle n’attribue 

pas la « From colour » à la « From value » et  remplace la « From colour » 

par une couleur intermédiaire, ce qui annihile la valeur ajoutée de cette 

option.  

Les 11 « paramètres phénologiques » sont présentés pour l’année 2002 dans la figure ci-

dessous. 
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Remarque: les images Aup et Adn sont quasiment binaires: 

• Aup : valeurs de 90 et 91 

• Adn : valeurs de 89 et 90 

11.6.9.4. Création de la structure de la base de données pour accueillir les 

variables phénologiques 

Afin de réaliser l’extraction de statistiques sur les paramètres ou variables phénologiques, il 

est nécessaire de créer ces variables dans la structure de la base de données, similairement à 

ce qui a été fait à la section 11.6.6.1 page 358. 

• Analysis > Database > Variable 

Pour ce faire,  

• Soit créer les variables manuellement via l’interface dédiée 

• Soit importer le fichier texte, préalablement créé pour vous, qui reprend ces 

variables, disponible dans le répertoire : 

« C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\TXT\VARIABLES.txt » (confer image 

ci-dessous). (Si vous aviez déjà réalisé cette opération à la section 11.6.6.1 page 358, 

inutile de le refaire.) 
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11.6.9.5. Extraction des statistiques par zone (RUM) pour les variables 

phénologiques  

Création de « fichiers liste » ou « list file » des images des paramètres phénologiques 

Pour extraire les statistiques à partir des images correspondant aux paramètres 

phénologiques, il faut préalablement créer des « fichiers listes » (« list file »).  

Chaque fichier liste listera l’ensemble des 22 images (car 22 années étudiées, entre 1998 et 

2019) correspondant à un paramètres phénologique donné. 

(Confer page 31 et suivantes du manuel officiel de SPIRITS pour plus d’information sur la 

création de « list file »). 
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Pour créer ces fichiers liste : 

• Analysis > Database > Extract > Tool > Onglet List of files > New 

• Sélectionner les 22 images correspondant à un paramètre phénologique 

• Sauvegarder la liste (File > Save as) dans le répertoire 

« C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\LNL\ » avec comme nom, par 

exemple pour le paramètre Adn, « Adn_1998_2019 ». 

• Ensuite, 

o Soit répéter l’opération pour les autres paramètres,  

o Soit faites de simples copier/coller du fichier texte de liste et adaptez-les via 

remplacement de texte. 

o Soit se contenter des fichiers listes préalablement créés pour vous dans le 

répertoire « C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\LNL\ » 

 

Pour extraire les statistiques des listes d’images phénologiques: 

• Rester dans le menu « Analysis > Database > Extract > Tool > Onglet List of files” 

• Ensuite : 

o Soit paramétrer la fenêtre comme indiqué dans l’image ci-dessous, exécuter, 

et éventuellement sauvegarder le « task file » correspondant dans le dossier 

« TNT ». Puis répéter l’opération pour chaque variable phénologique. 
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▪  !! Ne pas mettre de préfixe et suffixe ici ! 

o Soit ouvrir (File > Open) le « task file » préalablement créé pour vous pour le 

paramètre « Adn » et disponible dans le répertoire 

« C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\TNT\ ». L’exécuter. Puis 

exécuter l’outil pour les 10 autres paramètres phéno en modifiant à chaque 

fois dans l’interface de l’outil, le fichier liste input et la variable (section 

« Parameters »)! 

 

• Vérifier le résultat : 

o Dans le panneau « Results » de SPIRITS (point noir) 

o Dans le dossier 

“C:\TIME_SERIES_ANALYSIS\SPIRITS\SENEGAL\RUM\SEN\PHENO\ » (présence 

des 242 fichiers de résultat (11 paramètres * 22 années = 242) 

11.6.9.6. Visualisation des statistiques par zone (RUM) pour les variables 

phénologiques 

Une fois extraites, les statistiques peuvent être explorées via consultation de la base de 

données et la réalisation de graphiques, comme indiqué préalablement à la section 11.6.6.4 

page 371. 

Pour consulter la base de données produite : 
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• Analysis > Database > Browse  
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On retrouve pour le paramètre Vmx (maximum NDVI value) le même comportement que 

celui observé à la section 11.6.6.4 page 371 pour les départements de Dagana (Vmx faible et 

irrégulier), Pikine (Vmx décroissant avec le temps) et Ziguinchor (Vmx haut et régulier). 

Notons la possibilité de calculer d’autres « paramètres phénologiques » via le menu (qui ne 

sera pas exploré dans le cadre de cet exercice): 

• « Processing > Temporal > Phenology > Season detection » 

Cet outil permet de détecter le nombre de saisons par année, les dates de début, maximum 

et fin de saison, de même que les valeurs de NDVI (par exemple) associées et la longueur 

de la saison. Confer le manuel officiel de Spirits, page 148 et suivante.  
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12. BFAST : Breaks For Additive Season and 

Trend (dans R et RSTUDIO) 

 

 

Objectifs 
pédagogiques 

Se familiariser à l’utilisation du langage de programmation R via les 

logiciels R et R-Studio pour : 

• Télécharger des images MODIS (MODIS Fixed sites) 

• Analyser des séries temporelles d’images MODIS, et en 
particulier : 

o Créer une figure représentant une image MODIS 
(visualisation) 

o Analyser une série temporelle d’images MODIS avec le 
package BFAST permettant notamment de : 

▪ Décomposer une série temporelle en : tendance 
(trend), saisonnalité (season), cassure (break), 
bruit (remain) (fonction « bfast() ») 

▪ Identifier en presque temps réel (near real time) 
les cassures (breaks) dans les séries temporelles 
(fonction « bfastmonitor() ») 

 

Données 

Le dossier associé à cet exercice est le dossier 
«…\8_SERIE_TEMPORELLE_BFAST\...» (~ 20 Mo). 

Téléchargez ce dossier sur votre ordinateur en local dans votre 
répertoire de travail et décompressez-le. ATTENTION ! Voyez la section 
1.2 page 19 pour plus d’information sur l’accès aux données. 

Ce dossier, présenté en détails à la section 12.2, ne contient pas de 
données (pas nécessaire pour cet exercice). Il contient par contre : 

• Le code R à utiliser « R_CODE_BFAST.R » 

• Des exemples de graphiques résultant du code 

• Des ressources complémentaires (documents pdf) 

 

Logiciel ou 
application 

BFAST (package R) (http://bfast.r-forge.r-project.org/) 
R et RSTUDIO (https://www.r-project.org/ et https://rstudio.com/) 

 

Temps 
approximatif 

~ 2 heures (45 minutes d’introduction et 1h15 de 
découverte/compréhension/application du code R) 

http://bfast.r-forge.r-project.org/
https://www.r-project.org/
https://rstudio.com/
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Prérequis 
Il est fortement préférable que l’apprenant ait déjà quelques notions de 
programmation, idéalement dans R.  Le non initié risque fort de ne pas 
s’y retrouver.  

 
# série temporelle, basse résolution spatiale, indice de végétation 
 

12.1. Introduction 

Les sections suivantes présentent d’abord le contenu du dossier de l’exercice, le package R 

« BFAST » et ses concepts principaux, le tutoriel source sur lequel est basé cet exercice, la 

manière d’installer les logiciels R et RSTUDIO,  la présentation des images MODIS « 

MOD13Q1 » qui seront utilisées pour l’exercice, et l’outil web MODIS « Fixed Sites Subsets 

Tool » qui permet d’accéder facilement à certaines données MODIS. Il n’est pas nécessaire 

d’explorer en détails tous les liens qui sont donnés dans ces sections.   

Ce n’est qu’à la section « 12.8 Utilisation de BFAST dans R et RSTUDIO » page 419 que 

l’exercice pratique commence réellement via l’utilisation du code R « R_CODE_BFAST.R ». 

Pour bien comprendre ce que le code R fait, les indications des sections précédentes doivent 

avoir été parcourues.  

12.2. Contenu du dossier de l’exercice 

Le dossier relatif à cet exercice est le dossier suivant : 

• « 8_SERIE_TEMPORELLE_BFAST » qui contient : 

o « R_CODE_BFAST.R » le code R à utiliser pour cet exercice (adapté depuis le 

tutoriel source présenté à la section 12.4) 

o Documents PDF : 

▪ « bfast R PACKAGE MANUAL.pdf »: le manuel du package R 

« BFAST ». 

▪ « MODISTools R PACKAGE MANUAL.pdf » le manuel du package R 

« MODISTools » pour travailler sur les données MODIS dans R. 

▪ « MOD13_User_Guide_V6.pdf » : le guide d’utilisateur des produits 

MODIS avec beaucoup d’information techniques sur ces produits.  

o « RSE PAPERS JAN VERBESSELT » : les 3 articles scientifiques de Jan 

VERBESSELT en lien avec le développement et l’utilisation de BFAST. 

o « PLOT » : un dossier pour recueillir les graphiques (plots) générés par 

l’analyse BFAST pour différents sites, avec certains graphiques déjà générés 

lors de tests.  
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12.3. Présentation de BFAST (package de R) 

« BFAST, Breaks For Additive Season and Trend » permet la décomposition de séries 

temporelles en différentes composantes : une tendance (anglais : « trend »), un aspect 

saisonnier (anglais : « season »), et reste (anglais : « remainder ») et propose une séries de 

méthodes pour détecter et caractériser les changements (dont des cassures (anglais : 

« breaks » qui sont des changements brutaux et importants) au sein d’une série temporelle.  

Jetez un œil rapide aux pages web de référence suivantes : 

• Projet home page : http://bfast.r-forge.r-project.org/ 

• Project summary page: http://r-forge.r-project.org/projects/bfast/  

Source: http://bfast.r-forge.r-project.org/ 

12.3.1. Fonction “BFAST” 

La function “BFAST estimates the time and number of abrupt changes within time series, 

and characterizes change by its magnitude and direction.” 

 

Figure 202 : « Fitted seasonal, trend and remainder (i.e. estimated noise) components for a 16-day 
MODIS NDVI time series (data series) of a pine plantation” 

http://bfast.r-forge.r-project.org/
http://r-forge.r-project.org/projects/bfast/
http://bfast.r-forge.r-project.org/
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Source : J. Verbesselt et al. / Remote Sensing of Environment 114 (2010) 106–115 

12.3.2. Fonction « BFASTmonitor » 

La function “BFASTmonitor provides functionality for monitoring disturbances in time series 

models (with trend/season/regressor terms) at the end of time series (i.e., in near real-

time).” 

 

Figure ci-dessus: “Simulated 16-day MODIS NDVI time series. The period from 2004 until 

mid-2010 (i.e., the time step just before the simulated break), is considered the history 

period and the period after the simulated break is the monitoring period (grey background). 

The monitoring period contains 6 observations. The result of the monitoring approach is 

shown: A stable history period is identified within the history period (i.e., 2007 until mid-
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2010) and used to model and predict the normal data variation (blue dashed line) to enable 

disturbance detection. Here, a disturbance is detected after 3 observations in the 

monitoring period (green vertical line). Applications: Deforestation, forest health 

monitoring and phenological change detection within time series of spatio-temporal data 

sets (satellite images)." 

D’autres exemples sont donnés dans la figure ci-dessous.  

 

 

Source : J. Verbesselt et al. / Remote Sensing of Environment 123 (2012) 98–108. 
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12.4. Tutoriel source 

L’exercice qui est présenté dans cette section « BFAST » de ce manuel de travaux pratique se 

base en très grande majorité sur le tutoriel de Jan Verbesselt disponible ici : 

• MODIS based time series analysis using BFAST 

• https://verbe039.github.io/BFASTforAEO/ 

Ce tutoriel ne doit pas être parcouru vu que toutes les informations nécessaires à la 

réalisation de l’exercice sont reprises dans ce manuel et dans le code R mis à disposition. Il 

pourra cependant peut être s’avérer une ressource utile en cas de problème.  

https://verbe039.github.io/BFASTforAEO/
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12.5. Installation des 2 logiciels R et RSTUDIO 

BFAST est un package du logiciel R. Il s’utilise donc dans l’environnement de R et il vous faut 

donc installer R sur votre ordinateur. 

RSTUDIO est un logiciel qui sert d’interface pour travailler avec R. Il faut également installer 

RSTUDIO sur votre ordinateur.  

12.5.1. Téléchargement et installation de R 

• Page principale du logiciel R :  

o https://www.r-project.org/  

• Page et procédure de téléchargement : 

o https://www.freestatistics.org/cran/ 

o > "Download R for Windows" si vous êtes sur Windows 

o > Choisir "base"  

o > Choisir "Download R 3.6.3 for Windows" (téléchargez la dernière version 

disponible qui est peut être ultérieure à cette version)  

o > Télécharger puis installer 

12.5.2. Téléchargement et installation de R STUDIO 

• Page principale du logiciel RSTUDIO :  

o https://rstudio.com/ 

• Page et procédure de téléchargement : 

o https://rstudio.com/ 

o > Cliquer sur « Download RSTUDIO » 

o > Choisir la version gratuite "RStudio Desktop free" 

o > Choisir "l'installers" pour votre système d'exploitation, par exemple pour 

Windows: "RStudio 1.2.5033 - Windows 10/8/7 (64-bit)" (téléchargez la 

dernière version disponible qui est peut être ultérieure à cette version) 

o > Télécharger puis installer 

https://www.r-project.org/
https://www.freestatistics.org/cran/
https://rstudio.com/
https://rstudio.com/
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12.6. Présentation des images MODIS « MOD13Q1 » 

Le produit NDVI de MODIS est repris dans le produit MODIS appelé « MOD13Q1 ». Ce 

produit sera utilisé dans ce tutoriel comme source de donnée du NDVI pour construire la 

série temporelle. Cette section présente brièvement les images MODIS et ce produit en 

particulier.  

Page web principale de MODIS: 

• https://modis.gsfc.nasa.gov/ 

Informations sur MODIS : 

• https://modis.gsfc.nasa.gov/about/ 

o MODIS (or Moderate Resolution Imaging Spectroradiometer) is a key 

instrument aboard the Terra and Aqua satellites.  

o Terra MODIS and Aqua MODIS are viewing the entire Earth's surface every 1 

to 2 days, acquiring data in 36 spectral bands, or groups of wavelengths  

• Technical specifications: https://modis.gsfc.nasa.gov/about/specifications.php  

o Spatial Resolution: 250 m (bands 1-2, red & NIR), 500 m (bands 3-7), 1000 m 

(bands 8-36) 

• List of MODIS products: 

o https://modis.gsfc.nasa.gov/data/dataprod/ 

• MODIS Vegetation Index Products (NDVI and EVI): MOD13! 

o https://modis.gsfc.nasa.gov/data/dataprod/mod13.php 

• MOD13Q1 v006 

o https://lpdaac.usgs.gov/products/mod13q1v006/ 

o MODIS/Terra Vegetation Indices 16-Day L3 Global 250 m 

o NDVI + EVI (EVI: improved sensitivity over high biomass regions) 

o 2 vegetation layers + 1 quality layer and 1 quality reliability layer for the 

indices NDVI and EVI + 4 reflectance bands (1 (red), 2 (near-infrared), 3 (blue), 

and 7 (mid-infrared)), as well as 4 other layers → 12 bands 

→ Le NDVI de MOD13Q1 sera utilisé dans ce tutoriel.  

https://modis.gsfc.nasa.gov/
https://modis.gsfc.nasa.gov/about/
https://modis.gsfc.nasa.gov/about/specifications.php
https://modis.gsfc.nasa.gov/data/dataprod/
https://modis.gsfc.nasa.gov/data/dataprod/mod13.php
https://lpdaac.usgs.gov/products/mod13q1v006/
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Source de l’illustration : https://sites.google.com/site/chempendix/em-spectrum  

https://sites.google.com/site/chempendix/em-spectrum
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12.7. Présentation du MODIS « Fixed Sites Subsets Tool »  

Le MODIS « Fixed Sites Subsets Tool » est une plateforme web qui donne un accès facile à 

certaines données MODIS pour des sites prédéfinis. Cet exercice utilisera des données 

MODIS provenant de ces sites prédéfinis.   

Site web : 

• https://modis.ornl.gov/sites/ 

“The Fixed Sites Subsets Tool provides: 

• customized subsets and visualizations of several MODIS/VIIRS land products and 

Daymet daily surface weather data for selected fields 

• for predefined areas of about 8 X 8-km centered on the selected sites.” 

 

Sélectionnez un site d’intérêt sur la carte : 

• Dans le tutoriel web de Jan VERBESSELT, c’est le site 'Gelderland Loobos' aux Pays-

Bas qui est utilisé.  

https://modis.ornl.gov/sites/
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• Dans ce manuel, c’est le site « ke_laikipia_mpala » dans le centre du Kenya qui sera 

utilisé. Trouvez et sélectionnez ce site via l’interface spatiale ou le menu de 

recherche. 

• Mais libre à vous d’utiliser un autre site. Choisissez cependant un site encore actif 

(certains ne le sont plus). Idéalement trouvez un site présentant une évolution 

temporelle du NDVI non régulière (présence d’une variation saisonnière, d’une ou 

plusieurs tendances et cassures) afin que l’analyse de cette série avec BFAST (section 

suivante) produise des résultats « intéressants ». ATTENTION, il vous faudra alors 

adapter le nom du site lors de l’utilisation de R (confer section suivante). 

Sélectionnez ensuite, dans le tableau sous la carte, le produit MOD13Q1 « MODIS/Terra 

Vegetation Indices (NDVI/EVI) » (décrit plus haut). 

Identifiez, pour le site sélectionné: 

• Dans l’onglet « Download Data »  

o Le nom de la bande d’intérêt, (ici : « 250m_16_days_NDVI ») 

o L’évolution des valeurs de NDVI à travers le temps via le graphique disponible 

sous le tableau 

o Le type d’occupation du sol présent via la webmap disponible en bas de page, 

onglet « Land Cover » 

o La phénologie via le graphique disponible en bas de page, onglet 

« Phenology » 

• Dans l’onglet « Subset Summary » : 

o Le « Site ID » (ke_laikipia_mpala) 

o Le « Subset Date Range » (période couverte) (2000-02-18 (2000049) to 2020-

03-05 (2020065) au moment d’écrire ces lignes) 

Remarquez également :  

• “Under 'Download data' tab and table you can see the Pixel Numbering Scheme 

where the blue pixel (i.e. 545) is the "site pixel" (i.e. the middle of the spatial 

subset).” 

ATTENTION ! Dans le cadre de cet exercice, la série temporelle d’images NDVI MODIS ne 

sera pas téléchargée manuellement à partir de ce site web « Fixed Sites Subsets Tool » de 

MODIS MAIS plutôt via l’utilisation du code R mis à disposition (confer section suivante) qui, 

lui, téléchargera automatiquement les données à partir de ce site web. Certaines des 

informations identifiées ci-dessus (« Site ID », etc) sont reprises dans le code R.  
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12.8. Utilisation de BFAST dans R et RSTUDIO 

Dans cette section, vous allez utiliser l’outil BFAST pour réaliser une analyse de série 

temporelle d’images NDVI MODIS dans R et RSTUDIO pour un site MODIS prédéfinis (confer 

ci-dessus). 

Utilisez le fichier « 8_SERIE_TEMPORELLE_BFAST\R_CODE_BFAST.R » qui est : 

• un copié collé du tutoriel mentionné ci-dessus 

(https://verbe039.github.io/BFASTforAEO/) 

• dans lequel quelques améliorations ont été apportées  

Double-cliquez sur ce fichier qui s’ouvrira en principe dans RSTUDIO. 

Suivez les indications reprises sous forme de commentaires (#) dans ce fichier. Tentez de 

comprendre comment fonctionne ce code R en l’exécutant morceau par morceau et 

visualisez les résultats intermédiaires et finaux. Faites éventuellement varier certains 

paramètres afin de comprendre leur impact sur les résultats de l’analyse.  

Quelques résultats sont repris ci-dessous pour le pixel central (N° 545) du site 

« ke_laikipia_mpala » dans le centre du Kenya. 

• Série temporelle du NDVI 

 

• Résultat de la fonction bfast() 

https://verbe039.github.io/BFASTforAEO/
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• Résultats de la fonction bfastmonitor() en fonction de différents paramétrages 

 
Trend + Harmo + Order 3 

 
Trend + Harmo + Order 1 

 
NO Trend + Harmo + Order 3 

 
Trend + NO Harmo (+ Order 3) 
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13. Autres outils d’analyses de séries 

temporelles d’images satellites 

Section donnée à titre d’information 

13.1. AρρEEARS - Application for Extracting and Exploring 

Analysis Ready Samples 

https://arset.gsfc.nasa.gov/land/webinars/time-series-19  

• Exercise 1: Extracting MODIS Time Series Data Using AppEEARS 

• https://lpdaacsvc.cr.usgs.gov/appeears/ 

• + confer the slides of présentation 

Example: https://lpdaacsvc.cr.usgs.gov/appeears/help 

13.2. LandTrendr via Google Earth Engine 

https://arset.gsfc.nasa.gov/land/webinars/time-series-19  

• Exercise 2: LandTrendr via Google Earth Engine 

• + confer the slides of presentation 

13.3. MODIS NDVI Time Series 

• Page principale :  

o https://arset.gsfc.nasa.gov/land/workshops/WCC2016 

• « MODIS NDVI Anomalies and Time Series » 

o NDVI, Anomaly, visualization, graphique, outils web 

o https://arset.gsfc.nasa.gov/sites/default/files/land/workshops/WCC2016/S4.

7%20MODIS%20NDVI%20Time%20Series%20Exercise.pdf 

13.4. Time series analysis in remote sensing by LUND 

UNIVERSITY  

Confer : https://www.nateko.lu.se/research/remote-sensing-and-earth-observation/lund-

earth-observation-research-group/time-series-analysis-in-remote-sensing 

https://arset.gsfc.nasa.gov/land/webinars/time-series-19
https://lpdaacsvc.cr.usgs.gov/appeears/
https://lpdaacsvc.cr.usgs.gov/appeears/help
https://arset.gsfc.nasa.gov/land/webinars/time-series-19
https://arset.gsfc.nasa.gov/land/workshops/WCC2016
https://arset.gsfc.nasa.gov/sites/default/files/land/workshops/WCC2016/S4.7%20MODIS%20NDVI%20Time%20Series%20Exercise.pdf
https://arset.gsfc.nasa.gov/sites/default/files/land/workshops/WCC2016/S4.7%20MODIS%20NDVI%20Time%20Series%20Exercise.pdf
https://www.nateko.lu.se/research/remote-sensing-and-earth-observation/lund-earth-observation-research-group/time-series-analysis-in-remote-sensing
https://www.nateko.lu.se/research/remote-sensing-and-earth-observation/lund-earth-observation-research-group/time-series-analysis-in-remote-sensing


422 
 

• TIMESAT software 

o http://web.nateko.lu.se/timesat/timesat.asp 

• PolyTrend  

o Web-app : http://polytrend.gis.lu.se/ web application for time series analysis  

o R-package: https://cran.r-project.org/web/packages/PolyTrend/index.html 

• DBEST R package 

o https://cran.r-project.org/web/packages/DBEST/index.html  

13.5. QGIS EO Time Series Viewer  

• https://eo-time-series-viewer.readthedocs.io/en/latest/index.html 

• Petit tuto exemple 

• explorer une image dans QGIS  

o + time grid signification 

o + eotimeseries de qgis  

o + missing data code 

 

http://web.nateko.lu.se/timesat/timesat.asp
http://polytrend.gis.lu.se/
https://cran.r-project.org/web/packages/PolyTrend/index.html
https://cran.r-project.org/web/packages/DBEST/index.html
https://eo-time-series-viewer.readthedocs.io/en/latest/index.html
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14. Introduction à GOOGLE EARTH ENGINE 

(GEE) 

 

 

Objectifs 
pédagogiques 

Découvrir Google Earth Engine à travers : 

• une brève introduction générale pour fixer le cadre 

• quelques exercices simples pour vous initier à la manipulation de 
données d’observation de la terre dans cet environnement 

A la fin de cette section vous devriez être familiarisé avec GEE et 
suffisamment à l’aise que pour continuer à apprendre par vous-même à 
l’aide des ressources existantes sur le web.  

 

Données 

Aucune donnée n’est nécessaire pour cet exercice. 

Quelques tutoriaux sont disponibles dans le dossier 
«…\9_GOOGLE_EARTH_ENGINE\...» (~ 4 MB). 

Téléchargez éventuellement ces documents (non directement utilisés 
dans le cadre de cet exercice) sur votre ordinateur en local dans votre 
répertoire de travail.  

 

Logiciel ou 
application 

Google Earth Engine (GEE) (https://earthengine.google.com/) 

 

Temps 
approximatif 

~ 3-4 heures 

 

Prérequis 
Aucun. Cependant, l’étudiant ayant déjà quelques notions de 
programmation aura plus de facilité qu’un non initié. 

 
# Google Earth Engine, Javascript, programmation, cloud processing 

 

 

https://earthengine.google.com/
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14.1. Préalable !! 

ATTENTION! Un délai de quelques jours peut être nécessaire pour obtenir un accès à GEE. 

Faites donc la demande d’accès plusieurs jours (1 semaine) avant la séance de TP (une 

demande faite le 21/11/2019 a pris une dizaine d’heures pour être acceptée). 

« How do I get access? 

To get access to Earth Engine, please fill out the form at signup.earthengine.google.com. You 

will receive an email titled "Welcome to Google Earth Engine" with instructions for getting 

started. » (FAQ GEE). 

• (Avoir OU se créer un compte Google via 

o https://account.google.com ) 

Pas besoin d’installer de logiciel : les traitements se font dans le cloud GEE. 

14.2. Présentation de Google Earth Engine (GEE) (30 min) 

14.2.1. Page web principale 

• https://earthengine.google.com/ 

 

https://signup.earthengine.google.com/
https://account.google.com/
https://earthengine.google.com/
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14.2.2. Vidéo d’introduction (2 minutes) 

• Geospatial data processing and analysis platform 

• Powered by Google’s data center infrastructure 

• Collections Landsat, Sentinel-1 et -2, MODIS, MNT, autres données directement 

disponibles 

o Détails des données disponibles : https://developers.google.com/earth-

engine/datasets  

• Environnement de développement JAVASCRIPT API et PYTHON API 

• → permet de travailler facilement sur de très grandes quantités de données à 

l’échelle planétaire  

• Dans quels cas utiliser/ne pas utiliser GEE? Confer Figure 203. 

 

Figure 203 : When to use Earth Engine? (Source de la dia: 
https://servirglobal.net/Portals/0/Documents/Articles/ChangeDetectionTraining/Module2_Intro_Go
ogle_Earth_Engine_presentation.pdf) 

14.2.3. Timelapse 

GEE Timelapse est une « vidéo mondiale zoomable » qui permet de visualiser l’évolution de 

l’occupation du sol de la planète pendant ces 35 dernières années (1984 - 2018) 

o https://earthengine.google.com/timelapse/ 

https://developers.google.com/earth-engine/datasets
https://developers.google.com/earth-engine/datasets
https://servirglobal.net/Portals/0/Documents/Articles/ChangeDetectionTraining/Module2_Intro_Google_Earth_Engine_presentation.pdf
https://servirglobal.net/Portals/0/Documents/Articles/ChangeDetectionTraining/Module2_Intro_Google_Earth_Engine_presentation.pdf
https://earthengine.google.com/timelapse/
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14.2.4. Exemples de cas d’étude avec GEE 

• https://earthengine.google.com/case_studies/, notamment 

o Global Forest Cover Change 

o Global Forest Watch 

o Global Surface Water 

o … 

14.2.5. Les datasets 

Toutes les informations sur les datasets (description, accès) de GEE sont disponibles ici : 

• https://developers.google.com/earth-engine/datasets/ 

 

 

https://earthengine.google.com/case_studies/
https://developers.google.com/earth-engine/datasets/
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14.2.6. 2 Interfaces: EXPLORER et CODE EDITOR 

GEE propose 2 interfaces, présentées ici https://earthengine.google.com/platform/  

14.2.6.1. EXPLORER : VA ETRE SUPPRIMÉ EN 2026 

o https://explorer.earthengine.google.com/#workspace  

o “The Explorer is a lightweight web app for exploring our data catalog and 

running simple analyses.” 

 

14.2.6.2. CODE EDITOR: 

• https://code.earthengine.google.com/  

• “The Code Editor is a web-based IDE (Integrated Development Environment) for 

writing and running scripts.” 

• Documentation sur le code editor:  

o https://developers.google.com/earth-engine/playground  

https://earthengine.google.com/platform/
https://explorer.earthengine.google.com/#workspace
https://code.earthengine.google.com/
https://developers.google.com/earth-engine/playground
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Découvrez les différentes parties de l’interface du CODE EDITOR grâce au “Feature tour”. 

 

Figure 204 : Accès au « Feature tour » du « CODE EDITOR » de GEE 
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14.2.7. Documentations 

La documentation sur GEE est disponible via : 

• https://developers.google.com/earth-engine/ 

o GUIDE: intro, info générale, tutoriels, etc 

o REFERENCE : définition précise des algorithmes disponibles 

o TUTORIALS : tutoriels 

o EDU : autres tutoriels 

o DATA CATALOG : catalogue de données 

 

https://developers.google.com/earth-engine/
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14.3. Exercices 

14.3.1. GEE EXPLORER : VA ETRE SUPPRIMÉ EN 2026 

14.3.1.1. Découverte de l’EXPLORER et classification supervisée (20 minutes) 

Tutoriel de référence : Training Classifiers, Supervised Classification and Error Assessment 

o https://drive.google.com/file/d/1NRREEjp_KFaJcmQtqYcof2rGvHcUBBZz/view  

o aussi disponible en PDF dans le dossier de formation « GEE_0 GEE Explorer and 

Supervised Classification.pdf »  

Suivez ce tutoriel 

Démarrez l’EXPLORER et soyez connecté à GEE: 

o https://explorer.earthengine.google.com/#workspace  

Adaptation du tutoriel : 

o Zoomez sur un pays/région qui vous intéresse, par exemple la région de Kasese en 

Ouganda (confer exercice de classification SCP dans QGIS) 

o Choisissez dans le « data catalog » les 2 jeux de données suivants : 

o « Landsat 7 Collection 1 Tier 1 32-Day TOA Reflectance Composite » 

o « Landsat 8 Collection 1 Tier 1 32-Day TOA Reflectance Composite » 

o Et constatez : 

o La présence importante de nuage → d’où l’utilité de travailler avec des 

composites désennuagés (comme ce sera le cas plus loin dans l’exercice). 

o Le problème des stries de Landsat 7 (https://www.usgs.gov/faqs/what-

landsat-7-etm-slc-data?qt-news_science_products=0#qt-

news_science_products)  

o Comparez la disponibilité des images pour : 

o La période de 32 jours en cours de réalisation (une partie du territoire 

seulement est couvert : variable en fonction de la date actuelle par rapport à 

la période de 32 jours) 

o Une période de 32 jours précédente (100% du territoire est couvert) 

o Informations détaillées sur les bandes de Landsat-7 (utiles pour la réalisation des 

compositions fausses et vraies couleurs) : 

o https://developers.google.com/earth-

engine/datasets/catalog/LANDSAT_LE07_C01_T1_TOA  

o Attention ! Le téléchargement du produit finit ne semble pas fonctionner ! 

L’interface reste à l’étape de « Preparing download… » indéfiniment…  

https://drive.google.com/file/d/1NRREEjp_KFaJcmQtqYcof2rGvHcUBBZz/view
https://explorer.earthengine.google.com/#workspace
https://www.usgs.gov/faqs/what-landsat-7-etm-slc-data?qt-news_science_products=0#qt-news_science_products
https://www.usgs.gov/faqs/what-landsat-7-etm-slc-data?qt-news_science_products=0#qt-news_science_products
https://www.usgs.gov/faqs/what-landsat-7-etm-slc-data?qt-news_science_products=0#qt-news_science_products
https://developers.google.com/earth-engine/datasets/catalog/LANDSAT_LE07_C01_T1_TOA
https://developers.google.com/earth-engine/datasets/catalog/LANDSAT_LE07_C01_T1_TOA
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Pour en savoir plus sur ce qu’est le « Landsat TOA Percentile Composite » : 

o « TOA reflectance » : Top-Of-Atmosphere reflectance (pas de correction 

atmosphérique) (https://developers.google.com/earth-

engine/datasets/catalog/LANDSAT_LC08_C01_T1_TOA)  

o « Surface reflectance » : avec correction atmosphérique, 

https://developers.google.com/earth-

engine/datasets/catalog/LANDSAT_LC08_C01_T1_SR. 

o Landsat 7 5-year TOA percentile composites  

o https://developers.google.com/earth-

engine/datasets/catalog/LANDSAT_LE7_TOA_5YEAR  

o Landsat 7 annual TOA percentile composites  

o https://developers.google.cn/earth-

engine/datasets/catalog/LANDSAT_LE7_TOA_1YEAR  

o Algorithme utilisé : « ee.Algorithms.Landsat.simpleComposite() » 

o https://developers.google.cn/earth-engine/landsat#simple-composite  

Définitions : 

o TIER 1 (T1), TIER 2 (T2), Real Time (RT) : 

o → https://developers.google.com/earth-engine/landsat   

o API : Application Programming Interface 

14.3.1.2. Advanced - Visualizing change over time (5 min) 

Objectif : visualiser l’expansion de la ville de Las Vegas entre 1987 et 2011 à partir de 

composites annuels de Landsat-5.  

Tutoriel de référence : 

o https://drive.google.com/file/d/1oD1jbWfjxXFWFXbBs87QoXi1ReO_cvLZ/view 

o page 19 

o Aussi disponible en PDF dans le dossier de formation sous le nom de : 

o « Google Earth Outreach Introductory Tutorial.pdf » 

Informations complémentaires au tutoriel : 

o Données à utiliser : « Landsat 5 TM Collection 1 Tier 1 Annual TOA Reflectance 

Composite » 

o https://explorer.earthengine.google.com/#detail/LANDSAT%2FLT05%2FC01%

2FT1_ANNUAL_TOA 

o  ! « All the images from each year are included in the composite, with the 

most recent pixel as the composite value.” (pas très utile comme composite)   

https://developers.google.com/earth-engine/datasets/catalog/LANDSAT_LC08_C01_T1_TOA
https://developers.google.com/earth-engine/datasets/catalog/LANDSAT_LC08_C01_T1_TOA
https://developers.google.com/earth-engine/datasets/catalog/LANDSAT_LC08_C01_T1_SR
https://developers.google.com/earth-engine/datasets/catalog/LANDSAT_LC08_C01_T1_SR
https://developers.google.com/earth-engine/datasets/catalog/LANDSAT_LE7_TOA_5YEAR
https://developers.google.com/earth-engine/datasets/catalog/LANDSAT_LE7_TOA_5YEAR
https://developers.google.cn/earth-engine/datasets/catalog/LANDSAT_LE7_TOA_1YEAR
https://developers.google.cn/earth-engine/datasets/catalog/LANDSAT_LE7_TOA_1YEAR
https://developers.google.cn/earth-engine/landsat#simple-composite
https://developers.google.com/earth-engine/landsat
https://drive.google.com/file/d/1oD1jbWfjxXFWFXbBs87QoXi1ReO_cvLZ/view
https://explorer.earthengine.google.com/#detail/LANDSAT%2FLT05%2FC01%2FT1_ANNUAL_TOA
https://explorer.earthengine.google.com/#detail/LANDSAT%2FLT05%2FC01%2FT1_ANNUAL_TOA
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14.3.1.3. Raster de classification (2 minutes) 

Objectif :  

• Visualiser le raster de classification « MCD12Q1.051 Land Cover Type Yearly Global 

500m» 

• https://explorer.earthengine.google.com/#detail/MODIS%2F051%2FMCD12Q1  

Identifiez la correspondance entre les couleurs de la légende et la description des classes 

telle que disponible dans le « datacatalog ». 

14.3.1.4. Advanced - Viewing Classified Rasters (5 min) 

Objectif :  

• Visualiser un « Classified Raster type data layers ». 

Tutoriel de référence : 

o https://drive.google.com/file/d/1oD1jbWfjxXFWFXbBs87QoXi1ReO_cvLZ/view 

o page 14 

o Aussi disponible en PDF dans le dossier de formation sous le nom de : 

o « Google Earth Outreach Introductory Tutorial.pdf » 

14.3.2. GEE CODE EDITOR 

14.3.2.1. Découvrir et visualiser une collection via le code editor (45 minutes) 

Les collections de données sont disponibles ici : 

• https://developers.google.com/earth-engine/datasets 

A partir de cette page, choisissez les dataset suivants : 

• Landsat-8 Surface reflectance  

o https://developers.google.com/earth-

engine/datasets/catalog/LANDSAT_LC08_C01_T1_SR 

o Lisez la description du dataset 

o Lancer le script dans le code editor via le bouton « Open in Code Editor » 

o Visualisez le résultat : il y a beaucoup de nuages ! 

https://explorer.earthengine.google.com/#detail/MODIS%2F051%2FMCD12Q1
https://drive.google.com/file/d/1oD1jbWfjxXFWFXbBs87QoXi1ReO_cvLZ/view
https://developers.google.com/earth-engine/datasets
https://developers.google.com/earth-engine/datasets/catalog/LANDSAT_LC08_C01_T1_SR
https://developers.google.com/earth-engine/datasets/catalog/LANDSAT_LC08_C01_T1_SR
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Figure 205 : Aperçu de la collection Landsat-8 Surface reflectance 

 

o Analysez, comprenez et testez le code utilisé : confer les indications et 

instructions dans le tableau ci-dessous 

Code Signification et commentaires 

var dataset =  Permet de définir une variable « dataset » et de lui attribuer 
la valeur à droite du signe = 

ee.ImageCollection('LANDS
AT/LC08/C01/T1_TOA') 

Permet de construire une collection d’images 
Pour accéder à la définition de la fonction, cherchez le nom 
de la fonction dans l’onglet « DOC » du panneau de gauche 
du code editor (aussi disponible ici 
https://developers.google.com/earth-
engine/api_docs#ee.imagecollection) 

.filterDate('2017-01-01', 
'2017-12-31') 

Permet de filtrer la collection pour une période.  
Cherchez la définition précise de cette fonction dans l’onglet 
« DOC ». 

; A utiliser pour marquer la fin d’une ligne de commande 
JavaScript  

dataset.select(['B4', 'B3', 
'B2']) 

« dataset » fait référence à la variable préalablement créée. 

La fonction « select » s’applique à la variable « dataset ». 

Pour trouver la documentation sur la fonction « select », 
tapez « select » dans le menu de recherche de l’onglet 

https://developers.google.com/earth-engine/api_docs#ee.imagecollection
https://developers.google.com/earth-engine/api_docs#ee.imagecollection
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« DOC » et descendez jusqu’à trouver celle qui se rapporte à 
« ee.ImageCollection » 

 

Cette commande permet de sélectionner les bandes 4-3-2. 
Documentation sur les bandes disponible ici 
https://developers.google.com/earth-
engine/datasets/catalog/LANDSAT_LC08_C01_T1_SR  

Tentez de créer une composition fausse couleur. Cette 
composition sera affichée via la fonction « Map.addLayer » 
présentée en fin de tableau. 

{ 
  min: 0.0, 
  max: 1.0, 
  }; 

{ } Permet de définir un « dictionary » aussi appelé 
« object ». Un « dictionary » peut contenir plusieurs paires 
de « key: value » où « key » est similaire au nom générique 
d’une paire et « value » aux valeurs que prennent cette 
« key ». Plus d’information sur les « dictionary » ici 
https://developers.google.com/earth-engine/tutorial_js_01  
2 paramètres de visualisation sont définis et une valeur leur 
est attribuée 
Les paramètres de visualisation possibles sont brièvement 
décrits dans l’onglet « DOC » via la fonction 
« ee.data.getMapId » 

Map.setCenter(6.746, 
46.529, 6); 

Confer la définition dans l’onglet « DOC » 
Faites varier les paramètres et exécutez le code pour 
visualiser l’impact de ces paramètres. 

Map.addLayer(trueColor43
2, trueColor432Vis, 'True 
Color (432)'); 

Confer la définition dans l’onglet « DOC » 
Vérifiez l’utilité du paramètre « name » (dans menu 
« Layers » du viewer) 
Ajoutez et faites varier les valeurs de paramètres « shown » 
(0 ou 1) et « opacity » (0.5 par exemple) et exécutez le code 
pour visualiser l’impact de ces paramètres. 
 
Ajoutez une commande « Map.addLayer » afin d’afficher la 
composition fausses couleurs créée précédemment. 
Comparez ensuite les compositions vraies et fausses 
couleurs.  

 

• Landsat 7 Collection 1 Tier 1 8-Day NDVI Composite 

o https://developers.google.com/earth-

engine/datasets/catalog/LANDSAT_LE07_C01_T1_8DAY_NDVI 

o + lancer le script dans le code editor via « Open in Code Editor » 

https://developers.google.com/earth-engine/datasets/catalog/LANDSAT_LC08_C01_T1_SR
https://developers.google.com/earth-engine/datasets/catalog/LANDSAT_LC08_C01_T1_SR
https://developers.google.com/earth-engine/tutorial_js_01
https://developers.google.com/earth-engine/datasets/catalog/LANDSAT_LE07_C01_T1_8DAY_NDVI
https://developers.google.com/earth-engine/datasets/catalog/LANDSAT_LE07_C01_T1_8DAY_NDVI
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Code Signification et commentaires 

dataset.select('NDVI') Cette commande semble inutile car dans ce cas-ci la 
collection ne contient qu’une seule bande, celle du NDVI.  

Pour le vérifier, modifiez cette ligne de commande comme 
ceci : 

o var colorized = dataset;//.select('NDVI'); 

et exécutez le script. Y a-t-il une difference?  

Le signe « // » permet de mettre en commentaire ce qui se 
trouve à sa droite , commentaire qui ne sera pas pris en 
considération au moment de l’exécution du code.  
Multi-line comments can start with /* and end with */ 
Remarque : il ne semble pas possible d’exécuter une partie 
de code seulement (une ligne par exemple). Pour ne pas 
exécuter certaines lignes d’un code, il faut les mettre sous 
forme de commentaires. 

palette: [ 
    'FFFFFF', 'CE7E45', 'DF923D', 'F1B555', 
'FCD163', '99B718', '74A901', 
    '66A000', '529400', '3E8601', '207401', 
'056201', '004C00', '023B01', 
    '012E01', '011D01', '011301' 
  ] 

Pour la palette de couleur, les « Hex color codes » sont 
utilisés. Ces codes sont documentés ici par exemple : 

• https://htmlcolorcodes.com/  

 

https://htmlcolorcodes.com/
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14.3.2.2. Tutoriel officiel « The Earth Engine API » 

Suivez le tutoriel officiel « The Earth Engine API » à partir de la section « Visualizing Images 

and Image Bands » disponible ici : 

o https://developers.google.com/earth-engine/tutorial_api_02 

Copiez-Collez les lignes de codes dans le CODE EXPLORER, lisez les instructions et 

descriptions et faites l’effort de comprendre ce que vous faites. N’hésitez pas à : 

o utiliser l’onglet REFERENCE de ce site ou l’onglet DOC du CODE EDITOR pour trouver 

plus d’information sur les fonctions utilisées 

o Consulter le DATA CATALOG pour obtenir plus d’information sur les données 

utilisées.  

Les 4 premières rubriques de ce tutoriel (sur un total de 6) sont brièvement expliquées 

dans les sections ci-dessous : objectifs et visualisation des résultats + explications 

supplémentaires au tutoreil officiel si nécessaire. 

14.3.2.2.1. Visualizing Images and Image Bands (20 minutes) 

Objectifs : afficher correctement une image à bande unique, SRTM dans ce cas-ci, via le 

contrôle des paramètres de visualisation. 

 

https://developers.google.com/earth-engine/tutorial_api_02
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14.3.2.2.2. Computations using Images (20 min) 

Objectifs : réalisation de divers calculs sur des images :  

• calcul des pentes à partir d’un SRTM,  

• calcul à l’aide d’opérateurs mathématiques (conversion de degrés en radians et calcul 

d’un sinus),  

• calcul de statistiques par région 

Remarque : « aspect » est exprimé en degré de 0° à 360°. 

 
Slope 

 
Sin(Aspect) 

 
Calcul de statistiques par région 
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14.3.2.2.3. Image Collections (20 minutes) 

Objectifs : gérer une collection d’images via : 

• L’importation d’une collection dans le CODE EDITOR 

• Sélection d’une image d’intérêt au sein de la collection par la réalisation de : 

o un filtre spatial (par zone d’intérêt (un point)) 

o un filtre temporel (par période d‘intérêt) 

o un tri des images en fonction de la couverture nuageuse 

o la sélection de l’image la moins ennuagée  

• La réalisation de compositions colorées vraies et fausses couleurs de qualité 

• L’utilisation de la console et de l’inspector pour comprendre et analyser les images 

 
Filtres spatial et temporel sur une collection 
Landsat-8 dans la « Console » et (entre 
autres) metadata « CLOUD_COVER » d’une 
image 
 

 
Composition RGB par défaut, de l’image 
présentant le moins de nuages pour la zone 
et la période d’intérêt identifiée par les 2 
filtres 
 

 
Composition RGB vraies couleurs améliorée, 
de l’image…(idem) 
 

 
Composition fausses couleurs 543, de 
l’image…(idem) 
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Collection Landsat-8, de l’image…(idem) 

 

 
Graphique des valeurs de la bande BQA 
pour un pixel pour les 38 images de la 
collection Landsat-8 2016 (2720 = pas de 
nuage*) 

  

* La signification des valeurs de la bande BQA de Landsat-8 est reprise sur la page web 

suivante : 

 

• https://www.usgs.gov/land-resources/nli/landsat/landsat-collection-1-level-1-

quality-assessment-band?qt-science_support_page_related_con=0#qt-

science_support_page_related_con 

• dans la table « Landsat 8 OLI/ OLI-TIRS Level-1 Possible Attributes, Pixel Values, and 

Pixel Value Interpretations » 

 

14.3.2.2.4. Compositing, Masking, and Mosaicking (20 minutes) 

Objectifs : apprendre des méthodes pour : 

• réaliser un composite « pixel le plus récent » d’une collection d’images 

• réaliser un composite « pixel médian » d’une collection d’images (Reducer median) 

• réaliser un composite personnalisé à l’aide de masque et de mosaïquage à partir 

d’une collection d’images et d’un autre jeu de données  

https://www.usgs.gov/land-resources/nli/landsat/landsat-collection-1-level-1-quality-assessment-band?qt-science_support_page_related_con=0#qt-science_support_page_related_con
https://www.usgs.gov/land-resources/nli/landsat/landsat-collection-1-level-1-quality-assessment-band?qt-science_support_page_related_con=0#qt-science_support_page_related_con
https://www.usgs.gov/land-resources/nli/landsat/landsat-collection-1-level-1-quality-assessment-band?qt-science_support_page_related_con=0#qt-science_support_page_related_con
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Composite « pixel le plus récent » de la collection d’images Landsat-8 2016 
 

 
Composite « pixel median » de la collection d’images Landsat-8 2016 
 

 
Composite « pixel median » de la collection d’images Landsat-8 2016 masquée par les pixels 
classifiés comme « water » et « no data » (according to the Hansen et al. dataset) (pixels 
masqués = pixels transparents : on voit Google maps à la place du composite median). 
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Mosaïque de : 

• composite « pixel median » de la collection d’images Landsat-8 2016 masquée par 
les pixels classifiés comme « water » et « no data » (according to the Hansen et al. 
dataset)  

• une image des zones classifiés comme « water » et « no data » (according to the 
Hansen et al. dataset) colorées en bleu foncé 

 
 

14.3.2.2.5. NDVI, Mapping a Function over a Collection, Quality Mosaicking 

[…] confer tutoriel officiel 

14.3.2.2.6. Exporting Charts and Images 

[…] confer tutoriel officiel 

 

14.3.2.3. Landsat Algorithms  

For creating simple cloud-free Landsat composites 

• https://developers.google.cn/earth-engine/landsat 

14.4. Ressources complémentaires 

o https://developers.google.com/earth-engine 

o Principales ressources associées à GEE 

o https://americaview.org/program-areas/education/google-earth-engine-tutorials/ 

o Tutoriaux supplémentaires  

o https://geohackweek.github.io/GoogleEarthEngine/ 

o Tutoriel d’introduction à GEE couvrant plusieurs types de manipulation 

 

https://developers.google.cn/earth-engine/landsat
https://developers.google.com/earth-engine
https://americaview.org/program-areas/education/google-earth-engine-tutorials/
https://geohackweek.github.io/GoogleEarthEngine/
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15. Visionnage de la vidéo « HOLOGLOBE » 

15.1. Présentation de la vidéo « HOLOGLOBE » 

Cette petite vidéo d’animation de la NASA, d’une durée de 6 minutes, en anglais, montre, 

sur un globe terrestre tournant, la dynamique de plusieurs phénomènes d’origine naturelle 

ou anthropique (Figure 206). 

Cette vidéo est réalisée en grande partie à partir de données issues de satellites 

d’observation de la terre. Entre autres, les phénomènes suivants sont illustrés: 

• Dynamique des flux d’énergie de la terre (mouvements atmosphériques (formation 

des ouragans), courants marins, etc 

• Dynamique des températures des océans et phénomène El Nino 

• Croute et plaques terrestres, tremblements de terre et volcans 

• Saisons et dynamique de la végétation 

• Vision nocturne de l’influence de l’homme sur la terre (lumière artificielle, incendies, 

agriculture sur brulis, combustion de gaz, etc) 

La traduction des commentaires de cette vidéo sont disponibles dans la section suivante. 

Cette vidéo, et une série d’informations complémentaires, sont disponibles sur le site web 

https://svs.gsfc.nasa.gov/155. 

 

Figure 206 : illustrations issues de la vidéo « Hologlobe » : mouvements atmosphériques, 
végétation, température des océans. 

 

 

https://svs.gsfc.nasa.gov/155
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15.2. Traduction des commentaires de la vidéo 

HOLOGLOBE_v3 

 

Source : 
https://svs.gsfc.nasa.gov/155http://svs.gsfc.nasa.gov/vis/a000000/a000100/a000155/ 
Durée : 6 minutes 19 secondes 
 
La terre dans l’espace : 

• 9 planètes en orbite autour du soleil 

• 3ème planète est la terre 

• Vénus et Mars sont les planètes les plus proches et les plus similaires par rapport à la 

terre.  

Mais Vénus et Mars sont très différentes de la terre.  

• Vénus est la plus similaire à la terre point de vue taille, masse et gravité mais a une 

atmosphère dense en CO2 et n’a pratiquement pas d’eau avec une surface très 

chaude (+/- 800°F) = 400°C. (°C = (°F - 32) / 1,8) 

• Mars : moitié de la taille de la terre et une atmosphère mince. Surface est froide (-

190°F) = -123°C et l’eau est gelée à ces pôles et probablement en dessous de sa 

surface. 

Notre terre est unique : 

• 70% de la surface terrestre est couverte par de l’eau liquide 

• L’atmosphère est riche en vapeur d’eau 

• Planète géologiquement active 

• Caractéristique principale : présence et diversité de la VIE sur terre ! 

Les navettes spatiales et les satellites qui enregistrent des images de la terre changent 
notre vision de la terre. 
 
Nous voyons maintenant les océans, les surfaces terrestres, l’atmosphère, la vie, le tout 
interconnecté dans un système mondial. La terre est baignée dans l’énergie solaire. Les 
océans, surfaces terrestres et atmosphères absorbent et sont réchauffés par l’énergie 
solaire. La chaleur absorbée par les océans et transportée par les courants marins est 
continuellement libérée vers l’atmosphère. La chaleur et l’humidité libérées par les océans 
dirigent la circulation atmosphérique et le climat. L’humidité dans l’atmosphère forme les 
nuages qui couvrent en moyenne 40% de la surface terrestre à tout moment donné. 
 
“The pattern in cloud motion in this time lapse sequence shows how earth's winds, moving 
bands or zones, which define regional winds directions” (difficile à comprendre et traduire). 
 
Le mouvement de l’humidité ou de la vapeur d’eau dans l’atmosphère jouent un rôle 
important dans la détermination du climat. Dans cette animation des mouvements des 
vapeurs d’eau de l’atmosphère, les ouragans de 1995 sont visibles. Les ouragans se forment 

https://svs.gsfc.nasa.gov/155
http://svs.gsfc.nasa.gov/vis/a000000/a000100/a000155/
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au large des côtes africaines (2m32) et se déplacent à l’ouest à travers l’Océan Atlantique 
vers les Caraïbes et la côte est des USA. 
 
Le climat mondial est également influencé par la manière dont la chaleur est répartie par les 
océans. Sont montés ici les changements de températures de surface des océans sur une 
période de 9 ans. Les surfaces d’eau les plus chaudes sont indiquées en rouge, les plus 
froides en bleu. Avec ce genre de données, il est possible de détecter l’augmentation 
anormale de température qui arrive lorsque les eaux froides en temps normal de l’est de 
l’Océan Pacifique sont remplacées par des eaux plus chaudes. Ce phénomène est connu sous 
le nom d’El Nino. El Nino pourrait perturber le climat à une échelle mondiale causant de 
vastes inondations et sécheresses. 
 
Drainant les océans […], il y a la surface solide de la terre avec la croute terrestre qui est 
divisée en « Hautes terres » et « Basses terres » 

• Les Hautes terres sont les terres émergées qui forment les continents 

• Les Basses terres forment les bassins océaniques. 

La croute terrestre n’est pas une coquille fixe et continue. Elle est brisée en une mosaïque 
de plaques mouvantes. Au fur et à mesure que ces plaques bougent et se frottent les unes 
aux autres, elles libèrent d’énormes quantités d’énergie sous la forme de tremblements de 
terre. Les points jaunes montrent la localisation des tremblements de terre qui ont eu lieu 
entre 1980 et 1995 avec une magnitude supérieure à 4.5 sur l’échelle de Richter. Ces 
tremblements de terre indiquent clairement les limites des plaques de la croute terrestre.  
 
Lorsque les plaques océaniques s’entrechoquent avec les plaques terrestres […] cela forme 
les volcans. Les triangles rouges indiquent les éruptions volcaniques enregistrées qui se sont 
passées entre 1960 et 1995. Comme pour les tremblements de terre, la plupart des volcans 
sont localisés le long des limites des plaques terrestres. 
 
Les océans, l’atmosphère et les continents jouent tous un rôle critique pour le maintient de 
la vie durable sur terre. Les caractéristiques des courants marins, des vents, et de la 
topographie peuvent faire d’une région un désert et d’une autre une région verte […]. Les 
changements de saisons affectent grandement la végétation terrestre. Les couleurs vertes 
et jaunes montrent comment les plantes grandissent et dépérissent au cours des saisons 
d’une année. Les vastes déserts du nord de l’Afrique, de la péninsule arabique et de l’Asie 
centrale sont facilement reconnaissables à cause de l’absence de végétation. 
 
L’influence des hommes sur la terre peut également être vue depuis l’espace. Une vision de 
la terre pendant la nuit permet de voir les lumières des campements, villages et villes qui 
sont éclairés. Les endroits fortement peuplés apparaissent en blanc. Les incendies et 
l’agriculture sur brulis (slash and burn) et la combustion de gaz dans les champs de pétroles 
sont montrés en rouge et jaune. Depuis ce point de vue, l’importance de l’activité humaine 
sur la planète peut être évaluée. L’entièreté du globe est concernée. 
 
Un suivi global de la terre nous aide à comprendre les interactions complexes entre les 
atmosphères, les océans et les terres ainsi que leurs impacts sur la vie. Seule une vue 
mondiale nous permet d’apprécier notre terre en tant que planète. 
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16. Sites web intéressants 

16.1. Applications environnementales  

Changement de la couverture forestière mondiale entre 2000-2018 à partir d’images 
Landsat, University of Maryland,  application web. 
http://earthenginepartners.appspot.com/science-2013-global-forest 
 
Quelques exemples de détection de changement avec des images Landsat, vidéo, anglais.  
« A Planetary Perspective: With Landsat and Google Earth Engine ». 
http://www.youtube.com/watch?v=Ezn1ne2Fj6Y  
 
Quelques exemples d’applications environnementales à partir des images Landsat, site web, 
anglais. 
« Landsat Applications ». 
https://landsat.gsfc.nasa.gov/article/landsat-applications/ 
http://www.nasa.gov/content/goddard/environmental-watch-with-nasa-s-landsat-satellites/  
 
Observation mondiale des feux, de la végétation et de la couverture neigeuse à partir des 
images MODIS NDVI, NASA, entre Juillet 2002 et Juillet 2011. 
https://svs.gsfc.nasa.gov/3868/    

16.2. Divers 

Programme belge “STEREO” 

• Belgium has its very own national program supporting research in Earth observation 

called STEREO (Support To Exploitation and Research in Earth Observation). 

Documentation sur tous les projets STEREO disponible ici: 

o https://eo.belspo.be/en/stereo-in-action  

 
Le film documentaire “HOME”, un film de Yann Arthus-Bertrand, 90 minutes, 2009,  

français, disponible gratuitement ici:  

• http://www.youtube.com/watch?v=NNGDj9IeAuI&feature=youtu.be&hd=1.  

• Site web du film : http://www.homethemovie.org/. « Ce film développe le lien qui 

unit l'homme à la Terre. Conçu comme un carnet de voyages, il est constitué 

uniquement d'images aériennes et d'une voix off » (Source : Wikipedia). 

 
EARTH as ART, NASA, Top Five, collection de magnifiques images satellites 

• Vidéo en anglais: http://www.youtube.com/watch?v=Tq88dRFokgg  

http://earthenginepartners.appspot.com/science-2013-global-forest
http://www.youtube.com/watch?v=Ezn1ne2Fj6Y
https://landsat.gsfc.nasa.gov/article/landsat-applications/
http://www.nasa.gov/content/goddard/environmental-watch-with-nasa-s-landsat-satellites/
https://svs.gsfc.nasa.gov/3868/
https://eo.belspo.be/en/stereo-in-action
http://www.youtube.com/watch?v=NNGDj9IeAuI&feature=youtu.be&hd=1
http://www.homethemovie.org/
http://fr.wikipedia.org/wiki/Homme
http://fr.wikipedia.org/wiki/Terre
http://www.youtube.com/watch?v=Tq88dRFokgg
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• Page web : http://www.nasa.gov/connect/ebooks/earth_art_detail.html 

 
Simulation 3D de la couverture nuageuse mondiale durant 7 jours  sur base de données 
réelles, vidéo. 

• https://www.youtube.com/watch?annotation_id=annotation_397244329&feature=i

v&src_vid=JZXErLns1mM&v=zlqjz9OEhk0  

 
Simulation numérique des courants atmosphériques et marins, vidéo, anglais.  
« Dynamic Earth, NASA. » 

• http://www.youtube.com/watch?v=JQZ3QkaWWqA  

 

 

http://www.nasa.gov/connect/ebooks/earth_art_detail.html
https://www.youtube.com/watch?annotation_id=annotation_397244329&feature=iv&src_vid=JZXErLns1mM&v=zlqjz9OEhk0
https://www.youtube.com/watch?annotation_id=annotation_397244329&feature=iv&src_vid=JZXErLns1mM&v=zlqjz9OEhk0
http://www.youtube.com/watch?v=JQZ3QkaWWqA
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17. Exemples d’applications de la 

télédétection spatiale pour la gestion des 

risques et des catastrophes 

17.1. Copernicus Emergency Management Service 

(Copernicus EMS) 

Présentation générale du programme COPERNICUS (vidéo 4 min 30, anglais) 

• http://www.esa.int/spaceinvidéos/Vidéos/2016/02/Sentinels_for_Copernicus  

• Ou sur Youtube avec sous-titre : https://www.youtube.com/watch?v=xcflQZJ5n88  

o Les satellites Sentinels et exemples d’applications 

o Les données satellites, aériennes, et stations au sol, intégrées dans un même 

système : COPERNICUS 

o Cœur du système = famille de satellites Sentinels 

o Rôle des 6 satellites Sentinels 

 

Copernicus Emergency Management Service (Copernicus EMS) 

• https://emergency.copernicus.eu  

• Copernicus Emergency Management Service (Copernicus EMS) provides information 

for emergency response in relation to different types of disasters, including 

meteorological hazards, geophysical hazards, deliberate and accidental man-made 

disasters and other humanitarian disasters as well as prevention, preparedness, 

response and recovery activities. The Copernicus EMS is composed of: 

o an on-demand mapping component providing rapid maps for emergency 

response and  

o risk & recovery maps for prevention and planning and of the early warning and 

monitoring component which includes systems for floods, droughts and forest 

fires: 

• 4 modules constitute the Copernicus EMS : confer 

https://emergency.copernicus.eu/  

o The Copernicus EMS - MAPPING 

http://www.esa.int/spaceinvideos/Videos/2016/02/Sentinels_for_Copernicus
https://www.youtube.com/watch?v=xcflQZJ5n88
https://emergency.copernicus.eu/
https://emergency.copernicus.eu/


448 
 

o The Copernicus EMS - Mapping addresses, with worldwide coverage, a 

wide range of emergency situations resulting from natural or man-made 

disasters. Satellite imagery is used as the main datasource,  

o https://www.youtube.com/watch?v=NhFZa7gQ2zA    

o Rapid mapping Flood: the Copernicus Emergency Management Service  

o https://emergency.copernicus.eu/mapping/ems/service-overview    

o Rapid Mapping consists of the provision of geospatial information within 

hours or days from the activation in support of emergency management 

activities immediately following a disaster. Standardised mapping 

products are provided:  

▪ to ascertain the situation before the event (reference product),  
▪ to roughly identify and assess the most affected locations (first 

estimate product),  
▪ assess the geographical extent of the event (fdelineation product) 

or  
▪ to evaluate the intensity and scope of the damage resulting from 

the event (grading product). 
o Examples here:  

▪ https://mapping.emergency.copernicus.eu/activations/EMSR388/  
o List of activations and associated maps :  

▪ https://mapping.emergency.copernicus.eu/activations/  

• FLOODS: The European and Global Flood Awareness Systems (EFAS & GloFAS) 

o Vidéo, anglais, 8 minutes 

o https://www.youtube.com/watch?v=DwFAjr6f8jQ  

o Short introductory vidéo explaining the structure of EFAS and the main 

objectives using floods in Eastern Europe in May 2010 

o Passer le début: combine précipitations + conditions hydrologiques et fait 

un warning !  

o Prévision des inondations via un viewer spatial : 

o https://www.efas.eu/efas_frontend/#/home  

• FOREST FIRE: The European Forest Fire Information System (EFFIS) 

o https://effis.jrc.ec.europa.eu/  

o Visualisation des risques d’incendies (prévisions, feux actifs et surfaces brûlées) :   

o https://effis.jrc.ec.europa.eu/apps/effis_current_situation/   

• The EMS Drought Observatory (DO) 

o https://drought.emergency.copernicus.eu/tumbo/edo/map/  

o Indicateur de sécheresse combiné, visible dans une interface web de 

visualisation cartographique  

https://www.youtube.com/watch?v=NhFZa7gQ2zA
https://emergency.copernicus.eu/mapping/ems/service-overview
https://mapping.emergency.copernicus.eu/activations/EMSR388/
https://mapping.emergency.copernicus.eu/activations/
https://www.youtube.com/watch?v=DwFAjr6f8jQ
https://www.efas.eu/efas_frontend/#/home
https://effis.jrc.ec.europa.eu/
https://effis.jrc.ec.europa.eu/apps/effis_current_situation/
https://drought.emergency.copernicus.eu/tumbo/edo/map/
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Plusieurs exemples de l’utilisation des satellites dans le cadre de la gestion des crises : 

• https://www.esa.int/Applications/Observing_the_Earth/Copernicus/Emergency_man

agement  

• Services for emergency management response will help mitigating the effects of 

natural and manmade disasters such as floods, forest fires and earthquakes and 

contribute to humanitarian aid exercises. 

17.2. Le SERTIT, le Service régional de traitement d’image et 

de télédétection (France) 

• Vidéo de présentation générale du SERTIT, français, 4,43 minutes, français 

o http://sertit.unistra.fr/  

o Explications en lien avec le service de cartographie rapide/de crise. 

• http://fr.euronews.com/2016/06/03/copernicus-ou-quand-l-imagerie-satellite-

permet-d-aider-a-la-gestion-des  

o Vidéo en français de 1 min 26. 

o « Copernicus ou quand l'imagerie satellite permet d'aider à la gestion des 

catastrophes naturelles, 8 juin 2016 » 

o Le SERTIT, impliqué dans le service européen de gestion des situations d’urgence 

Copernicus, explique en vidéo sur la chaîne Euronews comment l’imagerie 

satellite permet de fournir une aide à la gestion des catastrophes naturelles, 

notamment dans le contexte d’inondations en France, Allemagne et en Belgique. 

• Navigateur des cartes des crises les plus récentes 

o http://sertit.unistra.fr/cartographie-rapide/  

17.3. La Charte Internationale Espace et Catastrophes 

Majeures 

Voir le site web de la Charte : 

• https://disasterscharter.org/fr/web/guest/home 

Qu’est-ce que la Charte ? :  

« Des données satellitaires au service des interventions d'urgence à l'échelle 

mondiale. » 

https://www.esa.int/Applications/Observing_the_Earth/Copernicus/Emergency_management
https://www.esa.int/Applications/Observing_the_Earth/Copernicus/Emergency_management
http://sertit.unistra.fr/
http://fr.euronews.com/2016/06/03/copernicus-ou-quand-l-imagerie-satellite-permet-d-aider-a-la-gestion-des
http://fr.euronews.com/2016/06/03/copernicus-ou-quand-l-imagerie-satellite-permet-d-aider-a-la-gestion-des
http://sertit.unistra.fr/cartographie-rapide/
https://disasterscharter.org/fr/web/guest/home
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La Charte est une collaboration mondiale, grâce à laquelle des données satellitaires 

sont disponibles au profit de la gestion des catastrophes. En combinant les actifs 

d'observation de la terre de différentes agences spatiales, la Charte permet de 

coordonner les ressources et l'expertise pour répondre rapidement aux situations de 

catastrophe majeures; aidant ainsi les autorités de protection civile et la 

communauté humanitaire internationale. 

Cette initiative unique permet de mobiliser des agences dans le monde entier et de 

bénéficier de leur savoir-faire et de leurs satellites par le biais d'un seul point d'accès 

qui fonctionne 24 heures par jour, 7 jours par semaine et sans frais pour 

l'utilisateur. » 

Résumé infographique  

• https://disasterscharter.org/web/guest/about-the-charter 

2 vidéos de présentation, en anglais, 4 min + 5 min (sur la version anglaise du site web) 

• Ces vidéos expliquent comment fonctionne la charte et à quoi elle sert.  

• https://charte.cnes.fr/fr/videos-22  (4 minutes) 

• https://disasterscharter.org/en/web/guest/about-the-charter (5 minutes) 

1 vidéo de présentation de la charte, en français, 3 minutes 

• Fonctionnement de la charte et exemples, en particulier concernant les ouragans et 

cyclones :  

• https://www.youtube.com/watch?v=XKqyXImYRbI&t=177s 

Accès aux activations de la charte  

• Liste des activations :  

o https://disasterscharter.org/en/web/guest/charter-activations 

• « Charter Geobrowsing Tool » : portail web cartographique des activations :  

o https://cgt.disasterscharter.org/en  

S’abonner à la newsletter 

• https://disasterscharter.org/web/guest/news  

Autre vidéo mentionnant la charte 

• Présentation de la charte et de l’utilisation des images satellites pour le suivi des 

catastrophes (éruption volcanique (2), inondation, marée noire,…). « Les satellites au 

service des populations. L'ESA et les autres agences spatiales ont mis à disposition 

leurs satellites afin de venir en aide aux pays frappés par les catastrophes naturels ou 

industriels. © ESA » 

https://disasterscharter.org/web/guest/about-the-charter
https://charte.cnes.fr/fr/videos-22
https://disasterscharter.org/en/web/guest/about-the-charter
https://www.youtube.com/watch?v=XKqyXImYRbI&t=177s
https://disasterscharter.org/en/web/guest/charter-activations
https://cgt.disasterscharter.org/en
https://disasterscharter.org/web/guest/news
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o vidéo en français, 2007, 5 minutes 

o https://www.youtube.com/watch?v=wXhaJLLmr2k  

Autres ressources sur la Charte 

• https://charte.cnes.fr/fr/ 

• https://cnes.fr/fr/web/CNES-fr/10586-gp-la-charte-espace-et-catastrophes-

majeures-sous-presidence-francaise.php  

17.4. Exemples supplémentaires d’applications de la 

télédétection spatiale pour la gestion des risques et 

des catastrophes par outils ou thématique 

Earth Observatory, par la NASA 

• https://earthobservatory.nasa.gov/topic/natural-event  

• Exploration par thème ou par navigateur géographique 

• Contient notamment une catégorie « Natural events » (incendie, inondation, typhon, 

sécheresse, tremblement de terre, etc).  

Google Earth Engine (GEE) 

• Google Earth Engine (GEE) 

o https://earthengine.google.com/  

o Plateforme pour faire tourner des géo-algorithmes à l’échelle mondiale en 

utilisant les ressources de Google et qui donne accès à de très grandes bases de 

données d’images satellites à l’échelle mondiale. 

• Google Earth Engine (GEE) Timelapse  

o Vidéo de 2 min : https://www.youtube.com/watch?v=kIYHGkSb-fU  

o Timelapse 1984-année actuelle moins 1, série d’exemples d’évolution temporelle 

de la surface terrestre suite à diverses actions anthropiques mise en évidence 

o https://earthengine.google.com/timelapse/   

• Cas d’études 

o https://earthengine.google.com/case_studies/  

o Global Forest Cover Change 

o Malaria Risk Mapping 

Google Earth: exemples d’images de catastrophes naturelles visualisables dans GOOGLE 

EARTH 

https://www.youtube.com/watch?v=wXhaJLLmr2k
https://charte.cnes.fr/fr/
https://cnes.fr/fr/web/CNES-fr/10586-gp-la-charte-espace-et-catastrophes-majeures-sous-presidence-francaise.php
https://cnes.fr/fr/web/CNES-fr/10586-gp-la-charte-espace-et-catastrophes-majeures-sous-presidence-francaise.php
https://earthobservatory.nasa.gov/topic/natural-event
https://earthengine.google.com/
https://www.youtube.com/watch?v=kIYHGkSb-fU
https://earthengine.google.com/timelapse/
https://earthengine.google.com/case_studies/
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Certains sites web mettent à disposition des fichiers dont l’extension est « .KMZ » ou 

« .KML », formats qui permettent la visualisation de ces données dans GOOGLE EARTH 

facilement et rapidement sans devoir télécharger l’image brute. Voici quelques exemples : 

• Inondation 

o Australian city of Rockhampton, 2011 

o Capteur : Advanced Spaceborne Thermal Emission and Reflection Radiometer 

(ASTER) on NASA’s Terra   

o http://earthobservatory.nasa.gov/IOTD/view.php?id=48456&src=eorss-iotd 

o Cliquer sur “Google Earth file (KML)” 

• Typhon 

o http://www.gearthblog.com/blog/archives/2016/10/acquisition-imagery-natural-

disasters-improving.html  

o Hurricane Matthews, 2016, widespread devastation, crossing over Haiti, the 

Bahamas and then up the east coast of the United States. 

o Cliquer sur: “You can see the satellite imagery in Google Earth with this KML file

 from Google Crisis Response” 

o Dans Google Earth : cocher uniquement : « Hurrican Matthews 2016 > Haiti > 

Digital Globa imagery > Les Irois, Haiti » 

• Tremblement de terre 

o http://www.gearthblog.com/blog/archives/2016/09/post-earthquake-

kumamoto-google-earth-3d.html  

o Large earthquakes in the City of Kumamoto, Japan, 2016 

o Images acquises après le séisme: visualisation des destructions 

o Google Earth tour of the area showing all the light blue roofs, which you can view 

in Google Earth with this KML file  or see in the YouTube vidéo below. 

Déforestation 

• Déforestation en Amazonie et dans le monde, Timelapse, vidéo 3 min. 

o https://www.youtube.com/watch?v=b4eLTYUcj7k  

• Pattern de déforestation en Amazonie, en détails 

o Visualisation dans Google Earth Pro des motifs de déforestation au Brésil, 

Indonésie, etc 

• Déforestation au Brésil, Etat du Rondonia, en détails, vidéo haute qualité (30 ‘’)  

o https://www.youtube.com/watch?v=JsIB81sLe2w  

http://asterweb.jpl.nasa.gov/
http://terra.nasa.gov/
http://earthobservatory.nasa.gov/IOTD/view.php?id=48456&src=eorss-iotd
http://www.gearthblog.com/blog/archives/2016/10/acquisition-imagery-natural-disasters-improving.html
http://www.gearthblog.com/blog/archives/2016/10/acquisition-imagery-natural-disasters-improving.html
http://mw1.google.com/crisisresponse/2016/hurricane_matthew/2016-hurricane-matthew-updated-imagery_nl.kml
http://mw1.google.com/crisisresponse/2016/hurricane_matthew/2016-hurricane-matthew-updated-imagery_nl.kml
http://www.gearthblog.com/blog/archives/2016/09/post-earthquake-kumamoto-google-earth-3d.html
http://www.gearthblog.com/blog/archives/2016/09/post-earthquake-kumamoto-google-earth-3d.html
http://www.gearthblog.com/wp-content/uploads/2016/09/Kumamoto-in-3D.kmz
https://www.youtube.com/watch?v=b4eLTYUcj7k
https://www.youtube.com/watch?v=JsIB81sLe2w
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• Déforestation à Haïti, vidéo 

o http://svs.gsfc.nasa.gov/cgi-bin/details.cgi?aid=2640&button=popular  

• Autre courtes vidéos sur différents endroits déforestés entre 2000 et 2012, avec 

LANDSAT 

o https://www.youtube.com/channel/UCGnX8ABNZYuZrhzT-sJVaeg  

• Monitoring Forests From the Ground to the Cloud, vidéo 5 min, Système d’alerte de 

déforestation via Google Earth Engine, exemples internationaux,  

o https://www.youtube.com/watch?v=ymKHb3WJLz4  

• Déforestation en Papouasie-Nouvelle-Guinée (2 images géotiff) 

o http://earthobservatory.nasa.gov/IOTD/view.php?id=8810  

• Déforestation au Brésil (2 images géotiff) 

o http://earthobservatory.nasa.gov/IOTD/view.php?id=6811  

Mine 

• Appalachian Mountaintop Removal in Google Earth & Maps (vidéo en anglais, 5 min) 

o https://www.youtube.com/watch?v=aiSzOiGFa-0  

• En savoir plus : https://appvoices.org/end-mountaintop-removal/mtr101/  

Masse d’eau 

• Mer d’Aral: Aral Sea Time Lapse, vidéo 1 min 

o https://www.youtube.com/watch?v=NxFNoHBCuwA  

• Lac Chad: UNEP & Google Earth highlights environmental change, vidéo 1 minute 

o https://www.youtube.com/watch?v=JXW29zsr6xg  

Inondation 

• Centre royale de télédétection du Royaume du Maroc, cartographie rapide en cas 

d’inondations 

o https://www.crts.gov.ma/thematiques/risques-naturels/inondations  

• Télédétection et gestion des catastrophes naturelles : application à l’étude des 

inondations urbaines de Saint-Louis et du ravinement lié à l’érosion hydrique à Nioro-

Du-Rip (Sénégal)  

o https://hal.archives-ouvertes.fr/hal-00434297/document 

http://svs.gsfc.nasa.gov/cgi-bin/details.cgi?aid=2640&button=popular
https://www.youtube.com/channel/UCGnX8ABNZYuZrhzT-sJVaeg
https://www.youtube.com/watch?v=ymKHb3WJLz4
http://earthobservatory.nasa.gov/IOTD/view.php?id=8810
http://earthobservatory.nasa.gov/IOTD/view.php?id=6811
https://www.youtube.com/watch?v=aiSzOiGFa-0
https://appvoices.org/end-mountaintop-removal/mtr101/
https://www.youtube.com/watch?v=NxFNoHBCuwA
https://www.youtube.com/watch?v=JXW29zsr6xg
https://www.crts.gov.ma/thematiques/risques-naturels/inondations
https://hal.archives-ouvertes.fr/hal-00434297/document
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• « Crues dans les Alpes-Maritimes : les vidéos et données satellites dévoilent une 

catastrophe inédite. » 

o Vidéo de 5 minutes qui montre notamment une cartographie des zones inondées 

et une localisation des dégâts, toutes deux faites à partir d’images satellites. 

o https://www.youtube.com/watch?v=mcuPHusMiOM 

 

Glaces et fontes des glaces 

• Annual Arctic Sea Ice Minimum 1979-2022 with Area Graph, vidéo  

o https://svs.gsfc.nasa.gov/5036   

• Weekly Animation of Arctic Sea Ice Age with Graph of Ice Age by Percent of Total: 

1984 – 2016, vidéo + textes:  

o http://svs.gsfc.nasa.gov/cgi-bin/details.cgi?aid=4509&button=popular  

• Fonte des glaces en Arctique : vidéo de Greenpeace 

o https://www.facebook.com/greenpeace.belgium/vidéos/10154505188555239/ 

• Epaisseur de glace par Radar : Icesat-2 Measurements Over Antarctica (prelaunch), 

vidéo 2 min,  

o http://svs.gsfc.nasa.gov/cgi-bin/details.cgi?aid=4492&button=recent  

Feux 

• https://earthdata.nasa.gov/earth-observation-data/near-real-time/firms 

Température du globe 

• Global Temperature Anomalies from 1880 to 2022, vidéo,  

• https://svs.gsfc.nasa.gov/5060 http://svs.gsfc.nasa.gov/cgi-

bin/details.cgi?aid=4419&button=popular  

Urbanisation 

• Urban growth of Las Vegas (1985 - 2021) - Time lapse, vidéo 30 secondes,  

• https://www.youtube.com/watch?v=adAoosRTjws 

https://www.youtube.com/watch?v=cPRGfyd93fo  

Tsunami 

• Cartes satellites des zones sinistrées au Japon, vidéo, français, 1 minute,  

o https://www.youtube.com/watch?v=XJVF1TNnLZY 

https://www.youtube.com/watch?v=mcuPHusMiOM
https://svs.gsfc.nasa.gov/5036
http://svs.gsfc.nasa.gov/cgi-bin/details.cgi?aid=4509&button=popular
https://www.facebook.com/greenpeace.belgium/videos/10154505188555239/
http://svs.gsfc.nasa.gov/cgi-bin/details.cgi?aid=4492&button=recent
https://earthdata.nasa.gov/earth-observation-data/near-real-time/firms
https://svs.gsfc.nasa.gov/5060
http://svs.gsfc.nasa.gov/cgi-bin/details.cgi?aid=4419&button=popular
http://svs.gsfc.nasa.gov/cgi-bin/details.cgi?aid=4419&button=popular
https://www.youtube.com/watch?v=adAoosRTjws
https://www.youtube.com/watch?v=cPRGfyd93fo
https://www.youtube.com/watch?v=XJVF1TNnLZY
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o « Les scientifiques du Service régional de traitement d'image et de télédétection 

(SERTIT) de Strasbourg aident les sinistrés japonais. Ils élaborent de précieuses 

cartes à l'aide de satellites français pour permettent aux secouristes de se 

déplacer dans les zones dévastées. » 

Littoral 

• La télédétection pour surveiller le littoral, vidéo français 3 minutes, drones,  

o https://www.youtube.com/watch?v=SNLyd_FAYOg  

Marée noire 

• NASA, Satellites View Growing Gulf Oil Spill,  

o https://www.youtube.com/watch?v=mCWW5xt3Hc8  

• NASA Aids Nation's Response to Oil Spill with Aircraft, Satellites,  

o https://www.youtube.com/watch?v=f5qh13Xp-_0  

Volcan 

• Monitoring Volcanoes Using ASTER Satellite Imagery, vidéo, English, 5 min,  

o https://www.youtube.com/watch?v=A39FnHdSoNk  

Sécurité alimentaire 

• http://www.fews.net/fr 

Avertissements précoces 

• Suivi des conditions de végétation, précipitations, climat, niveau des étendues d’eau, 

etc dans l’optique de déclencher des avertissements vers les autorités d’un pays, 

d’une région en cas de problème/crise 

o https://earlywarning.usgs.gov/fews 

• En particulier, le « Water Point Viewer » (monitoring du niveau des masses d’eau en 

Afrique) 

o https://earlywarning.usgs.gov/fews/waterpoint/  

Refugiés 

• Story Map about Rohingya refugees (by the The UN Refugee Agency (UNHCR)) 

o https://www.esri.com/en-us/arcgis/products/esri-story-maps/contest/winners-

gallery/2018-winners  

Divers 

https://www.youtube.com/watch?v=SNLyd_FAYOg
https://www.youtube.com/watch?v=mCWW5xt3Hc8
https://www.youtube.com/watch?v=f5qh13Xp-_0
https://www.youtube.com/watch?v=A39FnHdSoNk
http://www.fews.net/fr
https://earlywarning.usgs.gov/fews
https://earlywarning.usgs.gov/fews/waterpoint/
https://www.esri.com/en-us/arcgis/products/esri-story-maps/contest/winners-gallery/2018-winners
https://www.esri.com/en-us/arcgis/products/esri-story-maps/contest/winners-gallery/2018-winners
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• ENVI, Les images satellites pour la gestion des catastrophes naturelles, vidéo 

français, 28 minutes (2014) 

o https://www.youtube.com/watch?v=Tp2hIeeSVXE  

• La télédétection appliquée aux catastrophes naturelles : Faits et chiffres. Article très 

intéressant !  

o https://www.scidev.net/afrique-sub-saharienne/sciences-de-la-terre/article-de-

fond/la-t-l-d-tection-appliqu-e-aux-catastrophes-naturelles-faits-et-chiffres.html 

• Observation satellite catastrophes naturelles, vidéo en français (mais ancienne 

(1998) !), 2 minutes 

o « 25 août 1998 Catastrophes naturelles : Diverses organisations 

internationales disposent de moyens de haute technologie pour observer les 

évolutions climatiques, comme l'Agence spatiale européenne qui dispose, 

grâce aux satellites, d'images pour prévenir contre d'éventuelles catastrophes. 

Images d'archive INA Institut National de l'Audiovisuel » 

o https://www.youtube.com/watch?v=FINb3xtd6O4 

• MapGive 

https://mapgive.state.gov/   

o Volunteers like you can help trace roads, buildings, and houses using 

OpenStreetMap that will aid in humanitarian missions. 

• Nombreux exemples d’analyse diachroniques à partir d’images satellites, classés par 

thèmes, lieux, dates. 

o http://earthobservatory.nasa.gov/Images/?eocn=topnav&eoci=images 

• Systèmes d’analyse des risques par télédétection spatiale   

o https://ressources.uved.fr/Grains_Module3/Teledetection_spatiale/site/html/Tel

edetection_spatiale/Teledetection_spatiale.html 

• Liste de données SIG sur des catastrophes naturelles.  

o https://freegisdata.rtwilson.com/#natural-disasters  

 

https://www.youtube.com/watch?v=Tp2hIeeSVXE
https://www.scidev.net/afrique-sub-saharienne/sciences-de-la-terre/article-de-fond/la-t-l-d-tection-appliqu-e-aux-catastrophes-naturelles-faits-et-chiffres.html
https://www.scidev.net/afrique-sub-saharienne/sciences-de-la-terre/article-de-fond/la-t-l-d-tection-appliqu-e-aux-catastrophes-naturelles-faits-et-chiffres.html
https://www.youtube.com/watch?v=FINb3xtd6O4
https://mapgive.state.gov/
http://earthobservatory.nasa.gov/Images/?eocn=topnav&eoci=images
https://ressources.uved.fr/Grains_Module3/Teledetection_spatiale/site/html/Teledetection_spatiale/Teledetection_spatiale.html
https://ressources.uved.fr/Grains_Module3/Teledetection_spatiale/site/html/Teledetection_spatiale/Teledetection_spatiale.html
https://freegisdata.rtwilson.com/#natural-disasters
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18. Recherche d’images satellites sur le web 

Une des premières étapes de tout travail en télédétection spatiale est de se procurer les 

images satellites à partir desquelles votre étude pourra être menée. Cette section à pour 

objectif de vous introduire à la recherche d’images sur le web. 

Avant de commencer votre recherche d’images, il est important que vous cerniez clairement 

quel sont vos objectifs (en termes de résultats) et quels sont vos moyens (connaissance, 

argent, temps).  

Au cours de vos recherches, vous devrez trouver un juste compromis entre ce que le web 

vous « offre » et ce que vous recherchez. En particulier, vous ferez très attention aux critères 

suivants:  

• Type d’image pertinente pour répondre à vos objectifs en termes de résolution 

spatiale, temporelle et spectrale. 

• Disponibilité d’images pour la zone et l’époque sur lesquelles vous voulez travailler 

(couverture nuageuse) 

• Prix des images (gratuit vs très cher !) 

GOOGL EARTH (gratuit) : 

Vous pouvez enregistrer (sur votre disque dur) les images qui apparaissent à l’écran lors de 

votre visite dans Google Earth. Pour ce faire, après avoir zoomé sur le lieu d’intérêt, cliquez 

sur « Fichier/Enregistrez/Enregistrez l’image/… » et vous pourrez sauvegarder la vue en 

format « jpg ». Attention, l’image que vous enregistrez par cette opération n’est donc pas 

une image satellite en tant que telle, mais une simple « capture d’écran » de l’image telle 

qu’elle est affichée sur votre écran. L’information spectrale contenue dans cette image jpg 

est donc  beaucoup plus pauvre que celle contenue dans une image satellite réelle. De plus 

l’image jpg ne sera pas géoréférencée, et la résolution spatiale de l’image dépendra du zoom 

que vous avez utilisé lors de la capture d’écran. Vous devrez donc tenir compte de ces 

limitations si vous comptez utiliser des images dérivées de Google Earth. Un exemple 

d’utilisation d’images de Google Earth : image pour fond de carte à but illustratif. 

USGS EARTH EXPLORER (gratuit) 

• http://earthexplorer.usgs.gov/  

• USGS Earth Explorer, catalogue de la « United States Geological Survey » (USGS), 

donne accès à de nombreux types d’images dont les images : 

o LANDSAT 

o ASTER : altitude, température, réflectance (14 bandes spectrales)  

http://earthexplorer.usgs.gov/
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o https://asterweb.jpl.nasa.gov/  

o https://asterweb.jpl.nasa.gov/characteristics.asp 

o Données d’ALTITUDE : DEM (Digital Elevation Model) ou MNT (Modèle 

Numérique de Terrain) pour l’ensemble de la planète à ~30 mètres de 

résolution spatiale via l menu « Data Sets > Digital Elevation > SRTM » 

o Toute une série de cartes thématiques (occupation du sol,…) 

o RADAR 

o … 

NASA EARTHDATA (gratuit) 

• https://earthdata.nasa.gov/  

• Grande variété de données, dont des images issues de la télédétection, dont le 

Advanced Spaceborne Thermal Emission and Reflection Radiometer (ASTER) Global 

Digital Elevation Model (GDEM), un DEM global à 30 mètre de résolution spatiale 

(info ici https://asterweb.jpl.nasa.gov/gdem.asp)  

COPERNICUS:  Copernicus is a European system for monitoring the Earth 

(gratuit) 

• Page principale d’accès aux produits Copernicus « Land » 

o https://land.copernicus.eu/  

• Produits végétation, dont le NDVI 

o https://land.copernicus.eu/global/themes/vegetation   

• Copernicus Open Access Hub : accès aux données Sentinel-1, Sentinel-2 et Sentinel-3 

o https://scihub.copernicus.eu/dhus/#/home  

• Sentinel Hub : accès facile aux données Sentinel du programme Copernicus 

o Page principale 

▪ https://www.sentinel-hub.com/  

o EO Browser 

▪ https://www.sentinel-hub.com/explore/eobrowser  

IMAGES BASSE RESOLUTION : SPOT VEGETATION, METOP-AVHRR, PROBA-

V (gratuit): 

• http://www.vito-eodata.be/PDF/portal/Application.html#Home , S’enregistrer, 

Rechercher un produit, le télécharger et le visualiser dans un viewer 

• VGT extract : logiciel à télécharger (avec java) 

(https://rs.vito.be/africa/en/software/Pages/vgtextract.aspxhttp://www.vgt4africa.o

rg/VGTExtract.do) et installer sur votre pc. Cet outil permet d'extraire du dossier 

zipper, uniquement les canaux que l'on désire, de découper spatialement les images 

selon une région d'intérêt définit par l'utilisateur ou préenregistrée et de convertir 

https://asterweb.jpl.nasa.gov/
https://asterweb.jpl.nasa.gov/characteristics.asp
https://earthdata.nasa.gov/
https://asterweb.jpl.nasa.gov/gdem.asp
https://land.copernicus.eu/
https://land.copernicus.eu/global/themes/vegetation
https://scihub.copernicus.eu/dhus/#/home
https://www.sentinel-hub.com/
https://www.sentinel-hub.com/explore/eobrowser
http://www.vito-eodata.be/PDF/portal/Application.html#Home
https://rs.vito.be/africa/en/software/Pages/vgtextract.aspx
http://www.vgt4africa.org/VGTExtract.do
http://www.vgt4africa.org/VGTExtract.do
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les données dans un format plus facile à utiliser (ENVI, géotiff, ERMapper ...) Logiciel 

« Crop VGT » disponible pour les pays non africains. 

PLANET.COM (gratuit et payant) 

• https://www.planet.com/ 

• Une couverture satellite de la terre entière chaque jour (ou presque) à très haute 

résolution spatiale (0.72 cm)!! 

DIGITALGLOBE (très haute résolution spatial, payant) 

• Page principale du site web: https://www.digitalglobe.com/  

• Portail de recherche d’images : 

• https://browse.digitalglobe.com/imagefinder/main.jsp;jsessionid=7AB20ED95749275

03AD11E38FBEA6237? 

AIRBUS DEFENSE AND SPACE – SPOT IMAGE : 

• Page principale 

o https://www.intelligence-airbusds.com/geostore/ 

• Navigation et recherche de produits 

o http://www.geo-airbusds.com/en/4871-browse-and-order 

• produits spot, autres satellites, spot scene et spot view, fiches techniques, etc 

o http://www.geo-airbusds.com/fr/  

• En 1994, le CNES (Centre National d’Etudes Spatiales français) a lancé le programme 

ISIS (Incitation à l'utilisation Scientifique des Images Spot), destiné à faciliter l'accès 

à l'imagerie Spot pour l'ensemble de la communauté scientifique, en lui permettant 

d'acquérir ces données satellitaires à un tarif préférentiel. ISIS est accessible à tout 

chercheur et étudiant travaillant dans un laboratoire européen.  

o https://www.theia-land.fr/le-programme-isis-du-cnes-sintegre-a-dinamis/   

o https://www.theia-land.fr/   

PPNC – Plan Photographique Numérique Communal (Belgique) (gratuit) 

• La Région Wallonne met à disposition du grand public toute une série d’information 

de type géographique (carte thématique, MNT, etc) sur des serveurs web de type 

ArcIMS accessible en mode « lecture seule » via ArcGIS. 

• Démarrez un projet ArcGIS et référez-vous aux notes de TP relatives à ArcGIS 

(disponible ici : http://orbi.ulg.ac.be/handle/2268/135775) à la section « Ajouter des 

données ». 

https://www.planet.com/
https://www.digitalglobe.com/
https://browse.digitalglobe.com/imagefinder/main.jsp;jsessionid=7AB20ED9574927503AD11E38FBEA6237
https://browse.digitalglobe.com/imagefinder/main.jsp;jsessionid=7AB20ED9574927503AD11E38FBEA6237
https://www.intelligence-airbusds.com/geostore/
http://www.geo-airbusds.com/en/4871-browse-and-order
http://www.geo-airbusds.com/fr/
javascript:openGlossary(161,%20'fr');
https://www.theia-land.fr/le-programme-isis-du-cnes-sintegre-a-dinamis/
https://www.theia-land.fr/
http://orbi.ulg.ac.be/handle/2268/135775
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AUTRES (gratuit): 

• Africa data dissemination service 

o http://earlywarning.usgs.gov/adds/imgbulks3.php?imgtype=nd&spextent=a 

• Site de BELSPO: liste de satellites et liens 

o http://eo.belspo.be/Directory/Satellites.aspx  

o exemples : CORONA, IKONOS2, NOAA, Airborne platform-Apex, MSG3, 

PROBA-CHRIS, ENMAP 

LISTE DE SITES WEB listant des sites web fournissant des images satellites 
• 15 Free Satellite Imagery Data Sources 

o https://gisgeography.com/free-satellite-imagery-data-list/  

• 50 Satellites You Need To Know: Earth Satellite List  

o https://gisgeography.com/earth-satellite-list/  

• Resources for Finding and Using Satellite Images  

o https://gijn.org/resources-for-finding-and-using-satellite-images/   

 

http://earlywarning.usgs.gov/adds/imgbulks3.php?imgtype=nd&spextent=a
http://eo.belspo.be/Directory/Satellites.aspx
https://gisgeography.com/free-satellite-imagery-data-list/
https://gisgeography.com/earth-satellite-list/
https://gijn.org/resources-for-finding-and-using-satellite-images/
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19. Ressources complémentaires en ligne  

Sont reprises ci-dessous une sélection de ressources en ligne pour l’apprentissage des 

techniques d’analyses des données d’observation de la terre  

19.1. ARSET NASA Applied Remote Sensing Training 

En anglais et parfois en espagnol.  

Gamme très large et très variée de tutoriaux prêts à l’emploi pour apprendre les techniques 

d’analyses des données d’observation de la terre. 

Up to date. 

• https://arset.gsfc.nasa.gov/  

19.2. SNAP de l’ESA 

Ensemble de tutoriaux (50) développés principalement par l’ESA et focalisés essentiellement 

sur l’utilisation du logiciel SNAP  

• http://step.esa.int/main/doc/tutorials/ 

19.3. EO College - The first Massive Open Online Course on 

Radar Remote Sensing 

Ce site est un excellent cours moderne complet sur la télédétection RADAR avec théorie et 

exercice.  

Le site web présente cependant quelques ratés pour le moment (octobre 2019). 

Page d’accueil 

• https://eo-college.org/ 

Introduction au cours 

• https://eo-college.org/courses/echoes-in-space/lessons/history/topic/what-is-radar/ 

Chaine YOUTUBE de EO College 

• https://www.youtube.com/channel/UCka-UP2X3y3JpJRRvARzEhQ  

https://arset.gsfc.nasa.gov/
http://step.esa.int/main/doc/tutorials/
https://eo-college.org/
https://eo-college.org/courses/echoes-in-space/lessons/history/topic/what-is-radar/
https://www.youtube.com/channel/UCka-UP2X3y3JpJRRvARzEhQ
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Liens vers une séries de cours RADAR supplémentaires 

• https://eo-college.org/resources/#results  

RADAR COURSES I, II, III by ESA 

• https://earth.esa.int/web/guest/missions/esa-operational-eo-

missions/ers/instruments/sar/applications/radar-courses  

19.4. SERVIR Training Materials 

En anglais. 

Page web principale:  

• https://www.servirglobal.net/ 

“SERVIR is a joint development initiative of National Aeronautics and Space Administration 

(NASA) and United States Agency for International Development (USAID), SERVIR works in 

partnership with leading regional organizations world-wide to help developing countries use 

information provided by Earth observing satellites and geospatial technologies for 

managing climate risks and land use. We empower decision-makers with tools, products, and 

services to act locally on climate-sensitive issues such as disasters, agriculture, water, and 

ecosystems and land use.” 

“SERVIR aims to strengthen the ability of governments and other development stakeholders 

to incorporate Earth observations and geospatial technology into decision-making through 

workshops, training events, and other capacity building activities.” 

Page web du matériel pédagogique: 

• https://www.servirglobal.net/training-

materials/search?country=NaN&themes=&pageIndex=1&pageSize=6  

19.5. EO LEARN 

En anglais. 

Série de tutoriaux pour apprendre les techniques d’analyses des données d’observation de la 

terre. Cependant certaines leçons semblent dater, elles se focalisent surtout sur l’utilisation 

du logiciel BILKO et elles se limitent parfois à retaper un code préétabli.  

• https://www.learn-eo.org/  

Basé essentiellement sur le logiciel BILKO (UNESCO)  

https://eo-college.org/resources/#results
https://earth.esa.int/web/guest/missions/esa-operational-eo-missions/ers/instruments/sar/applications/radar-courses
https://earth.esa.int/web/guest/missions/esa-operational-eo-missions/ers/instruments/sar/applications/radar-courses
https://www.servirglobal.net/
https://www.servirglobal.net/training-materials/search?country=NaN&themes=&pageIndex=1&pageSize=6
https://www.servirglobal.net/training-materials/search?country=NaN&themes=&pageIndex=1&pageSize=6
https://www.learn-eo.org/
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• www.bilko.org 

19.6. Pôle THEIA 

Des supports pédagogiques disponibles en ligne sont recensés par le pôle Theia pour les 
personnes qui souhaitent se former ou former à la télédétection et à ses applications. 

• https://www.theia-land.fr/supports-pedagogiques/    

19.7. Newcomers Earth Observation Guide 

• https://business.esa.int/newcomers-earth-observation-guide   

The aim of this guide is to help non-experts in providing a starting point in the decision 

process for selecting an appropriate Earth Observation (EO) solution. 

19.8. Eduspace (ESA) 

• https://www.esa.int/SPECIALS/Eduspace_FR/index.html   

• Pour le secondaire  

19.9. “From GIS to Remote Sensing” 

Ce blog, créé par Luca Congedo, est le site de référence lié au plugin QGIS « Semi-Automatic 

Classification Plugin » (SCP) et contient une série importante de tutoriaux liés à la 

classification supervisée d’images satellites avec ce plugin.  

• https://fromgistors.blogspot.com/ 

 

http://www.bilko.org/
https://www.theia-land.fr/supports-pedagogiques/
https://business.esa.int/newcomers-earth-observation-guide
https://www.esa.int/SPECIALS/Eduspace_FR/index.html
https://fromgistors.blogspot.com/
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20. Newsletters auxquelles s’abonner 

Pour rester informé des dernières nouveautés dans le domaine de la télédétection, vous 

pouvez vous inscrire aux newsletters suivantes : 

• Sentinel Hub Newsletter  

o En lien avec le Sentinel Hub, EO Browser et les données COPERNICUS 

o https://www.sentinel-hub.com/faq/#how-can-i-stay-updated-and-subscribe-your-

newsletter 

• Theia 

o Actualités autour de la télédétection par le pôle français Theia.  

o https://www.theia-land.fr/category/theia/lettre-dinfo/ (lettre d’information 

semestrielle)  

o https://mailchi.mp/teledetection.fr/pole_theia_insciption (bulletin d’information 

semestriel)  

• NASA - Applied Remote Sensing Training (ARSET) 

o Cours de télédétection en ligne  

o https://arset.gsfc.nasa.gov/  

o S’abonner ici: https://lists.nasa.gov/mailman/listinfo/arset  

• DIGITAL EARTH AFRICA 

o Accès à certaines données satellites sur l’Afrique 

o https://www.digitalearthafrica.org/news 

o Besoin de s’inscrire en bas de page 

• PLANET 

o Images satellites à très hautes résolution, fréquentes, couverture mondiale, 

partiellement gratuites 

o https://www.planet.com/  

o Besoin de se créer un compte 

• Actualités de la communauté géomatique en Wallonie (région de Belgique) 

o Newsletter du Géoportail wallon et de la communauté géomatique wallonne 

(spécifique à cette région de Belgique) 

o https://geoportail.wallonie.be/newsletter 

• Charte Internationale Espace et Catastrophes Majeures 

o https://disasterscharter.org/web/guest/news  

 

 

https://www.sentinel-hub.com/faq/#how-can-i-stay-updated-and-subscribe-your-newsletter
https://www.sentinel-hub.com/faq/#how-can-i-stay-updated-and-subscribe-your-newsletter
https://www.theia-land.fr/category/theia/lettre-dinfo/
https://mailchi.mp/teledetection.fr/pole_theia_insciption
https://arset.gsfc.nasa.gov/
https://lists.nasa.gov/mailman/listinfo/arset
https://www.digitalearthafrica.org/news
https://www.planet.com/
https://geoportail.wallonie.be/newsletter
https://disasterscharter.org/web/guest/news
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21. Quelques logiciels de télédétection 

spatiale 

Nom Prix Site web 
   
Télédétection   
SNAP Gratuit https://step.esa.int/main/toolboxes/snap/ 

Logiciel de l’ESA pour les images « Sentinel » et + 
ENVI Payant http://www.exelisvis.com/ProductsServices/ENVI/ENVI.aspx 
IDRISI Payant http://www.clarklabs.org/products/idrisi.cfm  
ERDAS 
 

Payant http://geospatial.intergraph.com/products/ERDAS-
IMAGINE/Details.aspx  

QGIS 
 

Gratuit http://www.qgis.org/fr/site/  
Via des extensions de Quantum GIS : GDAL/OGR, GRASS, SAGA, etc. 

R Gratuit http://www.r-project.org/ 
Via des packages dédiés aux rasters : raster, rgdal, maptools, etc 
 

RSTUDIO Gratuit https://rstudio.com/  
Interface pratique pour utiliser R 

Google Earth 
Engine (GEE) 

Gratuit https://earthengine.google.org/  
Application cloud puissante idéale pour travailler sur de très 
grandes quantités de données 

SIG   
ArcGIS Payant http://www.arcgis.com/features/  
QGIS 
 

Gratuit http://www.qgis.org/fr/site/  

 
Pour travailler spécifiquement sur des séries temporelles d’images 
TIMESAT Gratuit http://www.nateko.lu.se/TIMESAT/timesat.asp  
SPIRITS Gratuit https://mars.jrc.ec.europa.eu/asap/download.php 
VGT EXTRACT 
 

Gratuit http://www.devcocast.eu/VGTExtract.do  

 
Pour travailler sur des données hyperspectrales ponctuelles 
ViewSpec Pro Gratuit http://support.asdi.com/Products/Products.aspx  

https://step.esa.int/main/toolboxes/snap/
http://www.exelisvis.com/ProductsServices/ENVI/ENVI.aspx
http://www.clarklabs.org/products/idrisi.cfm
http://geospatial.intergraph.com/products/ERDAS-IMAGINE/Details.aspx
http://geospatial.intergraph.com/products/ERDAS-IMAGINE/Details.aspx
http://www.qgis.org/fr/site/
http://www.r-project.org/
https://rstudio.com/
https://earthengine.google.org/
http://www.arcgis.com/features/
http://www.qgis.org/fr/site/
http://www.nateko.lu.se/TIMESAT/timesat.asp
https://mars.jrc.ec.europa.eu/asap/download.php
http://www.devcocast.eu/VGTExtract.do
http://support.asdi.com/Products/Products.aspx
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22. Liste de logiciels utilisés dans ce manuel 

• QGIS 3.10.0 ou version ultérieure 
o https://qgis.org/en/site/ 
o Dont les plugins/extensions suivant : 

▪ « Semi-Automatic Classification Plugin » (SCP) 

• GOOGLE EARTH PRO 
o https://www.google.be/intl/fr_ALL/earth/versions/#earth-pro  

• GOOGLE EARTH ENGINE 
o https://earthengine.google.com/  
o Besoin de se créer un compte Google 
o Pas besoin d’installer quoi que ce soit : application dans le cloud 

• SPIRITS + JAVA: 
o https://mars.jrc.ec.europa.eu/asap/download.php#box5  
o SPIRITS ne doit pas être installé en tant que telle mais "déposé" et 

« décompressé » sur l’ordinateur  
o SPIRITS nécessite que JAVA soit installé : « Spirits requires a Microsoft 

Windows system with a Java 7 Runtime Environment (JRE 1.7) or higher 
properly installed. » (source : manuel officiel de SPIRITS) 

▪ https://www.java.com/fr/download/ 
▪ Remarque : SPIRITS démarre via « javaw.exe  «  (localisé par exemple 

dans « C:\Program Files\Java\jre1.8.0_171\bin\javaw.exe ») 

• R + Rstudio 
o https://www.rstudio.com/ 
o https://www.r-project.org/ 

• SNAP 7 (ESA) 
o https://step.esa.int/main/download/snap-download/  
o --> voir le tableau et la ligne "All Toolboxes" 
o Faire les mises à jour des plugins après installation 

 

https://qgis.org/en/site/
https://www.google.be/intl/fr_ALL/earth/versions/#earth-pro
https://earthengine.google.com/
https://mars.jrc.ec.europa.eu/asap/download.php#box5
https://www.java.com/fr/download/
https://www.rstudio.com/
https://www.r-project.org/
https://step.esa.int/main/download/snap-download/
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